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Biopac Student Lab PRO 

 
Welcome! 

Welcome to the Biopac Student Lab PRO. The Biopac Student Lab PRO System includes both hardware and 
software for the acquisition and analysis of life-science data. You can use the Biopac Student Lab PRO for data 
acquisition, analysis, storage, and reporting and retrieval. 

The Biopac Student Lab PRO not only makes data collection easier, but also allows you to quickly and easily 
perform analyses that are impossible on a chart recorder. You can edit data, cut and paste sections of data, perform 
mathematical and statistical transformations, and copy data to other applications (such as a drawing program or 
spreadsheet). 

The PRO software uses the familiar point-and-click interface common to most applications. Complex tasks such as 
digital filtering or fast Fourier transformations are now as easy as choosing a menu item or clicking your mouse. 

This manual covers use of the Biopac Student Lab PRO and details a variety of common applications. If the 
application you desire is not addressed, visit the BIOPAC website at 3www.biopac.com to download one of over 50 
Application Notes, or call to request a hard copy. 
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Using this Manual 

The Biopac Student Lab PRO Guide is divided into five parts: 

Part A  
Introduction 

You should look through the Introduction whether you’re new to computer-based 
data acquisition systems or an old hand at physiological monitoring. This section 
covers the basic features of the BSL PRO System. 

Part B 
Recording Data 

Tells you how to be up and running with the Biopac Student Lab PRO in just a few 
minutes. Use this section to acquaint yourself with how the system works and the 
most frequently used features. 

Part C 
Acquisition Functions 

Explains data acquisition features and gives a detailed summary of different 
acquisition parameters. Provides an in-depth description of the commands used to 
determine acquisition rate, acquisition duration, and specialized functions such as 
triggering, averaging, and online calculations. 

Part D 
Analysis Functions 

Details information on analysis features; covers the range of post-acquisition analysis 
functions and transformations available with the Biopac Student Lab PRO software. 
Describes how to edit data, take measurements and perform basic file management 
options (save, print, etc). 

Part E  
Appendices 

Answers frequently asked questions, offers hints for working with files, includes 
information on upgrading from previous versions, discusses electrode use and digital 
filtering. 

 

Additional Guides 
In addition to The Biopac Student Lab PRO Guide, you should have the following Guides: 

Installation Guide The Installation Guide was packaged with your BIOPAC software CD. It contains 
complete, step-by-step instructions for connecting the MP Unit to your computer and 
details the installation process screen shots. 

BSL Hardware Guide The BSL Hardware Guide is part of the Biopac Student Lab documentation – see 
the User Support folder. It provides instructions for connecting external devices to the 
MP UNIT acquisition unit (electrodes, transducers, stimulators, and so forth) and also 
includes practical examples of how the BSL PRO is used with different components 
for common types of data acquisition and sample results and applications for widely 
used test procedures. 

 

 

IMPORTANT SAFETY NOTE 

BIOPAC Systems, Inc. components are designed for life science education and research 
applications with humans and animals. BIOPAC Systems, Inc. does not condone the use of its 
instruments for clinical medical applications. Instruments, components, and accessories provided 
by BIOPAC Systems, Inc. are not intended for the diagnosis, cure, mitigation, treatment, or 
prevention of disease. 

BIOPAC Systems, Inc. accepts no liability, or consequential liabilities, for the loss, effects of 
loss, or corruption of data caused when using any BIOPAC instruments. 
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Where do I find help? 

The Introductory sections are intended to provide you with enough information to get up and running with the 
Biopac Student Lab PRO, and familiarize you with some basic functions. There are far more features than described 
in the first few pages, so here is a guide for how to continue using this manual. 

The Help menu includes options to launch your web browser and go the BIOPAC site for PRO Lessons 
or launch Adobe Acrobat and open the complete Software or Hardware Guide as a searchable PDF 
document (see page 6248 for details). 

Biopac Student Lab PRO software 
Information about how to edit, display and transform data can be found in Part D — Analysis Functions. It explains 
how to import and export data, how to save files, and other file management commands. This section also explains 
how to use all of the post-acquisition features of the BSL PRO software. 

Connecting input devices 
To find out how specific modules connect to the MP UNIT acquisition unit, refer to the BSL Hardware Guide that 
was included with your Biopac Student Laboratory Manual. This section describes how to connect electrodes, 
transducers and input/output devices to the MP UNIT. 

Acquiring data 
For more specific information on different types of acquisitions, see Part C — Acquisition Functions. It covers basic 
acquisition parameters in detail, and describes some acquisition features (such as peak detection techniques and 
online calculation channels) not covered in the Getting Started section. 

Working with large files 
Acquisitions with fast sampling rates or long duration can generate large data files (several megabytes) that can be 
difficult to load, store, and view. The Biopac Student Lab PRO can handle such acquisitions — see Appendix B for 
information on how to optimize setup for these types of acquisitions. 

Troubleshooting 
Includes a list of the most frequently asked questions regarding the Biopac Student Lab PRO. Check this section (in 
Appendix A) for commonly encountered problems and solutions. For software problems or hardware conflicts, also 
check the troubleshooting section of the Biopac Installation Guide. 

Contact BIOPAC Systems, Inc. 
To speak directly with a representative, check the How to Contact BIOPAC Systems, Inc. directory of 
worldwide representatives (included at the back of this manual, in a separate section after the Index). You 
can visit the BIOPAC web site at 3www.biopac.com for product information and application guidelines, or 
send an email to 3info@biopac.com. 
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Biopac Student Lab PRO Features 

   

New Features in BSL PRO 3.7 

 Output Control Panels—Stimulator, Pulses, Digital, Voltage, Analog CH 

 Segment Overlap for Append 

 More Powerful Markers—Distinguish Appended Segments from Events, Pre-Label markers, etc. 

 Digital Channels: 8 Input and 8 Output—MP36/35 required 

 Rewind—Delete last recorded segment 

 Help menu—quick access to PDF support files and the BIOPAC web site 

 Japanese Language Support 

 Works on XP Home/Pro/Media Operating Systems 

 USB1.0 and USB2.0 Options 

 Horizontal Scale: Hold Relative Position  

 Horizontal Axis Format  

 Standard Curve for Colorimetery 

 Manual Documentation Updates 

 MP35 Software Adjustments 

   Plus, in 3.7.1 

 Security Options utilize “Limited”or “Restricted” user account setup 

 Preset Enhancements: Organization tools, new Newtons force, new EEG & Gamma 

 Triggering via I/O: Synch acquisition to SuperLab interface or Stroboscope—MP36/35 only 

 Marker Manager allows access to all markers in the record (vs. previous limited view of 127) 

 Data Selection Enhancement simplifies switching cursor styles and retaining selection 

 Display Enhancements—right-click option to "Paste measurements to Journal” from graph 

 Plot options—display a “thicker” line for any channel’s data plot. 

   Plus, in 3.7.3 

 Save As (Export) MATLAB file format 

 MP36 compatibility 

 Electrode Check enhancements 

  Plus, in 3.7.5  

 MP45 compatibility 

  Plus, in 3.7.7 

 Media Capture/Playback 

 Playback Mode 

 Gauge View 

 New Startup Wizard and seamless launching between BSL PRO and BSL Lessons 

 Pulse Sequence and Sound Sequence Output Controls 

 Automatic hardware selection (Supports MP36/35/30/45) 

 Calculation Control Channel 

 Calculation Rescale Channel 

 New Analog Channel Presets 

 

 

See the Features overview on page 14 or see the corresponding section of the manual for each item. 
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Features Overview 
In conjunction with your computer, the Biopac Student Lab PRO is a complete system for acquiring almost any 
form of continuous data, whether digital or analog. The Biopac Student Lab PRO can perform a range of recording 
tasks, from high-speed acquisitions (up to 100,000 samples/sec) to long duration acquisitions. Generally speaking, 
for physiological applications, the Biopac Student Lab PRO is limited only by the speed of your computer and its 
available memory or disk space. Features of the Biopac Student Lab PRO include: 

PC 3.7.7 Feature Description 

NEW  

Output Control Panels 

Different control panels are used for different output devices: 

CH3 or Selected CH#  

Digital Outputs (if MP36/35 is connected) 

Pulses 

Voltage 

Stimulator – BSLSTM 

Stimulator – Low Voltage Stimulator (MP36 Analog Out or MP35 with SS58L) 

Pulse Sequence 

Sound Sequence 

The Output Control panels attach to the graph window for consistency and their 
compact design leaves more display space for graphs. Access the Preference 
dialog for each output by right-clicking on the dialog. Save settings, much like a 
preset but within the graph or template; access is via a pull-down menu in the 
control panel. 

NEW  

Segment Overlap 

A new "Overlapping Segment" toolbar button is available in the Append acquisition 
mode to overlap appended sections of data in viewed in Scope or Chart mode. It 
acts like the scope mode applied to horizontal sections of data and can be very 
handy for data comparisons. Choose the active segment to take measurements and 
display markers; the active segment will be highlighted in the graph display and you 
can use a pull-down menu showing segment labels to change it. 

NEW  

Marker Controls 

The application includes three types of markers instead of just one: 

 Append Markers appear as triangles located above the marker label region and 
will be automatically inserted at the start of each recording segment in the Append 
acquisition mode. Append markers are blue when active. 

 Automatic Event Markers appear as green inverted triangles located below the 
marker label region and use labels that are generated automatically when the 
assigned function key is pressed. Event markers are yellow when active. 

You can pre-establish Automatic Event marker labels as sequential or fixed. 

 Manual Event Markers appear as inverted triangles with a line above them and 
are located below the marker label region (in the same region as the Automatic 
Event Markers). Event markers are yellow when active. 

Marker tools have been improved, too. Check out these new Marker features... 

Marker menu additions 

Pre-establish Labels 

Automatic Time Stamp 

New Journal Summary Preference 
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PC 3.7.7 Feature Description 

 

NEW  

Digital Channels MP36 
or MP35 required 

Use the new digital channels to work with visual presentation programs like 
SuperLab and E-Prime. 

8 Digital Input Channels — Use the Setup Channels dialog from the MP36/35 
menu to establish up to eight digital input channels (use the arrows to scroll channel 
# up or down). 

8 Digital Output Channels — Use the "I/O Port" on the back of the MP36/35 to 
establish up to eight Digital Output channels, and use the Output Control and 
Preferences to establish parameters. 

 

 

NEW  

Rewind 
A  “Rewind” toolbar button allows you to erase the last recorded segment of 
appended data (just like in the BSL Lessons software). When this button is pressed, 
a warning dialog will appear and if you proceed, the last segment will be deleted 
along with the Append Marker for that segment. 

NEW  

HELP MENU 

Now you get our exclusive real-time System Manual, Hardware Guide, Sample 
Files, etc., with easy-to-use navigational tools. Search the manual (pdf files) while 
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PC 3.7.7 Feature Description 

you are running BSL PRO for on-the-spot, targeted help. New Help menu contains 
the following digital support items: 

PRO Lessons from Web... Opens the default browser, goes to our website and 
shows all available PRO lessons. 

Open BSL Hardware Guide... Looks for the “PDF” file; “BSL Hardware Guide” 
located in Application Folder\Documents and if present, opens it in Acrobat Reader. 

Open BSL PRO Manual... Looks for the “PDF” file; “BSL PRO Manual” located in 
Application Folder\Documents and if present, opens it in Acrobat Reader. 

About Biopac Student Lab provides version details for Tech Support. 

NEW  

LANGUAGES 

BSL PRO menu items and dialogs have been translated into Japanese. Also 
available in English, French and Spanish, with more translations on the way! 

NEW  

OS 

BSL Lessons and PRO have been fully tested and approved for Windows 7 and 
Windows Vista OS. Windows XP is also supported. 

NEW USB The USB1W connector works with USB1.0 and USB2.0 driver files. 

NEW  

HORIZONTAL SCALE 
— HOLD RELATIVE 

Zoom in on a section of data and have the next acquisition (in any acquisition 
mode; Save Once, Append etc.) hold the relative position of the horizontal scale. 
This is extremely convenient for many experiments such as Compound Action 
Potential when one is performing multiple acquisitions where the signal remains in 
the same location for each acquisition. This is very convenient when trying to do 
short duration, high speed acquisitions, where the signal of interest is in the same 
position when one performs acquisition (like when the stimulator, where you would 
like to be able to zoom in on the signal of interest and have the relative position 
(from the start of acquisition) stay the same. 

NEW  

HORIZONTAL AXIS 

This option in the Display menu generates a 
“Set Horizontal Axis format” dialog with two 
time format options. 

 

 

NEW  

STANDARD CURVE 

The BSL PRO can be used with common Colorimeters used in most Physiology 
labs to generate a Standard Curve (“best fit” line) plot of Absorbance vs. 
Concentration. The Standard Curve can then be used to find the concentrations of 
unknown solutions. 

 A new tool bar button is available when the graph is in the X/Y mode that 
generates a “Plot Standard Curve” dialog. Step through a simple calibration 
procedure to produce accurate Absorbance vs. Concentration plots for a specific 
solution type. 
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PC 3.7.7 Feature Description 

 

NEW 
DOCUMENTATION 

Updated algorithm information and formulas. 

New BSLSTM and BSLSTMA Specifications in the Hardware Guide. 

New USB Troubleshooting Guide. 

New information about A/D resolution. 

Updated GSR information in the Hardware Guide. 

Updated descriptions for Cut, Copy and Paste. 

Description of advanced analysis using the ECG arrhythmia data (from PhysioNet). 

NEW  

MP36/35 
ADJUSTMENTS 

The BSL PRO will detect whether an MP36, MP35 or is connected. If an MP36/35 is 
detected, the application will automatically make the following changes to optimize 
performance 

The Setup Channels dialog will include a region for “DIGITAL INPUT CHANNELS”. 

The High Speed mode will be eliminated. Communications at sample rates above 
2,000 s/s will be the same as at 2K and below. 

The “Setup Triggering” dialog will have an additional item in the “Source” menu 
called “External” allowing it to work with the “External trigger” BNC on the back of 
the MP36/35.  

The system will be optimized for MP36/35 performance (i.e., USB communication, 
“Gain” and “Input Ranges” settings may be changed). 

NEW  

SECURITY 

In BSL 3.7.1, the system (or network) administrator can set user accounts to 
“Limited” (Windows XP) or “Standard” (Windows Vista/7) access to achieve a good 
level of security when running under those Operating Systems. A Limited or 
Standard user account can handle individuals or groups of students and allows the 
option of password protection (recommended).  

See the “Biopac Student Lab User Account & File Location Guide” provided on 
the installation CD for more information.  

NEW  

PRESET 
ENHANCEMENTS 

The Preset pull-down listing is now organized into two groups,  Human and Animal, 
with a separator (horizontal line) between them. This applies to both the Analog 
Input Channels and the Calculation Channels presets list.  

Preset separators (horizontal lines) can be added by the user when customizing the 
preset listing. The separator could be manually placed in the: MP UNIT > Organize 
Channel Presets dialog.  

There is a new Analog Channel Preset available for the SS25LA Hand 
Dynamometer that is scaled to units of Newtons: “Clench Force (N).”  This is a 
proper unit of force which is “more scientific” than the units of Mass (Kilogram and 
Pounds) that are commonly used.  

There is a new, higher bandwidth, EEG Analog Channel Preset available: 
“Electroencephalogram (EEG), .5 - 100 Hz w/notch”.  When used in conjunction 
with the new “EEG gamma (30 - 90 Hz)” Calculation Channel Preset, it allows for 
the gamma frequency band to be recorded. The gamma frequency band seems to 
be correlated to information processing and cognitive functions of the brain.  

NEW  

I/O TRIGGERING 

MP36/35 only 

The user may now specify triggering (start the acquisition) when a change of logic 
level occurs on any of the 8 digital Input lines (“I/O Port”, DB25 on rear of unit). This 
can be useful for synchronizing the start of acquisition to un-isolated external 
devices, such as SuperLab interface, or a Stroboscope.  

NEW  

MARKER MANAGER 

BSL 3.7.1 adds a “Marker Manager” option that allows access to all markers in the 
file. Previous versions limited the number of markers (to 127) that could be 
accessed in the Marker menu > Show Event Marker or Append Marker listings.   

NEW  Following a single data point selection using the Arrow cursor, if the "I-Beam" cursor 
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PC 3.7.7 Feature Description 

DATA SELECTION 
ENHANCEMENT 

is selected, manually or using the "Ctrl + I" buttons; the cursor will be placed at the 
last data point selected.  It is useful for users who have found data using the arrow 
cursor to preserve this position when they switch to the other cursor style.  

NEW  

DISPLAY 
ENHANCEMENTS 

When in the Chart or Scope display modes, there is a new option in the right mouse 
pull-down menu (when cursor is in the wave plotting region) to "Paste 
measurements to Journal ".  This is a common option for some users and accessing 
it from the right click menu is much faster then accessing it through the Edit menu.  

 

NEW  

PLOT OPTION 

The user now has the option to display a “thicker” line for any channel’s data plot. 
The Display > Show > Dot Size is available when the mode is "Line Plot".  A thicker 
line can work better for display on projectors or when printing data.  The line 
thickness for each channel will saved with the data file. 

NEW  

SAVE AS MATLAB 

Save files in the MATLAB format. 

NEW 

STARTUP WIZARD 

BSL 3.7.7: New startup screen allows easy selection of BSL PRO, BSL Lessons or 
no-hardware Analysis mode. 

NEW 

AUTOMATIC MP 
HARDWARE 
SELECTION (Supports 
switching between 
MP36/35/30/45 
hardware) 

BSL 3.7.7 will support switching between multiple MP hardware types connected to 
the same computer. Only one hardware type may be used at a time to acquire data, 
but this feature allows the MP hardware type to be switched between application 
launches without having to rerun the installer CD, as in previous BSL versions. 
Simply exit the BSL application, turn OFF (or unplug) the unneeded hardware, turn 
ON (or plug in) the new hardware, and relaunch the BSL application. (MP hardware 
drivers must be installed in order to use this feature) 

NEW 

MEDIA 
CAPTURE/PLAYBACK 

BSL 3.7.7 supports audio/video media capture during acquisitions as well as 
playback when reviewing graph data. 

NEW 

PLAYBACK MODE 

BSL 3.7.7: User now has option to open a graph in Playback mode and replay the 
data as it was recorded. 

NEW 

GAUGE VIEW 

BSL 3.7.7: The MP menu now contains option for an onscreen, fully configurable 
analog blood pressure gauge. 

NEW 

PULSE SEQUENCE 
OUTPUT CONTROL 

BSL 3.7.7: User now has option to set up advanced Pulse Train configurations. 
(MP36/35/30 only) 

NEW 

SOUND SEQUENCE 
OUTPUT CONTROL 

BSL 3.7.7: Similar to Pulse Sequence, offers user-configurable sound setups for 
performing aural stimulus experiments. 

 

NEW 

CALCULATION 
CONTROL CHANNEL 

Control channel support for changing digital output lines based on calculation 
channel analysis. 

 

NEW 

CALCULATION 
RESCALE CHANNEL 

Applies two-point linear mapping and allows users to change the measurement 
units. 

 

Biopac Student Lab PRO Benefits 

Easy to use The Biopac Student Lab PRO offers the same convenient and easy-to-use features that 
Windows® users are accustomed to. Since the Biopac Student Lab PRO software runs under 
these environments, you can run other applications while you are collecting data. In terms of 
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Biopac Student Lab PRO Benefits 
hardware setup the Biopac Student Lab PRO uses simple plug-in connectors and standard 
interface cables. You don’t need a degree in electronics to set up your system. 

Flexible setup The Biopac Student Lab PRO can be configured for a wide variety of applications, from single 
channel applications to multiple-device (up to 4 analog) measurements. You control the length 
of acquisition, the rate at which data is collected, how data is stored, and more...all with a few 
clicks of the mouse button. Whether you’re measuring alpha waves or collecting zoological 
data, the Biopac Student Lab PRO can meet your needs. 

Flexible acquisition rates The BSL PRO can acquire data from 1 to 100,000 samples/sec. This allows recording of almost 
all physiological parameters from slow moving temperature data to fast response action 
potential data. This means you can use the BSL PRO System to replace both your chart recorder 
and oscilloscope.  

Flexible menu display You can easily customize menu displays to show only the functions you are using, thereby 
reducing the risk of error or confusion in the lab. This is particularly powerful for laboratories 
working to GLP guidelines and is also useful for teaching applications. 

Online calculations Although the Biopac Student Lab PRO software provides an extensive array of measurements 
and transformations you can apply to collected data, sometimes you need to perform 
computations while data is being collected. The Online Calculation functions allow you to 
calculate new channels based on incoming signals. This feature allows you to compute BPM, 
for instance, based on raw ECG data. 

Online filtering Many times, it is preferable to filter data as it is being collected, rather than having to wait until 
after the fact, so now you can apply filters to incoming data and view the results in real time. 
That means online monitoring of data filtered to suit your needs. 

Online measurements The Biopac Student Lab PRO software can instantly compute over a twenty measurements and 
computations for any given data point(s). These options are available from pull-down menus 
and include: mean; peak-to-peak value; standard deviation; frequency; and BPM. 

Grid options You can apply several different grid styles to your data to help with analysis. UNLOCKED 
grids help you view the data display on the monitor whereas LOCKED grids help more with 
printing. You can set the Grid Options to create printouts that look similar to chart recorder 
output. 

Presets There are over 80 factory-established “Presets” that allow you to easily configure hardware 
parameters. These presets can be modified, and/or new presets can be created and saved for 
later use.  

 

Graph templates This powerful feature allows instructors to predefine experiments. Students simply open the 
template file and click “Start” to run the experiment. A sample graph template file 
(HeartTemplate.gtl) is included with the PRO installation. 

Replace (or augment) a 
chart recorder 

Whether you want to replace a chart recorder or simply supplement an existing setup, the BSL 
PRO is fully compatible with most major recording devices. What’s more, the BSL PRO is 
compatible with most popular input devices, so you can continue using the same transducers, 
electrodes and sensors. 

Preview your data Similar to chart recorders, the Biopac Student Lab PRO allows you to change both the vertical 
scale and the horizontal scale. You can change the amplitude scale or the time scale to any 
value you wish, or you can have the Biopac Student Lab PRO software automatically scale 
them for you. 

Simplified editing It used to be that once your data was collected, the only way to edit it was with scissors and 
adhesive tape. Now you can delete unimportant sections of your data with a keystroke. You can 
“paste” together sections from different waves, or edit out noise spikes from individual waves. 

Append mode For some applications, data only needs to be recorded during some portions of a long 
experiment. The Biopac Student Lab PRO software has added an Append mode that lets you 
pause the acquisition for as long as you wish, and resume the acquisition as many times as 
needed. When data are acquired in this mode, you can start and stop a recording as you would 
with a chart recorder. This saves on storage space and processing time for transformations. 
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Biopac Student Lab PRO Benefits 

Digital filtering All data contains measurement error and noise. Now you can reduce or eliminate that error by 
using the digital filters and smoothing transformations included in the Biopac Student Lab PRO 
software. You can smooth data or filter out noise from any frequency or bandwidth you wish. 

X/Y plotting You can view and acquire data in the form of an X/Y plot, with one channel on the horizontal 
axis and another on the vertical axis. This allows you to explore relationships between different 
channels and opens up a whole range of applications, from chaos plots to respiration analysis to 
vectorcardiograms. 

Histogram function You can easily examine the variability and the measures of central tendency of any waveform 
data with the histogram function. Set the plotting options to suit or let the software determine 
the “best fit” for graphing data. 

Math functions In many cases, simply collecting raw data is not enough. The BSL PRO software has an array 
of built-in mathematical functions ranging from simple absolute value functions to computation 
of integrals, derivatives, and operations involving multiple waveforms (such as subtracting one 
wave from another). You can even chain multiple functions together to form complex 
equations. 

Annotation  The Biopac Student Lab PRO software has a journal you can use to append comments 
concerning the input data, either online or after the fact. This is especially useful for noting the 
characteristics of an acquisition (what was involved, what manipulations took place, and the 
like) for future reference.  

Triggering If you need to measure response times or start data collection only after some event has 
occurred, the Biopac Student Lab PRO software allows you to trigger an acquisition in a 
number of different ways. You can trigger on the level of a signal, or with an external 
synchronizing trigger. 

Event markers  Many times, especially during a long acquisition or in a laboratory setting, it is useful to make a 
note of when specific events (such as manipulation) occur, so that any changes in the data can 
be noted. The marker function allows you to insert symbols in the record and add up to 80 
characters of text for each marker. Markers can be added either while data is being collected or 
after the fact. 

File compatibility With the Biopac Student Lab PRO software, you can save data in a number of different formats. 
You can output data in either text or graphical form, and export or use the clipboard to place 
data in other programs. Use BSL PRO data in word processing programs like Microsoft 

Word®, spreadsheet programs like Microsoft Excel®, drawing programs like Aldus 

IntelliDraw®, or desktop publishing programs like Aldus PageMaker®. Biopac Student Lab 
PRO software will even read-in raw data from a text file. 

Pattern recognition Using an advanced pattern search/recognition algorithm, the Biopac Student Lab PRO software 
can automatically find a specific pattern within waveforms. This is useful for finding abnormal 
waveforms (such as irregular ECG waves) within a data file. 

Peak detection The Biopac Student Lab PRO software has a built in algorithm to find either positive or 
negative peaks from any size data file. You can even search for all the peaks with one command 
and automatically log statistics like peak time and area to the journal. 

Printing options The Biopac Student Lab PRO software provides a range of printing options, and allows you to 
fit data on one page or many. You can also print several graphs per page, even if you only have 
one-channel recordings. Since the Biopac Student Lab PRO software runs under Windows, no 
special printer drivers are required. 

Sample data files The Biopac Student Lab PRO installation disk includes sample data files from: a 4-channel 
recording, Blood Pressure, EEG, EMG with Force, Finger Twitch. 

User support Whether you have a question about compatibility with existing equipment or need to develop a 
specialized measurement device, BIOPAC’s Applications Department can address the problem. 
Plus, you can visit the BIOPAC website at 3www.biopac.com for answers to frequently asked 
questions, product information, and a wide array of Application Notes. 
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PRO Lessons 

PRO Lessons illustrate the scope of the Biopac Student Lab 
System. Each lesson describes the required hardware and 
software setup (channel setup, acquisition setup, gain, scaling, 
etc.) and outlines the basic procedure necessary to record and 
analyze a variety of applications on human and animal subjects. 

When applicable, a downloadable template file (*.gtl) is included 
with the lesson to further simplify setup. The template file 
includes all the appropriate settings for the lesson — just open 
the file, connect the hardware and begin recording! 

If you have developed lessons for your course, we invite you to 
make your lessons available to other users. You will receive full 
credit for the lesson. Just provide us with a copy of your lesson plan and a sample data file. We will add 
your lessons to the list and other users can benefit from your efforts. Please don't worry about formatting 
issues — the important part is the lesson plan and instructions. We'll take care of the formatting for you. 
Human PRO Lessons graph templates are included in the BSL 3.7.7 PRO Lessons folder and easily 
accessible from the Startup Wizard. Or visit our website or quick-click to the Lessons menu using 
Help>PRO Lessons from web for the most up-to-date listing and downloadable files. 

 

 See Higher Education > 3Curriculum section online for the full list of available lessons. 

 

Application Notes 

If you need information about an application not covered in this manual, visit the Support section of the BIOPAC 
web site to review more than 50 available Application Notes. The notes are static pages that provide detailed 
technical information about either a product or application. View or print the Application Note you need, or call to 
request a hard copy. 

 

 See the Support > 3Application Notes section online for the full list of available lessons. 
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Human Anatomy & Physiology Society Position Statement on Animal Use 

Adopted July 28, 1995 

It is the position of the Human Anatomy and Physiology Society that dissection and the manipulation of animal 
tissues and organs are essential elements in scientific investigation and introduce students to the excitement and 
challenge of their future careers. 

The Human Anatomy and Physiology Society (HAPS) is a national organization of science educators dedicated to 
the task of providing instruction of the highest quality in human anatomy and physiology. 
A fundamental tenet of science is the ordered process of inquiry requiring careful and thoughtful 
observation by the investigator. As subdivisions of biology, both anatomy and physiology share a long history of 
careful and detailed examination, exploration and critical inquiry into the structure and function of the animal body. 
Consistent with the origins and nature of scientific inquiry, HAPS endorses the use of animals as essential to the 
laboratory experiences in both human anatomy and human physiology. 

Historically, the principal tool of investigation in anatomy has been dissection. A properly directed dissection 
experience goes beyond naming structures and leads the student to conclusions and insights about the nature and 
relatedness of living organisms that are not otherwise possible. To succeed in their future careers, students must 
become thoroughly familiar with anatomical structures, their design features and their relationships to one another. 
Dissection is based on observational and kinesthetic learning that instills a recognition and appreciation for the 
three-dimensional structure of the animal body, the interconnections between organs and organ systems, and the 
uniqueness of biological material. While anatomical models, interactive computer programs, and multimedia 
materials may enhance the dissection experience, they should not be considered as equivalent alternatives or 
substitutes for whole animal dissection. 

HAPS supports the use of biological specimens for anatomical study provided their use is in strict compliance with 
federal legislation and the guidelines of the National Institutes of Health and the United States Department of 
Agriculture and that such use fulfills clearly defined educational objectives. 

Physiology experiments involving live animals provide an excellent opportunity to learn the basic elements specific 
to scientific investigation and experimentation. It is here that students pose questions, propose hypotheses, develop 
technical skills, collect data, and analyze results. It is here that they learn 
to remain focused on the details of procedure and technique that may influence the outcome of the experiment and 
the responses of the animal. When faced with unexpected and even erroneous results, students develop and improve 
their critical thinking and problem solving skills. 

Computer simulations and video programs are useful tools that help students acquire a basic understanding of 
physiologic principles. However, due to the inherent variability and unpredictable nature of biological responses, 
such programs fail to fully depict the uniqueness of living organisms 
and should not be viewed as equivalent alternatives or substitutes for live animal experiments. HAPS supports the 
use of biological specimens in physiology experiments provided their use is in strict compliance with federal 
legislation and the guidelines of the National Institutes of Health and the 
United States Department of Agriculture and that such use fulfills clearly defined educational objectives. 

Science educators have in common a respect and reverence for the natural world and therefore have a responsibility 
to share this with their students. They must communicate the importance of a serious approach to the study of 
anatomy and physiology. HAPS contends that science educators should retain responsibility for making decisions 
regarding the educational uses of animals. Furthermore, it opposes any legislation that would erode the educator's 
role in decision making or restrict dissection and animal experimentation in biology. 

Used with permission of: The Human Anatomy and Physiology Society (HAPS) 
222 South Meramec, Suite 203, St. Louis, MO 63105 
1-800-448-HAPS 
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Part A — Introduction 
Part A - Introduction covers the basics of data acquisition and analysis with the BSL PRO System. All of the 
material in this section is covered in more detail in subsequent sections (see Using this Manual on page 611 for a 
guide to sections). 

 
 

 

Chapter 1 Overview of the BSL PRO System 
The Biopac Student Lab PRO System performs two basic functions: acquisition and analysis. The acquisition 
settings determine the basic nature of the data to be collected, such as the amount of time data will be collected for 
and at what rate data will be collected. All of the acquisition parameters can be found under the MP UNIT menu. 
The other menu commands pertain to analysis functions such as viewing, editing, and transforming data. 

The BSL PRO System is a computer-based data acquisition system that performs many of the same functions as a 
chart recorder or other data viewing device, but is superior to such devices in that it transcends the physical limits 
commonly encountered (such as paper width or speed). Data collection generally involves taking incoming analog 
signals and sending them to the computer, where they are 
 (a)  displayed on the screen, and 
 (b)  stored in the computer’s memory (or on the hard disk). 

These signals can then be stored for future examination, much as a word processor stores a document or a statistics 
program saves a data file. Graphical and numerical representations of the data can also be produced for use with 
other programs. 

The Biopac Student Lab PRO consists of several major components, including hardware and software. The BSL 
PRO software allows you to edit data and control the way it appears on screen, and performs four general functions: 

Controls the data acquisition process 

Performs real-time calculations (such as digital filtering and rate detection) 

Performs post-acquisition transformations (such as FFT’s and math functions) 

Handles file management commands (saving, printing, etc.) 

The heart of the BSL System is the MP Unit data acquisition unit. This unit takes incoming signals and converts 
them into digital signals that can be processed with your computer. The MP Unit connects to your computer via the 
USB adapter (USB1W). 
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Launching the Biopac Student Lab PRO software 

You cannot run more than one copy of BSL PRO at a time and you cannot run BSL PRO if BSL lessons are 
running; see page 27 for launch error details. 

MP36/35/30/45 (NOTE: For MP45 hardware, lessons 7, 8, 9, 11, 14 & 20 are not available) 

Double-click the Biopac Student Lab 3.7.7 icon or use the Windows Start menu to launch the Startup Wizard. 
Choose the desired BSL application, (or select “Analyze”), and then click OK. 

 
After you launch the program, you may receive a warning prompt regarding the hardware, as shown here: 

 
To use the Biopac Student Lab PRO software without the MP UNIT hardware, click “OK.” When you’re ready to 
acquire data at any subsequent time, connect and/or switch on the MP Unit hardware and then restart the software. If 

the MP UNIT is properly connected, you will not get a warning and the light next to the  button in 
the display window will change from grayed-out to green. 

If the MP Unit is connected and you receive the Hardware warning when you launch the software, there are two 
possibilities: 

a) You have not properly connected everything and/or you have not powered up the MP UNIT. 
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b) You may have a device or software (init) conflict, which may prevent you from using the BSL PRO software. If 
you have any problems communicating with your computer, there is probably a setting in your computer 
conflicting with the setting used by the BIOPAC program. See your System Administrator and then, if 
necessary, contact BIOPAC for Technical Support. 

 

After personalizing your copy — 
and assuming you have already 
connected the MP Unit to your 
computer — you will see the 
following:  

This will flash briefly each time 
Biopac Student Lab is launched. 
This screen lists the Biopac Student 
Lab PRO release number, which is 
useful if you ever need to call 
BIOPAC for technical support. The 
same information is accessible via 
the “About Biopac Student Lab” 
option of the Help menu. 

 
 

 

Assuming everything is properly 
connected and there are no 
conflicts, an empty Biopac Student 
Lab PRO graph window will be 
generated. 

A “window” is the term used for 
the area on your computer’s screen 
where data is displayed and/or 
manipulated. Data can be displayed 
during acquisition. The graph 
window on the screen is designed 
to provide you with a powerful yet 
easy-to-use interface for working 
with data.  

At this point, you can use the new 
window, open a template, or open 
an existing data file. 

MP3X users 
 To create a new graph 

window, choose 
File>New. It’s a good idea 
to create a new graph 
window for each 
acquisition. 

To open an existing data file or a 
template, choose File>Open and 
then choose a file from the list in 
the dialog box. If you choose to 
open an existing file, you may want 
to close the new, blank window. 
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To open a Journal window, click 

the journal  icon on the 
toolbar (or choose 
Display>Show>Journal). 

 

 

NOTE: You may use FileGo To 
to switch seamlessly between the 
BSL PRO/Lessons applications or 
to relaunch the Startup Wizard. 
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Launch errors         
BSL PRO and Biopac Student Lab (lessons) can both be installed on a single computer. 

Windows/PC installation automatically installs both applications.      

Macintosh installation requires a separate installation for each application. 

Each application must be run individually—it is not possible to run BSL PRO and BSL Lessons at the 
same time. 

Mac only An error prompt will be generated to describe any application launch conflict: 

Another copy of BSL is still running. You must quit BSL before you can use BSL PRO. 

or 

Another copy of BSL PRO is still running. You must quit BSL PRO before you can use BSL. 

Quit the running application to enable launching the other. To quit an application, make it the active 
window and use File > Quit to exit the program. 

TIP You can activate some BSL PRO analysis options within the BSL Lessons “Review Saved Data” 
mode to increase analysis functionality. To activate the BSL PRO analysis options, see “Menu 
Customization Options” in the BSL Orientation Guide. 

 

Sound Errors for MP45 Users  

 Audio Properties  

You must select BIOPAC MP45 USB Data System from the Sound Playback menu (Control Panel > 
Sounds and Audio Devices) in order for sound to be heard. If the Sound/Audio Properties are not 
setup properly, no sound will be heard; no warning prompts will appear if set incorrectly. 

   
 Device Volume  

The Device volume slider must be set to “High” and “Mute” must not be enabled. 

 

 



28 Part A 

Visit the online support center at www.biopac.com 

Sample Files 

For purposes of illustration, you are encouraged to open a sample data file and follow along with the manual text. 
Default installation includes sample data files at C:\Program Files\BIOPAC\BSL 3.7\BSL PRO 3.7\Samples (see 
page 6255 for a static graph of each sample file). 

 
Open the 4Channel.ACQ sample file from the Samples folder. 

 
“4Channel.acq” Sample File Display 

The 4Channel.acq sample file contains four different types of data, with a border between each waveform display. 
To the left of each waveform is a vertical strip containing a channel label text string that can be used to identify each 
waveform: ECG, PPG, Respiration, etc. 

The horizontal scale along the bottom denotes when the data was recorded relative to the beginning of the 
acquisition. Only eight seconds of the total data record are visible in the display window, although the file contains 
the complete record. The data displayed on the left edge of the window represent events that occurred about 12 
seconds into the record, and the data displayed at the right edge of the screen represent events that occurred about 20 
seconds after the acquisition was started. The display scale can be adjusted to virtually any value range. 

The vertical scale along the right edge contains the amplitude unit range for each channel. 
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The Data Viewing Screen 

 
Parts of the Biopac Student Lab PRO screen  

 

Software Controls 

Use the left mouse button when a mouse function is referenced, except as noted for special shortcuts. See page 633 
for information about right-click shortcuts. 

Menu Structure 
The pull-down menu structure runs across the top of the display window. 

 
 

Menu Type of Commands 

File General file management commands, including opening, saving, and closing files. 
“Save as” to export data files. Set program preferences. 

Edit Select, cut, copy, and paste between and within files. 

Transform Mathematical transformations and functions, from simple arithmetic to digital filtering 
and spectral analysis. 

Display Control how data appears on the screen either during or after an acquisition. 

Window Standard Windows functions. Refer to the Windows System Guide for detailed 
information. 

MP Menu Acquisition parameters, including channel, acquistion, and trigger setup. Output 
Control, including stimulator. 

Changes to match the hardware unit: 

MP36 or MP35 or MP30 or MP45 

Help Access to BSL PRO lesson (requires browser), hardware and software documentation 
as real-time, searchable documents (requires Acrobat Reader), and information about 
the MP UNIT, BSL software, and firmware. 
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Toolbar 

 
The toolbar contains button shortcuts for many of the most frequently used features. Click an icon to activate it. The 
toolbar is displayed beneath the menu bar. To show or hide the toolbar, click Display menu > Show >Tool Bar or 
right-click at the top of the display screen in the menu bar region. 

Icon Function 

 
Change display to Scope mode. 

 
Change display to Chart mode (default). 

 
Change display to X/Y mode. 

 
Change display to Overlap Segments mode—overlaps appended segments of data. 

 
Autoscale, Vertical (active waveform only along the vertical axis). 

 
Optimize Range—adjusts vertical scale of active channel to display full range of data; see pages 638 and 6242. 

 
Autoscale, Horizontal (all waveforms along the horizontal axis). 

 

Center waveforms vertically in the active window (X/Y mode only). 

 

Center waveforms horizontally in the active window (X/Y mode only). 

 
Find the peak of a selected area. 

 
Find the next peak (after peak has been defined). 

 
Open a recently-used file. Select from a list of BSL PRO files in the current folder, or browse to open. 

 
Show/Hide gridlines in the graph window. 

 
Show/Hide measurement pop-up windows.  

 
Show/Hide channel selection boxes. 

   
 Channel selection boxes are displayed above the graph window; see page 49. 
 To select a channel, click the corresponding channel number box. 
 To hide a channel, Ctrl-click the channel box. A slash mark indicates the channel is hidden. 

 
Show/Hide Marker region and Marker tools; see page 6172. 
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Icon Function 

 
Show/Hide Journal window 

 Macintosh: Journal must be opened via the File menu. Once open, this icon toggles the 
display. 

 The Journal toolbar is displayed in the Journal window. Journal tools are: 

 Journal time, date, and auto-time paste functions. 

 Journal file functions: new, open, save, and print. 

 
Plot Standard Curve (X/Y mode only); see page 676. 

 
Rewind (only active in Append acquisition mode). Delete the last recorded segment; see page 648. 

 
Show/Hide Media (only active when video camera is connected in Media setup) Toggles Media Capture/Playback 
viewer on or off; see page 250 for Media Menu. 
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Keyboard shortcuts 
  

BSL PRO 3.7.3 and up is Section 508 Compliant; contact BIOPAC for a detailed Compliance Statement. 

See also: Appendix I - Accelerator Keys, page 6301 

Menu Item Shortcut 

File menu  

New Ctrl-N 

Open Ctrl-O 

Close Ctrl-W 

Save Ctrl-S 

Print Ctrl-P 

Quit Ctrl-Q 

Edit menu  

Undo Ctrl-Z (only shows when applicable) 

Cut Ctrl-X 

Copy Ctrl-C 

Paste Ctrl-V 

Clear Delete 

Duplicate waveform no shortcut 

Select all no shortcut 

Journal>Paste Measurement Ctrl-M 

Journal>Paste Wave Data Ctrl-D 

Transform menu  

Find Peak Ctrl-F 

Find Next Peak Ctrl-E 

Find All Peaks Ctrl-R 

Find Rate Ctrl-A 

Display menu  

Zoom Back Ctrl-minus (works up to 5 times) 

Zoom Forward Ctrl-plus (works up to 5 times) 

Cursor Style: Arrow Ctrl-B 

Cursor Style: I-beam Ctrl-I 

Cursor Style: Zoom Ctrl-G 

MP UNIT menu  

AutoPlotting Ctrl-T (toggles) 

Miscellaneous Functions  

Insert Marker Windows: F9 
Mac: Esc 

Move marker not available 

Start/Stop acquisition Alt-spacebar (toggles) 

Stop plot: Windows only Esc 

Zoom out Alt-click (when Zoom selected) 
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Right-click Shortcuts 
Click the right mouse button in the designated window to generate the following shortcuts: 

If the Graph window is active: 

   
If the Journal window is active: 

 
In the menu bar region, to show/hide the Toolbars: 

 
By clicking on the horizontal scale, to change the “Update screen interval” setting: 
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Cursor Styles 

 
When working with data, you will often want to select only a portion of a waveform to edit or analyze. Once you 
have selected an area, you can perform a variety of operations—such as editing, measuring, transforming or saving 
data. The tool icons control the cursor style, which varies based on the editing or analysis function selected. The data 
selection tools are in the lower right corner of the display window. Click the desired icon to activate the 
corresponding cursor style. You can also set the cursor style under the Display menu. 

 
Arrow 

The Arrow icon activates a general-purpose cursor tool. It can be used to select a waveform or 
channel, pull-down menus to select options for editing, measurement, etc., scroll through data, 
and resize chart boundaries between waveforms. 

All other cursors default to this style when moved outside of the graph window. 

 
Selection 
(I-beam) 

This is a standard I-beam area selection tool. The cursor changes to an I-beam when placed in 
the graph window. It is used to select an area of a waveform (or multiple waveforms) to be 
edited or transformed. This cursor is always selecting at least one sample point. See page 650 for 
details on using the I-beam to select an area.  

The I-beam cursor becomes a crosshair  cursor in X/Y mode. 

 
Zoom 

This is a standard Zoom tool. It changes to a magnifying glass when placed in the graph 
window. It can be used to magnify any portion of any wave. See page 650 for details on using the 
Zoom tool to select an area. 

If the I-Beam cursor is selected (manually or using “Ctrl + I”) after a single data point selection is made 
with the Arrow cursor, the I-beam cursor will be placed at the last data point selected. This is useful for 
preserving the data selection when switching the cursor style. 

 

Scroll bars 

You can use the horizontal scroll bar to move to different points in the record. As indicated by the horizontal scale, 
only a portion of the sample data file is displayed on each screen. The horizontal scroll bar allows you to move 
around in a data file, just as the scroll bar in a word processor allows you to move to different points in a document. 
Points left occured earlier in the record, points right occurred toward the end of the record. The horizontal scroll bar 
runs along the bottom of the display window. 

You can use the vertical scroll bar to change the amplitude offset of a selected channel. This will reposition the 
waveform up or down within its display “track.” The vertical scroll bar runs along the right edge of the display 
window. 

To use a scroll bar, click the bar and drag the box. Click the arrows at either end of the scroll bar to move in smaller 
increments. 

 TIP To display the entire waveform (in terms of duration), choose Autoscale horizontal from the 
Display menu. The Autoscale horizontal command fits the entire data file into the window, 
regardless of the total length of the acquisition. You can identify the duration of the record 
by choosing Display > Statistics. This will generate an information dialog that includes the 
Length of the record. 

 TIP You can “jump” to a different point in time by entering a “Start” value in the Horizontal Scale 
dialog. See the following section for more information. 
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Scale 
Any changes you make in terms of rescaling (either horizontal or vertical) will only affect the way data is displayed, 
and will not change the basic characteristics of your data file. Horizontal scale options affect all channels; vertical 
scale options can be set independently for each channel. 
 

Horizontal scale runs along the bottom of the display window and is where the numerical units are listed. You may 
show/hide the scale via the Show>X-scale command. The default setting uses four divisions (vertical lines) per 
screen. You can change the horizontal scale setting to control the amount of data that appears on the screen at any 
given time. See page 636 for details. 
 

Vertical scale  runs along the right edge of the display and controls the range of amplitude values displayed for 
each waveform. You may show/hide the scale via the Show>Y-scale command. You can set the scale midpoint (the 
value that appears in the center of the vertical scale) for each channel. When multiple channels are displayed, thick 
horizontal lines separate each waveform into its own vertical “track.” 
 
As with the horizontal scale, there are four divisions on the vertical axis, and the display range will equal the Scale 
value x 4. If Scale is set to 3 mVolts per division, 12 mVolts of data will be displayed. You can use the Range 
Guide as a visual aid to establish the proper Gain.  
 

Note: The Scale Precision setting only applies to the Scale. You must set measurement result precision 
separately. 
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Horizontal scale 

Click the cursor in the horizontal scale area to generate the Horizontal Scale dialog. The Horizontal 
Scale dialog — when display grids are not locked — is shown below. Note that the Horizontal Scale 
dialog will vary if grids are “locked.” See page 6174 for a discussion of Grid Options and how locking 
grids (Display>Show>Grid Options Display>Grid Options: Lock Grid Lines) affects the Horizontal Scale 
dialog. 

     
Horizontal Scale dialog (Grid Unlocked) 

Scale  The Scale setting controls how much of the record will be displayed on the screen at any given time. 
When grids are unlocked, the screen displays the horizontal scale value multiplied by four. Larger values 
will display more data and smaller values will display less data. 

Start  Enter a number in the Start box to “jump” to a certain point in the data display. This does not affect the 
data file, just the display. To view data from the beginning of the sample record, enter a Start value of 0 
seconds. 

 In the time scale shown above, the first data displayed (at the left edge of the graph window) was 
collected at the beginning of the acquisition (Time 0.0000 seconds). Also, the scroll box is fully to the 
left, indicating that the data on the screen represents data collected earliest in the record. 

 If you click in the horizontal scale area again, the same dialog will appear, and this time the value in the 
Start box should have changed from 12.0 to 0.00 to reflect the new section of data being displayed on 
the screen. 

Precision  The Precision setting determines the number of digits to follow the decimal (default is 2). Significant 
digits will be rounded rather than truncated. This setting is for scale precision only; you must set the 
measurement precision separately under Display > Preferences > General. 

  TIP To display the entire waveform (in terms of duration) in the data window, 
choose Display > Autoscale Horizontal. Use Autoscale Waveforms to adjust the 
vertical display and bring all data into view. 

Hold 
Relative 
Position 

Hold relative position is an option available only in the Append acquisition mode. When checked, the 
display for appended acquisitions will show the same relative position with respect to the start of 
acquisition. This is convenient when doing short-duration, high-speed acquisitions where you want to be 
able to zoom in on the signal of interest and have the relative position (from the start of acquisition) stay 
the same. If the acquisition is started with the horizontal scale such that it falls between acquisition 
segments, this feature is not implemented. 

When Hold relative position is checked, if you zoom in on a section of data that has been selected 
(highlighted) and is completely within one appended segment, the scale of the selected area changes with 
each appended segment such that it remains relative to the start of acquisition for that segment and 
updates the measurements. If the selected data area falls within two or more appended segments, this 
feature is not implemented. 
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Vertical scale 

Click the cursor in the vertical scale area (on the right edge of the window, where units are displayed) to 
generate the Vertical Scale dialog. The Vertical Scale dialog — when display grids are not locked — is 
shown below. Note that the Vertical Scale dialog will vary if grids are “locked.” See page 6174 for a 
discussion of Grid Options and how locking grids (Display>Show>Grid Options Display>Grid Options: 
Lock Grid Lines) affects the Vertical Scale dialog. 

 
Default Vertical Scale (Grid Unlocked) 

Channel Use this option, available only when grids are not locked, to jump to another channel and set its 
vertical scale options without having to close out of the dialog. 

Scaling… The Scaling… button appears in the "Vertical Scale" dialog 
regardless of the scale or grid mode if there is hardware 
associated with the channel. This gives fast access to the 
Change Scaling Parameters dialog for calibration control. 
Scaling changes will be applied following the next start of 
acquisition, and must remain the same for all appended 
segments. 

 

Scale  This determines how many units (usually Volts) are displayed in each track. Smaller Scale values increase 
the apparent amplitude, larger values decrease the apparent variability. Entering a number about half the current 
value will cause the amplitude of the wave to appear to double. 

Midpoint  This sets the median value display for the track. You can vary the midpoint and apparent 
magnitude of each waveform by changing the Midpoint entry. If Midpoint is set to 2 mVolts, the selected channel 
will display a range from - 4 mVolts to + 8 mVolts.  

Precision This setting determines the number of digits to follow the decimal (default is 2). Significant digits 
will be rounded rather than truncated. The vertical scale precision setting applies only to the specified channel. This 
setting is for scale precision only; you must set measurement precision separately under Display > Preferences > 
General. 

All Channels Click in this box to apply the setting to all channels rather than to the selected channel only. 

 TIP Use Display > Autoscale Waveforms to have the software automatically adjust the 
vertical scale parameters so all ampoitude data in the current time slice (horizontal scale) 
will be displayed. 
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Figure 4 

Range Guide 

  

 
 Figure 1 Figure 2 Figure 3 

The Range Guide is a green bar that runs along the vertical scale in the graph window for analog channels (fig. 1). 
It displays the maximum signal range for the Gain established for that channel. You can use the Range Guide as a 
visual aid to establish the proper Gain.  

The MP UNIT measures the actual input voltage and 
compensates for the Gain. As Gain increases, the peak-to-peak 
of a waveform stays constant but the resolution increases. 
Proper Gain will have a smoothing effect on the signal. 

For the best resolution, establish Gain such that, allowing for 
baseline drift (if applicable) and the maximum peak-to-peak of 
the signal, the maximum signal display is close to the maximum 
range. If the signal is clipped (fig 2.), lower the Gain. If the 
signal is small compared to the range (fig. 3), increase the Gain 
to improve signal resolution.  

Gain settings create a trade-off between range and resolution. 
Different gain settings applied to the same signal source show 
that 

 Higher Gain  better resolution + lower range (fig. 4, top) 

 Lower Gain  worse resolution + higher range (fig. 4, bottom)  

To display the full range (Fig. 2 vs. Fig. 4, for example), adjust the Vertical Scale. 

Gain guidelines are included in the MP UNIT Input and Offset Range table on page 692. 

The Range Guide will always reflect changes made to the channel Scaling.  
To quickly see the total range of each input channel, select Optimize Ranges from the Display menu. This will 
automatically adjust the upper and lower viewable limits of the Vertical Scales for all channels.  



Introduction 39 

  

 When Optimize Range is selected using the 
toolbar icon or the right-click mouse shortcut, only the 
active channel range guide is optimized. See page 6242 
for details.  

 

Display modes 

BSL PRO offers several display modes to change the way data appears on the screen at any time, even during an 
acquisition: Chart mode, Scope mode, Overlap Appended segments, and X/Y mode. To change the display mode, 
click the corresponding icon in the toolbar or make a selection from the Display > Show menu options. When in 
Chart or Scope mode, you have the additional option to display appended data in the Overlap Segments mode, 
activated from the Toolbar. 

Chart mode 

 Chart  is the default display mode and plots with Time on the horizontal axis. 

 
Chart mode emulates a chart recorder. Each channel of data is in its own “track” across the screen, with borders 
between channels. The waveforms will not cross boundaries into the tracks of adjacent channels. 

Waveforms cannot overlap in Chart mode, but it is possible for the waveform to be plotted off the scale of the 
channel track. To remedy this, choose Autoscale Waveforms and the software will select the “best fit” for 
waveforms to their tracks. 

When the active channel is disabled in Chart Mode, the first channel (of the remaining enabled channels) becomes 
the new (default) active channel and its Horizontal and Vertical Scales are displayed.  
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Scope mode 

 Scope plots with Time on the horizontal axis. 

 
Scope mode emulates an oscilloscope. All waveforms are in a single window with no borders between channels. 
Waveforms can overlap. 

The autoscale waveforms command will automatically separate the waveforms in the graph window and autoscale 
each as if it were the only waveform in the display region. This can be useful when overlapping waveforms that are 
of different units and scales. 

When the active channel is disabled in Scope Mode, the first channel (of the remaining enabled channels) becomes 
the new (default) active channel and its Horizontal and Vertical Scales are displayed. 

Note:  When only one waveform is present, the Scope and Chart modes are identical.  

 

Overlap Segment mode 

 Overlap Segments plots with Time on the horizontal axis. 

 
Overlap Segments mode overlaps appended segments of data and is useful for comparing waveforms. 
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Overlap Segments may be toggled on and off; its Toolbar icon is enabled only when the acquisition mode 
has been set to Append, at least one segment of data has been acquired, and the display mode has first 
been set to Chart or Scope. 

In Chart mode, when Overlap Segments is toggled on, all data segments of each channel are overlapped 
in their respective channel “tracks.” In Scope mode, all segments of all channels are displayed in a single 
window. 

The active segment is highlighted and its Horizontal scale, automatic Append marker, and marker label 
are displayed; Event markers are not displayed in this mode—see page 6172 for Marker details.) To choose 
a new active segment, right-click when the cursor is over the graph and select Show Segment from the 
pop-up menu. 

 

X/Y mode 

 X/Y mode plots one channel on the horizontal axis against another channel on the vertical axis. When a 
channel is plotted against itself, a straight line will be displayed. 

 
X/Y mode can be useful for chaos investigations and respiration studies. 

When X/Y mode is selected, you can Plot Standard Curve, which is useful for colorimetry studies. See page 676  for 
Standard Curve setup. 

In X/Y Mode, the label for the channel being plotted for the X-axis is displayed above the waveform window. The 
label for the channel being plotted for the Y-axis is displayed to the left of the waveform window. 

Clicking once in either the X-axis or Y-axis label areas generates a pull-down menu of all currently plotted channels. 
Select a channel from the list to plot it on the selected axis. 

  
X/Y plot of BPM (X) and lagged BPM ( Y) 
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BSL PRO functionality changes when in X/Y mode 

I-beam tool 
The I-beam tool changes into a crosshair  cursor and when it is moved into the 
graph window, the coordinates of the crosshair are displayed in the upper left corner 
of the graph window. The X value is the horizontal coordinate and the Y value is the 
vertical coordinate of the crosshair. 

Plot Standard Curve The Plot Standard Curve function is enabled in X/Y mode. This function plots a 
curve used in colorimetric measurements. See page 676. 

Autoscale Waveform The Autoscale Waveform function changes to read Autoscale Vertical, which 
plots the vertical channel so that it takes up two-thirds of the vertical channel space. 
This function controls the “height” of the data being plotted in the graph window. 

Autoscale Horizontal The Autoscale Horizontal function plots the waveform so that the waveform is 
plotted in the center two-thirds of the window. This function controls the “width” of 
the data being plotted in the graph window. 

Tile Waveforms / 

Compare Waveforms 

Since only two channels can be displayed at a time in X/Y mode, the Tile 
Waveforms and Compare Waveform commands are replaced by the more relevant 
Center Horizontal and Center Vertical. These two center commands change the 
midpoint of the horizontal and vertical scales (respectively) so that the midpoint of 
the scale is equal to the mean value (average) for that channel. These features are 
useful for centering the display so that it is easier to interpret. Whereas Autoscale 
commands adjust the center point and the range of data displayed, Center functions 
adjust only the midpoint. 

Channel boxes The channel numbering boxes are disabled in X/Y mode since they are not 
meaningful in X/Y mode. 

Measurement region The measurement windows are disabled in X/Y mode since they are not meaningful 
in X/Y mode. Instead, when the cursor is the X/Y plotting region of the graph, the 
measurement region displays the X-axis and Y-axis coordinates of the data point 
closest to the cursor. If the left mouse button is pressed, horizontal and vertical lines 
track the cursor movement. 

If the right mouse button is pressed (even while the left mouse button is down) and a 
journal is open, a “Paste Values to Journal” option is available from the pop-up 
menu.  
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Part B — Recording Data 
Part B – Recording Data  covers the basics of data acquisition and analysis with the Biopac Student Lab 
PRO. All of the material in this section is covered in more detail in subsequent sections (see Using this 
Manual on page 611 for a guide to sections). 

Chapter 2 Acquisition Overview 
Collecting data / acquisition 

Acquisition is defined as data collection from an external 
source (such as electrodes connected to an amplifier). BSL 
PRO acquisitions require hardware connections and software 
setup. 

Hardware Connections 
The MP UNIT is designed to accept amplified small analog 
signals and large analog signals (up to ± 10 Volts). Specific 
connections to the MP UNIT acquisition unit will vary 
greatly, depending on the amount and type of data collected. 
The most common applications of the BSL PRO involve 
amplified signals collected from electrodes and/or transducers. 

Input connection to the MP3X UNIT 

 

 
MP3X UNIT Front and back Panels — see page 6284 for MP UNIT specifications and symbology 
The two common types of input devices that connect to the front of the MP UNIT to interface between the subject 
and the hardware are electrodes and transducers. Electrodes directly reflect the electrical signal generated by the 
body, and transducers convert a physiological signal into a proportional electrical signal. You can also connect I/O 
devices to the MP UNIT. 

Electrodes are relatively simple instruments that attach directly to a subject’s skin surface and pick up 
electrical signals in the body. Electrode lead cables connect to the electrodes and send the signal to the MP Unit. The 
MP UNIT amplifies the signal and sends it to the computer and the Biopac Student Lab PRO software. Depending 
on where electrodes are placed, different types of signals will be picked up. 

Transducers convert a physiological parameter (such as clench force, blood pressure, or Galvanic Skin 
Response) to a proportional electrical signal. One example of this is the respiration transducer, which is like a rubber 
band that stretches with your chest. It measures how much larger your chest becomes when you breathe in, and how 
much smaller it becomes when you exhale. A device inside the transducer converts this physical change into an 
electrical signal, which can then be sent to the Biopac Student Lab PRO System and relayed to your computer, 
where it is plotted on the screen. 

I/O devices are specialized Input/Output devices, such as push-button switches and headphones. 
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Regardless of the type of device connected, every sensor or I/O device connects to the MP UNIT acquisition unit 
using a “Simple Sensor” connector. The Simple Sensor connector is designed so that there is only one way to plug it 
into the MP UNIT, so you don’t have to worry about plugging things in upside down or into the wrong socket. You 
don’t have to screw the end of the Simple Sensor into the computer port unless you want to — this makes it easy for 
you to experiment with different transducers. 

 See the BSL Hardware Guide for more information on the Simple Sensors available for use with 
the Biopac Student Lab PRO. 

 
Software Setup 
You must set up the input channels to acquire data and the acquisition parameters to use for each channel, such as 
sample rate, data storage, and acquisition length. 

 Before you begin software setup, make sure the MP UNIT is turned on and connected to your 
computer. If the MP UNIT is not connected to your computer and/or not turned on, a warning will 
be generated when you launch the BSL PRO Software. If you need more information on 
installation and connections, refer to the Installation Guide. 

1.  Launch the Biopac Student Lab PRO application. 

 BSL PRO opens to a new graph window. You should see a window similar to the following: 

 
2.  You must setup the specific channels to acquire data on. See Setup Channels for details. 

3. You must setup the acquisition parameters (such as sampling rate, acquisition length, and data storage options). 
See Setting up Acquisition for details. 
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Set up channels 
Select  Set up Channels from the MP UNIT menu. This will generate a Set up Channels dialog where you will 
designate the channels to be acquired, and the parameters for data acquisition. 

 
Setup Channel Options 

Channel The Channel column contains the alpha-numeric channel numbers. “Analog” (or continuous) 
input channels begin with “CH” and run from CH1-CH4. “Digital” input channels begin with 
“D” and run from D1-D8. “Calculation” channels begin with “C” and run from C1-C12. 

Display is limited to four channels of each type. Use the scroll button  to set up additional 
Digital or Calculation channels. 

Acquire When the Acquire Data box is checked for a given channel, data will be collected on that 
channel. 

Plot If Plot on Screen is also checked, data will be plotted on screen in real-time during the 
acquisition. If the plot box is unchecked, data will still be recorded for that channel, but the 
waveform display will be disabled. To display the waveform plot after the acquisition is over, 
show the channel. 

Enable Value 
Display 

Checking the Enable Value Display box means that you can choose to display (numerically 
and/or graphically) the values for each channel in real time. To display the values, you must also 
select Show Input Values (via the MP UNIT menu). Input values are displayed in a separate 
window from the main graph window. 

 

Default The default is to collect one channel of data on analog channel 1 (CH1), and to plot and enable 
value display for this channel 

MP35/36 required 
for Digital Input 
Channels 

MP45 users 

 

ANALOG INPUT CHANNELS 
CH3 and CH4 are inactive. 

 

 

 

 

DIGITAL INPUT CHANNELS are 
inactive. 

 

 

 

 

CALCULATION CHANNELS 
Analog Source Channel options are 
CH 1 and CH 2 only 
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Setup Channel Options 

 TIP  Usually, you will want to check all three boxes for each channel you acquire 
data on 

Label The Label entry for each channel allows you to type in up to 38 characters to identify the channel. 

Presets 

 

Clicking on the Presets button will generate a menu of available presets for the channel. Presets 
for common applications configure the hardware gain, filters, etc. 

 For a detailed summary of Analog Input channel, Digital Input channel, and 
Calculation channel options see the Presets section beginning on page 69. 

View/Change 

 

To View/Change Parameters for a Preset, click the wrench icon. If you change the parameters, 
you have the option of creating a New Channel Preset to make the established parameters 
available to other channels. 

If you make a change to a preset and start recording in the Append mode, you will be prompted as 
follows. Choose Abort, save your data, and then change the presets to aquire as a new data file. 
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Setup Acquisitions 
Once you have set up the channel parameters, the next step is to specify the acquisition settings. You can do this by 
choosing Setup Acquisition from the MP UNIT menu. This generates a dialog box that will describe the type of 
acquisition about to be performed. 

There are a number of options here, but the basic parameters involve specifying: where data should be stored as it is 
being acquired, the sample (data collection) rate, and the acquisition length. 

 
Data storage — At the top of the Acquisition Setup dialog box, you should see a display that reads Record and 
Append using PC Memory. This is the default option for collecting data and tells the Biopac Student Lab PRO to 
automatically record data into single continuous file, and to store the data in computer memory (RAM) during the 
acquisition. The third pop-up menu (which defaults to PC Memory) allows you to specify where the data should be 
stored during the acquisition. You will need to choose PC Memory or Hard Disk storage. Computer memory 
(RAM) is usually faster (but less abundant) than disk space. If your system uses any virtual memory, the Biopac 
Student Lab PRO software will use as much as possible. 

Sample rate — This is analogous to “mm/sec” on a chart recorder, and refers to how many samples the MP UNIT 
System should take each second. As the sample rate increases, the representation of the signal becomes more 
accurate — however, so does the demand for system resources memory, disk space, etc.). The Biopac Student Lab 
PRO’s sampling rate has a lower bound of 1 sample per second, and an upper bound of 100,000 samples per second 
(2 kHz). Choose the best sample rate from the pull-down menu generated when you click the Sample Rate entry. 

 A good rule of thumb is to select a sampling rate at least four times the highest frequency of 
interest for the signal. 

Acquisition Length — This entry controls how long an acquisition will last (duration). This can be scaled in 
seconds, minutes, hours, milliseconds or number of samples, as selected from the pull-down menu. Set this value by 
entering a number in the Acquisition Length box or by moving the scroll box left (to decrease) or right (to increase). 

Repeat — The Repeat function is an advanced operation and is discussed on page 686. 
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Starting an acquisition 
After you have setup the channels to contain data and defined the channel parameters, you are ready to start the 
acquisition. If a file window is not already open, choose File > New to generate a graph window. 

In the lower right corner of the screen, next to the  button, you should see a button with a circle next 
to it. The circle indicates the status of the communication link between your computer and the MP UNIT. If the MP 
UNIT is properly connected to the computer and is turned on, the circle should be solid and green. If the MP UNIT 
is not properly connected, a solid gray circle will appear (on monochrome displays, the circle will appear solid when 
the MP UNIT is connected properly, and unfilled when the MP UNIT is not communicating with the computer). 

You can start the acquisition by positioning the cursor over the  button and clicking the mouse button 
or by selecting “Alt + Spacebar.” If there are no input devices (e.g., electrodes or transducers) connected to the MP 
UNIT, it will collect a small value of random signal “noise” with a mean of about 0.0 Volts. 

 For information on how to connect measurement devices to the Biopac Student Lab PRO, see 
the BSL Hardware Guide. 

 You may also start an acquisition using a variety of “triggers,” which are discussed on page 6149. 

Once acquisition starts, the  button in the acquisition window changes to . The two 
opposing arrows to the right of the button indicate that data is being collected. Also, the “Busy” status indicator light 
on the front of the MP UNIT will illuminate, showing that data is being collected. 

 

Stopping an Acquisition 

To stop an acquisition at any time, click the  button in the lower right corner of the screen or select 
“Alt + Spacebar.” An acquisition will stop automatically when it has recorded an amount of data equal to the 
Acquisition Length entry. 

 

Rewind 

 The Rewind button on the Toolbar allows you to erase the last recorded data segment and continue to Append 
data to the existing data file. This function will erase the last segment along with the Append Marker  for that 
segment; the application will keep track of Append Marker labels, so that the label always matches the segment 
number. 

  
If the “Warn on Overwrite” option is active, a warning dialog will be generated before the segment is deleted.  

 

Saving acquisition data 
To save a data file, pull-down the File menu and choose the Save command (see page 6183 for details). 
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Chapter 3 Analysis Basics 
Selecting a waveform / channel 

Although multiple waveforms can be displayed, 
only one waveform at a time is considered 
“active.” Most software functions only apply to the 
active waveform, which is also referred to as the 
selected channel. Selecting a channel allows you to 
highlight all or part of that waveform, and enables 
you to perform transformations on a given channel. 
In the upper left corner of the graph window there is a 
series of numbered boxes that represent each channel of 
data. The numbers in the boxes correspond to the 
channel used to acquire the data (the specifics of setting 
up channels are discussed on page 645).  

In the sample file, ECG is on channels 1 and 2, with 
respiration is on channel 3 and blood pressure is on 
channel 4.  

To select a channel, position the  cursor over the channel box that 
corresponds to the desired channel and click the mouse button or position the 

 cursor on the waveform of interest and click the mouse button. Note that the 
selected channel box appears depressed and the channel label to the right of the 
channel boxes changes to correspond to the selected channel. Additionally, the 
channel label in the display (on the left edge of the track) will be highlighted 
for the active channel. 

 

 
 

 

Channel Labels 
 Each channel has a label on the left edge of the track to identify the contents of the channel. When a 
channel is active, its label is highlighted and also appears by the channel boxes. 

To change the label for a given channel, double-click the track label. A dialog will be generated so you can change 
the text. You can also change the Label entry in the MP UNIT > Setup Channel dialog. When you change the 
Label this way, the change will not take effect until you start an acquisition. 

Hide a channel 
You can “hide” a waveform display without changing the data file. 
To hide a channel, hold down the Ctrl key and click in the channel 
box. When a channel is hidden, the channel box will have a slash 
through it. You may view a hidden channel by holding down the 
Ctrl key and clicking in the channel box again. Channels 2 and 4 
are hidden in the following display. 

When the active channel is hidden in Chart or Scope Mode, the 
first channel (of the remaining enabled channels) becomes the new 
(default) active channel and its Horizontal and Vertical Scales are 
displayed. 

The hide/show function should only be used after acquisition, not during. The entire Graph window will be 
refreshed when channels are shown or hidden during an acquisition. For large acquisitions, the refresh may interfere 
with the acquisition and generate an “Acquisition buffer overflow” and stop acquisition. 
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Selecting an area 

Once you have selected a channel, you can “edit” parts of that channel by selecting a section of the waveform. The 
options available to you include cutting, copying, and pasting sections of waveforms. You can also transform and 
analyze entire waveforms or specific sections of waveforms. 

 IMPORTANT: When multiple waveforms are present, the highlighted area appears to include all 
of the waveforms, but most modifications and transformations apply only to the selected 
channel. 

For any of these functions, you will need to use the I-beam  tool to select (or highlight) an area. 

To select the I-beam tool, position the cursor over the  icon in the lower right hand corner of the screen and click 
the mouse button. Now move the cursor to the first point in the area that you wish to select. As you move the cursor 
into the graph area, you will see it change from an arrow cursor to a standard I-beam editing tool. 

To highlight a section of a waveform: 

1) Position the I-beam at the left edge of the desired area and hold down the mouse button. 

2) Move the mouse to the right until the desired area is selected and then release the mouse button. 

To select an area that spans multiples screens: 

1) Click the I-beam at the start (left edge) of the section to be highlighted. 

2)  Use the horizontal scroll bar to move to the desired endpoint (right edge) in the record. 

3)  Hold down the Shift key while you position the cursor and click the left mouse button. 

This method of selecting an area allows you to “fine tune” the selected area to include only a specific range of data. 
To fine tune: coarsely select an area, then zoom in (using the Zoom tool) on either edge and shift-click with the I-
beam to precisely select and/or align the edge of the selected area. 

To deselect an area: 

Click a new point of data with the I-beam tool to deselect the last area. 

Once a channel has been selected and a section of data highlighted, you can operate on and edit that section of the 
waveform. The editing commands behave much the same way as the editing functions in a word processor. You can 
cut, copy, delete or paste sections of data as defined by the selected area. In most cases (depending on available 
memory) you may undo an edit by choosing Undo from the Edit menu, or by using the CTRL + Z shortcut. 

Selecting a portion of a waveform allows you to apply transformations to a particular area, rather than the entire area 
or all waveforms. Selecting an area also allows you to take snap measurements for parameters such as delta T, mean, 
standard deviation, frequency, and so forth. The measurement options are discussed on page 6157. 

Zoom 
Another way to select an area is to use the “zoom” tool. The zoom tool allows you to select any portion of any wave 
and magnify it for closer analysis. 

To use the Zoom tool: 

1. Click the  icon in the lower right portion of the screen. 

2. Positioning the cursor at one corner of the data region of interest and hold down the left mouse button. 

3. Drag the crosshair horizontally, vertically, or diagonally to form a “box” which encompasses the area you need 
to zoom in on. 

4. Release the mouse button. 

When you draw a Zoom box, the Biopac Student Lab PRO software will automatically adjust the horizontal and 
vertical scales for all waveforms, not just the selected one. 

To “unzoom” or repeat the zoom one level at a time, choose Zoom Back or Zoom Forward from the Display 
menu. You can select either function up to five times per zoom. Keyboard shortcuts are Ctrl-Minus (Zoom Back) 
and Ctrl-Plus (Zoom Forward). 

You can also use Zoom/Ctrl-Zoom to zoom in and out by a factor of 2 without drawing a zoom box.  
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Grids 

You can apply several different grid styles to data to help with analysis.  

Click the Grid  icon in the toolbar or select Display > Show > Grids to toggle grid display on and off. 

Select Display > Show > Grid Options to set grid options such as locked/unlocked, major/minor 
divisions, line color, and line width. UNLOCKED grids help you view the data display on the monitor 
whereas LOCKED grids help more with printing. Using the Grid Options, you can create printouts that 
look similar to chart recorder output or clinical ECG. See page 6174 for Grid details. 

 

Measurements 

To display the measurement windows, select Display > Show > Measurements or use the    icon  

Once you have selected a channel, you can quickly and easily take measurements on each waveform. The following 
measurements are available (see page 6161 for a full explanation of measurements): 

Single-point measurements Selected range measurements 

Delta S, Lin_reg, Max, Max T, Min, 
Min T, Samples, Time, Value, X-axis 
T/F/X 

Area, BPM, Correlate, Delta, Delta S, Delta T/F/X 
(based on units), Frequency (time domain), Integral, 
Lin_reg, Max, Max T, Mean, Median, Median T, Min, 
Min T, p-p, Samples, Slope, Stddev 

 
Measurement Area 
It is important to remember that the software is always selecting either a single point or an area spanning multiple 
sample points. When a single point is selected, the cursor will “blink.” Otherwise, the selected area will be 
highlighted. If an area is defined and a single point measurement is selected (such as Time), the measurement will 
reflect the last selected point. See page 6158 for further explanation.  

 
Measurement Window 
Each measurement window consists of three boxes: 
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Channel selection Allows you to calculate a measurement either for the selected channel (SC) or from a 
numbered channel in the record. To switch between the channel options, click in the channel window. The pop-up 
menu shows the channel numbers for all channels in the file. By default, each measurement will reflect the contents 
of the selected channel. 

Measurement function Allows you to choose between different types of measurements. To choose a 
measurement, click the measurement pop-up menu and select a measurement from the list. Depending on the nature 
of the measurement being taken, the windows can display information regarding a single point or a range of values 
on the selected channel. Some of the measurements that depend on a selected area look at differences in the 
horizontal axis, such as the delta T measurement, which returns the difference in time between the first sample point 
in the selected area and the last sample point in the selected area. Other range measurements also select an area, but 
use the vertical scale information in calculating measurements, like the peak to peak (p-p) measurement, which 
computes the difference in amplitude between the maximum value in the selected area and the minimum value in the 
selected area. 

Measurement result Lists the result for the selected measurement across the selected area. If no data is 
selected, or if not enough data is selected for a meaningful measurement, the measurement result box will display 
“****.” In the following example, the BPM for the selected channel (SC) is 230.7, whereas the mean for the 
selected area of channel 1 is 0.18030, and the integral calculation for channel 40 is 0.04557. 

The number of measurement windows depends on (a) the width of the screen and (b) the number of rows selected in 
the File > Preferences > General dialog box. By default, only one row of measurement windows is displayed. As 
the screen gets wider, more measurement windows can be displayed in the area above the graph windows. 
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Transforming data 

The Biopac Student Lab PRO software includes a vast library of functions, which can transform data or perform 
mathematical calculations on waveform data. All of these options can be found under the Transform menu, and are 
discussed in detail in the Transform Menu Commands section beginning on page 6199. 

When performing transformations, keep in mind that when a section of a waveform is highlighted, the 
transformation will apply to that section. Also, if no area is defined, the BSL PRO software will always select a 
single data point. Some transformations can only be performed on a selected area (spectral analysis and digital 
filtering, for instance), so if a single point is selected the entire waveform will be transformed.  

 

Markers 

In many instances it is useful to have the BSL PRO software “remember” an occurrence or event during an 
acquisition so it can be referenced later. For instance, you may want to note when a treatment began or when an 
external event occurred so you can examine any possible reaction. 

The Biopac Student Lab PRO software uses “markers” which are placed above the data to record events. “Append 
markers” are automatically inserted each time you record a new segment in “append” mode, and you can enter an 
“Event markers” either during an acquisition or after recording (off-line). 

 You can automatically insert event markers during an acquisition by pressing the F9 key on a 
Windows PC or the Esc key on a Mac. This will insert a marker at the exact time the key is 
pressed and will activate the text line entry so you can immediately enter a comment to be 
associated with the marker. 

 To enter an event marker after the recording session, click the cursor in the area beneath the 
marker area. This will insert a marker. To add text describing the event, click the cursor in the 
marker box and key the desired text. 

To view the text associated with a marker, position the selection tool over the marker and click the mouse button. 

You can also move from marker to marker by using the  icons in the marker toolbar. 

Refer to the Marker section on page 6172 for a detailed description of markers and marker functions, including 
options to pre-establish marker labels and set function keys for different labels. 
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Journals 
The journal is a general-purpose text editor built into the PRO software. The journal is essentially an “electronic 
notepad” that allows you to record notes and data at the same time you are acquiring data. Using the journal, you can 
store waveform data (in numeric format) or make notations and comments in a text file. One common function of a 
journal is to save comments and other similar information about an acquisition in a text file, so that this information 
can be referenced later. The journal works in connection with Find Peak and other measurement functions to paste in 
values from waveform data for further analysis.  

Once a Journal is open, you can enter text, data or both. To enter text, just click the cursor in the journal area and 
begin typing. This is especially useful for noting the date and time of a recording, what was involved, and so forth. 

You may also paste measurements and waveform data into the journal. 

 To paste measurements into an open journal, select the desired area or point and choose Paste 
measurements from the Edit > Journal menu. This will paste all visible measurement window 
data into the journal. 

 To paste waveform data into the journal, select the desired area and choose Paste Wave Data 
from the Edit > Journal menu. This will insert a text file of the waveform into the journal, where 
points and trends can be analyzed. 

 
Open a Journal 

Click the Journal  icon on the toolbar or choose Display>Show>Journal. 
Each graph window has its own “embedded” journal. The journal is displayed below the graph window and will be 
saved with the graph file. 

 
Resize a Journal 

To resize the journal window, click the bar at the top of the Journal window and drag it up (to increase the size) or 
down (to decrease the size).  

 
Enter Text 

To enter text, just begin typing when the journal is open. To automatically “wrap” the text to fit the screen width, 
use the wrap option in the File > Preferences > Journal submenu. PC users can click the right-mouse button in the 
Journal window and select Wrap Text > Wrap to Window from the shortcut menu. To change the font or tabs of 
the Journal, use the Display > Preferences > Journal dialog. 

 
Time Stamp, Date Stamp and Auto-time functions 

 These options are available in the upper left corner of the journal window and refer to the 
computer’s clock to record the time and/or date directly into the Journal. The Time option is a clock icon and the 
Date option is a calendar icon. Just click the icon to activate the option. The Auto-time function records the time at 
the instant the carriage return is pressed, which is useful for tagging commands as data is collected. To activate 
“Auto-time” click the clock icon with the left-pointing arrow. 
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Journal File Functions 

 The Journal file icons perform the following functions (as displayed from left to right): 

 

New The page icon will clear the Journal and provide a blank page. 
Any Journal entry not saved to a separate file will be lost. 

 

Open The open folder icon is used to “load text” from any simple text file, including previously saved journal 
files. When pressed, the open folder icon will generate a standard “Open” dialog. The default file type is “text.” 
Only files of type “text” (.txt) can be opened and loaded into the Journal. Upon selecting a file, the text in the 
selected file will be “loaded” into the Journal. If there is already text in the Journal, the new text will be inserted 
at the current cursor location. After insertion, the cursor location moves to the end of the newly inserted text 
block. 

 

Save  The disk icon will generate a Save As function dialog. The data in the journal will be saved in simple text 
(.txt) format. 

 

Print  The printer icon will generate a Print function dialog. 

 

Paste measurements and data into the journal 

To paste measurements into an open Journal, select an area, then select Edit > Journal > paste measurements 
(Ctrl+M). The measurements in the measurement windows are copied into the Journal. By changing the Journal 
Preferences, you can simultaneously record measurement name, channel number, and units. 

 
Paste waveform data into the journal 

To paste waveform data into a journal, select an area, pull down the Edit menu, select the Journal option and 
choose Paste Wave Data (Ctrl+D). The result is a text file of wave data from the selected area for all channels 
pasted into the active journal. 

 
Note: See pages 6160 and 6198 for more information about pasting data to the Journal. 

 

Saving data 

Once data has been collected, it can be saved as a file and opened later. The data file can be moved, copied, 
duplicated and deleted just like any other computer file. By default, files are saved .ACQ files, which use a 
proprietary format designed to store information as compactly as possible. Although these files can only be opened 
with the Biopac Student Lab PRO software, the data in these files can be exported either as a text file or as a graphic 
image. 

Exporting data to a text file allows you to examine the data using other programs, such as a spreadsheet or statistical 
analysis package. Saving data as a graphic (.WMF format) enables you to work with the data in graphic format. 

 One of the most useful applications of the Save As options is the ability to edit and place Biopac Student Lab 
PRO data as it appears on the screen. You can use this feature to paste graphs into word processors, drawing 
programs, and page layout programs. To learn more about these options, turn to the Save As section beginning on 
page 6183. 
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Printing 

In some cases, it is important to have a hard copy of the data. The Biopac Student Lab PRO software allows you to 
produce high-resolution plots of graphs much as they appear on-screen. To print a file, choose Print from the File 
menu. An example of the print dialog box follows.  

 
Print dialog box 

 

If you click OK, the contents of the screen will be printed on the selected printer. 

 To print the entire file, choose Autoscale Horizontal from the Display menu first, so that 
the screen contains the entire record. 

Often, you may want to print the contents of a file across several pages. To do that, change the value in the Fit to __ 
pages box. Entering “4” in this box, for instance, will place the length of the page evenly across four pages when 
printing. To find out more about the Print command, see page 6187. 

 

Playback  

Playback mode will replay a graph file stored on disk in real time to simulate acquisition. This is useful for 
observing a replay of data as it was acquired, and is a valuable visual feedback tool providing users with a data 
presentation mode familiar from chart recorders or other physiological monitoring equipment. To use: 
        

1. In the File menu, select Open for Playback.   
2. Browse to location of desired graph file and click Open. 
3. A new graph window will be generated. 
4. Press Play to begin playback. 
  

The Play button status alternates with STOP, which also acts as a pause function. To rewind the segment so it can be 
replayed, use the yellow Rewind toolbar button. The Playback data can be modified and transformed without 
affecting the data stored on disk in the original graph file. Appended segments are replayed separately, and all 
markers and marker labels are preserved. 
 
Playback mode has millisecond timing accuracy and allows for reconfiguration of most acquisition 
parameters. Exceptions include: 

 Length is limited to the amount of data in the file 
 Acquisition Sample Rate is fixed (use TransformResample to downsample) 
    Number of analog and digital channels is fixed 
    Playback is supported in *.acq format only. 

 
Graphs opened for Playback can be saved via FileSave As under a different name but the original source data file 
cannot be overwritten. 
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NOTE: You may also open a file for Playback by holding the Ctrl key down and selecting a graph from the recent 
files list in the File menu, or by checking the “Open for Playback” box while in the Startup Wizard’s “Analyze” 
option. (See below)  
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Chapter 4 Creating Your Own Lessons 
 

The multi-level learning features of the BSL software let you control the material and method of each experiment. 
Use our 17 guided- BSL Lessons for introductory concepts, modify them with your own lab procedures or analysis 
techniques, choose from 35+ PRO Lessons for advanced concepts, or easily create your own lessons. You can even 
use the BSL for graduate programs and advanced research. BSL lesson experiments are included in a number of the 
leading published lab manuals and have been successfully used to study: 

ECG  

EEG  

EMG 

EOG  

EDA (GSR) 

Biofeedback 

Bioimpedance/Cardiac 
Output 

Blood Pressure  

Heart Sounds 

Nerve Conduction 

Pulmonary Function 

Respiration 

Reaction Time 

Temperature

By combining two of the new features it is possible to create your own lessons. The graph template 
function (described on page 6182) allows you to save custom settings. The menu customizing function 
(described on page 659) allows you to remove menu options that are not required in your lesson. This 
prevents students from being confused by unnecessary options. 

TO CREATE YOUR OWN LESSON: 

1) Set the channel, acquisition, and display options you require.  

2) Type any comments and/or instructions for your students into the Journal window. 

  To open a journal window: Select Display > Show > Journal or click the toolbar icon . 

3) Select “File > Save as” and choose “Graph 
Template” from the file type options in the dialog. 

4) Create a new folder, and then name it appropriately 
for your lesson. 

5) Save as a graph template (.gtl) file in the new folder 
for your lesson. To further protect your file settings, 
set the Read-only attribute in the file Properties 
dialog. 

6) Clear the Journal window using the clear journal 
icon in the journal tools section. 

Journal tools =   
clear journal / open file /save file /print journal 

Copy and revise the Startup menu to turn “OFF” the 
menu items you do not require (page 659). 

Save the Startup file as directed. 

 

Menu customization will be applied when the BSL PRO 
software is next launched 

 
 

 

  For customization details, see the Instructor’s Guide (BSL 3_7 Orientation.pdf) installed with the 
program to the User Support folder or at the root level on the Biopac Student Lab installation CD. 

 



Recording Data 59 

Customizing Menu Functionality 

The BSL PRO software includes a powerful customization feature that lets you choose the program 
features to display as menu options. If you have a specific procedure, you can limit the menu options to 
list only those functions you need, thereby reducing the chance for confusion or error in your lab. For 
instance, you might want to hide/show BSL PRO menu options (as discussed in “Adding BSL PRO 
Analysis Features to BSL” on page 63) or remove Setup options from the MP UNIT menu, as shown:  

 
 Default MP UNIT menu Customized MP UNIT menu 

When BSL PRO is first launched, a “startup” routine runs to establish any global application variables; 
translate application prompt and dialog text (mainly if language other than English); remove any menus 
that are not used in the PRO; and check if the MP Unit is connected (only if installed for Hardware). If 
disconnected, it generates the communications error prompt. 

 

Follow the simple procedure below to customize the startup for your own needs. 

 

1. Open the BIOPAC Program folder (default installation used main drive:\Program Files\BIOPAC 
Systems, Inc\Biopac Student Lab 3.7.7). 

 
2. Copy the startup file. 
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a. Right-click the startup file and scroll to select “Copy.” 

 
b.  Right-click in the program folder and scroll to select “Paste.” 

 
3. Open the original startup file. 

 “Copy of startup” is for backup. 

 Choose to select a program from a list and select Microsoft WordPad if prompted for a 
program to open Startup with. 

 
4. Follow the instructions provided in the startup file to display or hide menus or menu items.  

 BSL PRO Menu variables are edited at the end of the startup file—search for “PRO 
Menus” to jump to the correct section. 

 Do not alter lines above or below the specified section. 
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 To hide a menu/menu item, delete the semicolon (“;”) at the start of the line that lists it. 

       
 To show a menu/menu item, add a semicolon (“;”) at the start of the line that lists it. 

The Startup script is sensitive to syntax 
errors, font change, name change, etc., 
so be extremely careful not to change 
anything — just add or delete 
semicolons at the start of the line that 
contains the menu item you want to 
display or hide. 
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5. Select File > Save to save the revised Startup file. 

 Use File > Save (not Save As!) to save your changes so the script file name is exactly the 
same — the program will not recognize an altered file name. 

6. Restart the BSL program. 

7. Check your menu listing. 

 The MP menus on page 59 show the result of changing the MP Menu items per step 4 above. 
Note that the Setup options, AutoPlotting, and Organize Channel Presets are no longer 
included in the menu listing (rather than simply being disabled and grayed-out). 

8. If you have the desired menu result, delete “Copy of Startup” from the program folder. 
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Adding BSL PRO Analysis Features to BSL Review Saved Data Mode 

The primary difference between each level of the Biopac Student Lab is the number of software options 
employed. The standard version uses pre-configured lessons to manage the setup, collection, and analysis 
of data. The PRO version affords a greater degree of control over the setup and data collection 
parameters, although with a slightly different “look and feel.” The following PRO features can be 
activated within Review Saved Data mode of the BSL Lessons: 
BSL PRO Analysis Tools in RSD Mode                       Default BSL Analysis Tools 
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To activate the BSL PRO software features for the Review Saved Data mode of the BSL Lessons, you 
must set the BSL PRO menu option in the BSL Lesson startup file. The procedure is outlined below, and 
more fully detailed in “Customizing Menu Functionality” on page 659. 

1. Open the BIOPAC Program folder (default installation used main drive:\Program Files\BIOPAC Systems, 
Inc\Biopac Student Lab 3.7.7). 

 
2. Copy the Startup file to create a backup. 

3. Open the original Startup file (not the copy) with a text editor such as Word Pad. 

4. Locate the “REVIEW SAVED DATA MODE OPTIONS” section. 
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5. Set Q = 0 to enable BSL PRO menus, as noted in the comments. 

 
6. Select File > Save to save the revised Startup file. 
 DO NOT USE the “SAVE AS” option. The file must retain the exact same name as the original startup 

file. 

7. Close the Startup file. 

8. Restart the BSL program. 

9. Check the menu listings. 

10. If you have successfully configured the startup script, the menus will now have the BSL PRO options 
specified on page 663 and you may delete the copy of the startup file that you created as a backup from the 
program folder. 
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Part C — Acquisition Functions: The MP Menu 
 

 
 

This section describes the various acquisition parameters for the Biopac Student Lab PRO that can be set under the MP UNIT 
Menu. Acquisition is defined as data collection from an external source (such as electrodes connected to an MP UNIT input 
channel). Biopac Student Lab PRO software adds acquisition and control capability to the BSL System. The MP UNIT Menu 
commands and procedures can be used to: 

 

a) Setup channels for data acquisitions 

 b) Control acquisition parameters such as sampling rate and duration 

 c) Perform online calculations and apply digital filters 

 d) Set acquisitions to begin on command from a mouse click or external trigger 

 e) Display values numerically and graphically during an acquisition 

 f) Output waveforms and digital signals during an acquisition 

 g) Control the on-screen waveform display characteristics 

 

Note: The Setup Channels and Setup Acquisition menu items are inactive (grayed) during acquisition. 

Recording Data (Part B) covered some of the basic functions involved in setting up an acquisition. This section will cover the 
same functions in more detail, as well as describe some features not discussed in Part A or Part B. All the commands covered 
here can be found under the MP UNIT menu. 
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Chapter 5 Recording Basics — Acquisition Overview 

Setup Channels 
Basic PRO Channel Setup 

Before you acquire data, you must specify which channels you will collect data from and establish their respective input 
parameters. The first step is channel setup. To access the channel setup options, select Setup Channels from the MP UNIT 
menu. 

The minimum setup is to acquire analog data from one channel, which is the default (on CH1). You must set Setup Channels 
options prior to starting the acquisition. You cannot change the channel setup during acquisition. The MP UNIT > Setup 
Channels menu item is inactive (grayed) during acquisition. 

BSL PRO can record and display up to four analog input signals from devices connected to the analog inputs on the front of 
the MP UNIT Acquisition Unit. It can record and display signals from up to eight digital inputs signals connected to the I/O 
port on the back of the MP36/35. In addition, BSL PRO can perform calculations based on the inputs and display and save them 
as separate signals. All three types of signals are referred to as “channels.”  

 
The Setup Channels dialog is divided into sections for Analog Input Channels, Digital Input Channels, and Calculation 
Channels. Each channel type has options for:  

Acquire Data 

Plot on screen 

Enable Value Display 

Label 

Analog Input and Calculation channels have options to select Presets and View/Change Parameters. 

 

MP35 required 
for Digital Input 
Channels 

MP45 users 

 

ANALOG INPUT CHANNELS 
CH3 and CH4 are inactive. 

 

 

 

 

DIGITAL INPUT CHANNELS are 
inactive. 

 

 

 

 

CALCULATION CHANNELS 
Analog Source Channel options are 
CH 1 and CH 2 only 
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Note: Setup options function similarly for each channel type, although there are considerable differences 
between the types of data each channel is designed to handle. Setup options will be discussed 
briefly here. See the Advanced Channel Setup beginning on page 669 for more details. 

 

Setup Channels Dialog 

Channel Channels are designated alpha-numerically. Analog (or continuous) Input channels begin 
with “CH” and run from CH1-CH4. Digital Input channels begin with “D” and run from 
D1-D8. Calculation channels begin with “C” and run from C1-C12. Display is limited 
to four channels of each type. Use the scroll button to set up additional Digital and 
Calculation channels. 

 

Acquire Data The Acquire data box must be checked for the software to collect data from a channel. 

 

Plot on Screen The Plot on Screen box indicates whether or not data for each channel will be plotted on 
the screen. When unchecked, data will still be collected (if the Acquire box is checked), 
but it will not be displayed during the acquisition.  

 

Enable Value Display 

 

This option enables incoming data values to be displayed during an acquisition, either 
numerically and/or in “bar chart” format. Values are displayed in a separate Show Input 
Values window activated under the MP UNIT menu. 

 

Label 

 

You may attach an editable “label” to each channel. Channel labels allow you to provide 
a brief description for each channel. To change the label for any channel, position the 
cursor in the Label box and revise the text. 

 

Presets 

 

Preset parameters are provided for specific kinds of physiological data (e.g., ECG, EEG. 
EMG, etc.). Set the preset the parameters for each channel to match the type of data you 
are collecting. The preset values are designed to be good starting points for most 
acquisitions, though you may wish to modify them for your particular laboratory 
situation. 

Click the Presets button  to generate a list of available presets. Scroll to select the 
Preset you want to apply to the selected channel. You can also establish custom 
parameters and save your own Presets. 

Presets are available for Analog Input and Calculation channels but not for Digital Input 
channels. 

 

View/Change Parameters 
Click the Settings button  to generate an Input Parameters dialog for the selected 
Preset. To access the scaling parameters, click the Scaling button at the bottom of the 
Parameters dialog. 

View/Change Parameters options are available for Analog Input and Calculation 
channels but not for Digital Input channels. 
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Advanced Channel Setup 

The previous section covered the basic options used in almost all acquisitions. In addition to the features described above, a 
number of other options are available in terms of setting up channels. These advanced features are also found under the MP 
UNIT>Setup Channels menu item. 

Most acquisitions involve collecting analog signals and then displaying them on screen. It is frequently useful, however, to 
collect other types of data (digital data, for instance) or to perform transformations (calculations) on data as it is being acquired 
or after it has been acquired.  

The Setup Channels dialog is divided into three sections, Analog Input Channels, Digital Input Channels, and Calculation 
Channels. For each channel you wish to collect data on, there are three options: Acquire Data, Plot on Screen, and Enable 
Value Display. The general features (acquiring, plotting, enabling value display, labeling) are the same for each type of channel, 
although there are considerable differences between the types of data each channel is designed to handle. Additional options for 
Analog Input channels and Calculation channels allow you to set Presets and View/Change Parameters.  

 

 
 

Channel 
This is the alpha-numeric channel designation. Analog Input channels are designated CH1-CH4, Digital Input channels are 
designated D1-D8 and Calculation channels are designated C1-C12. The dialog displays only 4 channels at a time. Use the 
scroll button to display and set up additional Digital Input and Calculation channels. 

Channel Types 
Acquisitions involve collecting analog or digital signals and then displaying them on screen. It is frequently useful, however, to 
perform transformations on data as it is being acquired, or after it has been acquired. Channels containing transformed data 
signals are referred to as Calculation channels. The MP36/35 can collect up to four Analog Input channels, 8 Digital Input 
channels, and 12 Calculation channels. Analog and digital channels may be acquired in any combination, and the only 
requirement for Calculation channels is that they be based on at least one input channel (either analog or digital). 

MP35 required 
for Digital Input 
Channels 

MP45 users 

 

ANALOG INPUT CHANNELS 
CH3 and CH4 are inactive. 

 

 

 

 

DIGITAL INPUT CHANNELS are 
inactive. 

 

 

 

 

CALCULATION CHANNELS 
Analog Source Channel options are 
CH 1 and CH 2 only 
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Analog Input channels are the most common type of channel and are used to acquire any data with “continuous” values. 
Examples of this include nearly all physiological applications where input devices (transducers and electrodes) produce a 
continuous stream of varying data. The range of values for analog channels is typically in the range of ±50 mV, although 
voltages as high as ±50 V can be measured with BSL PRO. BSL PRO records and displays up to four analog signals from 
devices connected to the analog input ports on the front of the MP UNIT Acquisition Unit. 

Digital Input channels (MP36 or MP35 required), in contrast to analog input channels, are designed to collect data from a 
signal source with only two values (0 and 1). This type of data can be useful in recording whether a switch is open or closed, and 
ascertaining if a device is on or off, as in reaction time studies or control applications. Input values for digital channels have two 
values, +5 Volts and 0 Volts. The MP36/35 interprets +5 Volts as a digital 1 and interprets 0 Volts as a digital 0. Since digital 
channels have a fixed value, the parameters and scaling options are disabled for these channels. The main function of digital 
channels is to track on/off devices such as push-button switches and/or to receive digital signals output by timing devices. 
Similarly, these channels are also used to log signals from devices that output auditory/visual stimulus for examination of 
stimulus response patterns. BSL PRO records and displays up to eight digital signals from devices connected the I/O port on the 
back of the MP36/35 acquisition unit. 

 

0 volts

+5 volts

Positive edge Negative edge 

(binary "1")

(binary "0") 

 
Digital Input Channels Have a Fixed Value 

 

Calculation channels transform incoming data in some way (rather than collect external data as input channels do). The original 
data is not altered — it is just stored in a modified form on a new channel. You can use Calculation channels to compute a host 
of new variables by using transformations (such as BPM, integration calculations, and math functions). 

Up to 12 Calculation channels can be acquired. You may use the output of one Calculation channel as the input for another 
channel, as long as the output channel has a higher channel number than the input channel. In other words, it is possible for 
Calculation channel 3 to include the result of Calculation channel 1, but not the other way around. This allows for complex 
Calculations to be performed that involve two or more Calculation channels, such as filtering ECG data then computing BPM. 

Each Calculation channel acquired will reduce the maximum possible sampling rate and increase the amount of memory 
required to store data both during and after an acquisition. Thus, you may want to consider performing some of these functions 
after the fact if high sampling rates are needed for your particular application. 

Notes: Calculation channels are OFF by default. To turn a Calculation channel on, click the  Presets button 
for that channel and make a selection from the menu. 

 TIP All of the calculations that can be performed online can also be performed after an acquisition has 
been completed. These options are available under the Transform menu. 
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Acquire Data 
Check the option Acquire Data if you wish to collect data on a channel. Unless you specify otherwise, BSL PRO by default will 
only collect data on Channel 1. To collect data on other channels, position the cursor over the Acquire box (on the far left) and 
click the left mouse button. Toggle the Acquire box to uncheck. 

 With BSL PRO, it is possible to leave hardware connected to the MP Acquisition Unit, but have the 
software essentially “ignore” the channel by leaving the Acquire box unchecked. Thus, if an input 
device (such as a force transducer) is connected to the CH3 input on the MP, data from that channel 
will not be collected unless the CH3 Acquire box is checked. 

Plot on Screen 
The second option determines whether or not data for each channel will be plotted on the screen. In most cases, you will want to 
check this option. When this box is left unchecked, data will still be collected when the Acquire box is checked, but it will not be 
displayed during the acquisition. 

Disabling Plot on Screen can be useful for 

a) Large scale acquisitions (i.e., multiple channels and/or high sampling rates). This will allow for faster display rates (see 
Appendix B - Hints for working with Large Files for other options). 

b) Calculation channel setup. For example, you may need the ECG Rate data for a calculation, but not need to see the ECG 
display. 

Enable Value Display 
The third option enables incoming data values to be displayed either numerically and/or in a “bar chart” format in a separate 
window during an acquisition. Checking Enable Value Display allows you to open an Input Values window (by choosing 
Show Input Values... under the MP UNIT menu) that displays the value for each input that has the Enable Value Display 
option checked. 

 This option is especially useful for tracking slowly changing values such as heart rate, respiration rate, or 
concentrations of chemicals in a substance. For more information on how input values are displayed, 
please turn to page 6150. 

 TIP Hold down the Ctrl (PC) or Option (Mac) key while you check an Acquire, Plot, or Enable Value 
Display box to toggle the entire column of boxes for that option. In other words, if none of the 
Acquire boxes are checked and you check the Acquire box for CH1 with the Ctrl key depressed, 
the Acquire boxes will be checked for all channels. If the Acquire box for CH1 is then unchecked 
while the Ctrl key is depressed, the Acquire boxes for all channels will be unchecked.  

 
Label 
You may attach an editable “label” to each channel to provide a brief description for each channel. To change the label for any 
channel, position the cursor in the Label box and enter a text label. You may key up to 38 characters. 

When a Preset is selected, a corresponding preset Label description will be automatically entered. 

A channel’s label is used in the display window and for a variety of software dialogs. If you revise a label entry, the change will 
display after you start an acquisition. 

Presets 
Presets are like “templates” for channel parameters. There are two ways to establish channel parameters. You make a selection 

from the Presets  menu and (1) use the corresponding default parameters or (2) modify the Preset using the View/Change 

Parameters  tool. 
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Analog Input Channel presets Calculation Channel Presets 

Click the Presets button  to generate a list of available presets. Scroll to select the Preset you want to apply to the 
selected channel. When you select a Preset, the channel Label will change to reflect the selected preset name. 

Preset parameters are provided for specific kinds of physiological data (e.g., ECG, EEG, EMG, etc.). Set the preset the 
parameters for each channel to match the type of data you are collecting. The preset values are designed to be good starting 
points for most acquisitions, though you may wish to modify them for your particular laboratory situation. You can also 
establish custom parameters and save your own Presets. 

Analog Input Presets and Calculation Presets are mutually exclusive and control different settings, as appropriate for the type of 
data each channel contains. Presets are not available for Digital Input channels. 

See Channel Presets on page 687 for more information. The Table of Analog Presets beginning on page 6266 and the Table of 
Calculation Presets beginning on page 6278 provide details on the settings that each preset specifies.  

 

An important concept to understand about Presets is that each channel uses its own set of parameters. When you select a 
Preset, the software performs a one-way dump into the channel to establish the parameters. Once the preset parameters are set in 
the channel, the settings are no longer tied to the Preset. That is to say, any modifications you make to the settings in the Input 
Parameters dialog after you select the Preset will affect only that channel, not the Preset file. If you choose the Preset from the 
menu again, the original, default settings of the Preset will be used. 

If you want to create a new preset so your modified parameters are 
available for other channels, just change the Channel Preset name to a 
new, unique name. This enables the New Channel Preset button. Click 
the button to create a new Preset with the parameters you establish. 

You will see the following dialog if you have been successful: 

 

Note: You can use the Organize Channel presets option from the MP UNIT menu to rename, rearrange or 
delete Presets. For instance, you might move frequently used Presets to the top of the list. See page 
6153 for more information. 

 You can use the Save As Template option from the File menu to save setup parameters in a 
BIOPAC graph template file (.gtl). A Graph Template never contains data; it only contains the setup 
parameters. Templates only save MP UNIT Menu functions — this includes calculation channel 
functions, but not their Transform menu counterparts. Graph templates will open to the same 
window displays and positions you closed the file with. See page 6182 for more information. 
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View/Change Parameters 

The settings for a Preset can be accessed via the  View/Change Parameters button in the Setup Channels dialog. This 
will generate an Input Channel Parameters dialog for the specified channel Preset. 

 
Sample Analog Input Channel Parameters Dialog 

 
Sample Calculation Channel Parameters Dialog 
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Scaling 
To access the scaling parameters, click the Scaling button at the bottom of the Parameters dialog. This generates the Change 
Scaling Parameters dialog. 

  
Analog Scaling  Calculation Channel Scaling  

Scaling options vary based on the channel type. For Calculation channels, the Input value must be 1,000x the Scale 
Value for a 1-to-1 scaling (mapping) result. See the following pages for further explanation of scaling. 
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Analog scaling 
The PRO software allows you to rescale the signal on analog channels to more meaningful numbers. As an example, let’s say a 
temperature transducer is connected to channel 1. Ordinarily, the values from the input channel would be read in as milliVolts. 
For this acquisition, the signal from the transducer should be expressed in terms of degrees Fahrenheit. 

To calibrate the transducer, you would bring it to two known temperatures. At the first temperature you’d take a voltage reading 
by selecting Show input values from the MP UNIT menu. At 90° F, you’d get a reading of 0 Volts. The transducer would then 
be brought to a temperature of 95° F, and you’d get a reading of +1 Volts. 

To have the software map the incoming signal to degrees F, click the 
“Scaling” button at the bottom of the Parameters dialog to open the 
Change Scaling Parameters dialog. 

The Input value and Scale value boxes reflect the value of the 
incoming signal and how it will be plotted on the screen, respectively. 
Enter these numbers into the Channel Scaling Parameters box, type in 
the new units as “degrees F,” and click the OK button. Then click OK 
again to close out of the Input Channel parameters. 

 See Calibration Guidelines on page 6290. 

The software calculates the slope and offset from the two points entered. 
Each data sample from channel 1 will be scaled according to the slope 
and offset calculations previously made. When an acquisition is 
performed, the amplitude scale (vertical axis) will reflect the rescaled 
units. 

 

 
Scaling set to rescale from Volts 

to degrees Fahrenheit 

Note:  An incoming signal of +1 Volts would be plotted as 95° F, whereas a signal of 0 Volts would be plotted as 
90° F. The software will perform linear extrapolation for signal levels falling outside this range (i.e., -2 Volts 
will be mapped to 80 ° F), as well as perform similar interpolation for values between this range. 

As a shortcut for scaling analog channels, you can use the Cal 1 and Cal 2 buttons. Click either one of these buttons to read the 
current voltage for the selected channel. Set the transducer to a known value (i.e., temperature), click the Cal 1 button, and then 
enter the value in the Scale value box for Cal 1. 

Then bring the transducer to another known value that is considerably higher or lower than the first, click Cal 2 and enter the 
new known value in the Scale value box for Cal 2. The software calculates the slope and offset from the two points entered. 
Each data sample from the selected channel will now be scaled according to the slope and offset calculations previously made. 
When an acquisition is performed, the amplitude scale (vertical axis) will reflect the rescaled units. 

 

It is important to note that Cal 1 and Cal 2 may be set when data is being acquired but will not take effect until the acquistion is 
stopped and then restarted. A channel must be calibrated before data acquisition. To set the calibration for a given channel, 
connect the input device to the MP UNIT and power up the BSL PRO System, then perform calibration before starting data 
acquisition. 
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Calculation channel scaling 

 

 

Input value 10 V constant 

 

Scale value Input value x (sample rate/samples to be mean averaged) 

 

It is important to note that this rescaling should be performed 
independent of any rescaling performed on analog channels 
themselves. Even if an analog channel is being rescaled to some 
other units, the Input values in the calculation channel scaling 
should be set to +10 Volts (next to Cal 1) and -10 Volts (next to 
Cal 2). 

 

The "Scaling" option for Calculation Channels corresponds to the source Analog Channel input (and not the source channel's 
mapped value). Typically, the default scaling settings will be fine. However, if the calculation values will be on a different scale 
than the original units, you need to change the scale of the calculation channel to reflect the new units (i.e., liters/sec to liters). 
Click the Scaling… button to generate the Change Scaling Parameters dialog, which includes options that allow you to modify 
the units or linearly scale the output. 

Rescaling involves multiplying the “Input value” by a factor determined by the sampling rate and number of samples mean 
averaged across. As an example, if data was acquired at 75 samples per second and you wanted to integrate across an interval of 
10 samples, you would set the Integrate > Scaling parameters so that an Input value of +10 Volts corresponded to a Scale value 
of 75 and an Input value of -10 Volts corresponded to a Scale value of -75. 

 
Plot Standard Curve – Windows only 

 The Plot Standard Curve command is only available in X/Y mode. A Standard Curve   is a graph used in colorimetry to 
help determine the concentration of a solution, wherein the light absorbance value of the solution is compared to standard values. 

BSL PRO can generate a Standard Curve on a plot of Concentration vs. Absorbance of known solutions, which can then be used 
to determine the concentrations of unknown solutions. 

About Standard Curve 

Colorimeters, or spectrophotometers, are useful for determining such things as the amount of glucose, 
cholesterol or protein in blood. Colorimeters use a monochromatic light source (composed of a single 
wavelength). They output an Absorbance value, which is a measure of the percent transmission of light 
through a liquid. Because the light is monochromatic, Beer's Law can be applied. Beer’s Law states that the 
absorbance value is directly proportional to the concentration of the solution. One or more solutions of 
known concentrations, called Standards, are used to generate a “Standard Curve”plot. The concentrations of 
unknown solutions can then be determined from the Standard Curve data. 

Before plotting a Standard Curve, you must first set up two Channels in a BSL PRO file to represent your X-axis (normally 
“Concentration”) and Y-Axis (normally “Absorbance”). Refer to “Setting up a file to plot a Standard Curve” on page 678. 

  Consider starting with the sample file “StandardCurve.acq” for preset X-Axis and Y-axis units and scale. 
Review the sample file “StandardCurveData.acq” for sample data. 

Plot your curve by pressing the Plot Standard Curve button on the Toolbar.  This will generate the Plot Standard Curves 
dialog. 
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Plot Standard Curve Dialog 

For each standard data point to be plotted, place a standard in the colorimeter and then 

Enter values for the X-axis [Concentration (mg/100mL)] and the Y-axis (Absorbance) from the colorimter 

Press Add to List. 

To delete a data point, select it from the list and click Delete. If a curve has been previously plotted, adding and deleting points 
generates an alert that the previous curve will be deleted. 

Once all data points have been entered and added to the list, click Plot Curve. 

The standard data will be displayed in the graph as dots and the standard curve will be plotted as a “best fit” line drawn through 
the standard data.. 

 
A typical Standard Curve (blue line) plotted through Standard data (red dots) 

When you click a plotted data point in the graph window with the Cursor, its X-axis and Y-axis values are displayed in the 
measurement region. You may record these values to the journal, if the journal is open, by right-clicking and choosing “Paste 
Values to Journal.” 

To determine the concentration of an “Unknown” solution: 

Place unknown solution in the Colorimeter and obtain the Absorbance value. 

To find the Absorbance value in the graph, click and hold the left mouse button, which activates the “snap to” data 
function, and move the mouse to the left or right until the Absorbance value is displayed in the cursor reading (upper 
left portion of graph). When the Absorbance value is displayed, its corresponding Concentration will be shown. 

 
To paste the Absorbance and Concentration values into the journal, right-click (while the left button remains pressed) 
and choose “Paste Values to journal” from the pop-up menu. 
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Standard Curve Settings 
Standard Curve Settings sets parameters for the Standard Curve to be plotted. If a curve has been previously plotted, an alert is 
generated and the graph is immediately updated to reflect the new settings. 

Plot From/To: Defines the range of Y-axis values for the data points to be 
plotted. The default range is from 0 to 1 units. Enter new range values to 
expand or limit the points on your list that are referenced when plotting the 
curve. 

Plot using: Sets the resolution, or number of samples, of the plotted curve. 
The default is 100. 

When plotting Standards, use: Allows control of dot color and size of the 
standard points on the list to be plotted. Choose from the pull-down menu to 
enter a new setting. (Note: The color of the standard curve is assigned on the 
X-axis channel, selected by right-clicking in the graph and choosing the 
Color option.) 

Setting up a file to plot a Standard Curve 
1. Launch BSL PRO to a new BSL PRO file with default parameters.  

2. Choose MP menu >Setup Channels and set CH1 and CH2 for Acquire Data and Plot on Screen. 

3. Change the Label for Channel 1 to “Concentration” and change Scaling units to “mg/100 ml.” 

 Click View/Change Parameters for Channel 1 and change the channel Label to “Concentration.”  

 Click Scaling and change the Units label to “mg/100 ml.”  

 Click OK to accept the new scaling parameters.  

 Click OK again to close out of the Input Channel Parameters dialog. 

4. Change the Label for Channel 2 to “Absorbance” and change Scaling units to “A.” 

 Click View/Change Parameters for Channel 2 and change the channel Label to “Absorbance.”  

 Click Scaling and change the Units label to “A.”  

 Click OK to accept the new scaling parameters.  

 Click OK again to close out of the Input Channel Parameters dialog. 

5. Close the Setup Channels dialog. 

6. Press Start and then Stop in the graph window to acquire a small amount of data. 

7. Go to the X/Y display mode by clicking its icon on the Toolbar.  

8. Establish “Concentration” for the X-axis and “Absorbance” for the Y-axis. 

 Click in the X-axis label displayed above the waveform window and choose Ch1, Concentration for the X-axis. 

 Click in the Y-axis label displayed to the left of the waveform window and choose Ch2, Absorbance for the Y-
axis. 

9. Scale the X-axis (Horizontal Scale) and Y-axis (Vertical Scale) appropriately for your experiment. 

 For example, set the “Absorbance” scale to go from 0 to 1, and set the “Concentration” scale to go from 0 to 100 
mg/100 ml. Your actual scale settings will depend on your experiment. 

 To set the scales, click in the horizontal and vertical scale regions, respectively. 

Setup is now complete and you are ready to plot the curve. 



Acquisition Functions 79 

Chapter 6 Set up Acquisitions 

 
Once you have selected the channels to be acquired, the next step is to set up the acquisition parameters under the MP UNIT 
menu. Among other things, these options control where data will be stored during an acquisition, the sample rate for data 
collection, and the duration (length) of each acquisition. The dialog box that allows these options to be set is generated via Set 
up Acquisition under the MP UNIT menu. You must establish acquisition parameters prior to pressing the “Start” button. The 
MP UNIT > Setup Acquisition menu item is inactive (grayed) during acquisition. 

Data storage options 

There are three pull-down menus at the top of the Set up Acquisition dialog that allow you to control how and where the 
acquisition data will be saved. 

1)  Record/Record last controls whether the software saves all the data or only the most recent segment. 

 Record will store data for the amount of time specified in the acquisition Length box. This is the default and is 
appropriate for almost all types of acquisitions. 

 Record last  will acquire data continuously, but store only the most recent segment of data (equivalent to the duration 
in the acquisition Length dialog box). That is, if the value in the acquisition Length box is 30 seconds and Record last 
is selected, data will be acquired data ad infinitum, but BSL PRO will store only the most recent 30 seconds of data. 

2)  Save once/Autosave file/Append allows you to vary how the data is saved to a file. By default, BSL PRO will append 
acquisition data to a single continuous file. 

 Save once  will begin an acquisition when the  button is clicked and will stop acquisition either when the 

acquisition Length has been reached or when the  button is clicked. 
 Autosave file  enables you to perform several acquisitions one after another and save the data from each acquisition in 

a separate file. 

When Autosave file is selected, a  button will appear by the 
Sample Rate entry box. Clicking on the File… button generates an 
“Autosave File Setup” dialog that prompts you to choose the root file 
name for the data from each acquisition. 

 
 

Append allows you to pause the acquisition for arbitrary periods. Append markers  are automatically inserted to indicate 
where each appended acquisition segment begins. (See page 172 to customize append markers and/or preset marker labels.) The 

Append mode is unique in that clicking on the  button only pauses the acquisition, which can then be restarted by 

clicking on the  button. This can be helpful when recording only a few key events that will occur randomly over a long 
period of time, since it will reduce data storage and transformation processing. 

 When Append is selected, a Reset button is generated in the Setup Acquisition dialog. Clicking on the Reset 
button erases the acquired data file and “continues” the acquisition. (This is essentially the same as saying yes to an 
“Overwrite existing data?” prompt.) 
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Each time an acquisition is restarted, an append marker  is automatically inserted into the record showing the time at 
which the MP UNIT restarted data acquisition. 

 

 When Append is selected, the display mode is set to Chart or Scope, and at least one segment of data has been 
acquired, the Overlap Segments icon is enabled on the Toolbar. The Overlap Segments display mode overlaps appended 
segments of data. See Overlap Segments, page 640. 

Although you can pause for any period of time, the Biopac Student Lab PRO will only acquire data for the amount of time 
indicated in the Acquisition Length box. 

Data can only be acquired in Append mode while being saved to PC memory. 

When used in conjunction with the external trigger, the Append mode can be a very useful acquisition tool. An acquisition 
that takes place over a long period of time with brief events which are few and far between can be set up in the following 
manner: the researcher watches for the events, triggers the acquisition to start, and then lets the pre-defined acquisition 
length run out. When another event of interest occurs, the researcher triggers the next acquisition. This acquisition will be 
“appended” onto the end of the first acquisition. Memory is the only limit as to how many “appendages” can be added. 

 

3)  PC Memory/Hard Disk controls where data is stored during an acquisition. The best choice depends in large part on the 
nature of the acquisition itself and the type of computer being used. 

 PC Memory  will store data in computer memory (RAM) during an acquisition. After the acquisition is 
finished you will have to select Save As... from the File menu to permanently save this to your computer’s 
hard disk. This usually allows for faster acquisition rates, although most computers have less available 
RAM than disk space. 

 Hard Disk will save data directly to the computer’s hard disk during an acquisition. Hard Disk mode is 
fast enough (in terms of maximum sampling rate) for many applications, especially when only a few 
channels are being acquired. Saving data to Hard Disk allows for longer acquisitions, since most 
computers have more hard disk space free than free RAM. An advantage of saving data directly to disk is 
that if there is a system failure (including power outage), all the data collected up to that point has been 
saved on the hard disk and can be recovered, whereas data saved to PC Memory would be lost. 
 

— IMPORTANT NOTE — 
If you are saving files in Hard Disk mode, always be sure to save files under a different name BEFORE you start each 
acquisition. Otherwise, any previous data in that file will be overwritten. In PC Memory mode, you simply go through the 
standard procedure of saving the file after the acquisition. Once data has been acquired and is stored in a file, it is stored on 
a hard disk or other similar device. 
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Sample Rate 

 
The “Sample Rate” value indicates how many samples the MP UNIT should acquire per second on each channel 
during data acquisition. The default Sample Rate is 1,000 samples/sec, but can be changed by clicking on the pull-
down menu. Use the pull-down menu to select a sample rate between 1 sample/sec. and 100,000 samples/sec. You 
must select one of the menu options — you cannot enter a custom sample rate. You need to scroll up to see the 
higher sample rates. 
MP30 users: It is important to note that Sample Rates above 2,000 samples/sec are considered “high speed” rates and the 
software behaves differently in High Speed mode (see page 684). 

Depending on the nature of the data being acquired, the “best” choice for Sample Rate will vary. 

Technically speaking, the minimum sampling rate should be at least twice the highest frequency component of interest. This 
means that if the phenomenon you are interested in observing has frequency components (of interest) of 100 Hz, you should 
sample at least 200 times per second. Fourier analysis (FFT) can be used to determine what frequency components are present in 
the data (see page 6222 for a more detailed description of the FFT function). Applications that typically involve higher sampling 
rates are ECG, EEG and evoked response acquisitions. In less technical terms, slower sampling rates can be used for data with 
slowly changing values (respiration, GSR, and the like), whereas higher sampling rates should be set for data where values 
change markedly (either in magnitude or direction). 

The disadvantage of acquiring data at high sampling rates is that each sample point takes up memory, whether it is RAM or hard 
disk space. Moreover, once the file is saved, it will require more hard disk space than a file of similar duration sampled at a 
slower rate. 

The maximum allowable sampling rate is 100,000/second, but rates over 2,000/second are considered “high speed” and do have 
limitations (see below). Set the Sample Rate from the pull-down menu options. 

 TIP  A good rule of thumb is to select a sampling rate at least four times the highest frequency of interest 
for the signal. 

Notes: 1) A waveform is considered “compressed” when more than three sample points are plotted per pixel on 
the screen. Using the default horizontal scale (which plots eight seconds of data on the screen), any 
data sampled at more than 250 samples per second would be considered compressed. 

  Standard VGA displays are 640 pixels wide, so a compressed waveform on this type monitor would be 
any type of waveform displaying more than 2000 samples (approximately) on the screen at any one 
time. Use the Draft mode for compressed waves option to plot compressed waveforms in draft mode, 
which results in faster plotting time, although the display is not exact. 

 2) It is possible to set a Sample Rate that is too high.  
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The acquisition will begin normally, but the BSL PRO System will terminate 
the acquisition and display a message indicating that the acquisition buffer 
has overflowed: 

Data acquired up to the overflow prompt will have been saved, but the 
Sample Rate must be set to a smaller value to continue acquisition. 

 

  

Sample Rate 

(samples/Sec) 
MP36/35 MP30 MP45 

1 YES YES YES 

2 YES YES YES 

2.5 NO YES NO 

5 YES YES YES 

10 YES YES YES 

20 YES YES YES 

25 NO YES NO 

50 YES YES YES 

100 YES YES YES 

200 YES YES YES 

250 NO YES NO 

500 YES YES YES 

1,000 YES YES YES 

2,000 YES YES YES 

5,000 YES YES YES 

10,000 YES YES YES 

20,000 YES NO YES 

25,000 YES YES YES 

40,000 NO YES NO 

48,000 NO NO YES 

50,000 YES NO NO 

100,000 YES YES NO 
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EXAMPLES OF SAMPLE RATE EFFECT ON ECG WAVEFORMS 
The sample ECG waveforms that follow illustrate the effect of different sampling rates on obtaining varying levels of fidelity 
when reproducing the data. 

In the first waveform to the right, the data is sampled relatively 
slowly, and it is difficult to make out the shape of the waveform. 

In the waveform sampled at the faster rate, more samples are 
taken in the same period of time that allows for higher resolution 
of some components of the waveform. 

 
Representation of ECG waveform sampled with 
relatively few samples per second. 

The “true” ECG wave is superimposed over dots that indicate 
sample points. As you can tell, under-sampling completely 
misses the QRS complex of this waveform, although it might 
detect components of the QRS in subsequent beats. 

Although this is an extreme example of how under-sampling can 
affect digitally processed data, it is important to note that the 
rate at which data is sampled has important implications for the 
interpretation and analysis of data. 

 

 

 

 
Above waveform as it would look if plotted in BSL 

PRO (with data points superimposed) 

The third waveform to the right illustrates the advantage of 
sampling data at relatively high rates — namely, increased 
resolution of the waveform. 

Waveform components that were obscured at slow sampling 
rates are now well defined, and measurements taken on this 
waveform would be able to better establish the maximum 
amplitude, time interval between different wavelets, etc.  

Representation of same ECG waveform sampled at a 
relatively higher sampling rate. 
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High Speed Mode—MP30 only 
The MP36/35 handles all acquisition the same, with no distinction for high speed. 

The High Speed mode is designed for acquisitions that utilize a high-sample rate/short duration setup, such as nerve conduction 
and action potential. When you select a Sample Rate over 2,000 samples/sec. it is considered a High Speed acquisition and the 

following alert will be generated:  

In High Speed mode, the MP30 acquires data and saves to 
its internal buffer so storage is locked to MP30 Memory 
setting. 

  

The following status window will be generated during High 
Speed acquisition. Data downloads to your PC RAM after 
the acquisition is completed. Because of that, the current 
memory size is limited to 100,000 samples or 200,000 
bytes. 

 

At or below a Sample Rate of 25,000, you can mix and 
match any or all of the four analog channels. At a Sample 
Rate of 40,000 only one or two analog channels can be 
active (if two channels are selected, they must be CH1 and 
CH2). If your Channel Setup is incorrect, you will be 
prompted to correct it: 

 

At 100,000 samples/sec. only one channel can be acquired. 
If your setup is incorrect, you will be prompted to correct it: 

 

The following limitations are enforced during High Speed acquisition: 

Calculation channels  Cannot calculate channels during High Speed acquisition; channels will be calculated after the 
data is downloaded from the MP30 to the PC. The calculation lag factor depends on the speed of 
the computer and the complexity of the calculation. 

Marker functions  Disabled during High Speed acquisition; can be added after acquisition. 

Real-time digital filters  Not available during High Speed acquisition 

Show Input Value  Display is not available during High Speed acquisition. 

Plot on Screen  Plot display is not available during High Speed acquisition. 

Save options Cannot save to PC Memory or Hard Disk. 

Stimulator functions  Can only use the “Start/Stop stimulator with Start/Stop of Acquisition” setting; no manual 
control options are enabled during High Speed acquisition. 

The “Start/Stop stimulator with button in Stimulator window” option functions normally when 
data is not being acquired, but is not available during High Speed acquisition. If the “Start 
with button” option is selected, the Stimulator window will be grayed (not selectable) during 
acquisition. 
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Acquisition Length 

 
To set the duration of an acquisition, enter a number in the Acquisition Length box. By default, 60 minutes of data will be 
recorded. 

The MP UNIT will automatically limit the maximum recording length to the amount of available memory on the target storage 
device (PC Memory or Hard Disk). The default is to record one acquisition of the duration specified in the Acquisition Length 
box. 

The pull-down menu to the right of the Length box allows you to scale the duration of the acquisition in terms of milliseconds, 
seconds, minutes, hours, or samples. Changing this option will not change the length of the acquisition, only the units used to 
describe it. Thus you can describe the same acquisition as lasting 30 seconds, or 0.5 minutes, or 30,000 milliseconds. Scaling the 
duration of an acquisition in terms of samples is essentially the same as the time scaling options, except the length of the 
acquisition will be expressed in the total number of samples to be collected on one channel. 

The maximum acquisition length and, on the PC only, current acquisition requires, are calculated based on all the active 
channels, the types of channels activated (analog or calculation), and the other acquisition setup parameters. This reference 
information is displayed above the Acquisition Length section of the Setup Acquisition dialog. The BSL PRO requires 2 bytes 
per analog sample and 8 bytes per calculation sample. The memory calculation does not include approximately 25KB per file for 
header information. 

In the default Append mode, “max acquisition length” reflects the total available length—if you are going to record more than 
one segment, you need to set the acquisition length so that the combined length of all appended segments falls within the 
specified maximum length. 

If you are using the Repeat function, the memory calculation is based on one acquisition; you will need to multiply by the 
number of repetitions to calculate the total memory required. 

Regardless of what scale you use to determine the length of acquisition, the MP36/35 will stop acquiring data when the value in 

the Acquisition Length box is reached. You may also stop the acquisition at any time by clicking on the button in the 
lower right hand corner of the graph window. 

Note The Acquisition Length parameter has a somewhat different interpretation in the Record last mode; see page 
679 for more information about settings for this mode. 
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Repeat 

The Repeat mode allows you to acquire data from repeated trials using the same parameters for each trial. When the Repeat 
every box at the bottom of the Acquisition Setup box is checked, a series of menus at the bottom of the dialog box are enabled. 
These allow you to establish the repetition interval and the number of repetitions. 

 
1)  Repeat every controls how long the software will pause between the start of one acquisition and the start of the next 

acquisition. The pull-down menu options are seconds, minutes, or hours. 

It is important to note that this value measures the interval between the start of two adjacent trials, rather than the interval 
between the end of one trial and the start of the subsequent trial. If the repeat interval is set for 15 minutes and the 
acquisition Length is set to 60 seconds, then there will be a 14 minute pause between the end of the one trial and the 
beginning of the next. For the fastest possible interval (least possible delay) between repeating acquisitions, set to repeat 
every 0 seconds. 

 When Repeat every is unchecked, the acquisitions will repeat as soon as possible (usually 
instantaneously, but slightly longer if data must be saved to a file between trials). 

2)  For/Forever controls how many trials will be acquired. The two general options are to perform a finite number of trials, or 
to perform an infinite number of trials. 

 For will acquire a fixed number of trials equal to the number entered in the box to the right. 
 Forever will acquire an infinite number of trials. Trials will be repeated at the specified interval until either a) 

the acquisition is stopped by clicking on the  button in the graph window or b) there is not enough 
free memory on the target storage device. 

Data for each trial will be acquired according to the acquisition parameters specified in the dialog box. In the preceding dialog, 
each trial of data will be sampled at 50 Hz and will be repeated every 15 minutes for a total of 8 trials. 

— IMPORTANT NOTE — 

By default, each acquisition will be appended to the data from the previous acquisition. You can change this by selecting the 
Autosave file option from the Save once/Autosave file/Append option at the top of the Setup Acquisition dialog. When the 
Repeat option is checked and Autosave is selected, the Biopac Student Lab PRO will save the data from each trial using the file 
name and extension indicated by the Autosave feature (see page 679 for details). 

When Save Once is selected, a prompt to overwrite existing data will be generated at the beginning of each acquisition using a 
Repeat/Autosave setup, so you will probably want to uncheck the Warn on overwrite option from the MP UNIT menu to 
disable the prompt. 
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Chapter 7 Channel Presets 
In addition to the Preset specific settings, each Parameters dialog includes: Channel Number, Channel Preset, Channel Label, 
Source, New Channel Preset, and Scaling features, which are detailed here: 

Channel Number This is the selected analog channel or the destination channel for a calculation. It 
corresponds to the Channel in the Setup Channels dialog. 

 

Channel Preset The Channel Preset entry lists the Preset that was selected from the Presets  menu. If 
you edit this field the “New Channel Preset” button will automatically be activated. 

 

Channel Label This is a modifiable description of the Preset parameters. Any change you make here will 
be reflected in other label displays for that channel, such as the graph window label or 
dialog box channel label. 

 
Source Calculation channels only 

This is the source channel for the calculation. The source channel defaults to CH1 but can 
be changed via the pull-down menu. Source options includes any Analog channels being 
acquired and any enabled Calculation channels. The units of the Source channel are 
displayed for easy reference. 

The Math and Function calculations use two source channels and the Expression 
calculation can use multiple source channels. 

IMPORTANT! 

Calculation Presets can only work in conjunction with Analog input presets, or with other 
calculation channels that are ultimately pointing to an Analog source channel. You must 
pay close attention to Source Channel and choose it carefully. 

 

New Channel 
Preset button 

The New Channel Preset button will be activated if you change the Channel Preset entry. 
When you click it, the newly named preset will be added to the menu available to every 
channel. If you change other settings but keep the Channel Preset entry the same, the 
changes only apply to the selected channel and the original Preset settings will be applied if 
you select the Preset from the menu again (for any channel). 

 

Scaling… button When you click the Scaling… button, a Change Scaling Parameters dialog will be 
generates for the selected channel. Scaling is explained in detail beginning on page 674. 

 

 See Calibration Guidelines on page 6290. 
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Analog Channel Presets 

 
Selecting an Analog Presets option automatically configures the Gain, Filter and Coupling options using preset values for the 
type of data designated for that channel. These preset values are designed to be good starting points for most people, and you 
may modify them as you see fit. The table beginning on page 6266 lists the default Presets for various physiological signals. 
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Input Channel Parameters 

 

The PRO software allows you to set a number of input channel parameters 
for analog acquisitions, including: 

Adjustable hardware filters 

Digital Filters 

Gain 

Offset 

Additional filtering can be applied in real time or after acquisition: 

Real-time filtering via calculation channels (page 669) 

Post-acquisition filtering via transformations (page 6201) 

When a Channel Preset is selected, all adjustable filters are set to standard 
settings. 

Click the View/Change Parameters  button in the Setup Channels 
dialog to view or change the Preset parameters. 

See also Appendix G—Filter Characteristics (page 6295) 
 Calibration Guidelines (page 6290) 

The different types of filters used in MP3X units are applied in the following sequence (does not apply to MP45 units): 

 

 

Adjustable Hardware Filters 

These filters are implemented using resistors and capacitors 
in the front end circuitry of the MP UNIT. They are set via 
the “Input coupling” section of the Input Channel 
Parameters dialog (MP UNIT > Set Up Channels > Wrench 
button). 

Notes 

Input Coupling enables you to record data as AC Coupled or DC 
Coupled signal values. 

Coupling Appropriate Use 

AC ECG, EEG, EMG, EOG, PPG, 
Respiration, and similar data. 

DC Temperature, GSR, Airflow, BNC, Switch, 
Pressure, Force, Hand dynamometer, 
Stimulator, Strain gauges, and similar data. 

 
 

Adjustable 
Hardware 

Filters 

Fixed 
Hardware 

Filter 

Fixed 
Anti-aliasing 

Filter 

A/D 
Converter 

Adjustable 
Digital Filter 

1 

Adjustable 
Digital Filter 

2 

MP3X Unit 

Adjustable 
Digital Filter 

3 

Channel 
Input 

Channel 
Output  
1001110… 
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There are a number of technical differences between these coupling settings, but the main issue is Offset. Offsets are values 
which impact the location of transducer zero. Most distinctions between “absolute” vs. “relative” accuracy are related to Offset. 

AC Coupled signals are centered on zero, so Offset is not a factor.  
Other hardware settings, such as Gain values or sensitivities, don't change significantly between AC and DC, but AC Coupled 
signals can use somewhat higher Gain settings, resulting in slightly higher resolution. 

DC Coupled signals usually have a non-zero Offset in amplitude that drifts during the course of the recording. DC Coupled 
measurements can be calibrated directly to account for the Offset. 

The 0.05 Hz / 0.5 Hz/ 5 Hz High-pass (HP) filter options are only available when “AC” is selected (see page 689 for a description 
of this setting). The 5 Hz HP filter option is only available on MP36/35. 

AC Filter setting Appropriate use 

0.05 Hz HP ECG 
Respiration data 

0.5 Hz HP ECG when there is a lot of motion artifact causing a shifting baseline  
EEG 
Pulse plethysmograph 
Most other types of AC Coupled data 

5 Hz HP 
MP36/35 only 

EMG 
Heart Sounds 

  
Fixed Hardware Filter 

To reduce high frequency noise, the MP Unit employs a low pass filter: 

 MP36/35: Low pass filter is set at approximately 20 KHz.  
 MP30: Low pass filter options for 1 KHz LP or 5 KHz LP are in the “Input coupling” section. 
 MP45: Low pass filter is set at approximately 8 KHz.  

Anti-Aliasing Filters—MP36 and MP35 only 

To ensure that the MP36/35 will not alias input data, the MP36/35 implements a high-order low-pass FIR filter prior 
to the Analog to Digital (A/D) Converter.  Filter frequency is dependant on sample rate and cannot be turned off. 

Sample Rate 
samples/second 

Anti-aliasing low-pass filter 
frequency (Hz) 

 1 – 20,000  9,000  

 25,000  11,250  

 50,000  22,500 

 100,000  45,000 

  
Digital Filters 

The MP Unit allows up to three user-configurable, sequential, biquadratic 
(second order) Infinite Impulse Response (IIR) filters. These filters are 
typically configured by choosing a Preset but they can be manually 
changed via the Input Channel Parameters dialog (MP > Set Up Channels 
> Wrench button). 

In the “Digital Filters” section, select Filter 1, 2, and/or 3 and then adjust 
the Type, Freq, and Q.  

MP36/35/30 users—The internal IIR Filters are processed as 32 bit fixed 
point filters. Since there are not enough bits to realize all frequencies, the 
minimum frequency is MP36/35: 10 Hz and MP30: 30 Hz. 

MP45 users—The internal IIR Filters are processed using floating point arithmetic at a rate of 48,000 s/s rate; this 
allows very low frequencies to be realized. The minimum frequency is MP45: 1 Hz, and although the dialog allows 
any frequency (Freq) to be entered, it is not practical to enter frequencies greater than 10,000 Hz because the filter 
cannot be realized. 
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Digital Filter Notes 

1. The “Q” setting refers to the skew of the filter, and an optimally dampened filter has Q of 0.707. In some cases, it may 
be desirable to over- or under-dampen a filter, depending on the particular requirements. 

2. Some common applications of these filters are removing 60 Hz noise and preventing “aliasing.” Other filters are 
available for broadly limiting the frequency range and removing low frequency “drift” of the incoming signal. 

3. The MP36/35 internally samples all input data at a rate of 20 kHz, 25 kHz, 50 kHz or 100 kHz, depending on the 
sample rate chosen. For all sample rates less than 20 kHz, the MP36/35 will initially sample the analog data stream at 
20 kHz and then down sample after the internal IIR filter calculations are performed, before sending the data to the BSL 
software application. 

4. MP30 only: digital filters are only applied if the sample rate is 2,000 samples/sec or less. 

 

Hardware settings 
The Hardware settings allow you to control the Gain and Offset for each channel. 

Gain settings 

The Gain setting specifies the extent to which an incoming signal is amplified. The Gain is automatically 
set when a data type is selected from the available Presets. The preset Gain settings are only educated 
guesses and should be used as initial starting values. You may need to adjust the gain settings depending 
on how the amplified signal appears once sample data is collected. Gain guidelines are included in the MP 
UNIT Input and Offset Range table on the next page. 

The software offers a variety of settings to amplify the raw analog signal up to 50,000 times. 
Select a Gain setting for a given channel from the pull-down menu next to Gain. 

Larger values are associated with higher gain settings, and thus greater amplification. 

The x100 Gain setting is range-limited and should not be selected unless absolutely required as the data will not 
operate under the full range in this mode and will be clipped.   

Some types of signals (such as EEG) typically need greater amplification than other types of signals (such as ECG 
or EMG), although ideal gain settings are best determined on a case-by-case basis. 

 Too small—Gain values that are too small for a given signal will result in data that typically appears as a 
“flat line” centered on 0. 

 Too large—Gain values that are too large for the input signal will result in data that is “clipped” or limited 
at either the extreme positive or negative levels. 

For the best resolution, establish Gain such that, allowing for baseline drift (if applicable) and the maximum peak-to-
peak of the signal, the maximum signal display is close to the maximum range. 

 Use the Range Guide (see page 638) as a visual aid to establish the proper Gain. If the signal is clipped, 
lower the Gain. If the signal is small compared to the range, increase the Gain to improve signal resolution. 

Offset 

To correct the offset of an incoming analog signal, you can add or subtract a constant to the signal prior to amplification. Offset 
can occur if a transducer or electrode has inherent offset, and is especially true of signals collected in DC mode (in AC coupled 
mode the Offset entry has no effect on the data). By default, Offset is set to zero, and the allowable entry range will vary 
depending on the Gain and Scaling values. The PRO uses the scale and units of the source channel for the offset units. Offset is 
limited from -10 mV to 10 mV and if you exceed the limits, values will be clipped to fit the range.  
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______________________________________________________________________________________________________ 

MP UNIT Input and Offset Range 
Gain Setting 

(X) 
Input Signal Range 

(+/- mV) 
Input Resolution 

(uV) 
Offset Range 

(+/- mV) 
Offset Resolution 

(uV) 
 MP36/35 

and MP45 
MP30 MP36/35

and MP45 
MP30 

(10 bit mode) 
MP36/35

and MP45 
MP30 MP36 

and MP45 
MP35 MP30 

(MP36/45 only) 5 200 N/A 61.0 N/A 100 N/A 8 N/A N/A 
10 1000 N/A 30.5 N/A 100 N/A 8 150 N/A 
20 500 N/A 15.3 N/A 100 N/A 8 150 N/A 
50 200 N/A 6.1 N/A 100 N/A 8 150 N/A 

100 100 70* 3.0 195 10 10 0.8 15 78.1 
200 50 50 1.5 97.7 10 10 0.8 15 78.1 
500 20 20 .61 39.1 10 10 0.8 15 78.1 

1000 10 10 .30 19.5 4 10 0.3 5.2 78.1 
2000 5 5 .15 9.77 4 10 0.3 5.2 78.1 
2500 N/A 4 N/A 7.81 N/A 10 N/A N/A 78.1 
5000 2 2 .06 3.91 4 10 0.3 5.2 78.1 

10,000 1 1 .03 1.95 4 10 0.3 5.2 78.1 
20,000 0.5 N/A .015 N/A 4 10 0.3 5.2 78.1 
25,000 N/A 0.4 N/A .781 N/A 10 N/A N/A 78.1 
50,000 0.2 0.2 .006 .391 4 10 0.3 5.2 78.1 

Notes *For MP30 only: This is a special case limit of the voltage range only for a gain of 100. 
  The actual range from unit to unit may vary by as much as 20%. 

To save as a Preset, change the Channel Preset name and then click the New Channel Preset button.  
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Calculation Channel Presets 

 

Calculation Channels are OFF by default. To turn a Calculation Channel on, click the  Presets button and make a 
selection from the menu. You must then check the Acquire box for each Calculation channel you want to compute (the Plot 
and Value boxes are optional). 

For any Calculation channel, you will (minimally) need to specify the source channel to be transformed and the nature of the 
transformation. 

To view or change the parameters specified for each Preset, click the  View/Change Parameters button in the Setup 
Channels dialog box to generate the corresponding Parameters dialog. The Preset specific settings are discussed on the 
following pages. 

IMPORTANT! 

Calculation Presets can only work in conjunction with Analog input 
presets, or with other calculation channels that are ultimately pointing 
to an Analog source channel. You must pay close attention to Source 
Channel and choose it carefully. 
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Calculation Preset: Integrate 

 
Integrate Calculation dialog  

Option 
The online Integrate calculation offers two basic operations: 

Average over samples Calculates the moving average (mean) of the specified number of samples. Additional 
parameters (Rectify; Root mean square) add further functionality. Used typically, these 
features allow you to process EMG signals and will display the integrated (rectified, then 
sample averaged) or Root mean square calculation on the original raw EMG data. 

 This option is useful for smoothing noisy data, real-time “integration” of EMG, 
real-time “root mean square” evaluation of EMG. 

 

Reset via channel Permits real-time integration of input data over a data-defined time interval. Perform a 
real-time integration over a potentially variable number of sample points. This feature is 
extremely useful for converting flow signals into volumetric equivalents. The integral of 
flow is volume. For example, when recording airflow with a pneumotach, volume can be 
precisely calculated as the flow varies in a cyclic fashion. 

 This option is useful for real-time conversion of flow signals into volume signals 
(Blood flow  Blood volume; Air flow  Air volume) and any processing involving 
a need for a cyclic, continuous integral calculated in real time (Acceleration  
Velocity; Velocity  Distance; Frequency  Number of cycles; Power  Energy). 
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Average over samples option 
Online sample averaging can be useful when there is a high degree of noise present in the data. At least some of this 
noise can be “averaged out” by pooling some number of adjacent data points together, taking the average of these 
points, and replacing the original values with the new averaged values. This process creates a “window” of moving 
averages that moves across the waveform smoothing the data.  

  
Integration used to smooth noisy data. Online “Average over samples” feature used as 

an envelope detector 
Since an average represents the sum of a series of data points divided by the number of data points present, you can 
use the Average over samples calculation to provide the information needed to create a moving average. When data 
is averaged in this way, a portion of the data at the beginning of the record (equivalent to the number of samples 
being integrated) should be ignored, as they will reflect a number of zero values being averaged in with the first few 
samples of data. 

Samples To specify the number of data points to average across, enter a value in the Samples box. 
The number you select will depend in large part on the sampling rate you select and the 
type of noise present. All things being equal, for slower sampling rates you will probably 
want to mean average across a smaller number of samples. As you increase the sampling 
rate, you will probably want to integrate across more and more samples. As the number of 
samples specified in the samples box increases, the amount of high frequency information 
contained in the data will decrease. 

 

Parameters Click in the box to the left of Parameters to enable the options, then choose an option: 

Rectify The Average over samples calculation can also be used for producing an envelope of 
modulated data. For instance, EMG waveforms frequently contain high frequency 
information, which is often of little interest compared to the low frequency information 
also contained in the data. When the Rectify option is checked, the PRO will take the 
absolute value of the input data prior to summing and a plot of the waveform’s mean 
envelope over a specified number of samples will be obtained. Typically, this option is 
only used for processing raw EMG and similar types of applications. 

Root mean square This feature provides the exact root mean square (RMS) of the input data (typically EMG) 
over the specified number of samples. 

Remove baseline This feature provides the exact standard deviation of the input data (typically EMG) over 
the specified number of samples. When the mean of the input data equals 0-0, the standard 
deviation and the RMS will be equivalent. 
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Reset via channel option 
This feature is used to integrate data over a data-dependent interval. Either the source channel or a different channel 
can control the integration process. 

 
 

Control channel: Allows the selection of any active channel as the control channel for the transformation. 

Reset Thresholds: The threshold is to be set at points surrounding the flow level. 

LOW is typically a negative value close to 0.00 

HIGH is typically a positive value close to 0.00 

In the case of airflow conversion to volume, the flow signal will vary positively and 
negatively around zero flow. 

Reset trigger: The Reset trigger polarity determines on which slope (Positive  or Negative ) the 
integration process will begin and end. 

Mean Subtraction: This option will subtract the mean from the data evaluated during the integration period. If 
this option is selected, the integration will only proceed after all the data in the integration 
period has been collected. When collected, the mean value of all the data is subtracted 
from each data point in the integration period. In this fashion, the integral of the corrected 
data points will result in the integral returning to exactly zero at the end of the integration 
interval. Although this option will result in “well-behaved” integrations, the integrated 
data will be delayed by a fixed amount of time, as specified by the max cycle period. 

Max cycle period: The max cycle period should be set to a value that is longer than the maximum time 
expected from trigger event to trigger event in the control data channel. 
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Integrate — formulas 

The Integrate formula is the same in the calculation (online, real-time) mode and the transformation (off-line, post-
processing) mode, and varies only based on the parameters selected. 

Note:  For the first points, value of index “i” will be less than or equal to zero; it means that for 
summation you have only values beginning with  1xf . 

For the first point for summation you have:  1xf ,  0xf ,  1xf . 

 1xf  and  0xf  - don’t  exist, so you have only  1xf . 

For the second point for summation you have:  0xf ,  1xf ,  2xf . 

 0xf  - doesn’t exist, so you have only  1xf +  2xf . 

Via samples, no extra parameters selected 

    xxfxF
j

sji
ij  



*
1

 

Where: 

i - index for source values (***the real range is 1..j); 

j - index for destination values (1..n); 

n - number of samples; 

ix , jx - values of points at horizontal axis; 

 ixf - values of points of a curve; 

 jxF - integrated values of points of a curve; 

s – number of samples to average across; 

1
1





n

xx
x n  - horizontal sample interval; 

1, xxn  - values at horizontal axis at the endpoints of selected area. 

  2. Via samples, rectify 

     xxfABSxF
j

sji
ij  



*
1

 

Where:           

i - index for source values (***the real range is 1..j); 

j - index for destination values (1..n); 

n - number of samples; 

ix , jx - values of points at horizontal axis; 

 ixf - values of points of a curve; 

 jxF - integrated values of points of a curve; 

s – number of samples to average across; 

1
1





n

xx
x n  - horizontal sample interval; 

1, xxn  - values at horizontal axis at the endpoints of selected area. 

 

Integrate formulas, continued… 
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Note:  For the first points, value of index “i” will be less than or equal to zero; it means that for 
summation you have only values beginning with  1xf . 

For the first point for summation you have:  1xf ,  0xf ,  1xf . 

 1xf  and  0xf  - don’t  exist, so you have only  1xf . 

For the second point for summation you have:  0xf ,  1xf ,  2xf . 

 0xf  - doesn’t exist, so you have only  1xf +  2xf . 

Via samples, root mean square 

 
  

1
1

2







s

xf

xF

j

sji
i

j  

Where: 

i - index for source values (***the real range is 1..j); 

j - index for destination values (1..n); 

n - number of samples; 

ix , jx - values of points at horizontal axis; 

 ixf - values of points of a curve; 

 jxF - integrated values of points of a curve; 

s – number of samples to average across. 

Via samples, root mean square, remove baseline 
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Where: 

i and m- indexes for source values (***the real range is 1..j); 

j - index for destination values (1..n); 

n - number of samples; 

ix , jx - values of points at horizontal axis; 

 ixf - values of points of a curve; 

 jxF - integrate values of points of a curve; 

s – number of samples to average across. 

k – coefficient : 

For the first few points that have index j < s  k=j, for the other points with j > =s    k=s 

 



Acquisition Functions 99 

 

INTEGRATE — EXAMPLE USING AIRFLOW/VOLUME RECORDING 
***This is a simplified example. For more complete details, see the Application Note. 

Click the MP UNIT menu and select Setup Channels. 

Use the Preset  pull-down menu to set a calculation channel to Integrate. 

Set the Source channel (Airflow). 

If necessary, adjust the Reset thresholds to suit the flow signal. 

Optionally, to avoid problems caused by a drifting airflow signal, select Mean Subtraction. (This will cause a delay 
in the display because Mean Subtraction requires a complete cycle to perform the mean subtraction). The Mean 
subtraction function will remove any offset on a breath-by-breath basis. 

The following graph shows an 
airflow signal with its 
corresponding volume: 
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Calculation Preset: Smoothing 

The Smoothing Calculation functions 
online and permits Median or Mean 
smoothing. (Smoothing can also be 
performed off-line using the smoothing 
option of the “Transform” menu). This 
function is very useful if you are trying to 
remove noise of varying types from a data 
set. 

 

Smoothing factor Enter the number of samples to use as a smoothing factor. 

Use Median value The default setting uses Mean value smoothing. Use Mean value smoothing when noise 
appears in a Gaussian distribution around the mean of the signal. 

Click in the box to activate Median value smoothing if some data points appear 
completely aberrant and seem to be “wild flyers” in the data set. 

 

Calculation Preset: Difference 

The Difference calculation returns the 
difference between two data samples over a 
specified number of intervals. The Difference 
Calculation is useful for calculating an 
approximation of the derivative of a data set in 
real time. 

The Difference Calculation dialog allows you 
to specify the source channel and the number 
of intervals between samples over which the 
difference is to be taken. 

 

Source When the Source channel contains relatively high frequency data, using the Difference 
Calculation may result in a very noisy response, so it’s best to use the Difference 
Calculation on relatively smooth data. 

Interval Difference is calculated with respect to the number of intervals between points (rather than 
the number of sample points). For instance, two sample intervals span three sample points: 

POINT<interval>POINT<interval>POINT 

If the Interval is “1” and the source and the output are displayed using Line 
Plot, then the difference plot will approximate a continuous derivative, 

shifted one point to the right. 
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Calculation Preset: Rate 

 
The Rate Calculation extracts information about the interval between a series of peaks in a waveform.  

Function The Function pop-up menu includes options to scale the rate in terms of Hz, BPM, Interval, Peak 
Time, Count Peaks, Peak Minimum/Maximum, Peak-to-Peak, Mean Value, or Area. See the 
table on page 6102 for an explanation of each Rate Function. 

Note: Parallel functions can be performed after data has been acquired. All of these Rate Function 
options are available in the post-acquisition mode through the Transform > Find rate function 
described on page 6237. 

Peak Detect For Rate Calculations involving data with positive peaks (such as the R-wave in ECG data), you 
will want to click the button next to “Positive” in the Peak Detect section. 

Remove 
baseline 

This will perform a hidden moving difference function on the waveform and is useful for tracing 
data that has a wandering or drifting baseline. 

Noise rejection Constructs an interval around the threshold level. The size of the interval is equal to the value in 
the % of peak box, which by default is equal to 5% of the peak-to-peak range. Checking this 
option helps prevent noise “spikes” from being counted as peaks. 

Auto Threshold 
detect 

 The most convenient way to calculate a Rate channel online is to use the PRO to automatically 
compute the threshold value (the “cutoff” value used to discern peaks from the baseline). This is 
done by checking the Auto Threshold detect box. 

Window These parameters define the range of expected values for the Rate calculation and are activated 
when “Auto threshold detect” is enabled. When the Rate calculation is set to automatic, you 
should also specify a minimum rate and a maximum rate. By default, these are set to 40 BPM on 
the low end and 180 BPM on the high end. The Rate Calculation will use these values to find 
and track the signal of interest, assuming the input BPM range is reasonably well bracketed by 
these values. Depending on the shape of the input cycle waveform, the Rate window settings 
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may be closer or further from the expected rates. 

Windowing Units are related to the selected “Function.” 

Rate Functions related to peak or peak time specify the unit after the Function. This is a fixed 
unit, so the Windowing Units menu will be disabled. 

 
Rate Functions related to data within a cycle can be specified in units of frequency (Hz) or time 
(BPM or seconds). The Windowing Units menu will be enabled,a nd when a unit is selected the 
software will convert the Min and Max settings to the selected units. 

 

See also: Application Note #142 for further information. 

 

Rate > Function Options 

The Function pull-down menu of the Rate dialog includes the following options: 

 

Area Computes the area of the signal between two peaks, on a cycle-by-cycle basis.  

Count peaks This peak counting function produces a plot of the number of peaks (on the vertical axis) vs. 
time (on the horizontal axis). When used with the delta measurements (in the measurement 
windows), this is a convenient way to calculate how many peaks occur within a selected area. 

Interval (sec) Returns the rate value scaled in terms of a time interval (sec), which is computed as the time 
difference (delta T) between the two peaks. This is sometimes referred to as the inter-beat 
interval or IBI. This measurement is perfectly correlated with the BPM calculation. 

Mean value Computes the mean of a pulsatile signal on a cycle-by-cycle basis between two peaks. It will 
also produce a staircase plot. 

Peak maximum 

Peak minimum 

Tracks the value of the peak. Peak maximum correlates to the systolic pressure in blood 
pressure readings (the ECG R-wave). 

Peak maximum locks the “Peak detect” option of the dialog to “Positive” and Peak 
minimum locks it to “Negative.” 

Peak to peak Determines the amplitude of a pulsatile signal. It looks at the vertical difference between the 
maximum and minimum values of the waveform on a cyclical basis.  

Peak time (sec) Returns the time (in seconds) at which the peak occurred. Like the other rate functions (e.g., 
BPM and Hz), the value of the last peak time will be plotted until a subsequent peak is 
detected. The resulting plot will resemble a monotonically increasing “staircase” plot. 

Rate (BPM) Equal to 60 times the frequency calculation, or 60/delta T. 

Rate (Hz) Returns the rate value scaled in terms in Hertz (Hz), which is computed by dividing 1 by delta 
T. This frequency measurement is perfectly correlated with the BPM calculation. 
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Rate Usage Guidelines 
1) One of the most frequent applications of the Rate Calculation is to compute BPM online for ECG, pulse, or 

respiration data. Waveform intervals can be scaled in terms of BPM (the default), frequency (Hz), or time 
interval between peaks. 

 The BPM (or beats-per-minute) Rate function is used as a measure of peaks or events that 
occur in a sixty-second period. 

 The frequency (Hz) Rate function is commonly used to describe the periodicity of data, or the 
amount of time it takes for data to complete a full cycle (from one peak to the next peak). 

 The Interval Rate function returns the raw time interval between each adjacent pair of peaks, 
which is essentially the inter-beat interval (IBI), frequently used in cardiology research. 

These three functions essentially provide the same information in different formats, since a frequency of 2 Hz is 
equal to an inter-peak interval of 0.5 seconds, both of which are equivalent to a BPM of 120. Other options allow 
you to record the maximum or minimum value of all peaks (the peak max/min option), or to count the aggregate 
number of peaks (the count peaks option). 

2)  Calculate systolic using the Peak Maximum Rate Function, diastolic using the Peak Minimum Rate Function, 
and mean blood pressure using the Mean Value Rate Function. 

3)  For ECG-type data (where the waveform peak is narrow with respect to the waveform period), the Rate window 
values will closely bracket the expected values. 

4) For more sinusoidal data, with the waveform energy distributed over the waveform period (as with blood 
pressure or respiration), the Rate window will closely bracket the expected rate on the high-end, but can be up 
to twice the actual measured rate at the low-end. 

5) Generally, it’s best to use the simplest Rate mode that is suitable for your application. If the simplest mode 
doesn’t work, add layers of sophistication one at time. For example, if the “Fixed threshold” mode can’t or will 
not work, use the “Auto threshold detect” mode. If the “Auto threshold detect mode” is similarly impaired, try 
adjusting the “Noise rejection” or adding the “Remove baseline” option (if selectable). 
 

Find Rate : Operational Mode Suggestions 

If the waveform data has Like Use 

Clearly defined positive or negative peaks that are 
consistently higher (in magnitude) than the rest of 
the waveform 

Respiratory 
or Air flow 
data 

Fixed threshold 

Clearly defined zero-crossing and you want to 
determine the rate of the crossings 

EMG Fixed threshold 

Wide, rounded peaks, but the peaks are otherwise 
larger in magnitude than other parts of the 
waveform and/or if the waveform data has a 
moving baseline 

Blood 
pressure 
signals 

Auto threshold detect 
*You may need to adjust the Noise 
rejection (Hysteresis) to optimize 
performance. 

 
High narrow peaks that may or may not be larger 
in magnitude than other parts of the waveform 
and/or if the waveform data has a moving baseline 

ECG Remove baseline and Auto threshold 
detect 
*You may need to adjust the Noise 
rejection (Hysteresis) to optimize 
performance. 
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6) The following stipulations dictate the Rate Detector options available: 

a) If the Remove baseline option is selected, the Auto threshold detect option is also selected. 

b) The Auto threshold detect feature can be used independently of the Remove baseline option. 

c)  The Noise rejection setting and the Window setting are automatically enabled when the Auto threshold 
detect option is selected. 

d)  The Remove baseline option is disabled when the following measurements are chosen: 
Peak-Peak, Peak Maximum, Peak Minimum, Area, and Mean. 

e)  The Auto threshold detect option creates a variable threshold for positive or negative peak detection, 
defined as follows: 

Positive peaks: (Peak max - Peak Min)(.75) 

Negative peaks: (Peak max – Peak Min)(.25) 
In addition, the Rate Detector will construct a moving average of data points defined by 1.5 times the number of 
samples that can be placed in the largest Window size (time). When the Rate detector loses sync (no threshold 
crossing inside the Window) the threshold is changed to the mean value of the moving average of data points. 
This operation permits successful recovery in the event of spurious waveform data values. 

f)  The Noise rejection setting  creates hysteresis around the variable 
threshold as follows: 

Hysteresis = Noise rejection (%)  (Peak Max – Peak Min) 
g)  The Remove baseline option combined with the Auto threshold detect option causes the Rate Detector to 

perform an automatic (and hidden) moving difference function on the waveform data: 

(0.025)(sampling rate) = Number of points over which the difference is performed 
The difference waveform is then processed as previously described under the Auto Threshold detect option. 

h) The sample rate must be greater than 40 samples/second for remove baseline and auto-threshold detect to 
function properly. 
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Calculation Preset: Math 

   
The Math Calculation performs standard arithmetic calculations using two waveforms or one waveform and a 
constant.  

Source To use a summed waveform as an input for another Math Calculation channel, select the 
calculation channel as a Source. The calculation channel used as a Source must have a 
lower channel number than the Math calculation channel. 

Operand Use the pull-down operand menu to select a math function. 

Operand Result  

+ Addition 

- Subtraction 

* Multiplication 

/ Division 

^ Power 

K (constant)  Enter a value to be used as the constant for the calculation. 

Scaling As an alternative to creating an additional Calculation channel for dividing the summed 
waveform, you can use the Scaling function to perform the same task. To do this, click 
Scaling… button and then set the Scale values for the summed waveform equal to +5 and 
-5 (to correspond to Input Volts values of +10 and -10 respectively). This will effectively 
plot the sum of channels A1 and A2 as the arithmetic mean of the two waveforms. 

See also… 

For additional libraries of online calculation options, consult the sections on Function Calculation and the online 
Expression Calculation. These types of calculation channels can be used to perform more complex operations on 
waveforms. Although calculation channels can be “chained” together to form complex calculations (wherein the 
output from one serves as the input for another), a separate channel must be used for each function. Additionally, 
chaining more than three or four channels together can require considerable system resources. 

For complex calculations (such as squaring a waveform then adding it to the average of two other waveforms) the 
Expression calculation is a more efficient solution (see page 6109). Also, all of the features available online in the 
Math Calculation channels can be computed after an acquisition using the Waveform Math option (see page 6220), 
which will eliminate the problem of system overload. 
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Calculation Preset: Function 

  
The Function calculation can be used to perform a variety of mathematical functions using two waveforms or a 
waveform and a constant. Function calculation channels compute new waveforms in a manner similar to the Math 
calculation, but provide access to higher order functions. Like Math calculations, Function calculations can be 
chained together to produce complex functions (such as taking the absolute value of a waveform on one channel and 
calculating the square root of the transformed waveform on another channel). 

Function Operation 

Abs Returns the absolute value of each data point 

ATan Computes the arc tangent of each data point 

Exp Takes the ex power of each data point 

Limit Limits or “clips” data values that fall outside specified boundaries 

Ln Computes the base e logarithm for each data point 

Log Returns the base 10 logarithm of each value 

Noise Creates a channel of random noise with a range of ± 1 Volt 

Sin Calculates the sine (in radians) of each data point 

Sqrt Takes the square root of each data point. 

Threshold Converts above an upper threshold to +1 while converting data below a lower 
threshold to -1. If the initial data lies between the upper threshold (UT) and the 
lower threshold (LT), the output is undefined. 
Note: Off-line Threshold values are +1 and 0 (see page 6207). 

 

See also… 

For post-acquisition operations, these functions are available under the Transform menu (page 6199). Function 
calculations can be chained together to produce complex calculations, but it is more efficient to program complex 
functions using the Expression calculation; many of these functions are also found in the online Expression 
calculation (see page 6109). 

Top: Signal + Noise 

Middle: P-P Noise > UT-LT 

Bottom: P-P Noise < UT-LT 
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Calculation Preset: Filter 

 
The Filter Calculation channel performs real-time digital filtering on Analog or Calculation 

channels.  

Output (filter 
options) 

The Output pull-down menu lists the four general types of filters: low pass, high pass, 
band pass and band stop. While the technical aspects of digital filtering can be quite 
complex, the principle behind these types of filters is relatively simple. Each of these 
filters allows you to set a cutoff point (for the low and high pass filters) or a range of 
frequencies (for the band pass and band stop filters). 

See filter table on next page. 

Freq This is the frequency cutoff or range (Low/High) for the selected filter type.  

Q The online filters are implemented as IIR (Infinite Impulse Response) filters, which have a 
variable Q coefficient. The Q value entered in the filter setup box determines the 
frequency response patterns of the filter. This value ranges from zero to infinity, and the 
“optimal” (critically damped) value is 0.707 for the Low pass and High pass filters, and 
5.000 for the Band pass and Band stop filters. If you wish, you may change the Q. A more 
detailed explanation of this parameter, and digital filters in general, can be found in 
Appendix D. 

In the dialog box above, the signal on analog channel one (CH1) is run through a Low Pass filter that attenuates data 
above 50 Hz. The “Q” for this filter is 0.707, which is the default. 

Note: One possible application of the online filtering option is in conjunction with the Show 
Input Values option (see page 6150). Raw EEG data, for instance, can be filtered into 
distinct bandwidths (alpha, theta, and so forth) using one source channel and multiple 
Filter calculation channels. The filtered data can then be displayed in a bar chart format 
during the acquisition using the Show Input Values option. 

See also… 

Digital filtering can also be performed after an acquisition using the same types of filters. You can choose from the 
different filter types by selecting Digital filters from the Transform menu. The filters available after the acquisition 
use a different algorithm but operate in essentially the same way. 

For more information on digital filters and filters that can be applied after an acquisition, turn to the Digital 
Filtering section on page 6201 or Appendix D. 
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FILTER 
Output Performance 

Low Pass Allows you to specify a frequency cutoff that will “pass” or retain all frequencies below this 
point, while attenuating data with frequencies above the cutoff point. 

High pass Retains only data with frequencies above the cutoff, and removes data that has a frequency 
below the specified cutoff (opposite of the Low Pass filter). 

Band pass (low 
+ high) 

Allows a variable range of data to pass through the filter. For this filter, you need to specify a 
low frequency cutoff as well as a high frequency cutoff. This defines a range or “band” of data 
that will pass through the filter. Frequencies outside this range are attenuated. The Band pass 
(low + high) is actually a combination of a low pass and a high pass filter, which emulate the 
behavior of a band pass filter. 
This type of filter is best suited for applications where a fairly broad range of data is to be 
passed through the filter. For example, this filter can be applied to EEG data in order to retain 
only a particular band of data, such as alpha wave activity. 

Band Pass Requires only a single frequency setting, which specifies the center frequency of the band to be 
passed through the filter. When this type of filter is selected, the “width” of the band is 
determined by the Q setting (previously discussed). Larger Q values result in narrower band 
widths, whereas smaller Q values are associated with a wider band of data that will be passed 
through the filter. This filter has a bandwidth equal to Fo/Q, so the bandwidth of this filter 
centered around 50 Hz (with the default Q=5) would be 10 Hz. 
This type of filter, although functionally equivalent to the band pass (low + high) filter, is most 
effective when passing a single frequency or narrow band of data, and to attenuate data around 
this center frequency. 

Band Stop Defines a range (or band) of data and attenuates data within that band (opposite of the Band 
Pass filter). A center frequency is defined and the Q value determines the width of the band of 
frequencies that will be attenuated. 

Band Stop – 
Line Freq 

Defines a band stop at 50 Hz or 60 Hz, based on the line frequency selected during installation. 
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Calculation Preset: Expression 

  
The online Expression evaluator can be used to perform complex computations that cannot be managed with the 
Math or Function calculations. The Expression evaluator uses standard mathematical notation and will symbolically 
evaluate complex equations involving multiple channels and multiple operations. 

Unlike the Math and Function Calculations—which can only operate on one or two channels at a time—the 
Expression calculation can combine data from multiple analog channels and allows you to specify other calculation 
channels as input channels for an Expression. Computations performed by the Expression evaluator eliminate the 
need for “chaining” multiple channels together to produce a single output channel. For example, you can square one 
channel, multiply it by the sum of two other channels, and divide the product by the absolute value of another 
waveform on a single Expression Calculation channel, which is more efficient than chaining five Math and Function 
Calculation channels together. 

While the Expression evaluator is more powerful than other Calculation channels, each Expression Calculation 
requires more system resources than other Calculation channels do. This essentially means that acquisitions that 
utilize Expression Calculations are limited to a lower maximum sampling rate than acquisitions without Expression 
calculations. 

For each expression, you need to specify at least one Source, the Function(s) to be performed, and any Operators to 
be used. Make a selection from the pull-down options or type directly into the Expression box. 

To measure skin resistance (SCR) using the SS3LA transducer, use an Expression calculation channel to take the 
reciprocal of conductance and then apply proper scaling. 

 

Note:  It is important to keep in mind that while different channels, functions, and operators can be 
referenced, this Expression Calculation cannot reference past or future sample points. That is, 
data from waveform one can be transformed or combined in some way with data from waveform 
two at the same point in time, but data from one point in time (on any channel) cannot be 
combined with data from another point in time (on any channel). See the section on post-
acquisition Expression commands (beginning on page 6218) for ways around this limitation.  
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Source Sources are typically analog channels, but you may select Time or Segment 
Timer from the Source menu to return the Time value (in seconds) of the 
horizontal axis. Time returns a cumulative value, whereas Segment Timer will 
reset to zero at the start of each consecutive appended segment. 

Function The Expression calculation offers the following functions: 

 Function Expression result 

 ABS Returns the absolute value of each data point. 

 ACOS Computes the arc cosine of each data point in radians. 

 ASIN Calculates the arc sine of each value in radians. 

 ATAN Computes the arc tangent of each sample point. 

 COS Returns the cosine of each data point. 

 COSH Computes the hyperbolic cosine of each selected value. 

 EXP Takes the ex power of each data point. 

 LOG Computes the natural logarithm of each value. 

 LOG10 Returns the base 10 logarithm of each value. 

 ROUND Rounds each sample point the number of digits specified in the 
parentheses. 

 SIN Calculates the sine (in radians) of each data point. 

 SINH Computes the hyperbolic sine for each sample point. 

 SQR Squares each data point. 

 SQRT Takes the square root of each data point. 

 TAN Computes the tangent of each sample point. 

 TANH Calculates the hyperbolic tangent of each sample point. 

 TRUNC Truncates each sample point the number of digits specified in the 
parentheses. 

Operator The following operators are available in the Expression dialog: 

 Operator Operation 

 + Addition 

 - Subtraction  

 * Multiplication 

 / Division 

 ^ Power 

 ( Open parentheses 

 ) Close parentheses 

See also… 

The same features that are available in online Expression calculation are also available under the Transform menu 
for evaluation of complex equations after acquisition. Also, simple calculations such as summing two channels or 
dividing one channel by another (and so forth) are best performed in either the Math calculation channels or the 
Function calculation channels. 
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Calculation Preset: Delay 

  
Delay allows you to use a calculation channel to plot another channel lagged (delayed) by an arbitrary interval. In 
the graph shown above, the Delay channel contains a 0.25-second interval of zeros at the beginning of data file. 

When a Delay channel is recorded, there is a segment at the beginning of the channel (equal to the value of the 
delay) that will read as 0 Volts. This is normal and occurs because the Delay channel is waiting to “catch up” with 
the original signal. The PRO fills this buffer with zeros until the Delay channel begins to plot actual data. 

Delay plots are useful for producing nonlinear (“chaos”) plots in X/Y display mode (see page 641).  

Delay  The Delay interval can be specified either in terms of samples or 
seconds and cannot exceed the acquisition length. 

 If the Delay entry exceeds the acquisition length, an error prompt 
will be generated. To correct the error, decrease the Delay value or increase 
the Acquisition Length entry under MP UNIT > Setup Acquisition.  

 

Setup Note Delay Calculation Channels run in series of two or more may not work properly in Save to Disk 
mode. The delay cannot exceed the maximum amount of the internal disk buffers, which is fixed to 8,192 samples. 
At sample rates of 5,000 s/s or above, the second of two Delay channels will not initiate at the desired delay rate. 
Work-around options are to select a Sample Rate below 5,000 for this type setup or set the acquisition mode to Save 
or Append to Memory.  

 

 TIP Although there is not a parallel function in post-processing mode, the same effect can be 
obtained by selecting a section of one waveform equal to the desired delay interval and 
choosing the Edit > Cut function or the Edit > Clear command to remove a section of the 
waveform. 

 

Calculation Preset: Control 
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The Control function is used to output a digital pulse when the value for a specified input channel exceeds a certain 
level, falls inside a given range, or falls outside a given range. This feature is unique in that the output is on a digital 
channel (which ranges from I/O 1 through I/O 8) rather than a Calculation channel. Also, unlike other Calculation 
channels, this Control Calculation can only be performed in real time (i.e., while data is being acquired) and cannot 
be performed in post acquisition mode.  

In addition to outputting a signal on a digital channel, the Control Calculation will also plot an analog version of the 
digital signal on the Calculation channel you specify. For instance, in the example below, Calculation channel C0 is 
used to perform a control function using analog channel 1 (C1) as an input and digital channel 0 (D1) as an output. 
In addition to outputting a pulse on D1, the setup below will also produce a plot on channel 40 (the first Calculation 
channel) that emulates the signal being output on digital channel 1. Since Calculations are analog channels, the 
Calculation channel does not contain a “true” digital signal, but is a reasonably good approximation. The calculation 
channel values are not guaranteed to precisely match the actual digital output. 

To have BSL PRO apply a Control Calculation in real time: 

1. Choose MP3x > Set Up Channels. 

2. Click the Calculation tab. 

3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 
check the Plot and Values boxes as appropriate for each channel. 

4. Click the Preset pull-down menu and select Control. 

5. Click the Setup button in the Input Channels dialog to generate the Control dialog. 

 

There are four parameters that need to be specified for each Control channel: 

a) Source channel   c) Type of threshold function 

b) Output channel   d) Threshold level values 

“Source” refers to the input channel to be used for the Control function. As with other Calculation channels, the 
Control function can use either an analog channel or another (lower) Calculation channel as an input. In the previous 
example, analog channel 1 (C1) is used as the input channel. It is not possible to use a digital channel as an input 
channel for a Control Calculation. 

The channel selected in the Output Channel section determines which digital channel the pulse will be sent to. 

The digital channels range from 1 to 8 (D1 through D8) and external devices can be connected to the MP36/35 
unit’s I/O port as described in BSL Hardware Guide. In the sample dialog shown, the digital pulse is sent over I/O 
line D5. 
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Digital channels have two levels, 0 Volts and +5 Volts. When the signal transits from 0 Volts to 5 Volts, an “edge” 
is created and since the signal is going from low to high, this is referred to as a positive edge. Similarly, as the signal 
transits back from 5 Volts to 0, a negative edge is created. These transitions or edges can be used to trigger external 
devices when an analog signal level meets certain threshold criteria. The Threshold Function option sets the criteria 
for the Control channel. You can specify threshold conditions such that the digital I/O line goes to +5 Volts when 
the conditions are met, or you can program the digital line to go to 0 Volts when the threshold conditions are met. 
Threshold conditions can be set so that either (a) the digital line is switched when the value of an analog channel 
exceeds a specified value or (b) the digital line is switched when an analog channel falls within a given range. BSL 
PRO also allows you to create a single level threshold or a “wide” threshold. 

 Tip  To use test conditions more complicated than simple thresholding, combine the conditional tests of 
Expression calculations with the Control channel to change digital output based on the Expression 
result. 

For example, suppose you want to set a Control channel to switch digital line 5 from low to high whenever the 
signal for Calculation channel one (C1) exceeds 85 BPM. Set the source channel to C1 and the output to D5. Select 
the upper left graph in the control dialog and set L2 and L1 to 85, as shown: 
 

   
 Control dialog and graph showing result of BPM control example 

As illustrated in the preceding graph, there are a number of instances where C0 (heart rate) exceeds 85, usually for a 
short period of time. When it does drop below 85, it appears to return to a value greater than 85 within a second or 
two. In instances such as this, it might be useful to “widen” the threshold so that the digital line is triggered 
whenever the input value is greater than 85, but the signal must drop significantly below the threshold value before 
the threshold is reset. 

As another example, the upper threshold value (L2) is set to 85 and the lower threshold (L1) is set to 83, which 
means that the threshold will not reset until the signal from the source channel drops below 83. In the following 
example, the digital line is switched from low to high (from zero to +5 Volts) when the heart rate channel exceeds 
85, and stays at +5 Volts for several seconds even though the source channel drops below 85 (but above 83). The 
digital line does not switch back to zero until the heart rate channel drops below 83 (toward the end of the record). 
Once this occurs, the threshold is reset and the digital line will switch again the next time the source channel exceeds 
85 BPM. 



114  Part C 

Visit the online support center at www.biopac.com 

  
 Control dialog and graph showing control channel with “wide” threshold 

It is also possible to have the digital line switch when the source channel drops below a certain value. In the example 
below, a simple threshold is used to switch the digital line high each time the source channel drops below 50 BPM. 
Since L2 and L1 are set to the same value, this is not a “wide” threshold (as above) and the threshold resets each 
time the source channel goes above 50 BPM. 

  
Control dialog and graph showing control channel detecting source channel levels less than 50 BPM 

 

These examples are only a few of the possible applications of the control channel using the two threshold icons on 
the left-hand side of the Control Setup dialog. You can construct variations of these (i.e., switching the digital line 
from low to high using a wide threshold whenever the source channel drops below a given channel) that are not 
discussed above. Moreover, each of the options can be construed somewhat differently than they have been 
presented here. For example, the previous example switches the digital line from low to high each time the signal on 
the source channel drops below 50 BPM. Conversely, it also switches from high to low each time the source channel 
value is greater than 50 BPM. This allows you to vary the default setting for the digital channels (whether the default 
is zero or +5 Volts) depending on what types of devices are connected. 

In addition to setting “above and below” type thresholds, you can program the Control channel such that the digital 
line is switched whenever the source channel falls within a given range or outside a specified range. In the example 
that follows, digital line 15 is set to switch from zero to +5 Volts whenever the source channel signal falls between 
the values entered in the L1 and L2 boxes. In this case, I/O is switched to +5 Volts whenever the heart rate is greater 
than 60 BPM but less than 80 BPM. 
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Control dialog and graph showing control channel switching from low to high when source channel is between 60 

BPM and 80 BPM 

You can also program the digital line to switch from high to low when the signal on the source channel falls within a 
given range. This is equivalent to setting the digital line to shift from low to high when the source channel values 
fall outside a given range (as shown below). 

  
Control dialog and graph showing control channel switching from high to low when source channel is between 60 

BPM and 80 BPM 

 

Calculation Preset: Rescale 
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Rescale applies two-point linear mapping and allows users to change the measurement units (for example, to change 
temperature from Celsius to Fahrenheit). The text corresponding to the new units can be manually entered. 

To have BSL PRO apply a Rescale Calculation in real time: 

1. Choose MP3x > Set Up Channels. 
2. Click the Calculation tab. 
3. Check an Acquire box for the Calculation channel you want to contain the filtered data. You may also 

check the Plot and Values boxes as appropriate for each channel. 
4. Click the Preset pull-down menu and select Rescale. 
5. Click the Setup button in the Input Channels dialog to generate the Rescale dialog. 

 Use the Rescale transformation (post-acquisition) to adjust forgotten calibration of analog channels or 
reverse incorrect calibrations. 

The rescale formula is: 

 
Rescale Source  Displays the label and number of the selected channel. 

Old Units  Displays the values of the current vertical units of the channel 

New Units  Allows for manual entry of the new units to be used. The new units will be displayed in the 
vertical units of the channel 

 

Note  When rescaling only a selected area of the waveform, the manual entry of new 

units is not available unless “Transform entire wave” is checked since it is not 

possible to display different units for different time ranges in the same channel. 
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Chapter 8 Output Control — MP Menu 

MP36 Hardware     MP 35 hardware  

 

 

The MP UNIT can output pulses or analog voltages via the Analog Out port; this port is also used to connect to 
BIOPAC’s external stimulators. The MP35 has an additional I/O Port which is used to output digital (TTL Level) 
signals. 

Parameters for output signals are set via Output Control. Access to a specific Output Control is via the 
MP35>Output Control submenu. 

There are seven Output Controls for the MP36, eight for the MP35A, seven for the MP35, four for the MP30, and 
two for the MP45: 

Output Control See… MP36/35 Functionality MP30 Functionality MP45 Functionality 

CH# to Output page 6119 Direct analog CH1-4 to output 

listen to signals 

Direct analog CH3 to 
output 

Direct analog CH1-2 
to output 

listen to signals 

Digital Outputs page 119 Control 8 digital outputs Not available Not available 

Voltage page 121 Output Voltage Level (0 – 4 V 
DC) Not available in MP36 

Output Voltage Level 
(0 – 5 V DC) 

Not available 

Pulses page 6115 Use with third-party devices; 
software can control pulse 
width and repetition. 

Use with third-party 
devices; software can 
control pulse width and 
repetition. 

Not available 

Stimulator - 
BSLSTM 

page 122 Use with BSL Stimulator Use with BSL 
Stimulator 

Not available 

Low Voltage 
Stimulator  

Stimulator – SS58L 

page 122 Use with MP36 Analog Out 
port or MP35 with SS58L 
Low Voltage Stimulator; 
software can control pulse 
amplitude, width and 
repetition (-10 to +10 V) 

Not available Not available 

Pulse Sequence Page 123 Available in MP35A & MP36 
only. Direct analog CH1-4 
output. Allows for output of 
customized pulse trains. 

Not available Not available 

Sound Sequence Page 126 Outputs customized sounds 
assignable to a user 
configurable pulse train. 

Available Available 

To open an Output Control, select it from the MP UNIT > Output Control submenu. A checkmark appears next to 
the submenu selection and an Output Control panel is displayed, bordered in red beneath the BSL PRO Toolbar in 
the active data window. To close an Output Control, select from the menu again (toggles between display and hide) 
or right-click in the open control panel and choose Close. 

Only one Output Control panel may be open at any time. Switching between different data files can change the 
display and operation of the control panel. 

Because some output devices can be used for stimulation on humans and can achieve voltages up to 
100 Volts, built-in software logic makes output control as safe as possible. 

See page 6141 for safety notes regarding human subjects. 
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The following applies to all Output Controls. 

The output will not operate unless its software control panel is open. 

When an Output Control panel is closed, or the BSL PRO application is closed, MP36/35 output goes to 0 Volts, 
preventing the output device from sending pulses. 

When an Output Control panel is opened, output is always OFF until activated by a click of the ON/OFF switch in 
the control panel or, if parameters allow, a click of the Start button in the data acquisition window. (Exceptions are 
the Voltage Output Control, which outputs immediately, and the Digital Outputs Control when set to the preference 
“Set each output immediately.”) 

Output preference parameters are local and are saved with the data file or a graph template file. The data or template 
file holds the output parameters as established when the file was saved. (See “Save as Graph Template,” page 6182.) 
Switching between other open graphs can change the display and operation of the control panel since the settings in 
each graph are independent entities. 

Controlling Output Signals 
Use both the Output Control panel and its respective Preferences dialog to control the output signal. Output Control 
Preferences  dialogs establish the parameters for output. Preferences dialogs are only available when the 
corresponding Output Control panel is open and active. Voltage does not have Preferences, and on the MP30 only, 
CH3 to Output does not have Preferences. 

To generate the Preferences dialog, either: 

Open an Output Control panel and then right-click anywhere in it to 
generate a pop-up menu. Choose Preferences to open the dialog (Close 
will close the control panel). 

 or  

Open an Output Control panel 
and then choose 
File>Preferences and select 
from the submenu to open the 
dialog. 

 

If a control panel entry box is grayed or disabled, its values may be established, or limited, by settings in 
the Preferences dialog. If Preferences parameters allow, enter values directly in the Output Control 
panel. 

   
Key into the entry boxes and then enter the value by pressing the Enter key. 

Use the Tab key or mouse to move to another entry box. 

Click the OK button if in the preference dialog. 

Values entered into a control panel or its Preferences dialog that are outside the specifications of the 
output device, or outside the limits defined by the Preferences dialog, may change automatically to reflect 
either the closest value to that requested that the the hardware can achieve, or the closest increment 
defined by the limits in Preferences. (The system will not check while you type, it checks and may make 
changes after the value is entered.) 

For example, if a Pulse width of 5 ms is entered into the Pulses Output Control panel entry box, but 
Preferences defines a range limit of .5 to 2 ms for Pulse width, the system will automatically change the 
new entry to 2 ms.  

Saving Panel settings: 

Output Control panel settings will be retained until a file is closed or saved. If a file is closed but not 
saved, settings will be lost (defaults established); if a file is saved, panel settings will be saved.
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CH# to Output Output Control 

 
The CH# to Output Output Control redirects an analog input signal to the Analog Out port on the back of the MP 
UNIT. The signal from the assigned channel will continue to be recorded and plotted as it normally would. This 
Output Control is used mainly when attaching headphones to the MP UNIT to listen to signals coming in on an 
analog input channel. One common use is listening to the EMG (muscle) signal, a clinical procedure physicians use 
to actually hear certain problems with muscles. 

To display this control panel: 

Choose MP UNIT>Output Control>CH# to Output to open the control panel. 

MP36/35 users may use analog input CH1-CH4. Channel 3 is the default setting. If another channel N has been 
designated, the menu will read “CH<N>.” 

MP30 users must use CH3. 

MP45 users may use analog input CH1 or CH2. 

Use the control panel ON/OFF Switch to start and stop output. OFF grounds the output so no signal (or sound) 
should be present. 

MP45 users—The ON button can be pressed at any time, however sound will only be heard during acquisitions.  
The button will remain ON until it is manually turned OFF or until the control panel (or file) is closed. 

Preferences 

Set Preferences to designate which channel to redirect to output. 

MP36/35 users—Open the Preferences dialog (right-click in the control panel 
or choose File > Preferences > CH# to Output). 

Use the pull-down menu to select the desired channel CH 1-4 to use for the 
output. 

Click OK to set the output channel and return to the control panel. 

MP30 users: The Preferences option is disabled because you may only redirect Channel 3 to output. When 
outputting the signal, you may want to set the low pass hardware filter to 5 kHz rather than 1 kHz (see page 689) to 
allow higher frequency output. 

MP45 users—Access Preferences via the right-click contextual menu when the cursor is over the control panel. The 
options are CH 1 (default) or CH 2. 

 

Note Only the Hardware settings (Gain, Offset, Input Coupling) from the Input Channel Parameters dialog (MP 
UNIT > Set up Channels > Wrench) will be applied since output is established prior to the processing of Digital 
Filters.  

 

See page 6289 for MP UNIT Input > Output Scaling values. 
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Digital Outputs Control — MP36/35 only 

 
 

MP30 Users: The Digital Outputs Control panel is not available when using an MP30. 

The Digital Outputs Control allows control of signal output on each of eight digital lines via the I/O Port connector 
on the back of the MP36/35. Use it to control external devices. The digital output uses stardard TTL levels which 
correspond to the control panel setting as follows:  

Control Panel setting   Output Voltage level (Volts) 

0 0 

1 +5 

To display this control panel: 

Choose MP36/35>Output Control>Digital Outputs to open the Digital Outputs Control panel 

Click each digital output line to set its digital state to 0 (off) or 1 (on). 

If desired, you may set Preferences for Digital Outputs. 

Open the Preferences dialog (right-click in the control panel or 
choose File>Preferences>Digital Outputs). 

Select from the following two options: 

Set each output immediately (default) allows you to toggle the 
state of each digital output line between 0 and 1, and change the 
state immediately. In this mode, no Set button is available in the 
control panel. Output for each line is set upon clicking its toggle 
button. 

Set all outputs when Set button is pressed allows you to toggle the state of each digital output line, but the states 
will not physically be changed until the Set button is clicked on the control panel. In this mode, a Set button is 
available in the control panel. When the Set button is clicked, all eight digital lines will update simultaneously. 

Click OK to set Preferences and return to the control panel. 
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Voltage Output Control 

 
The Voltage Output Control is used to output a voltage level (DC voltage) via the Analog Out port on the back of 
the MP35 to control another piece of equipment. 

To use this control panel: 

Choose MP35>Output Control>Voltage to open the Voltage Output Control panel. 

Enter a value manually, or use the scroll or arrow buttons to increase or decrease values. 

When using the scroll box, a change will not occur on the output until the mouse button is released. 

The display shows the value that is to be output. If an entry exceeds the voltage range limits of the MP Acquisition 
Unit, the value automatically rounds to the nearest obtainable value. 

MP Voltage Output 

 MP35 MP30 

Range 0 - 4.096 Volts 0 - 5 Volts 

Resolution  1 mVolt 19.5 mVolts 

There are no Preferences for the Voltage Output Control. 

When multiple graph windows are open, Voltage Output stops (goes to 0 Volts) if the graphs are switched 
and the new active graph contains its own Output Control panel. When the graph containing the Voltage 
Output Control panel is made active again, Voltage Output goes back to the previously set level.  
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Pulses Output Control 

Stimulator – BSLSTM Output Control 

Stimulator – Low Voltage Output Control 

Control panel options for Pulses, Stimulator – BSLSTM and Stimulator – Low Voltage  

 
Additional control panel options for Low Voltage Stimulator 

The BSL PRO System offers a variety of pulse ouput options. Exercise caution when using any of the options with 
human subjects—see the Safety Note on page 6141. 

Pulses Output Control 

Select this Output Control for general pulse output, or when synchronizing to 3rd-party devices. 

Use for reaction time measurements, where a subject listens with headphones for a series of “clicks” (pulses) and 
responds as quickly as possible with a button press. Determine reaction times by calculating the time between the 
start of the pulses and the responses. 

Use with the BIOPAC STP30W Stimulus Presentation System (SuperLab) to measure responses to visual or 
auditory stimuli. To perform sophisticated evoked response averaging tests (e.g. P300), pair triggers with different 
visual or auditory stimuli. 

Use to trigger another device (automatically send a pulse from the MP UNIT when acquisition starts). 

Use to control a 3rd-party stimulator. BIOPAC recommends use of the BIOPAC BSLSTM Stimulator with the MP 
UNIT and BSL PRO software. If using the BSLSTM Stimulator, use the Stimulator - BSLSTM Output Control 
instead of this Pulses Output Control. 

Stimulator – BSLSTM 

Select this Output Control when using the Biopac Student Lab stimulator 
(BSLSTM) 

Use with stimulation electrode HSTM01 for safe stimulation of 
human subjects (0 – 100 Volts), as well as lower voltage (0 - +10 
Volt) general-purpose stimulation, such is used with amphibian 
muscle or nerve preparations. 
 

Set up note Placing the BSLSTMA/B unit too close to MP UNIT hardware can result in data distortion 
of the BSLSTMA/B pulse width signal; distortion is more apparent at higher sampling rates. 

 NEVER set the BSLSTMA/B atop an MP UNIT 
 Position the BSLSTMA/B away from the MP UNIT to reduce the signal distortion 

Low Voltage Stimulator  

Select this Output Control for low-voltage (-10 - +10 Volt), direct drive 
stimulation via MP36 Analog Out port (with or without OUT3 BNC 
adapter) or an MP35 with SS58L connector. 

Use with stimulator electrode HSTM01for safe, stimulation of human 
subjects (0 – 100 Volts), as well as lower voltage (0 - +10 Volt) general-
purpose stimulation, such is used with amphibian muscle or nerve 
preparations. 

 Outputs through a BNC connector so it can be used  
with most stimulation cables (such as those that  
terminate in a needle probe). 
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To use one of these control panels: 

Choose MP UNIT > Output Control and then select Pulses, Stimulator – BSLSTM, or Low Voltage Stimulator. 
Control panel options for Pulses, Stimulator – BSLSTM and Stimulator – Low Voltage  

 
Additional control panel options for Low Voltage Stimulator 

 
 

Right-click in the Output Control panel (or choose File>Preferences and select from the sub-menu) to 
generate the Output Preferences dialog. 

 
Set the Preferences. 

General: ON/OFF, Number of pulses, Marker options — see page 6131 

Advanced: Pulse width, Pulse repetition (rate) — see page 7134 

Level (low voltage only): Pulse level — see page 7137 

Reference Channel (low volatge only): Channel assignment, signal generation — see page 7139 

Once configured, Preferences may be saved using the Save Settings command, activated by pressing the 
button at the bottom of the Preferences dialog (see page 7129). 

Confirm the settings in the control panel. Adjust as desired within the parameters established in 
Preferences. 

Entry limits: Settings entered into the Preferences dialog may establish, or limit, the values in the Output 
Control panel entry boxes. You may enter pulse settings directly into the control panel only if parameters 
established in Stimulator Preferences allow. If an entry box is grayed or disabled, its value is set or 
limited by Preferences. 

Initiate the pulse sequence as defined in Preferences (see page 7131). 

 ON/OFF Button in Output Control Panel uses the switch in the Control panel. 

 Recording uses the Start /Stop button in the data acquisition window. 

 

To close an Output Control panel: 

Right-click anywhere in the Ouput Control panel to generate a pop-up menu and then choose Close, or select it (or 
another output control) from the MP UNIT > Output Control submenu. 

 
 

Pulse Sequence Output Control (Available in MP36 & MP35A hardware only) 

This Ouput Control allows sequences of pulse configurations and delays to be sent to the MP36/35A unit, making it 
possible to create more complex stimulus setups. 
 
Enabling the pulse sequence output control option will display the following control panel at the top of the graph 
window: 
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Pulse sequence configuration is performed in the Preferences dialog of this output control panel. (Accessible via 
right-click on panel shown above or from FilePreferences) When a pulse train element is selected in the 
configuration, the controls will become visible in the right hand portion of the preferences dialog. The configuration 
makes use of three basic building blocks: 
 
A sequence consisting of a number of delay and pulse train elements. The final configuration consists of one or 
more sequences that are outputted in order. Normally the entire configuration is outputted. There is a special 
operational mode on ‘Start with Recording’ that will take only the indexed sequence matching the current recording 
segment. 
 
A pulse train element consisting of a fixed number of pulses of identical width output at a 
fixed pulse frequency. 
 
A delay element that allows for the introduction of time during which no pulses will be 
generated. 
 
Each one of these building blocks also has a “repeat” count associated with it that will perform the action a set 
number of times. (Adjust by selecting the desired ‘Repeat’ and inputting a new value) Individual sequences, pulse 
trains and delays can be added, repeated and reordered as desired. In the right pane of the Preference dialog (shown 
below), fixed or random pulse counts, widths and repetitions can be configured and combined. As in other Output 
Controls, custom settings can be saved and organized in a list view. (See below for additional setup dialogs)  
 
For a full explanation of preferences and tabs common to all Output Control panels, see the “Output Control” 
section on page 129.  
 

 
 Preferences available in Pulse Sequence tab 
 



Acquisition Functions 125 

 
Preferences available in Options tab 

 

 
Delay Preferences 
 

About Delay between Pulse Trains: 

The amount of actual Delay between pulse trains will vary from the set value depending upon the pulse 
repetition value that is used. In the example sequence below, a Delay of 100 milliseconds between pulse 
trains has been set up, combined with a pulse repetition rate of 20 milliseconds. Because the pulse 
repetition rate is applied before the Delay occurs, the actual Delay between pulse trains in this case will 
be 120 milliseconds. If it is critical that a Delay reflect an exact value, it is advisable to subtract the 
selected pulse repetition value when setting up the Delay parameters. 
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 Delay between pulse trains 

129 

Sound Sequence Output Control 

This Output Control offers users the option of configuring and customizing sounds to be outputted for aural stimulus 
experiments. The control panel and Preferences dialogs used for Sound Sequence closely resemble that of Pulse 
Sequence. The built-in sound resource (a default “click”) may be used or any other file in *.WAV format can be 
substituted via the “File”and “Browse” button. The “Width” and “Pulse Repetition” values are dependent upon the 
duration of the sound file selected for output. The “Test” button will ouput an audio sample of the selected sound 
resource. 
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The option all sequences means that each configured sound sequence (regardless of number) will be outputted 
within the same segment. If "Once" is selected in the "Output entire pulse sequence" option, a configured sequence 
will be heard one time only. If "Continuously" is selected, the first Sound Sequence will be repeated after the last 
one has completed, looping the pattern repeatedly until the recording is stopped. 

 

The option each sequence means that each sound sequence will be outputted on a segment-by segment-basis only. 
For example, if one Sound Sequence is configured, it will only be heard during the first recording segment, but not 
during the second recording segment). If two Sound Sequences are set up, the first one will be heard during the first 
segment and the second one during the following segment.. If no additional Sound Sequences have been configured, 
nothing will be heard during the third segments and beyond. (Exception: If "Save Once" acquisition mode is used, 
the Sound Sequence will be repeated when the recording is overwritten during subsequent passes). 

 

The following terms are used in the Output Control panels, Preferences, and guidelines for Pulses, 
Stimulator – BSLSTM and Low Voltage Stimulator. 

 

Delay before first Pulse Initial delay from start of acquisition to start of first pulse. 



128  Part C 

Visit the online support center at www.biopac.com 

Number of pulses Number of successive pulses that will be sent out at the specified Pulse Width, Repetition and 
Level. Set for Single (1), Multiple, or Continuous (Cont). 

Pulse Level Amplitude of the pulse, expressed in Volts. 

Note: The output of the BSLSTM is 0 Volts when the pulse is not active. 

Pulse Repetition 

Also called — 
Events per second Pulse 
frequency Pulse 
sequence  
Pulse train 
Repetition rate Sample 
train 

Can be expressed as Period (ms) or Rate (Hz). 

Period: Time between pulses; measured in milliseconds from the start of one pulse to the 
start of the next pulse. 

Rate: Number of pulses that occur in a one-second interval; measured in Hertz. 

Rate relates to Period as: Rate (Hz) = 1000 / Period (ms) 

Pulse Width Time that the pulse is in the non-zero or active state. 
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Output Control 
The Output Control panels for Pulses, Stimulator – BSLSTM and Low Voltage Stimulator work in conjunction with 
Preferences to control pulse output. Control panel functions are detailed here: 

OUTPUT CONTROL PANELS 

General Notes Pulse parameters can interact with each other. 

For example, the pulse repetition period cannot be set to a value less than the pulse width. 

In order to simplify the interaction, the Pulse width entry overrides other entries as 
required; it is the priority parameter. 

For example, if the pulse width is changed such that it exceeds the pulse repetition period, the 
pulse repetition period will be automatically adjusted to accomidate the new pulse width 
entry.  If, however, the pulse repetition period is changed such that it is less than the 
pulse width, the repetition period will be changed, upon attempted entry,  to the closest 
value that can be achieved without changing the pulse width.  

Entries are checked and rounded (not truncated) as necessary to meet limitations of 
the hardware or the Preferences. 

When a file is opened, the output device will not turn ON automatically. A user must 
manually press either the “Record” button or the “Start” button. 

The exceptions are the “Voltage Output” control panel and the “Digital Outputs” control 
panel if “Set each Output immediately” is selected; these settings will output values 
immediately. 

Output control settings are “local,” which means that they are stored at the data file 
level, not the program level. Use the save as graph template (File > Save As) option 
to use existing Preferences in new data files. 

If a file is saved with an Output Control panel visible and then closed, the panel will 
be visible when that file is re-opened. 

Preferences Right-click a control panel to generate the Preferences dialog, and then select a tab 
for the settings you want to adjust. 

 
You can also use the File>Preferences menu option to generate the Preferences 
dialog. 

Output Settings 

 

 

Displays the name of the current Preferences setting. The pull-down menu lists the 
names of all output Preferences saved using the Save Settings button (see page 
7129). The pull-down menu is not accessible when an output pulse train is in 
progress. 

If no settings configurations have yet been saved, when the Output Control panel is 
first opened and no parameters are changed, the Output Settings box displays 
“Default.” If any parameters parameters are changed (but not yet saved), it displays 
“Custom.” 

When output settings are saved, the Output Settings box displays the name of the 
last selected setting. Use Organize List to change the display order of the menu, 
rename, or delete items (see page 7130). 

When a saved setting is selected from the pull-down menu, the Output Control panel 
and all Preferences dialog options will be updated. 

For Reference Channel—Low Voltage only: All Output Settings must use the same reference 
channel assignment; other parameters can be unique for each setting. 

 

 
Once configured, Preferences may be saved using the Save Settings button at the bottom of 
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OUTPUT CONTROL PANELS 

the Preferences dialog. Save Settings generates a dialog to name and save a defined 
configuration of Stimulator output settings. Saved configurations are accessible via the 
Output Settings pull-down menu in the Output Control panel. When a setting is selected from 
the menu, all current output parameters are updated to reflect the saved settings. 

You can save multiple configurations as long as each has a unique name; the Save button will 
be inactive if the name you enter is not unique.  

Output settings configurations are local presets that are saved with the data file or a template 
file. The data file or template file holds the output parameters as established when the file 
was saved plus any other named configurations of Output Settings. 

 

 
Use the Organize List button at the bottom of the Preferences dialog to order, 
rename or delete saved Preferences settings. The up or down arrows are only 
available if two or more settings have been saved. Select a setting and then click the 
up and down arrows to set the position, or choose rename or delete. If you choose 
“Delete All,” all saved settings will be deleted and the default and Custom options will 
be reactivated. 
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GENERAL TAB (OUTPUT PREFERENCES) 

General Tab 

 

Number of Pulses 

 

Indicates the number of pulses to be output. When the Output Control panel is closed, the 
pulse output will be immediately stopped. 

Single will establish a single pulse for outputting. All pulse repetition options, entry boxes 
and scroll bars in both the control panel and preferences windows will be disabled 
(grayed). 

Multiple will establish a specific number of pulses for outputting. The selection will 
activate an entry box where you can enter 1-254 pulses. When this option is selected, the 
Pulse Repetition scroll bar is activated in the Output Control panel. 

Continuous will establish a continuous pulse train for outputting. When this option 
is selected, the Pulse Repetition scroll bar is activated in the Output Control panel. 

 

MP30 Only If using High Speed mode (>2,000 s/s) and “Initiate pulse 
sequence with Recording” is selected, the stimulator cannot be turned off manually 
since the MP30 will not accept any commands from the computer until the 
recording has stopped. 

 If “Initiate pulse sequence with ON/OFF button in Output control panel” is 
set, the pulse sequence will be stopped prior to acquisition and will have to be 
manually turned back on after the recording. 

Initiate pulse sequence 
with… 

ON/OFF Button 

 
OFF (red) 
 

 
ON (green) 
 

 
AUTOMATIC START 
(yellow) 

 

Controls the start and stop of pulses. Changes to Pulse Width and Repetition Rate can be 
made in the Output Control panel entry boxes during a pulse sequence, and during a 
recording, if all other Preferences parameters allow it. Any change in the pulse output will 
occur immediately. This lets you change the stimulator output “on the fly.” 

 

When “Initiate pulse sequence with ON/OFF button” is selected: 

The ON/OFF button controls pulse output independent of the acquisition status. 

OFF is always available. 

The ON/OFF button reflects the current output state, with one exception: if the pulse 
sequence lasts less than 0.5 seconds, the button will remain in the “ON” state for at 
least 0.5 seconds to indicate that the ON state occurred. 

When the Number of Pulses selected is Multiple, ON/OFF acts as a momentary switch. 
Press the ON (green) button to start pulses; 
it will automatically turn OFF (red) at the end of the specified pulse train. 

The switch defaults to OFF. Saving a data file or saving as a Graph Template will save all 
stimulator preferences except the status of the pulse switch, which will always be saved in 
the OFF position. 

Recording 

 
Start button 
 

When “Initiate pulse sequence with Recording” is selected: 

If the preference setting “Initiate pulse sequence with: ON/OFF button” is active, 
the control panel changes will take effect immediately. If settings are changed 
during a pulse train, changes do not take effect until the next time the stimulator 
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GENERAL TAB (OUTPUT PREFERENCES) 

 
Stop button 

starts. 

Pulse output turns ON and OFF corresponding to the Start and Stop of the recording. In 
other words, the Pulse output can only occur during a recording. 

When in this mode, and not recording, the ON button will display as yellow, indicating that 
pulse output will automatically begin at the “Start” of the recording. 

Pulse outputting can be turned OFF during a recording, but it cannot be turned back ON 
until the end of the recording. 

When a Repeat sequence is running, pressing the OFF button will turn OFF the output for 
the entire recording sequence and the button will display as OFF until after the last 
sequence, when the switch will display as yellow ON (automatic start) indicating that pulse 
output will begin again at the “Start” of the next recording sequence. You cannot turn pulse 
outputting back ON during a repeated recording sequence. 

When the acquisition stops, all stimulator pulses will cease, regardless of the Output 
Control panel settings. 

The pulse train will stop concurrent with the end of the acquisition, even if the specified 
pulse train is not completed before the acquisition ends. When a new acquisition is 
started, the pulse train will start from the beginning. 

In this mode, no changes can be made in the Output Control panel until the recording stops. 
Changes made after recording stops will take effect when a new recording is started. 

When a pulse is sent out, the marker label and indicator arrow will be generated (if the 
marker preference is turned ON and markers are displayed). 

After initial delay After initial delay of … is enabled only when “Initiate pulse sequence with Recording” is 
chosen. Specify a delay interval from the start of recording to the start of the first pulse. 
This is useful for viewing data prior to the stimulus pulse. The BIOPAC output device 
determines the delay range. 

INITIAL PULSE DELAY MP36/35 MP30 or BSLSTM 

 Range 0 - 100 milliseconds 0 or .5 - 100 milliseconds* 

 Resolution 10 microseconds 1.953 microseconds 

*Entries greater than 0 milliseconds must be at least 0.5 milliseconds. 
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GENERAL TAB (OUTPUT PREFERENCES) 

Pulse Markers 

 

 
An advantage of using the BSL PRO software for output signals is that information 
regarding the pulse is automatically recorded along with the data. On most chart recorders, 
information regarding the pulse level (amplitude), pulse rate, and pulse width must be 
noted by hand, a process that can be inefficient, time-consuming and error-ridden. With the 
BSL PRO: 

The amplitude reflects the output pulse level. 

Markers can be automatically inserted and labeled for each Reference pulse or change in 
pulse train. The label will contain the Pulse width and Pulse rate (and system time stamp if 
selected). 

Markers reflect setting changes made during an acquisition.  

All output pulse information is automatically recorded and archived with the saved data. 

Set the marker option by clicking in the box to “Create marker when output is changed.” 

Set the time stamp option with the global Marker Preferences available under the File menu 
(see page 7179). 

 
The marker label accurately captures pulse data, but the marker arrow may not always line 
up exactly with the leading edge of the pulse; this typically is not a problem because the 
recording will include the actual stimulus pulse which can be used for timing 
measurements. 

Depending on the acquisition Sample Rate, the leading edge of the pulse in the recording 
may not correspond to the exact time the pulse was sent—it may be off by as much as one 
sample period. If the marker precision is critical for your recording, increase the Sample 
Rate. 

To display markers, use the toolbar icon or Display>Show>Markers. 

The Range switch on the front of the BSLSTM stimulator should be set to 10V or 100V 
prior to recording and should not be changed during recording; if using a Preset, the 
corresponding Preset should also be selected prior to recording. The pulse level can then be 
determined by moving the decimal to the right or left depending on how the range was 
switched.  

 



134  Part C 

Visit the online support center at www.biopac.com 

ADVANCED TAB (OUTPUT PREFERENCES) 

Advanced Tab 

 

Pulse Width 

 

Indicates the Pulse Width setting, which determines the maximum Pulse Rate 
frequency. You may enter a Pulse Width value, unless limited by Preferences. 

The entry is activated when the value is changed and the Tab or Enter key is pressed; it 
does not require a stimulator restart to take effect. 

The Pulse width entry overrides other entries as required; it is the priority parameter. 

An entry may be automatically changed if any of the following conditions apply, in which 
case the closest possible value will be selected: 

It falls outside the allowable range. 

It is rounded to .01 millisecond increments (MP36/35 resolution). 

Width has been limited by the Pulse Width: Limit Entry settings of Preferences. 

Allow any entry Pulse width is limited to the output capabilities of the BIOPAC MP device. This 
option allows any entry within the allowable range specified below: 

PULSE WIDTH RANGE MP36/35 unit  MP30 unit  

Range  .050 – 100 milliseconds .049 – 100 milliseconds 

Resolution 10 microseconds 1.953 microseconds 

Lock entry to This entry locks the width to a single, specified value (within the allowable range). 
No other value can be entered. 

Calibration adjustment 

MP30 BSLSTM only 

The pulse width from the MP30 output connector is very accurate, but the 
BSLSTM hardware may add 0 to 150 microseconds to the pulse width in its 
internal circuit. This value can vary somewhat from unit to unit but mainly depends 
on the revision of the BSLSTM which is determined from the serial number on the 
back of the unit. To adjust for this, the BSL PRO software can subtract a specified 
amount of time from each requested pulse width. 

To determine a calibration adjustment value which will get one very close (within 
+- 5%) of the requested pulse width, refer to the following table: 

Serial No. Calibration adjustment value (microseconds). 

<= 308A 5100  70  

>= 310A 100 0 (default value) 

 

If you are using an older model manual control (no LED) BSLSTM stimulator, try 
using 110ms—and then contact BIOPAC for a free product upgrade. 

If pulse width accuracy greater than +- 5% is required, calibrate your specific 
BIOPAC BSLSTM stimulator (requires an oscilloscope) and enter a specific 
adjustment time from 0 to 150 microseconds (entries outside this range will be 
clipped). 

Only for MP30 BSLSTM 
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ADVANCED TAB (OUTPUT PREFERENCES) 

Calibration adjustment—MP30 BSLSTM only 

Connect a BNC to BNC cable from the BSLSTM output connector to an 
oscilloscope input.  

Set the “Calibration adjustment: subtract” to “0.” 

Specify a pulse width of .2 ms. 

Send out a stimulus pulse. 

Measure the actual pulse width out of the BSLSTM stimulator with an 
oscilloscope.  

The Manual Test button on the back of the BSLSTM cannot be used to make the 
oscilloscope measurement. 

Calculate the time required to make the pulse width exactly .2 ms.   

Enter this time, in microseconds (1 ms = 1000 microseconds), into the “Calibration 
adjustment: subtract” entry box. 

Pulse Repetition 

 

Indicates the Pulse Repetition period (Hz or ms). 

The Pulse period must be greater than the Pulse width. See  “TBPMIN” in the Output 
Preference > Advanced Tab Limits table on the next page. 

The full range of acceptable Pulse Rate values is from .2 to 6,667 Hz (MP36/35) or .2 to 
6,827 Hz (MP30). 

The maximum Pulse rate (PRPMAX) depends on the Pulse width setting: 

Pulse width 100 ms  maximum Pulse rate = 9 Hz 

Pulse width .020 ms  maximum Pulse rate = 3333 Hz 

The formula for pulse width vs. pulse repetition is PRPMIN = PW + TBPMIN 

Where: PRPMIN = the MINimum Pulse Repetition Period allowed. 
 PW = Pulse Width setting 
 TBPMIN = MINinum Time (in ms) between successive pulses 
       for the output device (see device specifications) 

If “Limit changes from ___ to ____” is selected in Advanced preferences, then 
PRPMAX will be determined by the formula above or the specified limit, whichever 
is greater. 

An entry may be automatically changed: 

If it falls outside the allowable range. 

To round it to .01 Hz increments (resolution of system). 

To make it at least 0.1 millisecond greater than the Pulse width. 

By the Pulse Repetition Rate: Limit entry Preference. 

By the Pulse Repetition: Adjust entry increments Preference. 

You may manually enter any value for pulse width, but when using the scroll bar or 
arrows, entries will be constrained by the “Adjust entry increments” Preference setting. 

 

 

Pulse Repetition Scroll 
Bar 

The Pulse Repetition Scroll Bar adjusts rate or period by the increment of change and 
limits established in Preferences. With each click of the scroll bar arrows, the rate will be 
increase by the specified increment. 

When “Initiate pulse sequence with ON/OFF button in Control Panel” is selected, 
changes take effect upon release of the scroll box as long as the stimulator is running. 

The scroll bar is disabled when Number of Pulses is set to “Single” or Pulse Repetition is 
set to Lock Entry to...” 

Display as Pulse repetition can be dispalyed as 

Pulse Rate (expressed in Hz), or 

Pulse Period (inverse of Pulse Rate, expressed in milliseconds). 

Pulse Repetition Rate relates to the Pulse Repetition Period as: 
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ADVANCED TAB (OUTPUT PREFERENCES) 

Pulse Rate (Hz) = 1000 / Pulse Period (milliseconds) 

The “Display as” units selection is also used for: 

Pulse repetition entries in the control panel. 

Scroll bar increments. 

The Pulse Repetition Rate: Limit entry Preference. 

The Pulse Repetition: Lock entry Preference. 

The Pulse Repetition: Adjust entry increments Preference. 

When units are changed from Rate in Hertz (Hz) or Period in milliseconds (ms), the 
limits of the Pulse Repetition range will be converted by the formula: 

Period increment in ms = Round to nearest whole number [Period Range * (Rate 
increment in Hz /Rate Range in Hz)] 

For example, if the Range was 1Hz to 10 Hz with an adjustment increment of 1Hz, the 
proportional calculation would be Period increment = 900 ms (1Hz / 9 Hz) = 100 ms 

Allow any entry Pulse width is limited to support the output capabilities of the BIOPAC output 
device. See Output Preference > Advanced Tab Limits table for allowable range. 

Limit entry Establishes minimum and maximum values that can be manually entered or changed with 
the scroll bar. 

Lock entry Locks the Repetition to a single, specified value (within the allowable range). No 
other value can be entered in the control panel. 

Adjust entry Controls the scroll bar or scroll arrow increment; does not apply to manual entry. 
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Output Preference > Advanced Tab Limits 

 Pulses 

MP36/35 MP30 

BSLSTM 

MP36/35 MP30 

SS58L 

MP36/35 
Only 

Pulse width      

 Range (ms): .050 – 100 .049  – 100  .050 – 
100 

.049  – 
100 

.050 – 
100 

 Resolution (ms): .010 .001953  .010 .001953 .010 

Pulse Repetition      

 Rate range (Hz): .2  – 16,667 .2 – 10,204 .2 -  
2,000  

.2 – 
2,004  

.2  – 
10,000 

 Period range (ms) .060 – 5,000 .098  - 5,000 .500 – 
5,000 

.499 – 
5,000  

.10 – 
5,000 

 TBPMIN Minimum tim
 between Pulses  (ms

.010 .049 .450 .450 .050 

 Resolution (ms): .010 .001953 .010 .001953 .010 

Initial Pulse Delay      

 Time range (ms): 0 – 100 0 or .5 - 100 0 – 100 0 or .5 - 
100 

0 – 100 

 Resolution (ms): .010 .001953 .010 .001953 .010 

 

LEVEL TAB (OUTPUT PREFERENCES) 

About Level 

 

The low voltage stimulator allows the softare to specify the pulse amplitude.  The 
amplitude can be set to any value within the limits of the stimulator; the range is -
10 to +10 Volts. 

Pulse Level 

Low Volatge only 

 

The Level entry box allows the user to 
manually enter any value within the limits 
of the system, or within the limits of the 
Preference settings from the Level tab. 

 

The Level entry box will be inactive 
(grayed) if: 

The Level preference “Lock entry to” is 
active. 

If “Initiate pulse sequence with Recording” is active (from the General tab) and a 
pulse sequence is in progress or “wait for trigger” is in progress. 

Use the entry box or the scroll bar to set the Pulse level. When a value is entered 
which is out of range, the value will be rounded to the closest value obtainable 
after the “Enter” or “Tab” key is pressed. 

If “Initiate pulse sequence with ON/OFF button in control panel” is active (from the 
General tab), then values entered during a pulse sequence will take place 
immediately. 

If “Initiate pulse sequence with Recording” is active (from the General tab), any 
entry made between acquisitions will take place on the next “Start” of acquisition. 

Allow any entry The level is limited from -10 to +10 V to support the output capabilities of the stimulator. 
This option allows any entry within that range.  

Limit entry This entry reduces the range (within the -10 to +10 V range limit). 

Lock entry This entry locks the level to a single specified value (between -10 and +10 V). 

Adjust entry This setting affects the scroll bar or scroll arrow increment only; it does not apply to 
manual entry. 
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LEVEL TAB (OUTPUT PREFERENCES) 

The smallest increment is 5 mV, as limited by the MP36/35. The specified increment is 
used to round manual entries to the closest obtainable value. 
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REFERENCES TAB (OUTPUT PREFERENCES) 

Reference Channel 

SS58L only 

 

 
This option allows you to “Monitor” the output signal on one of the analog or digital 
input channels without making any physical connections. This is an internal, 
hardware/firmware, feature that recreates the output signal and allows recording 
in “real time.” The assigned reference channel will override any “real” input signal. 

For example, if a transducer is connected to CH 1, and CH1 is chosen as the 
reference channel, then the signal coming from the transducer will not be 
viewable, and will not conflict with the reference signal generated internally. 

The reference signal is not the real signal, but is a very accurate “estimate” of the 
real signal. The pulse timing accuracy will be within 100 microseconds. If an 
analog input channel is used as the reference channel, the pulse level will be 
accurate within 5%. If the SS58L encounters a load that reduces or distorts the 
pulse output, the reference signal will not reflect this amplitude distortion. 

If a digital input channel is used as the reference channel, only a digital 
representation of the pulse will be generated. In other word, regardless of the 
pulse level, when no pulse is occurring, the level will be 0 Volts, and when the 
pulse is occuring, its level will be shown as +5 Volts. 

Channel Assignment Use the pull-down menu to choose which analog or digital input channel will be used as 
the output reference channel. 

When a new reference channel is assigned, a warning will be generated to alert you that 
this setting will overwrite the existing Channel Setup parameters for the selected channel. 

 
For example, if you set up CH1 for ECG data and then select CH1 for the Reference 
Channel, your ECG parameters will be replaced. If you then select another channel, CH1 
will be restablished with the default analog input parameters, and you would need to 
recreate your ECG settings (by using Presets or manual entry). 

The reference Channel label should read: “Low Voltage Stimulator - Reference Out”. 

When an Analog Input Channel is assigned as the Reference channel, that channel, as 
viewed from the MP UNIT>Set up Channels dialog, will be in a “Lock-Out” mode. This 
means that the Preset pull-down menu icon for that channel will be grayed (inactive). The 
assigned reference channel will be inactive for “real” inputs until the Reference Channel 
Preference is changed to “None” or another channel. The wrench button, when pressed for 
the Reference channel, will still allow viewing of the channel parameters, but all entry 
boxes and pull-down menus will be inactive. 

When a “Low Voltage Stimulator” control panel using an assigned Reference channel is 
closed, the channel that was assigned as the reference channel will be removed from 
“Lock-Out” and will automatically change to the default, “CH X Input” settings. The 
reference channel assignment will be saved in the template or data file, so that if the “Low 
Voltage Stimulator” control panel is reopened, the reference channel will be automatically 
re-assigned, without any warning prompt given. 
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REFERENCES TAB (OUTPUT PREFERENCES) 

Generate using You can specify how the Reference signal should be shown. 

If using analog input from CH1 - CH4, you may select actual or fixed (max) amplitude 
and actual pulse or fixed pulse width. Fixed pulse widths are useful when the pulse width 
is much smaller than the sample interval (1/sample rate) being used. 

For example, for Frog muscle stimulation, you may choose to use a 1 ms pulse width, but 
a sample rate of 200 samples/sec. to capture the muscle response. At this sample rate, the 
stimulus pulse could not be reliably recorded. By extending the displayed pulse width to 
100 ms, you will be guaranteed to always record the stimulus pulse. 

If using digital input from D1 - D8, select actual or fixed (15ms) pulse width. 
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Usage Guidelines & Setup Summary for BSLSTM Output Control 

HUMAN SUBJECT SAFETY 

Before using the stimulator on human subjects, it is very important to limit the 
energy the stimulator outputs. For optimal safety: 

Before powering on the BSLSTM stimulator, set the voltage level to zero by 
rotating the LEVEL knob on the front of the BSLSTM fully counterclockwise. 

Use BIOPAC HSTM Series Probes. You MUST use these probes order to limit 
the energy the stimulator can output. 

Never create an electrical path across the heart. 

Never use on subjects with pacemakers. 

Read this manual and the BSL Hardware Guide to become familiar with 
Stimulator operation. 

Connect the BSLSTM Stimulator to the MP UNIT and power on both units. (For instructions on how to connect the 
BSLSTM to the MP UNIT Acquisition Unit, refer to the BSL Hardware Guide.) 

Connect the Stimulator Trigger cable to the Analog Out port of the back of the MP UNIT. 

Connect the Stimulator Reference Output cable to an Input Channel on the front of the MP UNIT. This channel will 
be set up in Step 3 as the Stimulator Reference Channel. 

The Reference pulse has a fixed Pulse width of 15 milliseconds, so chosen so that the Sample Rate of the recording 
may be as low as 100 samples/second and still capture the Reference pulse. 

Before powering on the BSLSTM stimulator, set the voltage level to zero by rotating the LEVEL knob on the front 
of the BSLSTM counterclockwise all the way to the left. 

Launch BSL PRO software to a new data acquisition window. 

Confirm that Markers are activated. 

Markers are activated by default. If not activated for a given recording, choose Display> Show>Markers. 

Set up the Stimulator Reference Channel. This is the Analog Input 
Channel on the front of the MP UNIT that receives the Stimulator 
Reference Output cable from the back of the BSLSTM. 

Choose MP UNIT > Set up Channels. This will generate a Set up 
Channels dialog. 

Select the Acquire, Plot and Enable options for the analog channel to 
be set up as the Stimulator Reference Channel. 

Click Presets and scroll to select “Stimulator (0-10V)” or “Stimulator 
(0-100V)” to match the Range switch setting on front of the BSLSTM. 

Click View/Change Parameters. This will generate an Input Channel 
Parameters dialog. 

Read the entire Stimulator section of this manual and familiarize 
yourself with the unit and its options before changing any preset 
parameters. 

You may set the Gain and other input parameters as desired. 

Click OK to accept the parameters.  

Close the Set up Channels window.  

 

Adjust the voltage output of the stimulator by using the Level control on the front of the BSLSTM. 

Rotate the Level knob clockwise to increase and counterclockwise to decrease, reading the voltage in the 
BSLSTM’s digital display. 

Stimulator Safety Features 

The stimulator cannot operate unless its Output Control panel is open. 

The Pulse ON/OFF Switch on the Stimulator Output Control panel must be OFF in order to open and configure 
Stimulator Preferences. 

If the Stimulator Output Control panel (or the BSL PRO application) is closed in the middle of a pulse train 
while the stimulator is running, the stimulator will shut down and the pulses will stop. 

If another data acquisition window is activated, the stimulator will stop and remain OFF unless restarted 
using the parameters associated with the new data window. The only exception is that if the stimulator is 
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ON and the data window corresponding to current stimulator parameters is acquiring data, then the 
stimulator will continue to run until the end of the acquisition. 
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Chapter 9 Gauge 

 

The optional “Gauge” display 
shows one channel of data in a 
gauge/dial indicator format.  

The Gauge displays as a separate 
window, viewed simultaneously 
with graph and other windows. 

 

Custom Gauges can also be 
created and mapped to 
accommodate half circle layouts. 
(left) An optional range band 
overlay is also available. 

The Gauge window: 

 Will display one channel of data: analog CH 1 – CH 4 or a calculation channel (C1-C12) 
 Updates and displays simultaneously with the graph window. For analog channels only, the display will 

update when the recording is stopped, but at a slower rate when recording is running. 
 Can update during and in between acquisitions for all MP3X devices; display may be updated at a rate 

slower than the sample rate and may display a value that represents the average of several samples.  
 The background image (BMP, JPG or TIFF), indicator origin, range, length, thickness and color are all 

user-configurable. An optional range band overlay can also be enabled. 
 All window preferences as well as the window visibility, size and position will be saved with the file. 
 Window sizing is “fixed” to the size of the background image, meaning it will have a 1 to 1 correspondence 

with the monitor pixels 

Gauge display for BIOPAC Blood Cuff Transducers 

When the gauge view is first opened, a default blood pressure “background image” (Gauge.jpg) will be assigned. 
Other gauge types are also selectable by changing the background image preference. In order for a gauge to work 
correctly with the BIOPAC SS19LA or SS19L, the transducer must be calibrated and the gauge mapping values 
established. Instructions for setting up both transducer types are included at the end of this section. 

   SS19LA simplify setup by using the "SS19LA Gauge.gtl from the BSL PRO “Sample Data Files” folder  
 (use File > Open and make sure “Files of type” is set to All or Graph Template). 

   SS19L this older model blood pressure cuff transducer requires two-point calibration; see the Hardware Guide  
                   or contact support@biopac.com for details if necessary. 

mailto:support@biopac.com�
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Gauge Preferences: 

  

There are two ways to access Gauge Preferences: 

1. File > Preferences > Gauge (only a menu item when the Gauge is displayed). 
2. Right-click, contextual menu when the cursor is over the Gauge display window.  

Channel Provides a pop-up menu for assigning any one of the ENABLED analog or calculation channels.  

Background Displays the path and file name of the background image; the background image file format must 
be *.bmp, *.tiff or *.jpg. The default picture is a blue blood pressure gauge sized at 451 x 451 
pixels. To change the background image, click the “Browse” button and locate the desired file. 
Paths can be absolute or relative a relative path is preferred if the file resides within the 
application folder or if a graph or templeate file will be copied to other computers. To change to a 
relative path, delete the portion leading to the application folder. 

 Example: 

 Absolute path: F:\Program Files\BIOPAC Systems, Inc\Biopac Student Lab 
3.7.7\Artwork\BPM.jpg 

 Relative path: \Artwork\BPM.jpg 

 The default path and file is: \Program Files\BIOPAC Systems, Inc\Biopac Student Lab 
3.7.x\Artwork\Gauge.jpg. To create a different default, replace this image. The Artwork folder 
contains different background images, each with different size options. 

 After the background image is specified, the Height and Width of the image (in pixels) is updated 
below the path field. The Height and Width fields ARE NOT EDITABLE. The background image 
section of the dialog is above the Indicator section because it is necessary to refer to the Height 
and Width in order to determine the Origin’s X and Y values.  

 When the “Browse” button is pressed, the folder that is opened is the one defined by the current 
Background image path.  

Notes In order for the indicaor to be perfectly centered, the horizontal and vertical picture size should be 
an ODD number of pixels.  

Window sizing is “fixed” to the size of the background image, meaning it will have a 1 to 1 
correspondence with the monitor pixels 
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Indicator The “indicator” or “needle” is a simple line vector drawn from an assigned center point to an 
endpoint calculated according to the “Length” parameter. The indicator always rotates around the 
origin from low to high values in a “clockwise” fashion.  

Origin Is the center point of the indicator line referenced from the top left of the image not the top left of 
the window meaning neither the frame of window nor the title bar is included. The “X” parameter 
specifies the horizontal distance in pixels and the “Y” parameter the vertical distance. “X” cannot 
exceed the Width of the background image and “Y” cannot exceed the image Height. The default 
values are: Origin: X: Width/2, Y: Height/2. Note that the pixel count starts at “0” so a 225 
pixel square image will have its center point at 112 pixels. 

 Length Specifies indicator line length in pixels starting from the “Origin”. Default is the smallest of the 
Length or Width dimensions divided by 2. 

Thickness Specifies the number of pixels used for drawing the indicator line (needle) and is limited from 1 to 
10 pixels. The default is 1 pixel. If both the width and height of the background image are an odd 
number of pixels, the thickness should also be an odd number in order to achieve perfect 
alignment. It should not be necessary to adjust the “Origin” after changing the thickness. 

Color Specifies the color of the indicator line as Black (default) or White. 

When recording is stopped 

 If the source channel is a Calculation channel, no gauge updating will occur when the recording is 
stopped. Under this circumstance, the “When recording is sropped” options become available. 
This allows the user to specify whether the indicator should not be displayed, should be reset to 
zero or should retain the last value. 

  

Mapping Two point mapping: Input to Angle   

Input Row  Defines the input values in the scaled units. The units shown in the example are “mV”, however 
this would be the units of the source channel (mmHg, psi, etc.). The Input mapping default is a 
value of 50 at whatever units the Channel is assigned.  

Angle  Any angle can be entered, but 0, 360, 720, etc degrees means that the indicator will always be 
pointing straight down.  

 When assigning mapping angles: Because the indicator must rotate clockwise, the first (upper) 
value should be the lower angle. The first value also defines the indicator’s starting angle and 
does not to need to be 0 degrees. For example, for stopwatch gauge implementations, the starting 
angle may be 180 degrees (pointing straight up). If half-circle gauges are used, the starting angle 
may be 90 degrees. The second (lower) value also sets the indicator limit if the checkbox option 
“Indicator is limited to specific mapping” is selected. 

Indicator is limited to specified mapping 

<Default ON> means that the indicator (needle) is confined or limited to the specified range. In 
the example values shown in the above screen shot, if the input was -1 mV, the needle would stay 
at 0 degrees (and would not change color). If the reading goes past 50 mV, the needle “freezes” at 
359 degrees and turns RED. So there is a difference in color when the indicator is outside limits; 
RED if Clockwise limit is exceeded and NO CHANGE IN COLOR when limit is exceeded in the 
counter-clockwise direction. If this preference is NOT SELECTED, then the needle never 
changes color and if the defined mapping limits are exceeded, then the needle will just continue a 
CCW or CW rotation.  

Range Band 

<Default OFF> The Range band is an OPTIONAL feature used to highlight a specified area of 
the Gauge View. 
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The Start and End parameters define a “pie” shape (defined by Mapping values) sourced from 
screen center to the output edge of the background image, and superimposed over the background 
image.   
 

 
 
The Color button brings up the following dialog, which allows any color to be selected.  The 
default color is green. 
 

 
 
The Opacity button defines how much the range band will obscure the background.  100% means 
the background will not be viewable under the range band, and 0% means the range band will not 
be visible.  The default setting is 50%.    

 

If entries are made in the dialog that are outside the parameter limits, the entry should change to the limit, become 
highlighted and a system beep should occur.  

The Preferences dialog can be opened simultaneously with the Set up Channels dialog. Any changes in the Set up 
Channels dialog (i.e. Scaling > Units) will not be updated in the Preferences dialog until the dialog is closed and re-
opened. 

If the source “Channel” is an analog channel (CH1—CH4): Prior to data recording—and  after recordings have 
stopped—the MP unit will continue to acquire “bursts” of data (MP “Busy” light blinks) in orde to update the Gauge 
view. This updating will occur at a slower rate than during a recording which may cuase the indicator to appear 
sluggish. If the source channel is a calculation channel, the updating will not occur when the recording is stopped.   

Note: Sample template files containing different Gauge displays can be found in the Sample Data\PRO folder. 
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Setting up Gauge view for working with Blood Pressure Cuff Transducer SS19LA 

1. Connect the Blood Pressure Cuff Transducer to the MP acquisition unit.  

 Connect the SS19LA to the desired MP input channel (CH1 – CH4); template is set to CH1. 

 For MP3X units, it is recommended to plug in transducers prior to powering up the MP unit. 

2. Open the “SS19LA Gauge.gtl” template from the Sample Data\PRO folder. 

3. Calibrate the pressure cuff. 

a) Completely deflate cuff. 
b) Choose MP menu > Set Up Channels. 
c) Click View/Change Parameters (Wrench icon) for the channel the blood pressure cuff is 

connected to—the Input Channel Parameters dialog will be generated. 
d) Click Scaling to generate the Change Scaling Parameters dialog. 

  
 Default values Calibrated values (sample) 

e) Click "Cal1" to update the Input value. This value represents the baseline offset. 
f) Add the Cal1 Input value to the Cal2 Input value and manually enter the result as a new Cal2 

Input value.  

For example If the click on Cal1 produces an Input value of -0.1155 mV, and the existing Cal2 
Input value is 61.44, then the new Cal2 Input value is 61.44 mV - 0.1155 mV = 
61.32 mV (which should be entered as the new Cal2 Input value). So, after 
calibration, Cal1 Input value = -0.1155 mV and Cal2 Input value = 61.32 mV 

g) Do not change either Scale values or 
the Units label—close out of the dialogs: 
i. Click OK to close out of the Change 

Scaling Parameters dialog. 
ii. Click OK to close Input Channel 

Parameters dialog. 
iii. Click the close box in the upper right 

corner of Set up Channels dialog. 

4. Set Gauge Preferences (if not using template). 

a) Choose MP menu > Gauge to generate 
the default blood pressure gauge in a 
“floating” window. 

b) Reposition the Gauge window such that 
it is not overlapping the graph window. 

c) From the right mouse contextual menu, 
when cursor is over Gauge view, 
choose Preferences to bring up the 
Gauge Preferences dialog. 

d) Change the lower Mapping Input 
value to “319.11” mmHg.  
 Calculated by the equation:  

359 degrees*(320 mmHg/360 
degrees) = 319.11 mmHg 
where 320 mmHg is a standard sphygmomanometer max value. 

e) Click OK to close the dialog. 

The Gauge is now set to display blood pressure cuff transducer values when data is recorded. 
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Setting up Gauge view for working with Blood Pressure Cuff Transducer SS19L 

Note: The gauge display is optional with this older model at it contains a sphygmomanometer 
(mechanical gauge).  The gauge display may not correspond exactly with the sphygmomanometer 
because of accuracy tolerances. 

 

1. Connect the Blood Pressure Cuff Transducer to the MP acquisition unit.  

 Connect the SS19L to the desired MP input channel (CH1 – CH4); template is set to CH1. 

 For MP3X units, it is recommended to plug in transducers prior to powering up the MP unit. 

2. Roll up cuff and attach mating Velcro pieces to prevent unwrapping during inflation. 

3. Open “SS19L Gauge.gtl” from the Sample Data > PRO folder. 

4. Calibration point 1; 0 mmHg. 

a) Completely deflate cuff. 
b) Choose MP menu > Set Up Channels. 
c) Click View/Change Parameters (Wrench icon) for the channel the blood pressure cuff is 

connected to—the Input Channel Parameters dialog will be generated. 
d) Click Scaling to generate the Change Scaling Parameters dialog. 

 
e) Click "Cal1" to update the Input value. This value represents the baseline offset. 
 

5. Calibration point 2; 100 mmHg. 

a) Inflate cuff until sphygmomanometer reading stabilizes at 100 mmHg then press Cal2. 

 
 

b) Do not change either Scale values or the Units label—close out of the dialogs: 
iv. Click OK to close out of the Change Scaling Parameters dialog. 
v. Click OK to close Input Channel Parameters dialog. 
vi. Click the close box in the upper right corner of Set up Channels dialog. 

The Gauge is now set to display blood pressure cuff transducer values when data is recorded. 
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Chapter 10 MP Menu — Other Commands 

 
This chapter will cover the MP Menu commands not discussed in the preceding chapters on Setup Channels and 
Setup Acquisition. 

 

Set up Triggering 

Not available for MP45 

Using a trigger allows you to start an acquisition “on cue” from a trigger connected to an analog input channel (CH1 
to CH4). By default, the trigger is off, and during a normal acquisition, the MP UNIT will begin collecting data 

following a mouse click the  button in the lower right hand corner of the screen. When Set up Triggering is 
used, acquisition will begin when the established trigger level is reached. 

To begin an acquisition with a trigger: 

1)  Select Set up Triggering from the MP UNIT menu to generate the Set up Triggering dialog: 

   
Set up Triggering dialog box and Source options 

2)  Choose a channel from the Source pull-down menu. You can select CH1, CH2, CH3, CH4 (MP UNIT front 
panel) or an external Trigger (MP36/35 back panel). 

External Trigger requires a TTL signal from a third-party device such as a stimulator, pump, presentation program 
or force plate. 

3)  Choose Pos Edge or Neg Edge from the menu to indicate whether you want a positive or negative edge to 
trigger the acquisition. Look at the nature of the signal to determine which is most appropriate. 

 A Positive edge occurs when the signal begins below the threshold and crosses above it. 
 A Negative edge occurs when the signal begins above the threshold and drops below it. 

4)  Set the Trigger level by keying in a value or by moving the scroll bar to adjust the threshold value. 

When setup is complete, close the Set up Triggering window and click the  button to begin acquisition as 
soon as the trigger is activated. 

The dialog box shown above is set to begin acquisition when a level of 25.00 mV is reached on analog channel 4. 
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Show Input Values 

  
When Show Input Values is selected from the MP UNIT menu, a new window appears on the screen and displays 
the values of all channels that were setup to Enable Value Display (see Note below). The Input Values window 
can be resized and moved to any position on the screen. If the MP UNIT is disconnected or without power, the Input 
Values dialog will read “OFF.”  

Values are displayed in real time for the appropriate analog channels whether an acquisition is in progress or not, 
which allows you to display values prior to or after an acquisition; calculation channels will only be displayed 
during acquisition. 

The table on the following pages explains the Input Values (IV) window options. 

Note: The IV window is disabled during High Speed acquisition (see page 784). 
The IV window does not update calculation channels when the recording is stopped or while 
waiting for a trigger device to reach the triggering level. 

 The Enable Value Display option must be checked for Input Values display to work. 

 

 TIP The FFT transformation cannot be performed in real time (i.e., during an 
acquisition), but you can emulate online spectral analysis using several 
online filters and the Input Values window. 

See also… 

Save as Graph Template, page 7185. 

 

Show Input Values Display options 
Incoming data can be displayed either as numeric values or in a “bar chart” format. These options are represented by 
icons that can be selected from the mode menu at the top of the Input values display. 

 
Clicking the Options button of the Input values display generates an Input Values Setup dialog where you can set 
additional display parameters: 
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Show Input Values—Window Visibility & Position 
 

The visible state of the Input Values window display… 

for active graphs displaying “.acq” or Lesson data will depend solely on the visible state of the last active graph. 

for “.gtl” graphs will depend on the state when the file was saved, or changed since it was last opened. 

 

When only one graph is open: 

When opening .acq or lesson files, the Input Values window will be hidden, regardless of how the file 
was saved. You must choose MP UNIT > Show Input Values to make it visible. Once made visible, the 
Input Values display will appear in the same position as when it was saved. 

When opening .gtl (template) files, the Input Values window will open as it was saved (both visibility and 
window position).  

 

When more than one graph is open: 

For multiple “.acq” files, if any Input Values window is visible, then the Input Values window will be 
visible for all graphs regardless of visible state when the graph was saved. The position of the window, 
however, is graph specific and will depend on the coordinates when saved or where it was moved to since 
it was opened in that file. If a template file is alos open, the visibility of the Input Values display when the 
“.acq” file is made the active graph will depend on the last visible state of the active “.gtl” file. 

When switching between open “.gtl” (template) files, the visible state of the Input Values window will 
appear as it was saved or altered since it was opened (both visibility and window position). 
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Electrode Checker—MP36/35 

 
 

Electrode Checker 

Not available for MP45 

The Electrode Checker, in conjunction with the MP Unit, measures how well electrodes are making contact with 
the surface of the skin. To use this feature: 

1) Attach the electrodes as you normally would. 

2) Connect the electrodes to an electrode lead set (such as the SS2L). 

3) Instead of connecting the electrodes to one of the four analog inputs, connect the Simple Sensor end of the 
electrode lead to the Electrode Check port on the front of the MP UNIT acquisition unit. 

4) Click the MP UNIT menu and scroll down to select Electrode Checker. 

This will generate a small “thermometer-like” display. At the bottom of the display you should see a number with 
k after it. This value describes the impedance of the electrode/skin contact, with lower numbers being associated 
with better conductivity. The better the conductivity, the “cleaner” the signal displayed on the screen. If the MP 
UNIT is off or no nothing is connected to the “Electrode Checker” on the MP Unit, the Electrode Checker display 
will say “OFF.” 

    
 MP30 Poor contact MP30 Good contact MP30 Off 

 TIP While there are few absolutes as to what constitutes “good” contact, one rule of thumb is 
that this number should be below 10 k, and the lower the better. 

 TIP To decrease the impedance of an electrode connection, you may want to “abrade” the 
surface of the skin with an ELPAD abrasive pad (included with the Biopac Student Lab 
PRO System). This removes a thin layer of dead skin cells and should result in a signal that 
has relatively little noise. 
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Autoplotting and Scrolling 

AutoPlotting and Scrolling both control how data appears on the screen. By default, the most recently collected 
data will be displayed first and, if more than one screen of data is collected, the time scale will “scroll” so that the 
newest data is always on the right edge of the screen. 

When AutoPlotting is checked and Scrolling is deselected, the screen will be cleared when the data reaches the 
right edge of the screen, and plotting will continue from the left edge again. 

When both Scrolling and AutoPlotting are unchecked, the incoming data will be plotted until the screen is full. 
Once the screen is full, data will continue to be collected, but only the first screen is displayed. By default, the MP 
UNIT will display the first eight seconds of the data record, but this can be reset manually by changing the 
horizontal scale. To turn AutoPlotting ON or OFF in the middle of an acquisition, select Ctrl+T on the keyboard to 
toggle AutoPlotting. 

 

Warn on Overwrite 

The Warn on Overwrite option will prompt you each time you start a new acquisition. The option toggles on/off 
each time it is selected from the menu. 

   
 

The OverwriteYES/NO prompt appears using Repeat/Save Once acquisition setup. 
Click Yes to overwrite (erase) the current data file with the new acquisition data. 

Click No if you do not want to erase the file that you are working in, then open a new window. 

 

The File Exists OK/CANCEL prompt appears using a Repeat/Autosave acquisition setup. 
Click OK to overwrite (erase) the current data file with the new acquisition data. 

Click Cancel if you do not want to erase the file that you are working in, and then choose a new file name. 

You can uncheck the Warn on overwrite option from the MP UNIT menu to disable the prompt. 
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Organize Channel Presets 

The Organize Channel Presets option of the MP UNIT menu is related to the channel presets in the MP UNIT > 
Setup Channels dialog. You can organize the Presets (established or new) to place the most frequently selected at 
the top of the menu or to group related Presets, such as the established ECG Presets with any new channel Presets 
you create. Click a Preset description to select it, and then use the buttons to organize the Presets. The up and down 
arrows will move your selection one space at a time, and the Top and Bottom buttons will jump to the start or end 
of the list. 

  
Organize Channel Presets dialog and resulting Presets menu display 

  
Revised Organize Channel Presets dialog and resulting Presets menu display 

 

To delete or rename a Preset, select the 
Preset name from the listing and click 
the Delete or Rename button. Or, click 
the right mouse button to select the 
Preset from the listing and scroll to the 
desired option. 
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Rename a Preset by typing in a new 
description and clicking OK. 

 
 

Delete a Preset by selecting that option. 
You cannot delete the Default Analog 
Input preset. When you delete a Preset, 
you will be asked to confirm the request 
because it is an irreversible action.  
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Part D — Analysis Functions 
This part describes data analysis functions, which can involve creating, managing, and saving files, as well as 
editing data, performing mathematical transformations, and displaying data in various ways. In most cases, analysis 
is performed after the data has been collected. Features that can be computed during an acquisition (primarily 
transformations and calculations) were discussed in Part C — Acquisition Functions. 

The menu bar runs across the top of the display window. Menu bar structure is shown below: 

  
Chapter 8 (page 7157) provides advanced descriptions of the Measurement, Marker and Grid functions. 

Descriptions of specific menu functions can be found in the chapters describing the File, Edit, Transform, and 
Display menus. 

Menu Details Type of Commands 

File page 7179XX General file management commands, including opening, saving, and 
closing files. Export data files. 

Edit page 192 Cut, copy, and paste between and within files. Export data files. 

Transform page 7199 Mathematical transformations and functions, from simple arithmetic 
to digital filtering and spectral analysis. 

Display page 7240 Control how data appears on the screen either during or after an 
acquisition. 

 

Note: If you are not yet familiar with the “look and feel” of the Biopac Student Lab PRO 
Software, see Working With the BSL Software for a review of these basic functions: 

* Data window * Scales 
* Journal window * Scrolling 
* Tools — selection, I-beam, zoom * Keyboard Shortcuts 
* Channel display * Right-mouse button shortcuts 
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Chapter 11 Measurements, Markers & Grids 
Measurement Basics 

 
A convenient feature in the BSL PRO software is the pop-up measurement windows. A variety of different 
measurements can be taken, and you can display different measurements from the same channel and/or similar 
measurements from different waveforms. 

Measurement Display Windows 

To display the measurement windows in the area above the graph window, click the  icon or select Display > 
Show > Measurements. The number of measurement windows per row depends on the width of the screen; stretch 
the display window horizontally to increase the total number of windows per row.  

By default, only one row of measurement windows 
is displayed. To display more measurement rows, 
choose File > Preferences > General, and choose a 
number between one and eight from the pull-down 
Show __ measurement rows menu. 

 
When the number of measurement rows is changed under General Preferences, all current measurement settings are 
cleared (set to “None”). 
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Taking a Measurement 
1) Select a channel for measurement. The PRO software can display measurements for the selected channel (as 

denoted by an “SC” in the measurement box) or for any other channel. By default, the software displays 
measurements from the selected channel. To select a different channel, position the cursor over the part of the 
measurement window that reads “SC.” Click the mouse button and choose a channel number from the pop-up 
menu. The channel numbers in the pop-up menu correspond to the numbers in the channel boxes in the upper 
left corner of the graph window. Note: If “none” is chosen as the measurement function in the adjoining box, no 
measurement value will be displayed. 

 

2) Select a measurement area. Use the I-beam cursor to select an area to measure. It is important to remember 
that the I-beam always selects at least one sample point. If a single point measurement function is chosen (such 
as Time), the measurement will reflect the last selected point in the defined area. 

Single-point measurements: 

When a single point is selected, there is no 
area defined and the I-beam cursor will 
“blink.” The graph to the right shows how 
measurements for a single point can be 
selected with the I-beam. The cursor will 
flash when a single point is selected. 

 

Selected range measurements: 

To select an area spanning multiple sample 
points, click-and-drag the I-beam cursor to 
highlight the desired area (this is similar to 
highlighting in a word processor). See page 
750 for selection details. 

The following window shows how an area 
can be selected for measurement with the I-
beam. 

Note: If you have selected an area, but 
chosen a single point measurement function 
(such as Time), the measurement will reflect 
the last selected point in the defined area. 
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IMPORTANT! The first data point is “plotted” at time zero (1/2 dot on the left edge of the graph); the first visible data 
point is sample point 1. The selected areas below demonstrate this concept. The data slection is inclusive of the endpoint 
selections. 
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3) Select a measurement, position the cursor on a measurement box and click the mouse button. 

 Choose a measurement function from the pop-up menu. The measurement function in the upper half of the 
menu reflect amplitude measurements, or measurements which contain information about the vertical 
(amplitude) scale. Other measurement functions use information taken from the horizontal axis (usually Time) 
and are found on the section of the pop-up menu below the dividing line. Some of the measurement options 
change (or are disabled) if units are selected for the horizontal scale. 

Some of the values are single point measurements while others require at least two points to be selected. 

Single-point measurements Selected range measurements 

Delta S, Lin_reg, Max, Max T, Min, 
Min T, Samples, Time, Value, X-axis 
T/F/X 

Area, BPM, Correlate, Delta, Delta S, Delta T/F/X 
(based on units), Frequency (time domain), Integral, 
Lin_reg, Max, Max T, Mean, Median, Median T, Min, 
Min T, p-p, Samples, Slope, Stddev 

 

4) Review the result. If the measurement unit 
is cut-off, move the cursor over the result 
window to display the full measurement 
result below it. 

In some cases, the computations involved in the measurement can produce nonsensical results (such as dividing by 
zero, or calculating a BPM from a single point). In those cases, you may get a measurement value like INF (for 
infinite). This means that the result was undefined at this point.  

The measurement result will display “****” if no data is selected, or if there are not enough data points selected for 
a meaningful measurement. For a complete description of each of the measurement functions and the minimum 
samples for each, turn to page 7161. 

NOTE: You can validate measurements with the ValidateMeasurements.acq sample file that was included with 
the software. Pay attention to the “Sample data file” section of the measurement definitions that begin on page 7161, 
and where included, note which sample points to use for validation (i.e., the first four sample points are used to 
validate the Correlate measurement using the ValidateMeasurements.acq file). 

 
Copying measurements  
To the journal — One of the most useful options is to paste measurements to the journal. The journal is a general-
purpose text editor that allows you to open, edit, and save standard text files. You can “paste” measurements into the 
journal exactly as appear in the graph window by selecting Edit > Journal > Paste measurement. 

To the clipboard — You can copy measurements to the clipboard, where they are available for other applications. 
This means you can copy measurements (as they appear on the screen) to the clipboard and then paste the data into a 
word processor or other application. To do this, select Edit > Clipboard > Copy measurements and the values in 
the measurement windows will be copied to the clipboard. 

 
Exporting measurements 
One of the most important reasons to take measurements is to save them; Biopac Student Lab PRO software allows 
you to store and export these measurements in different formats. Under the default settings, only the measurement 
values themselves are copied to the journal or clipboard. You can change the settings to allow the measurement 
name and other options to be included via File > Preferences > Journal.
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The table below explains the measurement options available and the range required for each. 

MEASUREMENT Area EXPLANATION  

Area Minimum area: 
3 samples 

 

Uses: 
All points of 
selected area 

Area computes the total area among the waveform and the straight line 
that is drawn between the endpoints. 

Area is expressed in terms of (amplitude units multiplied by horizontal 
units) and calculated using the formula: 
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Where: 

n – number of samples; 

i – index (i = 1.n-1); 

1, ii xx  - values of two neighboring points at horizontal axis ( 1x – the 

first point, nx – the last point); 

   1, ii xfxf  - values of two neighboring points of a curve (vertical 

axis); 

   1, ii xyxy  -  values of two neighboring points of a straight line (vertical 

axis). 

At the endpoints y( 1x )= f( 1x ) and  y( nx )= f( nx ). 

1



n

X
xi - horizontal sample interval; 

The value of a straight line can be found by formula: 

  bxmxy ii   

  11 xmxfb  -  intercept; 

X

Y
m




 - slope of the straight line; 

   1xfxfY n   - vertical distance of increase at vertical axis; 

1xxX n  - horizontal distance of increase at horizontal axis. 

Sample plot: 

 
The area of the shaded portion is the result. 

Note: The Area measurement is similar to the Integral measurement 
except that a straight line is used (instead of zero) as the baseline for 
integration. 
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MEASUREMENT Area EXPLANATION  

 
Results: This calculation will always return a positive result. 

Units: Volts - sec. 

Sample data file: “ValidateMeasurements.ACQ” 
 Result: 0.4533 Volts - sec. 

BPM 

(Time domain 
only) 

Minimum area: 
2 samples 

 

Uses: 
Endpoints of 
selected area 

BPM (beats per minute) computes the time difference between the first 
and last points and extrapolates BPM by computing the reciprocal of this 
difference, getting the absolute value of it and multiplying by 60 (60 sec). 

The formula for calculation of BPM is: 

60
1

1















xx
BPM

n

 

Where:  

nxx ,1 - values of the horizontal axis at the endpoints of selected area. 

Note: This measurement provides essentially the same information as the 
Delta T and Freq measurement. 

Results: Only a positive value. 

Units: BPM. 

Calculate Minimum area: 
2 sources 

 

Uses: 
Results of 
measurements 
used in 
calculation 

Calculate can be used to perform a calculation using the other 
measurement results. For example, you can divide the mean pressure by 
the mean flow. 

When Calculate is selected, the channel selection box disappears. 

 
The result box will read “Off” until a calculation is performed, and then it 
will display the result of the calculation. As you change the selected area, 
the calculation will update automatically. 

To perform a calculation, Ctrl-Click (or on PC, right mouse button click) on 
the Calculate measurement type box to generate the “Waveform 
Arithmetic” dialog. 
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MEASUREMENT Area EXPLANATION  

 
Use the pull-down menus to select Sources and Operand. 

  
Measurements are listed by their position in the measurement display grid 
(i.e., the top left measurement is Row A: Col 1). Only active, available 
channels appear in the Source menu. 

You cannot perform a calculation using the result of another calculation, so 
calculated measurement channels are not available in the Source menu. 

The Operand pull-down menu includes: Addition, Subtraction, 
Multiplication, Division, Exponential. 

The Constant entry box is activated when you select “Source: K, 
constant” and it allows you to define the constant value to be used in the 
calculation. 

To add units to the calculation result, select the Units entry box and define 
the unit’s abbreviation. 

Click OK to see the calculation result in the calculation measurement box. 

Correlate Minimum area: 
2 samples 

 

Uses: 
All points of 
selected area 

Correlate provides the Pearson product moment correlation coefficient, r, 
over the selected area and reflects the extent of a linear relationship 
between two data sets: ix  - values of horizontal axis and  ixf  - values 

of a curve (vertical axis). 

You can use Correlate to determine whether two ranges of data move 
together. 

Association  Correlation  

Large values with large values Positive correlation 

Small values with large values Negative correlation 

Unrelated Correlation near zero 

The formula for the correlation coefficient is: 

Correlate = 
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Where: 

n – number of samples;  

i – index (i = 1..n); 

ix  –  values of  points at horizontal axis ( 1x – the first point, nx – the last 

point); 
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MEASUREMENT Area EXPLANATION  

 ixf - values of points of a curve ( vertical axis). 

Results: 

Returns a dimensionless index that ranges from -1.0 to 1.0 inclusive. 

Units: None 

Sample data file: “ValidateMeasurements.ACQ” 

 Result: -0.74825(for whole wave) and 0.95917  (for first four 
sample points). 

Delta Minimum area: 
2 samples 

 

Uses: 
Endpoints of 
selected area 

Delta returns the difference between the amplitude values at the endpoints 
of the selected area. 

Delta     1xfxf n   

Where: 

 1xf ,  nxf  – values of a curve at the endpoints of selected area. 

Results: 

If the data value at the starting location is greater than the data value at 
the ending location of the cursor, then a negative delta will result. 
Otherwise, a positive delta will result. 

Units: Volts 

Sample data file: “ValidateMeasurements.ACQ” 

 Result: -2 Volts (for whole wave). This result shows the absolute 
value of change of amplitude (2) and the minus sign means a decrease of 
amplitude. 

Delta S  Minimum area: 
1 sample 

 

Uses: 
Endpoints of 
selected area 

Delta S returns the difference in sample points between the end and 
beginning of the selected area. 

Results: This calculation will always return a positive result. 

Units: Samples 

 

Delta T(time) 

Delta F 
(frequency) 

Delta X 
(arbitrary unit) 

Minimum area: 
2 samples 

 

Uses: 
Endpoints of 
selected area 

The Delta T/F/X measurement shows the relative distance in horizontal 
units between the endpoints of the selected area. Only one of these three 
units will be displayed in the pop-up menu at a given time, as determined 
by the horizontal scale settings. 

Measurement Horizontal Axis 

Delta T Time 

Delta F Frequency (FFT) 

Delta X Arbitrary units (Histogram Bins) 

 

The formula for Delta T/F/X is: 

Delta T 1xx n   

Where: 

nxx ,1 - values of horizontal axis at the endpoints of selected area. 

Results: 

If the data value at the starting location is greater than the data value at 
the ending location of the cursor, then a negative delta will result. 
Otherwise, a positive delta will result. 

For Delta T measurements with the horizontal axis format set to 
HH:MM:SS. 
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MEASUREMENT Area EXPLANATION  

For values less than 60 seconds, you will get a value in decimal seconds. 

For values greater than 60 seconds, you will see an HH:MM:SS format 
value 

(See page 736 for details on how to change the horizontal scaling options). 

Units:  

Delta T: Seconds (sec.) 

Delta F: Hz 

Delta X: ”arbitrary unit” 

Sample data file: “ValidateMeasurements.ACQ” 

 Result: 0.12 sec. (for whole wave). 

Freq (time 
domain only) 

Minimum area: 
2 samples 

 

Uses: 
Endpoints of 
selected area 

Freq computes the frequency in Hz between the endpoints of the selected 
area by computing the reciprocal of the absolute value of time difference in 
that area. 

The formula for Freq is: 

Freq 













1

1

xxn

 

Where:  

nxx ,1 - values of horizontal axis at the endpoints of selected area. 

The information provided by this measurement is directly related to the 
Delta T and BPM measurements, and is related to a lesser extent to Delta 
S measurement. That is, if the Delta T interval between two adjacent 
peaks is calculated, the BPM and Freq measurement can be extrapolated. 

If the sampling rate is known, the Delta S can also be derived. 

 
Note: This does not compute the frequency spectra of the data. To 
perform a spectra analysis, use the FFT function (described on page 7222). 

Freq (or frequency) is only available in time domain windows. 

Results: This calculation will always return a positive result. 

Units: Hz 

Sample data file: “ValidateMeasurements.ACQ” 

 Result: 8.33 Hz (for whole wave). 

Integral Minimum area: 
2 samples 

 

Integral computes the integral value of the data samples between the 
endpoints of the selected area. This is essentially a running summation of 
the data. 

In this example, you can see 
Delta T, Freq and BPM 
measurements for the 
selected area. The Delta S 
can also be derived. 

The graph shows the 
selected area with 
measurements that describe 
the same interval in different 
terms. 
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MEASUREMENT Area EXPLANATION  

Uses: 
All points of 
selected area 

 
Integral is expressed in terms of (amplitude units multiplied by horizontal 
units) and calculated using the following formula. 

Integral =     
2
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Where: 

n – number of samples; 

i – index (i = 1.n-1); 

1, ii xx  - values of  two neighboring points at horizontal axis ( 1x – the 

first point, nx – the last point); 

   1, ii xfxf  - values of two neighboring points of a curve (vertical 

axis); 

1



n

X
xi - horizontal sample interval; 

1xxX n  - horizontal distance of increase at horizontal axis.  

Results: The Integral calculation can return a negative value if the 
selected area of the waveform extends below zero. 

Units: Volts – sec. 

Sample data file: “ValidateMeasurements.ACQ” 

Result: 0.300 Volts -sec.(for first 6 sample points) and –0.155 Volts -
sec.(for last 6 sample points – the wave below zero). 

Lin_reg Minimum area: 
2 samples 

 

Uses: 
All points of 
selected area 

Linear regression is a better method to calculate the slope when you 
have noisy, erratic data. 

Lin_reg computes the non-standard regression coefficient, which 
describes the unit change in f (x) (vertical axis values) per unit change in x 
(horizontal axis). 

For the selected area, Lin_reg computes the linear regression of the line 
drawn as a best fit for all selected data points using the following formula: 

Lin_reg = 
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Where: 

n – number of samples;  

i – index (i = 1.n); 

This plot 
graphically 
represents the 
Integral 
calculation. 

The area of the 
shaded portion 
is the result. 
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ix  –  values of  points at horizontal axis ( 1x – the first point, nx – the last 

point); 

 ixf - values of points of a curve ( vertical axis). 

Note: For a single point, Lin_reg computes the linear regression of the 
line drawn between the two samples on either side of the cursor. 

Results: 

If the data value at the starting location is greater than the data value at 
the ending location of the cursor, then a negative delta will result. 
Otherwise, a positive delta will result. 

Units: Volts/sec. 
This value is normally expressed in unit change per second (time rather 
then samples points) since high sampling rates can artificially deflate the 
value of the slope. If the horizontal axis is set to display Frequency or 
Arbitrary units, the slope will be expressed as unit change in 
corresponding vertical axis values (frequency or arbitrary units, 
respectively). 

Sample data file: “ValidateMeasurements.ACQ” 

Result: 230.00 Volts/sec. (for 1-4 samples) and 
–170.00 Volts/sec. (for samples 4-7). 

Max Minimum area: 
1 sample 

 

Uses: 
All points of 
selected area 

Max (maximum) shows the maximum amplitude value of the data samples 
between the endpoints of the selected area. To compare peak heights, 
select each peak — you can easily see the maximum peak values or paste 
the results to the journal. Also, since you can simultaneously obtain 
measurements for different channels, you can easily compare maximum 
values for different channels. 

Note: For a single point, Max shows the amplitude value in this point. 

Units: Volts 

Max T Minimum area: 
1 sample 

 

Uses: All points 

Max T shows the time of the data point that represents the maximum 
value of the data samples between the endpoints of the selected area. 

Note: For a single point, Max T shows the time value in this point. 

Units: Seconds 

Mean Minimum area: 
2 samples 

 

Uses: 
All points of 
selected area 

Mean computes the mean amplitude value of the data samples between 
the endpoints of the selected area, according to the formula: 

Mean =  



n

i
ixf

n 1

1
 

Where:  

n – number of samples; 

i – index (i = 1.n); 

ix  –  values of  points at horizontal axis; ( 1x – the first point, nx – the  last 

point); 

 ixf - values of points of a curve ( vertical axis). 

Units: Volts 

Sample data file: “ValidateMeasurements.ACQ” 

Result: 1.538462 Volts (for whole wave). 

Median Minimum area: 
2 samples 

 

Uses: 

Median shows the median value from the selected area. 

Note: The median and calculation is processor-intensive and can take a 
long time, so you should only select this measurement option when you 
are actually ready to calculate. Until then, set the measurement to “none.” 
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MEASUREMENT Area EXPLANATION  

All points of 
selected area 

Units: Volts 

Median T Minimum area: 
2 samples 

 

Uses: 
All points of 
selected area 

Median T shows the time of the data point that represents the median 
value of the selected area. 

Note: The median and calculation is processor-intensive and can take a 
long time, so you should only select this measurement option when you 
are actually ready to calculate. Until then, set the measurement to “none.” 

Units: Seconds. 

Min Minimum area: 
1 sample 

 

Uses: 
All points of 
selected area 

 

Min (minimum) shows the minimum amplitude value of the data samples 
between the endpoints of the selected area. 

Note: For a single point, Min shows the amplitude value in this point. 

Units: Volts. 

Min T Minimum area: 
1 sample 

 

Uses: 
All points of 
selected area 

Min T shows the time of the data point that represent the minimum value 
of the data samples between the endpoints of the selected area. 

Note: For a single point, Min T shows the time value in this point. 

Units: Seconds. 

None n/a None does not produce a measurement value. It’s useful if you are 
copying a measurement to the clipboard or journal with a window size 
such that several measurements are shown and you don’t want them all 
copied. 

 

 

P-P Minimum area: 
2 samples 

 

Uses: 
All points of 
selected area 

P-P (peak-to-peak) shows the difference between the maximum amplitude 
value and the minimum amplitude in the selected area. 

Results: The result is always a positive value or zero. 

Units: Volts 

Sample data file: “ValidateMeasurements.ACQ” 

Result: 13 Volts (for whole wave). 

Samples Minimum area: 
1 sample 

 

Uses: 
All points of 
selected area 

Samples shows the exact number of samples of the selected waveform at 
the cursor position—the first data point is not displayed, but is plotted at 
zero. 

See page 7159 for examples of selected area Samples. 

Note: When an area is selected, the measurement will indicate the number 
samples in the waveform at the last position of the cursor.  

Units: Samples. 

Slope Minimum area: 
2 samples 

 

 

Uses: 
All points of 
selected area 

Slope computes the non-standard regression coefficient, which describes 
the unit change in f (x) (vertical axis values) per unit change in x 
(horizontal axis). 

For the selected area, Slope computes the slope of the straight line that 
intersects the endpoints of the selected area and can be found using the 
formula: 

Slope = 
   

1

1
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xfxf

n

n
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Where: 

 1xf ,  nxf  – values of a curve at the endpoints of selected area. 

1x , nx - values of horizontal axis at the endpoints of selected area. 

This value is normally expressed in unit change per second (time rather 
then samples points) since high sampling rates can artificially deflate the 
value of the slope. 

Note: Lin_reg (linear regression) is a better method to calculate the slope 
when you have noisy, erratic data. 

For a single point, Slope computes the slope of the line drawn between 
the two samples: the selected sample point and the sample point to its left. 

Results: 

If the data value at the starting location is greater than the data value at 
the ending location of the cursor, a negative delta will result. Otherwise, a 
positive delta will result. 

Units: Volts/sec. (or corresponding to Freq or Arbitrary setting) 

Sample data file: “ValidateMeasurements.ACQ” 

Result: 233.33333 Volts/sec. (for samples 1-4) 
-166.66667 Volts/sec. (for samples 4-7) and 
-16. 66667 Volts/sec. (for whole wave). 

Stddev Minimum area: 
2 samples 

 

Uses: 
All points of 
selected area 

Stddev computes the standard deviation value of the data samples 
between the endpoints of the selected area. Variance estimates can be 
calculated by squaring the standard deviation value. 

The formula used to compute standard deviation is: 

Stddev =  
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Where: 

n – number of samples;  

i – index (i = 1.n); 

ix  –  values of  points at horizontal axis ( 1x – the first point, nx – the  last 

point); 

 ixf - values of points of a curve ( vertical axis); 




f  



n
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ixf

n 1

1
 - the mean amplitude value of the data samples 

between the endpoints of the selected area. 

Results: The result is always a positive value or zero. 

Units: Volts 

Sample data file: “ValidateMeasurements.ACQ” 

Result: 3.09570 Volts (for samples 1-4), 
1.000 Volts (for samples 10-12). 

Time Minimum area: 
1 samples 

 

Uses: 
All points of 
selected area 

See the X-axis: T measurement for explanation. 

Value Minimum area: 
1 sample 

Value shows the exact amplitude value of the waveform at the cursor 
position. 
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MEASUREMENT Area EXPLANATION  

 

Uses: 
All points of 
selected area 

For the selected area, Value indicates the value at the last position of the 
cursor, corresponding to the direction the cursor was moved (the value will 
be the left-most sample point if the cursor was moved from right to left). 

Units: Volts 

X-axis:T/F/X 

(horizontal 
units) 

Minimum area: 
1 sample 

 

Uses: 
All points of 
selected area 

The X-axis measurement is the exact value of the selected waveform at 
the cursor position, based on the Horizontal Axis setting: 

Measurement Horizontal Axis Setting    Units  

X-axis: T Time                                                       Sec. 

X-axis: F Frequency                                          Hz. 

X-axis: X Arbitrary units                                          Arb. units 

For X-axis: T measurements, the time value is relative to the absolute 
time offset, which is the time of the first sample point. 

The X-axis: F measurement applies to frequency domain windows only 
(such as FFT of frequency response plots). The Freq function for time 
domain windows is described on page 7165. 

Note: If a range of values is selected; the measurement will indicate the 
horizontal value at the last position of the cursor. 

Results: This calculation will always return a positive result. 

Cap_Dim 
Mac only 

 Capacity Dimension; fractal dimension estimate. 
(Fractals measure the amount of self-similarity in a data set. 
AcqKnowledge offers three alternate estimates for fractal dimension: 
Cap_Dim, Corr_Dim, and Inf_Dim. The estimates will not agree, based on 
the heuristic and the parameters.) 

Corr_Dim  
Mac only 

 Correlation Dimension; fractal dimension estimate. Always greater than 
capacity if parameters are the same. (See fractals note at Cap_Dim.) 

Evt_amp 
Mac only 

 Extracts the value of the measurement channel at the times where events 
are defined. The measurment result is unitless. Specify Type, Location, 
and Extract. 

The amplitude is always taken from the measurement channel, which may 
be different from the channel on which events are defined. 

Evt_amp can be useful for extracting information such as the average T 
wave height within the selected interval.  

Evt_count  
Mac only 

 Evaluates the number of events within the selected area. The 
measurement result is unitless. Specify Type and Location. 

 

Evt_loc  
Mac only 

 Extracts information about the times of events. The measurement result 
uses the units of the horizontal axis. Specify Type, Location, and Extract. 

Expression 

Mac only 

 Generates the Expression transformation dialog (page ) and offers Source 
“MC” Measurement Channel instead of “SC” Selected Channel to build 
recursive formulas, i.e. result of the expression as it was evaluated x 
samples ago. Data within the selected area is not changed. 

Inf_Dim  
Mac only 

 Information Dimension; fractal dimension estimate. (See fractals note at 
Cap_Dim.) 

Kurtosis  
Mac only 

 Kurtosis indicates the degree of peakedness in a distribution, e.g. the size 
of the “tails” of the distribution. 

Moment  
Mac only 

Uses: 
All points of 
selected area 

Central Moment is a general-purpose statistical computation that can be 
used to compute central variance and other higher-order moments of the 
data within the selected area. 
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Mult_inf  
Mac only 

 Mutual Information determines how much could probabilistically be known 
about an unknown signal given a known variable. Specify a time delay. 
Produces a single valued result. 

NLM  
Mac only 

 Nonlinear modeling (also called “arbitrary curve fitting”) determines the 
“best fit” model for the selected data of the selected channel. The 
measurement result corresponds to the value of one of the parameters of 
the best fit. NLM can be used to extract Tau (time delay LVP constant) for 
assessing cardiac condition. If a Model Expression uses MMT() syntax to 
reference a measurement and that referenced measurement is linearly 
interpolated, the results of the NLM measurement will also be displayed as 
being linearly interpolated. 

When combined with the Cycle/Peak Detector, the NLM measurement can 
be useful for extracting cycle-by-cycle best fit models for an entire 
waveform. 

Skew 

Mac only 

 Skew indicates the degree of asymmetry in a distribution (away from 
normal Gaussian distribution), e.g. if the distribution is weighted evenly or 
trends toward an edge. 
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Markers 

 
When Markers is selected from the Show submenu, the Marker region at the top of the graph 

window will be activated, and any markers associated with the data file will be displayed. 

 
You can insert “markers” into a record that act as bookmarks to record when an event occurs during the record. 
These markers appear as downward pointing triangles at the top of the graph window, and can be labeled to describe 
the associated event. Markers can be edited, displayed, or hidden from view. 

Markers can be inserted during an acquisition (except in high Speed mode) or off-line. 

 To add a marker while an acquisition is in progress, press the F9 key on a Windows PC or the Esc 
key on a Mac; the marker will be inserted at the exact time the key is pressed. 

 To add markers after an acquisition, position the cursor in the marker area and click the 
mouse button. 

When Display > Show > Markers is selected, icons are generated in the marker region for the following marker 
tools: 

 Finds the previous marker in the record. 

 Finds the next marker in the record. 

 Generates the marker pull-down menu, which lists all markers in the current file. To move to a given marker, 
scroll to select the desired marker label and release the mouse button. 

The Summary to Journal feature copies marker information to the Journal. The marker number, marker time, and 
marker label are copied. This option is not selectable (grayed-out) when the Journal is not open. 

Printing markers: The markers will be printed when the marker display is enabled. To keep the markers from being 
printed, hide the markers before printing. If the display is compressed, marker labels and/or indicators will be 
layered when printed to prevent overlapped text. 
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EXAMPLE OF MARKERS 
To see how Markers work, open the 4channel.acq sample file. 

 
 

Locate the marker icons near the top right of the display. If the marker icons are not showing, click 
select the marker (flag) icon from the toolbar or Display > Show, then drag right and down to 

select Markers. Selecting either of these again will “hide” the marker area. 

To view the text associated with a given marker, position the cursor arrow over the marker and click the 
mouse button. 

To move from marker to marker, use the arrow buttons in the marker area.  
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Grids 

To activate a grid display, click  in the toolbar or select Display > Show > Grids. 

Grid Display Off Grid Display On (unlocked) 

Grid Options 
To control the style and functionality of the grid display, 
select Display > Show > Grid Options. The Grid Options 
control grid format (line type, style, width and color), 
whether or not minor divisions are displayed, grid lock, and 
scale adjustment when grids are locked. 

 

 
 

Overview of Locked and Unlocked Grids 
Grid functionality and dialog options for Horizontal Scale and Vertical Scale change based on whether 
grids are locked or unlocked in the Grid Options dialog (see above). 

  Locked Grid  

  
  Unlocked Grid 
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Unlocked Grids 
Unlocked grids help you view the data display on the monitor. The Unlocked setting, enabled by NOT selecting 
“Lock Grid Lines”, displays four major grid divisions across the horizontal and vertical axes, and will generate 
interval numbers as needed to match the zoom factor. Unlocked grids are more helpful as a visual aid than an 
analysis tool. 

When not locked, the grid always cuts the horizontal scale into four major divisions (four vertical grid lines), 
regardless of the horizontal axis setting, which can be set to represent time, frequency, or amplitude values for an X 
variable. 

When not locked, the grid cuts the vertical scale into four major divisions (four horizontal lines across the screen) if 
the display is set to scope mode or X/Y mode; the grid cuts each track into four major divisions (four horizontal 
lines per waveform) if the display is set to chart mode. 

Beware!  Although the unlocked grid will be retained if the waveform is printed, saved as a graphic 
image or copied to the clipboard, the BSL PRO software will “round” the scale values. 
This process does not affect the nature of the data, only the scale used to plot it. 

 
Locked Grids 
Locked grids are helpful with analysis and printing. Selecting “Lock Grid Lines” locks the grid to the data for all 
functions. The default settings for the grid when in locked mode are: 

For vertical scale: 

Base Point  =  0; 
Major Division = 1/10 full scale range rounded to the nearest whole number. 
  (For example, with the default setting for Channel, gain of 200, 
  the major division would be set to 10mV / Division.) 

For horizontal scale: 

Base Point  = 0; 
Major Division = 1 second if sample rate is <= 2,000 s/s. 
 = 50 ms if sample rate is > 2,000 s/s. 

When grids are locked, you may set the grid interval (see next page). 
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Grid Interval 
Grid Interval follows the settings established in the Vertical scale and Horizontal scale options for the given channel 
or for all channels. When grids are locked, interval parameters for the horizontal and vertical scales are determined 
in the Grid Options dialog. Choose Start/End or Middle Point/Range as the parameters to use and then set the scale 
range and grid interval options in the Vertical Scale and Horizontal Scale dialogs, respectively. Scaling button 
generates the scaling dialog, which you may want to use to adjust the display of units. See page 736 for a discussion 
of Vertical scale and Horizontal scale when grids are unlocked. 

Grid Options : Lock option Vertical scale options Horizontal scale options 

Unlocked Grid (default) 

 

 

 

Locked Grid: 
Start/end parameters 

 
 

Note: The Base Point  
is the point from 
which the first grid 
line will be drawn. 

 

 
 

Lock Grid Lines: 
Midpoint/range parameters 

 
 

Note: The Base Point  
is the point from 
which the first grid 
line will be drawn. 
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A few Grid Option comparisons follow, but you are encouraged to experiment with grid settings to familiarize 
yourself with the effect each option has on the data display. 

Using Grid Options with the Print Options, you can 
very closely match chart recorder output: 

Note  The standard (“clinical”) ECG uses a grid with 
major divisions of 0.2 sec on the horizontal 
and 0.5 mV on the vertical, and minor 
divisions at one-fifth of that, or 0.04 sec 
horizontal and 0.1mV vertical. 

 

Grids On/Unlocked with Scale increased 2x Grids On/Locked with Scale increased 2x 

 
Grids On/Locked using start/end point adjustment 
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Grids On/Locked using middle point/range adjustment 
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Chapter 12 File menu commands 

 
Most File menu commands are standard menu items that follow the standard Windows conventions. 

New 

In almost all cases, you will need to create a new graph window before beginning an acquisition so that the data may 
be displayed on the screen. To create a new graph file, choose File>New. A new graph window will be generated 
similar to the one pictured. 
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You can modify any of the window parameters, including horizontal scale, vertical scale, window size and position. 
In addition, you can also set the acquisition parameters for sampling rate, number of channels, and acquisition 
length. These settings take effect once an acquisition begins. 

Note Choosing File>New from an open, active graph window generates a new window with the same 
settings as the active window. Choosing File>New when all windows are closed generates a new 
window with the same settings as the last saved window. To generate a new file with the 
application default settings, you must quit and relaunch the BSL PRO application. 

You may also open a new Journal file, which will be linked to and saved with the Graph window.  

To open a new Journal file, click the Journal icon  of the graph window toolbar or choose 
Display>Show>Journal. (Mac: Choose File>Open>Journal). The journal window will open below the graph 
window. 

Open 
The File > Open command generates the standard file open menu, and allows you to open a variety of different file 
formats from the pull-down menu at the bottom of the dialog box. Data can be read in from either text files or 
Biopac Student Lab (PRO or Lesson) files, and can be saved in text, graphic, or binary format. You can view the 
files by type from the following options: BSL PRO (*.ACQ), BSL Lesson (*.Ldd), Text (*.TXT), Graph Template 
(*.GTL), or All BIOPAC Files. The Open dialog points to the last location used by the BSL PRO Open function. 

 
The default display is BSL PRO files (*.ACQ). The File type option you select limits the file listing. If “Text” is 
selected, only text files are listed; if “GraphTemplate” is selected, only BIOPAC graph template files are listed. If 
“All BIOPAC Files” is selected, all files in formats that BSL PRO can open are listed. 

BSL PRO files (*.ACQ) 
The default file format (.ACQ) is referred to as a “BSL PRO” file. BSL PRO files are stored in the compact .ACQ 
format that retains information about how the data was collected (i.e., for how long and at what rate) and is the 
standard way of displaying waveforms in BSL PRO. BSL PRO files are editable and can be modified and saved, or 
exported to other formats using the Save as command. 

When you open a BSL PRO file, only the graph window will be displayed by default. To display the Journal that is 
associated with the file:  

PC: Click the icon of the toolbar display or choose Display>Show>Journal. 

Mac: Choose File>Open>Journal. 

BSL Lesson files (*.Ldd) 
BSL PRO can open lesson files generated in the Biopac Student Lab program. When BSL Lesson files are opened, 
they mimic the “Review saved data” mode of the Student Lab such that the data and journal files are both opened 
and properly positioned. If you open and make changes to a BSL Lesson file in BSL PRO, you cannot save as a 
Student Lab file. You must save the new file in the BSL PRO format or alternate format. 
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Text files (*.TXT) 
Text files are a useful way to transfer information between applications. BSL PRO can both import and export text 
files. Most spreadsheet and statistics programs are capable of importing or exporting data in a text file format. 

BSL PRO assumes that the text file to be opened contains numeric data laid out in columns and rows, and that there 
is some delimiter between each column. It also assumes that each column represents a distinct variable or channel of 
data. Normally, the values in each row represent the state of each variable at different points in time. When a text 
file is opened, the numeric values will be plotted as waveform data in a standard graph window and non-numeric 
values will be ignored. Each column of data is read in as a separate channel. 

IMPORTANT! Files saved with headers store the header information on the first line and start data on the second 
line (not the first). The Read Text Options default reads from Line 1 to the end, so you should adjust the line number 
if the file has a header. 

Text Options 
When the “Text files” option is selected, an Options button will be activated in the Open dialog. Clicking on this 
button generates a Read Text Options dialog box that allows you to control the amount and type of data to be read 
in, as well as the time scale for data display. 

 
Read Text Options : File > Open > *.TXT > Options… 

Read line This entry controls how much data is read in and indicates which row contains the first data 
point in the series. By default, text files will be read in starting at line one. 

To End/Line By default, text files will be read until the end of the file is reached. You may want to set it 
to another value since some applications (usually spreadsheets) generate a “header,” or text 
information at the top of a file. You can limit the amount of data read in by clicking next to 
line and entering a value in the box that is activated; the value in this box indicates the line 
to end the data on. 

Set to You can control the horizontal scale (usually time) for the text file after it is displayed in 
the graph window by changing the interval between sample points, which can be expressed 
either in terms of time or frequency. 

For example, if data were collected at 50 samples per second, there is an interval between 
sample points of 0.02 seconds. The BSL PRO software would then assume that there is a 
0.02 second “gap” between the data point in row two and the data point in row three (and 
all subsequent pairs of adjacent rows). Likewise, if you have a data file that spans 10 
seconds and has 100 rows of data, the interval between sample points will be 0.01 seconds. 

Most files contain time domain data, although some applications generate frequency 
domain data (the results of a spectral analysis, for example). The principle here is the same 
as with time data, that there is some interval between different frequencies. If a text file 
contains 20 sample points covering the range between 0 and 60 Hz, then the interval would 
be set to 3Hz per sample. 

Column 
delimiter 

This setting determines what characters indicate a “gap” between two columns. All text 
files must have some sort of column delimiter, unless there is only one channel of data 
present. This can be set to tab, comma, space, or auto. 

Tab Tab delimited text files are the most common, and in this type of text file a tab is placed 
between each column for every row of data. These files are most often generated by 
spreadsheets and similar packages. 

Comma Comma delimited files place a comma between each column of data for each row, much 
the same way as a tab delimited file. These types of files are frequently created by statistics 
programs such as BMDP and SAS. 
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Read Text Options : File > Open > *.TXT > Options… 

Space Space delimited files are also commonly created by statistics packages, and place some 
number of spaces (usually two) between each column of data for every row which contains 
information. 

Auto If you are not sure which delimiter to use, select Auto and the BSL PRO software will 
automatically select a delimiter. 

Note: When either Tab or Comma is selected, the software will read in a new column each time 
it sees a delimiter, even if there are no numeric values between delimiters. For example, the 
following text file will read in three channels of data, although the channels will be of 
different lengths:  

0.301424, 0.276737, 0.045015 

0.338723, 0.808811, 0.542627 

0.354271, 0.506313, 0.715995 

0. 001325,, 0.762115 

0.946207,, 0.894992 

0.926409,, 

Sample text file 
The first channel will contain six data points, the first being 0.301424 and the last value 
being 0.926409. The next channel will contain three data points, starting with 0.276737 and 
continuing through 0.506313 (the software considers that there are no other data values for 
the second channel; notice the double commas). The third channel will contain five data 
points, starting with 0.045015 and ending with 0.894992. 

 
Graph Template files (*.GTL) 
 Sample graph template files are included with the BSL PRO installation — see page 7265. 

The Graph Template option allows you to open a file that contains master settings. Graph template files are 
master files that open to previously saved window positions and setup parameters (as established under the MP36/35 
menu). 

When a Graph template file is opened, the graph window does not contain any data. The journal window can contain 
text saved with the template. The Journal display will use the default Tab setting, so you may need to adjust Tabs 
under File > Preferences > Journal. 

After acquiring data using a graph template, the Save As option must be used to save the data. 

 
 

This feature is especially useful for recreating protocols in the classroom. Instructors set up an experiment and save 
it as a Graph template and then set the Read-only attribute in the file Properties dialog. Students then simply open 
the Graph template file and click the Start button. See the Save As Graph template section for more details.  

File Compatibility  

MP45 users—When a file is opened (*.acq or *.gtl), the application will not check for channel 
compatibility until Start is pressed. This allows one to analyze files without being interuppted by 
incompatibility warnings that are not relevant to analysis. 

After Start is pressed, the following compatibility warnings may be generated: 

For example when the BSL PRO sample file “4Channel.acq” is open and Start is pressed: 
The file was created for an MP3X. You are using an MP45, so some parameters must be converted in 
order to record data. Data viewing and analysis functions will not be affected. Is this what you wish to do? 
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After OK is clicked:  
The file contains channels that require an MP3X. If you click “OK” to record with an MP45, existing data will be 
overwritten. 

 
After OK, CH 1 and CH 2 will be acquired and displayed, but CH 3 and CH 4 are not available. 

 
Open for Playback 

Opens Playback mode, which will will replay a graph file stored on disk in real time to 

simulate acquisition. For an explanation of Playback, see page 56. 

 

Close 

You can close the active window without quitting the application by selecting Close from the File menu. 

Alternately, you can click in the  in the upper right corner of the window or use the Ctrl-W keyboard shortcut. 

 

Save 

This menu item will save any changes you have made to a file. This includes changes to the Journal, markers, 
measurements, etc. If more than one file is open, this command only applies to the active window. For untitled files, 
you will be prompted to name the file you wish the data to be saved in. 

The file will remain open after you have saved it, allowing you to continue working. The Graph and Journal are both 
saved when Save is selected. By default, all files are created and saved in the BSL PRO file format, a proprietary 
format used to store binary data. 

Saving a file saves the setup parameters (established under the MP36/35 menu) and window positions, including the 
Journal window. 

Save As… 

Choosing Save As… produces a standard dialog box that allows you to set the format and location to save the data 
in. The Save As dialog points to the last location used by the BSL PRO software Save/Save As function. All Save 
features apply to the Save As function. You can use Save As to save a file to a different file name or directory than 
the default settings. 

 
The default file format for the Save As… command is to save data as BSL PRO (*.ACQ) files. The other options are 
to save data as a Text file (*.TXT), a Metafile (.WMF), or a Graph Template (*.Gtl). These options can be selected 
from the pop-up menu at the bottom of the dialog box. 

As a rule, saving a file in the BSL PRO format saves data in the most compact format possible and takes up less disk 
space than other file formats. Except in exceptional cases, you will save graph windows in the BSL PRO format. 
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BSL PRO files (*.ACQ) 

Selecting *.ACQ from the pop-up menu in the Save As… dialog box will save a file as a BSL PRO file, which is 
designed to be as compact as possible. These files can only be opened by BSL PRO software, but data can be 
exported to other formats once it has been read in. 

Option button 
When you Save As a BSL PRO (*.ACQ) file, an Option button is 
enabled in the Save As dialog box. Click the Option button to 
generate a Save Options dialog that allows you to control how much 
data is saved. 

 
Text files (*.TXT) 

Data from BSL PRO graphs can also be saved as text files through the 
Save As… dialog box.  

IMPORTANT! The Save As Text option will only save the graph 
data as text, you will lose all journal data. If you have journal data 
you want to save, you must first save the journal as a separate text file 
with a unique filename using the Save As option on the Journal 
Toolbar. Then save the graph data using the Save As Text option. 

Options button 
When you Save As a Text (*.TXT) file, there is an Options button in the Save As dialog box. 

Click the Options button to generate a Save Options dialog that allows you to control how much data is saved and 
the format it is saved in. 

 

Save Options : File > Save As > *.TXT > Option… 

Include header Includes a  “header” on the first line of the text file that contains information about the sampling 
rate, number of channels, date created, and other information relating to the data. This 
information is frequently useful, but some programs will attempt to read in the header 
information as data, which could result in nonsensical results. You may wish to include the 
header as it can always be edited out later using a text editor or the journal. With this option, data 
starts on Line 2. 

Selected 
section only 

Allows you to save only a portion of the data file. This saves the area selected with the I-beam 
tool from all channels as another file and will not affect the current file that you are working in. 
This is useful for saving a brief segment of a long file.  

 When only one data point is selected, the entire file will be saved. 

 If you want to save only a portion of the selected channel, you can either remove 
other channels or copy the data through the clipboard (see page 7196 for more 
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Save Options : File > Save As > *.TXT > Option… 

information). 

Horizontal 
scale values 

Allows you to include the horizontal scale values in the text file, along with the data to be 
saved. This allows you to produce time series plots in other applications, as well as correlating 
events to time indexes in graphing and statistical packages. Since a separate row is generated for 
each sample point, it is possible to exceed the limitations of programs if data is collected at a fast 
sampling rate (many spreadsheet programs are limited to about 16,000 rows). See page 7217 for 
information on resampling data after an acquisition is completed. 

Column 
delimiter 

Controls the type of delimiter used to separate columns of data in the text file. When data is 
saved as a text file, each channel of data is saved as a separate column, with the number values 
for each data point saved in rows. Select tab, comma, or space from the delimiter menu. By 
default, a tab is placed between each column for every row of data. This format is called a tab-
delimited text file and almost all applications will read in tab-delimited text files. 

Metafile (*.WMF) 

In addition to graph and text files, the BSL PRO software also supports formats for saving graphical 
information —Windows Metafile (.WMF). Most drawing, page layout, and word processing programs 
can read .WMF files. This is particularly useful for writing reports. A .WMF file can be opened in any 
standard drawing program and can then be embellished or used to highlight any particular phenomena of 
interest.  
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When data is saved as a graphic, only the data currently on the screen is saved. So, if you have a data file that spans 
eight hours but only two minutes is displayed on the screen, only two minutes of data will be converted to a graphic 
file. To save data in this format, choose .WMF from the pop-up menu at the bottom of the Save As dialog box. 
Since BSL PRO uses information about the computer screen in creating the graphic file, the default resolution of the 
file will be the same as the window. Most word processors and graphics packages allow for some way to resize and 
scale graphics. 

 
Graph Template (*.GTL) 
The Save As Graph template option saves the setup parameters (established under the MP36/35 menu) and 
window positions, including the Journal window. Any windows and controls (such as Input Values, Triggering 
Setup, and Output Control) that were active when the Graph template was saved will retain the same positions and 
settings when the Graph Template is reopened.  

IMPORTANT! Saving as a Graph Template does not save any data – it only saves the setup parameters and 
window positions. You must select Save / Save as to save the graph and/or journal data. 

When a Graph template file is opened, it does not contain any data. After data acquisition, the Save option will not 
be selectable; you must use the Save As option. This feature can be especially useful for recreating protocols in the 
classroom. Instructors can set up an experiment and save it as a Graph template and then set the Read-only attribute 
in the file Properties dialog., and then students can simply open the Graph template file and click the Start button. 

When this feature is used with the menu.dsc customization feature (on page 759) it is easy to create your own 
personal lessons in addition to those featured in the Biopac Student Lab Manual— see page 758. 

  

This is an example of a 
Windows Metafile (.WMF) file 
that was copied to the 
clipboard, pasted into this Word 
for Windows document and 
resized to better fit this page. 
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Matlab File 
(*.MAT) 

MATLAB® format—Uses the “MAT-file” binary format to save numerical and textual 
information as Filename.mat. 

Windows™ and Mac™ create MATLAB Version 6 files, which are compatible with both 
MATLAB Version 6 and MATLAB Version 7. 

Interoperability with earlier versions of MATLAB is not guaranteed. 

The following variables will be in the workspace when the file is opened in MatLab. 

data Contains the data of the graph in floating point format, for all of the 
channels of the array. The first dimension of this array is the amount of 
data in each channel, the second dimension increments with each 
channel. Therefore, each row contains a full channel of data that can be 
accessed in MATLAB via data (1:length). 

units This string array contains the textual representation of the units of the 
samples stored in data, with one element per channel of data. 

labels This string array contains the labels of each of the channels, with one 
element per channel. 

isi This floating point array of one element gives the number of units of a 
single inter sample interval of the data. 

isi_units This single string array provides a units string for a single unit of isi. 
Time data will always be “ms,” frequency data will always be “kHz,” and 
other values will be represented by an Arbitrary horizontal axis type in 
an ACQ graph. 

start_sample Contains the time offset of the index 0 sample of data in isi units. This 
will be 0 for many graphs, but if only a selected area of a graph was 
exported into the MAT file, the start_sample will contain the offset from 
the original data corresponding to the start of the data array in the MAT 
file. 
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Print 

 

The Print menu generated by 
the BSL PRO software is 
similar to the standard 
computer print dialog but 
contains two additional “Print 
Options” that add functionality. 
These two Print Options apply 
only to graph windows; they do 
not apply to journals. 

 
 

Print __ plots per page  Allows you to control how many plots appear per page when the file is printed. Printing 
more than one plot per page has the effect of “snaking” graphs on a page much the same way text appears in a 
newspaper. This option allows you to print records on considerably fewer pages than standard printouts, and is most 
effective when only a few channels of data are being printed. 

 For example, if this option was selected so that two plots were printed per page, the BSL PRO 
software would divide the amount of data to be printed on that page into two graphs — one graph 
printing at the top of the page, the second graph printing at the bottom of the page.  

Fit to __ pages  Allows you to print the contents of a window across multiple pages by dividing the amount of data 
on the screen (the amount of data to be printed) by the number of pages entered in the dialog box. The graph on the 
screen is then printed across the number of pages specified. 

 

Using Grid Options with the Print Options, you can very closely match chart recorder output: 
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Printer Setup / Page Setup 

Choosing Printer Setup (PC) or Page Setup (Macintosh) produces a standard printer setup dialog box that allows 
you to setup any available printers. All the options in this dialog box function as described in your system manual. 

 
There is also a Properties button that allows you to make several printing adjustments with respect to fonts, image 
orientation, and graphics presentation. 
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Preferences... 

 
The File>Preferences command displays a sub-menu with three options: General, Journal and Markers. 

Each option generates its respective Preferences dialog. 

 

The File>Preferences submenu may also display an option 
for Output Control Preferences, but only if an output control 
is active. See Output Control on page 7118 for more 
information. 

 
 

General Preferences 
Selecting File>Preferences>General generates a Display 
Preferences dialog that allows control of measurement and 
waveform display, and other BSL PRO features. 

File > Preferences > General: Display Preferences Dialog 

Measurement 
Options 

Measurement Options allows control of the measurement boxes for each channel at the top 
of the graph window.  

Show X 
measurement rows 

Controls how many measurement rows are displayed in the window at any one time. By 
default, this is set to “1” but may be set to any value between 1 and 8 by choosing a 
number from the pull-down menu. When you change this setting, all the current 
measurement values are cleared (set to "None"). (Note: To Show or Hide the measurement 
rows altogether, toggle the option in the Display > Show > Measurements menu. See 
page 7245 for more information.) 

Show X digits of 
precision 

Allows control of the precision with which measurements are displayed. The default is 6 
digits, but precision can be set to any value between 1 and 8 by choosing a number from 
the pull-down menu. This option controls the number of digits displayed right of the 
decimal place for all visible measurement windows. For instance, if this value is set to 3, 
one measurement window might show 125.187 while another reads 0.475. 

When the precision is changed, the value will be rounded up or down based on the selected 
data value. The precision does not alter the data file. For example, if the selected data value 
is 0.00480000, 4-digit precision will display 0.0048, 3-digit will display 0.005, and 2-digit 
will display 0.00 (not 0.01 which would be a round-up from 0.005 rather than from the 
selected value of 0.00480000). 

Waveform Display 
Options 

These options control how waveforms are displayed on the screen. 

Draft mode 
for compressed 
waves  

Allows for some (“compressed”) waveforms to be plotted in “draft” mode, which results in 
faster plotting time, although the display is not exact. A waveform is considered 
compressed when more than three sample points are plotted per pixel on the screen. 

For example, on a display that is 800 pixels wide, a compressed waveform would be any 
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File > Preferences > General: Display Preferences Dialog 

type of waveform displaying more than 2400 samples on the screen at any one time. Using 
the default horizontal scale (which plots eight seconds of data on the screen), any data 
sampled at more than 300 samples per second would be considered “compressed.” 

Enable tools during 
acquisition 

Activates the selection, I-beam, and zoom tools during an acquisition. The default is to 
disable these tools during acquisition. Use of tools during an acquisition may create display 
problems. It is recommended that you only turn on tools for very slow acquisitions. 

Update screen 
interval 

The Update screen interval option lets you adjust the rate that the screen is updated, 
which can be useful when you have a large data file (as in sleep studies) and you want to 
quickly jump through the data. 

Full, Half or Quarter 
page 
at a time 

You can set the interval to update in full page, half page, or quarter page increments. Click 
in the circle next to the desired interval in the “Update screen interval” section and the 
screen will update in the selected interval when you scroll through the data using the the 
horizontal scroll bar. 

 TIP Right-click in the Horizontal Scale region and choose the desired screen interval 
from the menu. 

Other Options There are four “Other Options” at the bottom of the dialog. The first two options control 
the amplitude (vertical) axis after data has been transformed (e.g., filtered or 
mathematically operated on). Neither option affects the horizontal axis. 

Autoscale after 
transformations 

Automatically rescales all waveforms after a transformation to provide the “best fit” along 
the amplitude axis. 

Tile after 
transformations 

Tiles all visible waveforms after any transformation, and is mutually exclusive of the 
Autoscale command. Waveforms appear to be stacked on top of each other. 

Use all available 
memory 

Attempts to use all the available memory for loading data. Otherwise, a variable sized 
buffer is used to load portions of large data files. This option works best if there is enough 
free memory to load the entire data file. 

Interpolate pastings Interpolates/extrapolates time base data to fit the sample rate of the destination window 
when working with data sampled at two different rates. 

Note  When you Interpolate pastings, you should copy data to a higher 
resolution window. Although it is possible to copy data in the other 
direction (from high resolution to low resolution), it is not recommended 
since some resolution will be lost in the process. 

For example, if you have one 30-second waveform sampled at 50 samples per second, and 
another 30-second waveform sampled at 2,000 samples per second, you can copy the 
contents of one window into another using the insert waveform command. This will 
interpolate one waveform so that both appear to be 30 seconds long. In this example, data 
would be copied from the 50 Hz (low resolution) window to the 2,000 Hz (high resolution) 
window. 
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Journal Preferences 

Selecting the Journal option in the File > Preferences menu generates a dialog that allows you to control 
the format of data when it is displayed in the journal. 

The Tabs and Font selections will be used to display and print the Journal and will be applied to all text 
within all open Journal windows (they are global application settings rather than file specific settings). 

 
 

File > Preferences > Journal: Journal Preferences Dialog 

Tabs The Tabs setting specifies the number of inches between tabs. The Journal display may or 
may not appear accurate, but tabs will be accurate for printing. 

Change font 

 

You can specify the font to use for journal text display. This button leads to the standard 
font dialog. 

Measurement paste 
options 

 

Include the 
measurement name 

Pastes the measurement name (i.e., BPM, delta T, Freq, and so forth) along with the values. 

Include the 
measurement units 

Pastes the measurement units (i.e., volts, mmHg, and so forth) after the numeric values. 

Include the channel 
number 

Includes the channel number at the top of each column of data. 

Put each 
measurement on a 
separate line 

Uses separate lines in the journal/clipboard. 

Wave Data Paste 
Options 

 

Include time values 
option 

Copies the horizontal scale values along with the waveform data when data is copied to the 
clipboard. This means that when you paste data from the BSL PRO screen into a 
spreadsheet or similar application, horizontal scale information is retained. 
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Marker Preferences 

Selecting the Marker option in the 
File > Preferences menu 
generates a dialog that allows you 
to control the options for markers. 
There are four tabs of settings options in the Marker Preferences dialog: Append Markers, Events 
Markers (Fixed), Event Markers (Sequential), and Journal Summary. For information about using 
Markers and setting Marker Preferences, see page 7172. 

 
Go To 

Selecting the FileGo To will bring up menu options to switch between BSL Lessons or PRO, or to launch the 
Startup Wizard. 

 
 
 

Quit 

Selecting Quit from the File menu exits the 
BSL PRO application and prompts you to 
save any open graph or journal files that have 
been modified since they were last saved. 
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Chapter 13 Edit menu commands 

  
One of the most useful features in the Biopac PRO software is the ability to edit and work with data by cutting 
sections and copying sections from one window to another. The Edit menu contains options that allow you to work 
with data much as a word processor lets you work with text. 

Undo 

With some exceptions, the Undo command will undo the last command carried out by Biopac Student Lab PRO 
software. This allows you to restore data that was unintentionally deleted or modified. The Undo command applies 
not only to editing commands, but also to transformations (such as digital filtering and mathematical operations). 
When Undo is enabled, it will list the command it can undo, such as “Undo Paste.” When a command can’t be 
reversed, the Undo option will read Can’t undo. 

 
Can’t Undo 
There are some exceptions to the Undo command, and you should be aware of them before you choose to use any 
command. The following commands cannot be undone: 

 Display options (i.e., changing the horizontal scale or changing the color of a waveform) cannot be 
undone, since they are easier to manipulate and less drastic than cutting data out of a waveform. If 
you modify the screen scale (or other display parameters) you will still be able to undo your latest 
data modification, which is much more difficult to recover than a screen parameter change. 

 Clear All cannot be undone. It is a good idea to make backup files before performing any editing, 
especially when using this command. 

 Remove Waveform cannot be undone. It is a good idea to make backup files before performing any 
editing, especially when using this command. 

 Insert Waveform cannot be undone, but selecting the inserted channel and choosing Remove 
Waveform from the Edit menu effectively undoes this operation. 

 Rewind button cannot be undone. 

 TIP If you accidentally remove a waveform or choose clear all, one way to recover the data 
is to close the file without saving the changes. The data file can then be reopened as it was 
when it was last saved; any changes made since it was last saved will be lost. 
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Cut 

When Cut is selected, the selected (highlighted) area of the active channel (waveform) is removed and copied to a 
clipboard, where it is available for pasting into other waveforms. When a selected area is cut from a waveform, the 
data shifts left to “fill in” the deleted area. So, if ten sample points are cut, all data after the selected area will be 
shifted ten sample points to the left. 

 TIP The Cut function alters the relationship of events to the time base, so you might want to 
consider alternatives to cutting sections of data. Other options include transforming the 
section of the data using smoothing, digital filtering, or the Connect Endpoints functions. 

 
Area selected using editing tool 

 
Same data with selected area deleted. Note that data  
after the selected area has shifted forward in time. 

 

Copy 

Choosing Copy will copy the selected area of a waveform to the clipboard without modifying the waveform on the 
screen. Once the area has been copied, it can be inserted in another waveform using either the Paste or the Insert 
Waveform commands. To copy a waveform to another channel in the same graph window, choose the Duplicate 
Waveform command. 

 

Paste 

The Paste command will take the contents of the clipboard and paste it into the currently active channel at the cursor 
point. If no point is selected, the data will be pasted at the beginning of the waveform. 
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Clear 

The Clear command works much the same way as the Cut command, with the key difference being that data is not 
copied to the clipboard. This function deletes the selected area from the selected channel only. If the entire 
waveform is selected (as with the Select All command), the Clear command will delete all the waveform data and 
leave an empty channel. As with the Cut command, the Clear function operates on only one channel, and when a 
portion of the waveform is cleared, the remaining data will shift left. If multiple channels of data are present, one 
channel will be “shorter” than the others. To remove a selected area of data from multiple channels, use the Clear 
All command. 

 

Clear All 

Choosing Clear All will delete the selected area from all channels. This is similar to the Clear function in that data 
is removed and is not copied to the clipboard. The Clear All command, however, removes a section of data from all 
waveforms, not just from the selected channel. 

 When Select All is chosen prior to performing the Clear All function, all waveform data for all 
channels will be deleted. 

 The Undo command does not work for Clear All. 

 

Insert Waveform 

The Insert Waveform command is useful for copying a waveform (or a section of a waveform) from one window 
to another. To do this, first select the area to be copied using the cursor and the Copy command. Next open the 
graph window you wish to insert the waveform into; it is possible to insert the waveform into the same graph it was 
copied from, although the Duplicate Waveform is a more straightforward way to do this. Once you have selected 
the graph you wish to insert the waveform into, choose Insert Waveform from the Edit menu. A new (empty) 
channel will then be created and the data will be copied into the empty channel. 

The new channel will always take on the lowest available channel number. 

 The Undo command does not work for Insert Waveform, but selecting the inserted channel and 
choosing Remove Waveform from the Edit menu effectively undoes this operation. 

 

Duplicate Waveform 

Choosing Duplicate Waveform will create a new channel in a graph window and copy an entire waveform (or a 
selected area) to the new channel. When a portion of the waveform is selected, only the selected area will be 
duplicated. To duplicate the entire waveform, choose Select All and then select Duplicate from the Edit menu. 

 TIP Right-click a waveform and select Duplicate from the pull-down menu.  

 

Select All 

When Select All is chosen from the Edit menu, the entire selected channel is highlighted. For almost all commands, 
when a waveform is selected using Select All, subsequent operations apply to the selected channel only. The 
exception is when Clear All is chosen after Select All. When this occurs, all data from all waveforms will be 
deleted. 

 

Remove Waveform 

The Remove Waveform command deletes the entire selected waveform, regardless of what other options are 
selected. 

 The Undo command does not work for Remove Waveform. 
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Clipboard 

 
Each clipboard command involves copying data from the Biopac Student Lab PRO to the standard Windows 
clipboard, where the contents of the clipboard are made available for other applications. Data can be copied to the 
clipboard in two formats: alphanumeric and graphic. The Copy Measurement and Copy Wave Data commands 
save information to the clipboards in text/numeric format, whereas the Copy Graph transfers the image on the 
screen to the clipboard in .WMF graphic format. In either case, transferring data through the clipboard allows you to 
copy data to other applications even after you have closed the graph window and/or quit the Biopac Student Lab 
PRO. 

 
Copy Measurement 
Copies the contents of all visible measurement pop-up menus, along with the values associated with these windows. 
By default, three windows are displayed (on most monitors); you can change this by increasing or decreasing the 
width of the window. Once the measurements have been copied, they can be pasted into any application that allows 
paste functions, including word processors, drawing packages, and page layout programs. A sample of 
measurements pasted from the BSL PRO into a word processor follows: 

BPM = 85.714 BPM delta T =  0.700 sec p-p = 0.8170 Volts 

 
Copy Wave Data 
Copies wave data (in numeric form) for all channels into the clipboard and includes a header line. When an area is 
selected, only the data in the selected area will be copied to the clipboard. For example: 

Hand Dynamometer EMG 

-0.0293386 -0.0228271 

-0.0579655 -0.0170898 

When multiple channels of data are copied to the clipboard, the data is stored in columns and rows, with data from 
each channel stored in a separate column with the channel label as the header for each column. For a four-channel 
record, four columns of data will be copied to the clipboard. 

As with a text file, the BSL PRO software will insert a delimiter between each column of data. The default delimiter 
is a tab; you can change the delimiter to either a space or comma in the Options dialog of the File > Save as Text 
option (see page 7184). 

Transferring data through the clipboard performs essentially the same function as saving data as a text file (using the 
File > Save As command), with the obvious exception that transferring data through the clipboard does not save 
data to disk.  

Once the data is stored in the clipboard, it can be pasted into virtually any application. 
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Copy Graph 
Copies the graph window as it appears on the screen to the clipboard, where it is stored in Windows Metafile format. 
The graph label and any associated markers, if displayed via Show > Markers, will also be copied to the clipboard. 
You can then place the graphic into a number of different types of documents, including word processors, drawing 
programs, and page layout programs. Windows Metafiles are common to almost all applications, and images saved 
in these formats can be edited in most graphics packages and many word processors. 

Using the Copy Graph function is similar to saving a graph window as a Windows Metafile (using the File > Save 
As command), except that using the File > Save command writes a file to disk, whereas transferring data through 
the clipboard does not save a file. 
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Journal 

 

 
The Journal sub-menu has two options: Paste measurement and Paste wave data. Both options are similar to those 
found in the Clipboard menu. The key difference is that data (whether measurements or raw data) is pasted directly 
into the journal rather than copied to the clipboard. 

Paste Measurement 
Choosing Paste Measurement will cause all visible measurement windows to be pasted into the journal. 

 Measurement names and values are pasted into the journal in columns using the Tab spacing 
specified in the File > Preferences > Journal dialog (see page 7191). 

 Use the Preferences > General dialog (see page 7189) to change the number of measurement rows 
displayed (and therefore, available for pasting) or the measurement unit precision. Note that when 
you change the number of rows displayed, all current measurement settings will be cleared (set to 
"None") so you should establish the number of rows required prior to selecting measurements.  

 
Measurements for “peak-to-peak” from CH 1 and “delta t” 

from CH 2 pasted from the open graph to the journal 

Paste Wave Data 
The Paste Wave Data option converts the selected area of the waveform to numeric format and pastes it into the 
journal in standard text file format. This will paste the selected area from all channels, not just the selected channel, 
and will place a delimiter between the columns when two or more channels are being pasted to the journal. By 
default, tab characters are used to separate columns; you can change to comma or space delimiters in the File > Save 
As > Text Options dialog. See the Save As…Text section on page 7184 for more information on how to change the 
column delimiter. 

 
Wave data (from the previous wave sample) pasted from the open graph to the Journal
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Chapter 14 Transform menu commands 

 
The Biopac Student Lab PRO provides a number of options for post-acquisition analysis and transformations. 
These transformations allow you to perform a range of operations on data, from digital filtering and Fourier 
analysis to Math Functions and histograms. All of these options can be found under the Transform menu, and 
are disabled while an acquisition is in progress. Unless otherwise noted, all of the transformations described here 
apply to the selected channel only. Some options (the Expression and Math functions) allow you to specify a 
channel (or channels) to be transformed. 

It is important to remember that the BSL PRO software is always selecting at least one point. When a section of 
a waveform is highlighted, the transformation will apply to that section. If no area is defined, the BSL PRO 
software will always select a single data point. Some transformations can operate on a single sample point (e.g., 
Math Functions, Waveform Math), and will transform a single sample point when only one is selected. Other 
transformations can only be performed on a selected area (spectral analysis and digital filtering, for instance), so 
if a single point is selected the entire waveform will be transformed.  

There are two ways to apply a transformation to an entire waveform. 

a) The first method involves selecting an entire waveform using the Edit > Select all command prior to 
selecting the transformation. This will work for all of the transformation functions, and is the only way to 
apply a transformation to an entire waveform for functions that do not produce a dialog box (e.g., Math 
functions, Integral). 

 

b) The second method can be used for any transformation that does produce a dialog box (e.g., Digital filters, 
Expression, FFT). These dialog boxes allow you to check a box (located toward the bottom of each dialog 
box) that will transform the entire waveform (regardless of whether a single point, area, or the entire 
waveform is selected). 
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Examples of “entire wave” option in Transform menu dialogs 
The table below groups the transformation functions into four general families or clusters. The Isolation 
functions perform “data cleaning” in that they perform some sort of filtering or data reduction tasks. The 
Calculation/Math transformations perform calculations or other mathematical operations on the data. The 
Search functions allow you to search though the data, either for peaks or patterns of data. The Summary 
functions provide graphical summaries of the data, either in terms of the frequency spectra of the data or the 
measures of central tendency and dispersion of waveform data. 

RAW DATA 

Isolate data  
Smoothing  
Digital Filtering 
Resample 

Calculation/Math  
Expression  
Waveform Math 
Math Functions 
Difference 
Integrate  
Derivative  
Integral 

Search  
Peak Detection Functions 
 Find peak 
 Find Next Peak
 Find All Peaks 
Template Functions 
 Set Template 
 Remove mean 
 Convolution 
 Correlation 
 Mean Square Error 
 Inverse MSE 

Summary  
Histogram 
FFT  
Find Rate 

BSL PRO Transformation Functions 
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Digital Filters 

There is a fair amount of arcane terminology and theory surrounding the use and implementation of digital 
filters. For a general overview, see Appendix D — Filter Characteristics. 

Two types of post-processing filters are available under the Transform > Digital filters submenu: FIR (finite 
impulse response) filters and IIR (infinite impulse response) filters. 

 
FIR  filters are linear phase filters, which means that there is no phase distortion between the original signal 
and filtered waveforms. 

IIR  filters are not phase linear filters, but are much more efficient than FIR filters in processing data. The 
IIR filters are useful for approximating the results of standard biquadric filters of the form: 

z)ys(xs

c)bs(as
2

2




 

IIR filters can be used to mimic filters commonly implemented in electronic analog circuitry and are also used 
for online filtering. 

FIR Filters 

To access the FIR filter dialog box, click the Transform menu, scroll to 
select Digital Filters, drag right to FIR and drag right again for the filter 
options. When you select an FIR filter, the corresponding Digital Filter 
dialog box will be generated, allowing you to specify a number of different 
filtering options.   

In most cases, the default settings are optimal, although specific situations may require different settings. The 
dialog will reflect data for the selected area, for example “50 samples at 50.000 samples/sec.” 

  
 

FIR Digital Filters Dialog 

Window At the top of the dialog box is a Window pop-up menu, which allows you to choose from a 
variety of filtering algorithms. By default, the filter default is set to a “Blackman” type. 
These different Windows (described in detail in Appendix D) allow you to “fine tune” the 
filter response. 

A “window” refers to a computation that spans a fixed number of adjacent data points. 
Window functions are used to eliminate discontinuities that may result at the edges of the 
fixed span of points for the FIR filter. 

Cutoff Frequency The second option is to provide a Cutoff Frequency, or threshold, for the filter function. 

 

Filter Type Default Cutoff Frequency  Cutoff range 

Low-pass 0.125 times the sampling frequency Between 0.0000000001Hz and 0.5 
times the sampling rate 
High pass 0.25 times the sampling rate Between 0.0000000001Hz and 0.5 
times the sampling rate 
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FIR Digital Filters Dialog 

Band-pass low: 0.125 times the sampling rate Any values, but low and high 
 high: 0.25 times the sampling rate cannot be set to the same value 

Number of 
Coefficients 

The Number of Coefficients determines how well the filter will match the desired Cutoff 
Frequency (or range). By default, this is set to 39. Filters that use a small number of 
coefficients tend to be less accurate than filters that use a large number of coefficients. 
Entering a larger value will result in a more accurate filter; however, as the number of 
coefficients increases, so does the processing time required to filter the data. To see how 
changing this value affects the way data is filtered, it can be useful to examine the filter 
response patterns. 

 TIP A good rule of thumb is to use a number of coefficients greater than or equal to 
two times the sampling rate divided by the lowest cutoff frequency specified. For 
example, if running a low pass filter at 1Hz on data sampled at 100 Hz, choose 
at least (2 x 100/1) or 200 coefficients in the filter. Additional coefficients will 
improve the response. 

Show Filter Response The Show Filter Response option instructs the software to produce a plot of the filtered data 
and generates a new graph window for the response plot. You must save the response plot 
separately. 

  

Don’t modify 
waveform 

The Don’t modify waveform option is useful when used with the Show filter response 
option. When both boxes are checked, the software will produce a plot showing the filter 
response, but will not modify the waveform. This allows you to repeatedly specify different 
filter options (without modifying the waveform) until the desired frequency response is 
achieved. 

Filter entire wave 
 

The Filter entire wave option will filter the entire wave and replace the original. 

 If you want to keep the original, you need to duplicate it prior to filtering. 
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FIR Filter example 

 
Comparison of 39 coefficient and 250 coefficient band stop FIR filters  

In the example above, the same data was band stop filtered using a coefficient range of 39 (upper waveform) to 
250 (lower waveform). The data was collected at 500 Hz, and the band stop filter was designed to remove 60 Hz 
noise using a low cutoff of 55 Hz and a high cutoff of 65 Hz. Along the horizontal axis, the units are scaled in 
terms of frequency, with lower frequencies at the left of the screen. The values along the vertical axis are scaled 
in terms of dB/V and indicate the extent to which various frequencies have been attenuated. In both filter 
response waveforms, there is a downward-pointing spike that is centered on 60 Hz. The baseline of the filter 
response corresponds to a value of approximately 0 on the vertical axis, indicating that the signals significantly 
above or below 60 Hz were not attenuated to any measurable extent. 

As you can tell, however, the filter does not “chop” the data at either 55 Hz or 65 Hz, but gradually attenuates 
the data as it approaches 60 Hz. For example, the upper waveform in the filter response plot represents data that 
was filtered using a value of 39 coefficients. The slope is relatively shallow when compared to the lower 
waveform, which represents a filter response performed with 250 coefficients. Although the filter that used 250 
coefficients took slightly longer to transform the data, the filter response pattern indicates that the data around 60 
Hz is attenuated to a greater degree. Also, the 250 coefficient filter started to attenuate data considerably closer 
to the 55 Hz and 65 Hz cutoffs, whereas the default filter began to attenuate data below 55 Hz and above 65 Hz. 

 

IIR Filters 
To access the IIR filter dialog box, click the Transform menu, scroll to select Digital Filters, drag right to IIR 
and drag right again for the filter options. 

 
The IIR filters under the Transform menu are identical to the real-time IIR filters (see the Filter Calculation on 
page 7107) but are applied to existing data, in a post-processing environment. For a more detailed explanation of 
digital filters in general, see Appendix D — Filter Characteristics. 
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Math Functions 

 
You can perform a wide range of mathematical and computational transformations after an acquisition has been 
completed with the Biopac Student Lab PRO. The table on the following pages explains each Math Function. 

Unless otherwise noted, each Math function applies only to the selected area of the active channel. If no area is 
selected (i.e., a single data point is selected) the cursor will blink and the transformation will apply only to the 
selected point. To perform a Math Function on an entire waveform, select a channel and choose Edit > Select 
All. 

If a Math Function is set to divide by zero, a zero will be returned. 

 TIP  For complex transformations involving multiple functions, you may want to use the 
Expression solver (see page 218 for more information on this feature). Many of the 
same functions found in the Math functions menu can also be found in the Expression 
solver. 
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The following table describes the commands available in the Transform > Math Functions menu:  

Math Function Transformation Result 

Abs (Absolute Value) Computes the absolute value of the data. All negative data values are made 
positive, with no change in magnitude. This function can be used to rectify data. 

Result: This calculation will always return a positive result. 

 

ArcTan (Arc Tangent) Returns the arc tangent of each data point in radians. 

Result: This rescales the data such that the range is from -/2 to /2. 

 

Connect endpoints Draws a line from the first selected sample point to the last selected sample 
point and interpolates the values on this line to replace the original data. The 
connect endpoints function is very useful for removing artifacts in the data or in 
generating waveforms. 

In the example below, the “noise spike” in the data is an undesired measurement 
artifact that should be removed. You could cut the section of data, but then all 
subsequent data points would shift left. In order to preserve the time series of 
the data, you could use the connect endpoints command to draw a straight line 
(although not necessarily flat) that connects the two extreme sample points of 
the selected area. 

 
Area selected prior to connect endpoints function 

 
Same waveform after connect endpoints transformation 

 

Result: A straight line of the equation:  

                  ynxyxy i  *)()( 1  

n – number of sample points; 

i – index of points of straight line; 
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Math Function Transformation Result 

1

)()( 1





n

xyxy
y n     

)( 1xy  and )( nxy - the endpoints. 

 

Exp (Exponential)) Computes the function ex, where x is the waveform data and e is 2.718281828. 
This is the base of the natural logarithms. 

 

Limit (Limit data values) ‘Clips’ data outside the range specified by the set of threshold in the limit 
dialog box. This function will prompt you for an upper and lower limit. 

Any data outside these limits will be clipped at the closer limit. 

Although both an upper and lower threshold must be entered, it is 
possible to limit only one extreme (upper or lower) while leaving the 
other extreme unaffected. 

For example, to limit data so that all negative values are set to zero but 
the positive values are left unchanged, you need to set the lower 
threshold to zero and the upper threshold to some other positive value 
that exceeds the maximum value for that channel. 

 

Result: In the range of upper and lower threshold. 

 

Ln (Ln Natural Logarithm) Computes ln x - the natural logarithm of each point of selected area, 
where x- is any positive value. 

 

The inverse of this function is the exponential function (see Exp). 

 

Note: The result for sample points with negative values is zero. 

 

Result: For x <1 – result is a negative value; for x>1 – result is a positive 
value. 

 

Log (Base 10 Logarithm) Computes the base 10 logarithm ( lg x) of selected area, where x – any 
positive value. 

 

Note: The result for sample points with negative values is zero. 

Result: For x <1 – a negative value; for x>1 – a positive value. 

 

In order to perform the inverse of this operation of this function which 

would be
x10 , use the Waveform Math power operator with the constant 

k=10 as the first operand and the waveform data as the second operand. 

 

Noise Converts the selected section into random data values between -1.0 and 
+1.0. This is mainly useful for creating stimulus signals and other 
waveforms. 

 

Result: In the range -1.0 to 1.0 

 

Sin (Sine) Calculates the sine of the selected section. The data is assumed to be in 



  207 

Math Function Transformation Result 

radians. 

 

Result: for 0< x < π -  is positive, 

             For π < x < 2 π – negative.  

 

Sqrt (Square Root) Takes the square root (√) of each data point in the selected section. 

Result: Always a positive number.  

 

Threshold (Threshold data 
values) 

Transforms all data points above the upper threshold to +1 and all points 
below the lower threshold to 0.  

Once the data crosses a threshold it will continue to be set to +1 for the 
upper cutoff and to 0 for the lower cutoff, until it crosses the opposite 
threshold. 

If the initial data lies between the upper threshold (UT) and the lower 
threshold (LT), the output is undefined. 

The most common application of this function is to serve as a simple 
peak detector, the result of which can be used in rate or phase 
calculations. 

 
 

Result: The sequence of 1 and 0 value according to data points. 

 

Note: Real-time Threshold values are +1 and –1 (see page 7106). 

Top: Signal + Noise 

Middle: P-P Noise > UT-LT 

Bottom: P-P Noise < UT-LT 
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Template Functions 

 
The Template Functions are useful for comparing waveforms. All the template functions perform a 
mathematical operation of the template waveform on the waveform to be compared, move one sample forward, 
and repeat the multiplication until the end of the longer waveform is reached. Technically, the template functions 
provide correlation, convolution and mean square error transformations of a template waveform against another 
waveform. 

Note: To determine a level of comparison between two waveforms, use the Correlation 
function. 

Set template 
If you detect an abnormality, you should find out if there are other (similar) abnormalities in the record. To do 
that, you need to select the pattern you’d like to search for, and then compare that pattern to other data sets in the 
file. You can use the Zoom tool to inspect the abnormalities more closely. 

Establishing the template: 

1)  Highlight the section to be used as a pattern. 

2)  Choose Set template from the Transform > 
Template functions submenu. This copies the 
selected portion into a buffer for subsequent 
template functions. 

3)  Select the waveform and position the cursor at the 
beginning of the data. 

4)  Choose Correlation from the Template functions 
submenu. 

 
The center waveform in this graph shows the result of 
the correlation and mean square error functions: 

Note the higher amplitude peaks where the template data 
more closely matches the waveform. The lower 
waveform illustrates the mean square error function, 
which is similar to the correlation function. 

This indicates that there are two abnormal beats in the 
record. The first one appears at about 21 seconds and is 
the one used as a template, the second one appears at 
about 33 seconds. 

 
 
 
 
 
Remove Mean 



  209 

A drifting baseline can be a problem in comparing waveforms. If you perform a Template function and the 
template or the waveform has a slowly moving baseline, you can increase the effectiveness of the comparison by 
choosing Remove mean from the submenu of the Template function. 

This option is toggled every time it is selected and is enabled when a check mark is present. 

The Remove Mean option causes the mean amplitude value of the template and the compared section of the 
waveform to be subtracted from each other before the sections are compared. This way, a large baseline offset 
will have very little effect on the comparison. 

For example, the following graph shows the correlation with and without mean removal: 

 
The original waveform is at the top, the correlated waveform with mean removal is in the middle, and the same 
correlation without mean removal is at the bottom. 

Note how the mean removal effectively compensates for the drifting baseline in the original waveform. 
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Template algorithms 
The template functions employ four algorithms: correlation, convolution, mean square error, and inverse mean 
square error. 

Correlation 
This algorithm is a simple multiplication and sum operation (as shown in the preceding example). The template 
is first positioned at the cursor position in the waveform to be correlated. Each point in the template waveform is 
multiplied by the corresponding point in the data waveform (the waveform to be correlated) and summed to 
produce the resulting data point. The template is then moved one data sample forward and the operation is 
repeated to produce the next resulting data point. The resulting data points replace the waveform to be correlated. 

The correlation function algorithm can be expressed by the following formula, where foutput(n) is the resulting 

data point, ftemplate(k) is the template waveform data points, and K is the number of data points in the template: 

f (n) =  f (k) *  f (n)output template waveform

k = 1

K

  

Convolution 
This function is identical to the correlation function except that the template waveform is reversed during the 
operation. This function is not generally useful by itself, but can be used as a building block for more 
sophisticated transformations. The convolution function algorithm can be expressed by the following formula, 
where foutput(n) is the resulting data point, ftemplate(k) is the template waveform data points, and N is the 

number of data points in the template: 

f (n) =  f (-k) *  f (n + k)output template waveform

k = -N/2

N/2 - 1

  

Mean Square Error 
For this function, the template is first positioned at the cursor position in the waveform to be compared. Each 
point in the template waveform is subtracted from the corresponding point in the waveform to be compared. The 
result is squared and summed to produce the resulting data point. The template is then moved one data sample 
forward and the operation is repeated to produce the next resulting data point. The resulting data points replace 
the waveform. 

The mean square error function tends to amplify the error (or difference) between the template and the 
waveform, which can be useful when you need an extremely close match rather than a general comparison. 
When a match is found, the mean square error algorithm returns a value close to zero. 

The mean square error function algorithm can be expressed by the following formula, where foutput(n) is the 

resulting data point, ftemplate(k) is the template waveform data points, and K is the number of data points in the 

template: 

f (n) =  [f (k) -  f (n)]output template waveform

k = 1

K


2

 

Inverse Mean Square Error 
This function simply inverts the result of the mean square error algorithm. Accordingly, when this algorithm 
finds a match between the template and the data, the algorithm returns the inverse of a value close to zero and, 
typically, a large positive spike will occur at the point of the match. 
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Integral 

The integral function is essentially a running summation of the data. Each point of the integral is equal 
to the sum of all the points up to that point in time. 
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Where: 

 

i - index for source values (1..n); 

j - index for destination values (1..n); 

n - number of samples; 

ix , jx - values of points at horizontal axis; 

 ixf - values of points of a curve; 

 jxF - integrate values of points of a curve; 

1
1





n

xx
x n  - horizontal sample interval; 

1, xxn  - values at horizontal axis at the endpoints of selected area. 

 

Note: 

The first destination point is always 0 value. 

 

The integral function can be used to compute the area under the curve in a continuous fashion. For 
instance, if you had data acquired by an accelerometer, the integral of the data would be the velocity, 
and the integral of the velocity would be the distance. As with all transformations, this function can be 
applied to either a selected area or to the entire waveform. 
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Derivative 

 
Transform > Derivative dialog box 

The Derivative function calculates the derivative of the selected area of a waveform (or the entire waveform if it 
has been selected).  

Window Since high frequency components will give you nonsensical results in a derivative, a low pass 
filtering function is included in the derivative function. Select a Window type from the pull-down menu. 

Cutoff Frequency The value should be roughly equivalent to the highest frequency component of 
interest. (See page 7201 for more information on low pass filters.) 

Don't modify waveform This option is only applicable when Show Filter Response is selected. 

 TIP If the data is already “well behaved” (i.e., low pass filtered or contains little or no high 
frequency information), use the Difference transformation with a 2-sample interval. This 
will provide results very similar to the Derivative function, but will work much faster. 

 

 

 

 

 

 

 

 

Integrate 

The Integrate transformation works the same as the Integrate calculation (see page 794 for formulas) and details. 
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Smoothing 

 
Smoothing  computes the moving average of a series of data points and replaces each value with the mean value 
of the moving average “window.” Smoothing has the same effect as a crude low pass filter, but is typically faster 
than digital filtering. This function is most effective on data with slowly changing values (e.g., respiration, heart 
rate, GSR) when there is noise apparent in the data record. 

Samples To set the size of the window, enter a value in the Transform > Smoothing factor dialog 
box. The BSL PRO software allows you to set the width of the moving average window (the 
number of sample points used to compute the mean) to any value larger than three. By 
default, this is set to three samples, meaning that the software will compute the average of 
three adjacent samples and replace the value of each sample with the mean before moving 
on to the next sample. 

 TIP For data acquired at relatively high sampling rates, set the smoothing 
factor to a higher value, since smoothing three sample points when 
data is collected at 1000 Hz will only average across three 
milliseconds of data, and may do little to filter out noise. 

Mean value 
smoothing 

Mean value smoothing is the default and should be used when noise appears in a Gaussian 
distribution around the mean of the signal. The Mean value smoothing formula is shown 
below: 

 Odd number of samples Even number of samples 
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Where: 

i - index for source values; 

j - index for destination values (1..n); 

n - number of samples; 

ix , jx - values of points at horizontal axis; 

 ixf - values of points of a curve; 

 jxF - integrate values of points of a curve; 

s – number of samples to average across. 

Note 

For points where i<=s, the formula cannot be followed because the indexes of the 
points involved in the calculation are negative and the points with such indexes 
don’t exist. 

 

 

 

 

 

 

Median value 

 

 

 

 

More 
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smoothing Use Median value smoothing if some data points appear completely aberrant and 
seem to be “wild flyers” in the data set. The Median value smoothing formula is 
shown below. 
Odd number of samples to smooth across: 

The Median for odd number of the samples to smooth across is a number in the 
middle of a set of numbers (see formula). 

                            ixF  Median       2/32/1 ,  sisi xfxf  

Where: 

i - index (1..n); 

n - number of samples; 

ix - values of points at horizontal axis; 

 ixf - values of points of a curve; 

 ixF - new values of point of a curve; 

s – number of samples to smooth across. 

 

Even number of samples to smooth across: 

The Median for even number of samples to smooth across is an average of the two 
numbers in the middle of a set of numbers (see formula). 

                             ixF  Median      2/2/2 , sisi xfxf 
 

Where: 

i - index (1..n); 

n - number of samples; 

ix - values of points at horizontal axis; 

 ixf - values of points of a curve; 

 ixF - new values of point of a curve; 

s – number of samples to smooth across. 

 

Note 
For points where i<=s, the formula cannot be followed because the indexes of the points 
involved in the calculation are negative and the points with such indexes don’t exist.  
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Difference 

 
The Difference function measures the difference (in amplitude) of two sample points separated by an arbitrary 
number of intervals. The difference is then divided by the total interval between the first selected sample and the 
last selected sample. 

Intervals The default Difference interval setting is 1 interval between samples. Using the default 
Difference setting of 1 interval will produce a “P/T” waveform when the 
transformation is applied to a blood pressure or similar waveform. 

For data with no high frequency components, a 1-interval difference transformation 
approximates a differentiator. Since it is not implemented as a convolution, it is much 
faster than the derivative. 

 Odd number of samples between the points: 
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Even number of samples between the points:  
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Where: 

i - index for source values(1..n); 

j - index for destination values (1..n); 

n - number of samples; 

ix , jx - values of points at horizontal axis; 

 ixf - values of points of a curve; 

 ixF - new values of points of a curve; 

s – interval between samples. 

Note 

For points where i<=s, the formula cannot be followed because the indexes of the 
points involved in the calculation are negative and the points with such indexes 
don’t exist. 

 

 

Online, real-time Difference is calculated differently because projected values are not available (see 
page 7100). 
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Histogram 

The Histogram function produces a histogram plot of the selected area. When a histogram  is created, the 
sample points are sorted into “bins” along the horizontal axis that contain ranges of amplitude values. These bins 
divide the range of amplitude values into equal intervals (by default, ten bins) and the individual sample points 
are sorted into the appropriate bin based on their amplitude value.  

The Biopac Student Lab PRO software 
then counts the number of “hits” (the 
number of data points) in each bin and 
plots this number on the vertical axis. For 
instance, if a waveform had a range from 
65 BPM to 85 BPM, the lowest bin would 
contain all data points with a value from 65 
BPM to 67 BPM. The second lowest bin 
would hold all data points between 67 
BPM and 69 BPM, and so on, until the 
tenth bin was created. 

 

 

Use manual range to fix the bin sizes and bin range for 
predetermined values. 

By default, the data is divided into ten bins. You can change this by 
entering a different number in the box to the left of bins at the top of 
the Histogram Options dialog box. 

The frequency of occurrence for each bin is displayed on the vertical 
axis. 

 

When Autorange is checked, the software automatically sets the 
center of the lowest bin equal to the minimum value of the waveform 
(or the selected area, if a section is highlighted), and centers the 
highest bin on the maximum value of the waveform (or selected area, 
if any). 

Checking the Autorange option will simply fit all the data selected 
into a bin. The bin sizes are determined by the extent of the data and 
the desired number of lines.  

The BPM and Freq measurements are not available with the Histogram function. 

 TIP To calculate the cumulative frequency, select the entire histogram waveform and choose 
Integrate from the Transform menu. 

 TIP Since the Histogram function sorts sample points into a relatively small number of 
categories, the histogram window is likely to display a large number of “hits” in each bin, 
especially if data was collected at a relatively fast sampling rate. If this is the case, you 
may want to resample the data at a lower rate (using the Transform > Resample 
function described below). The caveat to this is that resampling the data may cause a 
bias, unless the data was filtered to remove all frequency components that are more 
than 0.5 the resampling rate. 
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Resample 

 
This function resamples the entire data file to another rate, which can be used to “compress” data files by saving 
the data at a lower sampling rate. 

The minimum rate is based on the total number of samples. 

The highest sampling rate that a channel can be resampled to is the file acquisition rate (as established under MP 
UNIT>Setup Acquisition) 

 TIP  A good rule of thumb is to select a sampling rate at least four times the highest 
frequency of interest for the signal. 

 For example, the alpha component of an EEG signal has a frequency signature of 8-13Hz, so 
(assuming you have isolated the alpha component using a band pass filter) you would 
probably want to sample the data (in this case, isolated alpha waves) at a rate of at least 
52Hz. The acquisition sample rates are limited and you should choose the next highest 
option, or in this case 100 Hz. 

Resampling data maintains the time scale but reduces the number of samples per second. Whenever 
data is resampled to a lower rate, information is lost. 

For instance, a 4-channel data file sampled at 250 samples per second for 15 minutes takes up about 
1.8 MB of disk space. Resampling to 100 samples per second reduces the file size to about 720 KB of 
disk space, a considerable reduction. 
If data is resampled to a lower rate and then resampled again at a higher rate, the waveform will maintain the 
resolution of the lower sampling rate, only with more data points. 

 

Resampling and… 

Interval You can use Resample to increase the number of sample points per interval (usually samples per 
second). When this is done, the BSL PRO software will interpolate between sample points to adjust to the new 
rate. This will add data points — but not necessarily more information. 

 

Exporting If you plan to export resampled data, you should use this method of resampling: 

Select Find peak from the Transform menu. 

Select User defined interval and enter a time period for the new sample rate. 

Set First cursor to Peak. 

Check the Paste measurements to journal option. 

Set the measurements for the channel you want to resample. 

For example, if you set the Value and Time measurements, the software will take those measurements and paste 
the Value and Time results from the resampled channel into the Journal. 

Select OK and place the cursor at the beginning of the data file. 

Select Find all peaks from the Transform menu. 
 

Bias Resampling the data may cause a bias, unless the data was filtered to remove all frequency components 
that are more than 0.5 the resampling rate. 
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Expression 

 

 

 

A post-acquisition Expression transformation is available for performing computations more complex than the 
Math and Function calculation options can manage. The post-acquisition version of the Expression 
transformation includes all the same features as the online version (described on page 7109). The Expression 
transformation will symbolically evaluate complex equations involving multiple channels and multiple 
operations. 

Unlike the Math and Function calculations, which can only operate on one or two channels at a time, the 
Expression transformation can combine data from multiple analog channels, or specify other calculation 
channels as input channels for expression channels. Also, computations performed by the Expression 
transformation eliminate the need for “chaining” multiple channels together to produce a single output channel. 

To solve an expression and save the result to a new channel, choose Expression from the Transform menu. A 
dialog box will appear allowing you to select input source channels, functions, operators, and output 
(destination) channels. For each Expression, you need to specify a source channel (or channels), the function(s) 
to be performed, and any operators to be used. The different components of each Expression can be entered 
either by selecting items from the pull-down menus in the Expression dialog box, or by typing commands 
directly into the Expression box. 

In the preceding Expression example, the equation took the sum of analog channels 1, 2 and 4, and divided by 
three to return a mean value for the three channels. The result of this was then arcsine transformed and saved on 
the next available channel. Of course, more complex operations are possible, and it is possible to divide a 
complex equation into several steps and perform each part of the equation with a separate channel. 

It is important to keep in mind that while different channels, functions, and operators can be referenced when 
using the Expression transformation, this calculation cannot directly reference past or future sample points. That 
is, data from a given point in time on waveform one can be transformed or combined in some way with data 
from the corresponding time index on waveform two. However, data from one point in time (on any channel) 
cannot be combined with data from another point in time (on any channel). You can operate on waveforms that 
are lagged in time by an arbitrary number of sample points by duplicating a waveform, and removing some 
number of sample points from the beginning of the record. This will create two channels that are offset by a 
constant time interval. 
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Source Select a Source channel to perform the transformation on. 
 

Function The Expression transformation offers the following functions: 

 Function Expression result 

 ABS Returns the absolute value of each data point. 

 ACOS Computes the arc cosine of each data point in radians. 

 ASIN Calculates the arc sine of each value in radians. 

 ATAN Computes the arc tangent of each sample point. 

 COS Returns the cosine of each data point. 

 COSH Computes the hyperbolic cosine of each selected value. 

 EXP Takes the ex power of each data point. 

 LOG Computes the natural logarithm of each value. 

 LOG10 Returns the base 10 logarithm of each value. 

 ROUND Rounds each sample point the number of digits specified in the 
parentheses. 

 SIN Calculates the sine (in radians) of each data point. 

 SINH Computes the hyperbolic sine for each sample point. 

 SQR Squares each data point. 

 SQRT Takes the square root of each data point. 

 TAN Computes the tangent of each sample point. 

 TANH Calculates the hyperbolic tangent of each sample point. 

 TRUNC Truncates each sample point the number of digits specified in the 
parentheses. 

   
Operator The Expression dialog uses standard mathematical operators. 

 Operator Operation 

 + Addition 

 - Subtraction  

 * Multiplication 

 / Division 

 ^ Power 

 ( Open parentheses 

 ) Close parentheses 

   
Destination This is the channel to display the transformation result on.  
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Waveform Math 

 
The Waveform Math transformation allows arithmetic manipulation of waveforms. Waveforms can be added 
together, subtracted, multiplied, divided or raised to a power. These operations can be performed using either 
two waveforms or one waveform and an arbitrarily defined constant (k). 

You can operate on the entire waveform by choosing Transform entire wave (or Edit >Select All), or operate 
on portions of the waveform that have been selected using the cursor tool. If there is no selected area, only one 
sample point (the one selected by the cursor) will be transformed. 

All of the main components of a Waveform Math transformation can be selected from pull-down menus in the 
dialog box. 

Source The channels to be used in the transformation are referred to as source channels 
(Source 1 and Source 2), and can be combined using any of the operators in the pop-
up operand menu. Select any of the existing channels in the current window, or a 
constant (K). 

Note:  If you select two waveforms of unequal length as sources, the 
length of the resulting waveform will be equal to that of the 
shortest one. Likewise, if one of the source waveforms extends 
only into a portion of the selected area, the resultant waveform 
will only be as long as the shortest source portion. If Waveform 
Math is performed on a selected area and output to an existing 
waveform that does not extend into the selected area, the 
resultant waveform is appended to the destination waveform. 

k Enter a value for the constant (K). 

Note: If you divide by k = 0 the software will return a value of zero so 
that other channels using the result of this channel can be 
calculated. 

Operand Select addition, subtraction, multiplication, division or power functions. 

Destination This is where the result of the Waveform Math will be stored. Choose any of the 
active channels or the “New” option, which will create a new channel (using the next 
available channel). 
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WAVEFORM MATH EXAMPLE 
Waveform Math can be used many ways. As one example, two waveforms can be added together. 

The graph to the right shows a sine 
wave in channel 14 and a triangle 
wave in channel 16. To add these two 
waveforms: 

1) Select Transform > Waveform 
Math. 

 This will generate a Waveform 
Math dialog. 

 

2) Set Source 1, select an Operand, 
set Source 2, and select a 
Destination. 

 The dialog shown here will add 
CH 14 to CH16 and show the 
result on a New channel.  

3)  Click OK to perform the 
transformation 

 

 
The graph to the right shows the sum 
of CH14 and CH16 on a new channel 
(the top waveform in this example). 

By default, Biopac Student Lab 
displays the frequency of occurrence 
for each bin on the vertical axis. 
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FFT Fast Fourier Transformation 

 
The Fast Fourier Transformation (FFT) is an algorithm that produces a description of time series data in terms 
of its frequency components. This is also referred to as the frequency spectrum or spectral analysis. The output 
from an FFT appears in a graph window with magnitude (vertical axis) plotted against various frequencies 
(horizontal axis). A large component for a given frequency appears as a positive (upward-pointing) peak. The 
range of frequencies plotted is from 0 Hz to 1/2 the sampling frequency. Thus, if data were collected at 200 
samples per seconds, the BSL PRO software would plot the frequency components from 0 Hz to 100 Hz. 

Fourier analysis can yield important information about the frequency components in a data set, and can be useful 
in making determinations regarding appropriate data cleaning techniques (e.g., digital filtering). 

The FFT transformation cannot be performed in real time (i.e., during an acquisition). However, it is 
possible to emulate an online spectral analysis using several online filters and the Input Values window. See 
page 7150 for more information on how to display frequency information in real time. 

The FFT algorithm assumes that data is an infinitely repeating periodic signal with the end points wrapping 
around. Thus, to the extent that the amplitude of the first point differs from the last point, the resulting frequency 
spectrum is likely to be distorted as result of this startpoint to endpoint discontinuity. This can be overcome by 
“windowing” the data during the transformation. (For more information on the windowing feature, see the 
Window section on page 7224.) 

The BPM and Freq measurements are not available with the FFT function. 

 
Pad with zeros / Pad with last point 
The algorithm used by the FFT requires that the length of the data be an exact power of two (i.e., 256 points, 512 
points, 1024 points, and so on). Whenever possible, it is best to use an input waveform (select an area) that is an 
exact power of two. If a section of data is selected that is not a power of two, the BSL PRO software will always 
“pad” data up to the next power of two, filling in the remaining data point with either zeros or with the last data 
point in the selected area. In other words, if 511 data points are selected, the BSL PRO software will use a 
modified version of the waveform as input. The modified waveform will have 512 points, and the last point in 
the modified wave will be  

 a zero, if the Pad with zeros option is checked, or 
 equal to the 511th point of the original data, if the Pad with last point option is checked. 
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Fast Fourier Transformation  continued… 

 
Remove mean 
Remove mean calculates the mean of all the points in the selected area and then subtracts it from the waveform. 
This is generally useful for windowing a waveform that has a large DC offset. 

 

As an example, you might start with a sine 
wave with a 10-volt DC offset (with a little 
noise added to broaden the spectrum), and 
perform the FFT with and without mean 
removal:  

Note the large spectral components at the 
beginning of the top plot, without mean 
removal. This is due to the offset of the 
original data. The bottom plot is with mean 
removal. 

Since the offset of the waveform is often an artifact of the way it was generated, the remove mean option 
provides a more accurate indication of the true spectral components. This is especially true for applications 
where low frequency components are of interest. If the data has a large DC offset and you plan on windowing 
the data, you will generally get a more meaningful spectrum if you remove the mean prior to windowing (which 
is the same order the FFT uses). 

dB / Linear 
By default, the FFT output is described in terms of frequency along the horizontal axis and dBV on the vertical 
axis. dB are derived from the Bell scale, which is logarithmic. 

To scale the output in linear units, click the button next to linear and click OK. Linear means that the interval 
between any two sample points in the filtered waveform will be exactly equal to the distance between the 
corresponding sample points in the original waveform. 

The relationship between log and linear units is: 

dBVout = 20 log VIN. 

Magnitude /Phase 
The standard FFT produces a plot with frequency on the horizontal axis and either dB/V or linear units (usually 
Volts) on the vertical axis. In some cases, it may be useful to obtain phase plots of the waveform (as opposed to 
the default magnitude plots). Phase plots display frequency along the horizontal axis, and the phase of the 
waveform (scaled in degrees) on the vertical axis. This option functions exclusive of the magnitude option — 
you can check either independently, or if you check both, two plots will be produced (a magnitude plot and a 
phase plot). 

 

Show modified input 
Check the Show modified input box to view the modified waveform being used as input for the FFT. 
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Remove trend 
Sometimes, data contains a positive or negative 
trend that can cause extraneous frequency 
components to “leak” into the frequency 
spectrum. For example, the following sine wave 
has an upward trend through the data (positive 
trend component). 

In this case, you could select remove trend when 
you perform the FFT, which would draw a line 
through the endpoints, and then subtract the trend 
from the waveform. 

The second screen shows FFTs of the skewed 
sine wave data with and without the trend 
removed: 

Note that the spectrum of the data without the 
trend removal has gradually decreasing frequency 
components, while the data with the trend 
removed has far fewer frequency components 
except for the single spike due to the sine wave. 

without trend removal

trend removed

 

 
 
Window 

A “window” refers to a computation that 
spans a fixed number of adjacent data 
points. Window functions are used to 
eliminate discontinuities that may result at 
the edges of the fixed span of data points 
for the FFT. 

To apply a window transformation, 
check the box next to Window and 
choose a type of window from the 
pull-down menu. Each of the windows 
has slightly different characteristics, 
although in practice each provides 
similar results within measurement 
error. 

 
 As noted earlier, the FFT algorithm treats the data as an infinitely repeating signal with a period equal to the 
length of the waveform. Therefore, if the endpoint values are unequal, you will get a frequency spectrum with 
larger than expected high frequency components due to the discontinuity. Windowing these data minimizes this 
phenomenon. 

As shown here, the frequency spectra of the windowed and non-windowed data differ significantly 
when the endpoints are unequal. When the data are not windowed, the very low and very high 
frequencies are not attenuated to the same extent as when the data are windowed. 

 

 

 

 

 

 

 



  225 

FFT EXAMPLE 

The raw data, prior to FFT: 

This electroencephalogram (EEG) signal was 
acquired as the subject alternated between 
eyes open and eyes closed states. Typical 
results suggest that higher levels of alpha 
activity (with frequency components between 
8Hz and 13Hz) are to be expected when a 
subject’s eyes are closed. 

Eyes
open

Eyes

Eyes
open

closed

 

To perform the FFT: 

1) Click the Transform menu and scroll to 
select FFT. 

This will generate the FFT Parameters 
dialog. 

2) Establish the FFT parameters (the 
Window type used here is KaiserBessel, but 
you could choose any type). 

3) Click OK. 

 

4) A frequency domain window (a graph 
window that places frequency rather than 
time along the horizontal axis) will be 
generated, showing the spectrum of the input 
data. The window is named “Spectral of (the 
original window name)” and ends with the 
channel number, as shown here. The 
resulting magnitude value for each 
component is equal to the peak value of the 
sine wave contributing to that component. 

 

The entire pattern of frequency components 
is known as the frequency spectrum of the 
data. The somewhat erratic appearance of the 
spectrum is usually due to small-scale 
variations in the original waveform. This 
“noise” can be removed by applying a 
smoothing transformation to the FFT output. 

In this example, there is a pronounced 
frequency component centered on 8Hz, 
which corresponds to the alpha wave 
frequency band (8Hz - 13Hz). The frequency 
spectrum (0-20 Hz shown) used 20-point 
smoothing. 
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Find Peak (Peak Detector options) 

 
The Find Peak function is the primary tool used for waveform data extraction or reduction. It can be used on a 
selected area or the entire data file. This function can automatically analyze the data based on user-defined 
time intervals. 

The peak detector provides a variety of mechanisms to automatically control the I-beam selection tool. In other 
words, Find Peak can be used to automate tasks which otherwise would have to be performed manually using the 
I-beam selection tool and the respective pop-up measurements. 

There are two basic methods by which the Peak Detector operates. Both of these modes provide powerful 
strategies for reducing data. 

Find Peak: Positive peak or negative 
peak 

 Useful for automatically 
analying in-vitro tissue bath 
data, spike counting, ECG 
analysis, and EMG 
analysis. 

Places the cursor (or selected area) at a a specified time offset to locate 
positive peaks or thresholds or negative peaks (valleys) in the data file. 
Use when you want the waveform data itself to drive the waveform data 
reduction process. 

In this mode, the algorithm will find positive or negative peaks or 
thresholds and move the I-beam to that found peak or threshold, offset in 
time by some fixed time delta. If the pop-up measurements are set to 
certain functions, the value returned by those functions will be present in 
the respective pop-up measurement result box. 

Find Peak: User Defined Interval 

 Useful for hemodynamic 
data, psychophysiological 
data, sleep data, and any 
other applications where 
measurements need to be 
taken at pre-defined 
intervals. 

Places the cursor (or selected area) at a specified time offset to regular, 
pre-specified time intervals. 

This mode is very useful when the waveform data reduction requirements 
necessitate examining the data around many equally sized data segments. 
This mode is very similar to the “Find Peak: positive peak or negative 
peak” mode, but instead of referencing the I-beam to a peak or threshold 
in the data, the algorithm will reference the I-beam to pre-selected time 
intervals which can be set to “chop” the waveform data into equal 
chunks. 

 TIP See Application Notes PS161 In-Vitro Tissue Bath Data Analysis and PS148 ECG 
Complexes. Application Notes are available through our web site, or contact BIOPAC for 
a hard copy. 
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Don’t Find — Allows you to retain the search parameters (peak value, valence, and so forth) when you exit the 
peak detection dialog box. This is useful for setting parameters with an area of a waveform (described above) 
and then repositioning the cursor at another point in the record. 

Find Peak: Positive peak / Negative peak 

Threshold Level Enter the threshold parameter in the threshold box (the units are those of the waveform 
to be peak detected). 

Threshold mode  

— Fixed The Fixed threshold mode uses a fixed value as the threshold point. 

— Tracking The Tracking threshold mode modifies the threshold after it finds a peak, depending 
upon the value of the new peak, and will compensate for a slowly drifting baseline. 

The amount that the Tracking mode changes the threshold is specified by the  
% of previous value. 

Set first cursor to The selection area can be modified and set to a fixed-distance and offset from the 
reference point. In this mode, the first cursor can be set to any one of the following four 
options, plus or minus a fixed-interval of time: 

a) Previous peak c)  Previous Threshold 

b) Peak d)  Threshold 

Set Second cursor to The second cursor can be set to a peak or threshold plus a fixed-interval of time, as long 
as the first cursor is referenced to a peak or threshold, respectively. 

Paste measurements Values can be automatically written to the Journal by clicking in the box next to “Paste 
Measurements into Journal.” 

Find Peak: User-defined interval 

Start Point The Start Point can be specified at either the existing cursor (I-beam) location or at a 
specified time. This will work on a selected area. 

Interval The Interval is the reference point of the cursor (I-beam). The cursor will move by the 
specified time Interval as the Peak Detector algorithm automatically moves the cursor. 

The “Minimum Interval” is calculated as 1/Sample Rate. 

Set first cursor The selection area can be modified and set to a fixed-distance and offset from the 
reference point. In this mode, the first cursor can be set to either of the following 
options, plus or minus a fixed-interval of time: 

a)   Previous peak b)   Peak 

Set second cursor The second cursor can be set to peak plus a fixed-interval of time. In this mode, “peak” 
refers to the location of the next user-defined interval. 

Paste measurements Values can be automatically written to the Journal by clicking in the box next to “Paste 
Measurements into Journal.” 
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Off-line averaging 

 
The Off-line Averaging option works with all peak detection modes. With this option selected, you will be able 
to average waveform data together from different reference points in the complete data record. 

For instance, if the Find peak: Positive peak mode is selected for the purposes of evaluating an ECG record, the 
off-line averaging feature will generate a composite ECG cycle. This composite will be the “average” cycle of 
some specified number of separate ECG cycles, where each cycle is referenced to the peak in the QRS wave.  

  Control Channel The Control Channel (Trigger channel) pull-down menu lets you select a channel to 
use as a trigger while performing the average on the selected channel. To select a channel, click the channel box 
above the display window. 

  Setup Averaging The Setup Averaging button generates the dialog box shown below: 

 
Averaging Range 

  Entire waveform Use all relevant data in the entire waveform to generate an average 

  Selected area Use only relevant data from the selected area of the waveform to generate an average 

  From start…# Collect relevant data at the start point and continue until the specified number of averages is 
reached. 

  From start…end Collect relevant data at the start point and continue until the end of the data file is reached. 

Artifact rejection 

Artifact rejection is used to eliminate suspect data from the averaging process. Suspect data is identified as any 
sample value in a relevant data block that is higher or lower than the respective Reject High and Reject Low 
levels. 

Ave Start 

The OK button switches to “Ave Start.” Click the button to activate the settings after choosing the control 
channel and establishing the averaging options. 
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Find Next Peak 

If you select Find Next Peak from the Transform menu (or select the  icon), both cursors will move 
one peak to the right while staying above the threshold. The measurement values will show the selected 
measurements and will automatically update when each new peak is found. 

Next, repeat the above peak search with the automatic journal entry option enabled. Start as before by selecting 
the first peak and choosing Find Peak from the Transform menu. Check the Paste measurements into journal 
option and click OK. The journal will now contain the measurement values from the new peak. 

 

Find All Peaks 

When you choose Find All Peaks from the Transform menu, the software will find all peaks through the end of 
the selected area (or the entire file, as designated) and paste the measurement values into the journal each time a 
peak is found, as shown here: 

 
The process uses the default cursor settings to select the area between two adjacent peaks. In this mode, one 
cursor tracks the current peak location while the other cursor marks the location of the previous peak (these 
“cursors” are internal to the software and only appear in the graph window as “borders” for the propagating 
selected area). 

Each column in the Journal corresponds to the measurement values selected (in this case, Value and BPM). If the 
data file is very large, it may take some time to find all the peaks, since the BSL PRO loads data from disk while 
it scans for the peaks. 
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FIND PEAK EXAMPLE TO DETECT THE POSITIVE SPIKE IN THE QRS COMPLEX 

The easiest way to start is to select the area around a peak and then select the  icon, or you could 
choose Find Peak from the Transform menu. 

 

 
The peak detection dialog will appear and automatically compute a threshold value. If you don’t want the peak 
detector to automatically set the threshold, then make sure that no portion of the waveform is selected prior to 
choosing Find peak. 

At this point, you can select Transform > Find All Peaks or Transform > Find Next Peak or you can click the 
Find Peak icon in the toolbar. You will see one cursor move to the next peak value above the threshold and the 
other cursor remain at the current location, as shown below: 
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FIND PEAK -- DATA REDUCTION EXAMPLE USING HEMODYNAMIC DATA 
The following example will show you how to automatically reduce a large hemodynamic data file down to 5-
second measurements. In the example, min, max, mean, and p-p measurements will be taken for each 5-second 
interval. 

 
Hemodynamic data: Carotid pressure and Brachioceph blood flow 

From the Transform menu, select Find Peaks and check the “User defined interval” option. The dialog box will 
allow you to enter a measurement Interval. In this case, 5.00 seconds was entered. 

The time interval is based on the horizontal time axis. If the time scale is set to minutes, the interval will be in 
minutes. However, by zooming in and changing the horizontal scale to seconds, you can set the interval to 
seconds. Check the “Paste measurements into journal” box and click OK. Now choose Find All Peaks from the 
Transform menu. 

 
Peak detector settings for data reduction of hemodynamic data 
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As the following window shows, measurements will be pasted to the journal in a row and column format, ready 
for export to your favorite statistical package. It is possible to paste the measurements into the journal without 
the additional text (name, unit, etc.). The journal file will be saved in a text file format. 

 
As an option, you can select “Peak” from the Set first cursor to menu. This allows you to set a time window 
before and after the user-defined time interval. If a larger time interval is used, 10-seconds in this example, it is 
possible to select a window 3 seconds before and 3 seconds after, providing a 6-second measurement period 
every 10 seconds. 
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FIND PEAK -- OFF-LINE AVERAGING EXAMPLE USING ECG DATA 
See also: Application Note 177. 

The following example shows how to average a one-minute segment of ECG data. 

 
One-minute section of ECG data and result of Off-line Averaging 

Select Find Peaks from the Transform menu. For this example, a Fixed threshold of 0.7 Volts was used. Select 
Off-line Averaging and the dialog box will allow you to enter a time window prior to the R-wave and after the 
R-wave. In this example, an averaging window of –0.3 sec before the R-wave (first cursor) and .35 sec after the 
R-wave (second cursor) was used. From Setup Averaging, we also chose “Selected Area” for the averaging 
range. 

 
Peak detector dialog setting for Off-line Averaging example 
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TIME OFFSET EXAMPLE 
One measurement option is to change the time offset of the first cursor. To do this, enter a value in the text box 
next to the Set first cursor to: area. Entering a value of -0.5 will result in the first cursor being set to a point 0.5 
seconds prior to the previous peak, and when the Find next peak command is selected, the graph should like 
somewhat like that shown below left: 

  
Likewise, setting the offset of the first cursor to a positive value will result in a selected area similar to that 
shown above right. 

Alternatively, you can choose to locate both cursors at the found peak, and define an interval around the peak. 
To do this, go to the Set first cursor to: portion of the dialog box, and select Peak from the Previous 
peak/Peak pop-up menu. This causes the options for the second cursor to change by adding a time offset option. 
When both cursors are set to the found peak and the offsets are each set to zero seconds, the find peak command 
will select a single point at the peak maxima of the next found peak. 

As before, it is possible to include a time offset for the first cursor. This offset may be either positive or negative, 
and can be set to an arbitrary time value. In the following example, the second cursor was set at the found peak, 
while the first cursor was set 0.5 seconds prior to the peak. The dialog box and resulting waveform are also 
shown. 
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A time offset can be added to the second cursor, which allows for areas around a peak to be selected. The time 
offset associated with the second cursor must be either zero or positive, whereas the first cursor can be a positive 
value, zero, or a negative value. 

 

 
 



236 Part D 

Visit the online support center at www.biopac.com 

Since a selected area covers all channels, it is possible to highlight an area based on the location of a peak found 
on one channel and take measurements from other channels. For example, suppose ECG data was acquired and 
the derivative of the data was calculated on channel 0. The Find peak command could be used to locate peaks 
on the ECG channel, and measurement windows could display a value for the corresponding area on the 
derivative channel as shown in the following graph: 

 
 

Moreover, it is also possible to paste data from other channels using only data within the selected area. In the 
example shown, an area of +/- 0.5 seconds was selected based on the location of the peak found on channel 2 
(ECG). Measurements were displayed for the slope and max of the derivative channel. Data from both channels 
were then pasted to the journal along with the horizontal scale values. 



  237 

Find Rate 

 
The Find Rate function allows you to compute rate calculations (including BPM) for data that has already been 
collected. Although this function uses the same algorithm as the online Rate calculation, it can be advantageous 
to perform rate calculations after the data has been acquired. One benefit is that off-line rate computations do not 
require that a separate channel (i.e., a calculation channel) be acquired. Since the number of acquired channels is 
reduced, other data can be collected and/or data can be sampled at a higher rate. The Find rate function 
produces the following Rate Detector dialog, which has the following options: 

See also: Rate Usage Guidelines in the Rate Calculation section on page 7103. 

 Application Note 142 for further information. 

Function The Function menu lists a variety of calculations. The most commonly used function is the Rate 
(BPM) option, which calculates a rate in terms of beats per minute or BPM. Other Rate Functions 
are discussed in detail in the Rate calculation section on page 7102. 

Peak detect By default, the peak detector searches for positive peaks (upward pointing, such as the R-wave of an 
ECG signal) to calculate the rate of a waveform. In some instances, however, you may have to base 
the rate calculation on negative peaks (downward pointing). To do this, select “negative” in the 
Peak detect section of the dialog box. 

Remove 
baseline 

The Remove baseline option applies the optimal high pass filter based on the other settings. This 
option is useful for signals with a slowly fluctuating baseline. 

Auto 
threshold 
detect 

To control for this, check the Auto threshold detect box in the find rate dialog box. When this 
option is selected, Biopac Student Lab will automatically compute the threshold value using an 
algorithm that accentuates peaks and uses information about the previous peak to estimate when and 
where the next peak is likely to occur. This threshold detector is typically more accurate than a 
simple absolute value rate calculation function, and is able to compute a rate from data with a 
drifting baseline and when noise is present in the signal. For a detailed description of how the 
calculation is performed, contact BIOPAC Systems, Inc. for the complete Application Note. 
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Enabling Auto threshold detect enables Noise rejection and Window options. 

Noise 
rejection 

Biopac Student Lab constructs an interval around the threshold level when Noise rejection is checked. 
The size of the interval is equal to the value in the noise rejection text box, which by default is equal to 
5% of the peak-to-peak range. Checking this option helps prevent noise “spikes” from being counted 
as peaks. 

Window The Window section prompts you to specify an upper and lower limit for the rate calculation. By 
default, these are set to 40 BPM for the lower criterion and 180 for the upper criterion, but may be 
adjusted as necessary. Setting the upper and lower bounds for the “window” tells Biopac Student Lab 
when to start looking for a peak. Biopac Student Lab will try to locate a peak that matches the 
automatic threshold criteria within the specified window. If no peak is found, the area outside the 
envelope will be searched and the criteria (in terms of peak value) will be relaxed until the next peak is 
found. 

For instance, once the first peak is found, Biopac Student Lab will look for the next peak in an interval 
that corresponds to the range set by the upper and lower bounds of the window. The interval with 
associated with the upper band of 180 BPM is 0.33 seconds (60 seconds ÷ 180 BPM), and the interval 
for the lower band is 1.5 seconds (1 minute ÷ 40 BPM). If a second peak is not found between .33 
seconds and 1.5 seconds after the first peak, then Biopac Student Lab will look in the area after 1.5 
seconds for a “smaller” peak (i.e., one of lesser amplitude). For those rate functions that require a 
window interval in seconds, you will probably want to enter numbers like .33 seconds and 1.5 seconds 
(which correspond to the BPM defaults of 40 and 180). These numbers will be suitable for detecting 
the heart rate of an average subject. 

A simple peak detector uses what is called a threshold-crossing algorithm, whereby each time the 
amplitude (vertical scale) value exceeds a given value, the peak detector “remembers” that point and 
begins searching for the next event where the channel crosses the threshold. The interval between the 
two occurrences is then computed and usually rescaled in terms of BPM or Hz. This is how the Biopac 
Student Lab Rate Calculation functions when all options are unchecked. 

Windowing Units are related to the selected “Function.” 

Rate Functions related to peak or peak time specify the unit after the Function. This is a fixed unit, so 
the Windowing Units menu will be disabled. 

 
Rate Functions related to data within a cycle can be specified in units of frequency (Hz) or time (BPM 
or seconds). The Windowing Units menu will be enabled,a nd when a unit is selected the software will 
convert the Min and Max settings to the selected units. 

 
 

 In the sample waveform here, the threshold was 
set to 390 mVolts to detect of the peaks of the 
waveform and provide an accurate rate 
calculation. Since it only recognizes signals 
greater than 390 mVolts as a peak, this 390-
mVolt threshold is referred to as an “absolute 
threshold.” 

Most waveforms are not so well behaved, 
however, and artifact can be introduced as a 
result of movement, electrical interference, and so 
forth. 

Combined with actual variability in the signal of 
interest, this can result in “noise” being included 
with the signal, as well as baseline “drift” which 
can render absolute threshold algorithms useless. 
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Put Result in 
New Graph 

When this option is checked, the results from the find rate calculation are plotted in a new graph 
window with data displayed in X/Y format, with time on the horizontal axis. By default, this option 
is unchecked and the resulting transformation is placed in the lowest available channel of the current 
graph. 

Find Rate of 
Entire Wave 

When this option is checked, the rate (or other function from the Find Rate command) will be 
calculated for the entire wave (other than the selected area, if any). 

Don’t Find The Don’t Find button is useful when you realize you have not selected an area, or you want to 
change the selected area to perform the Find Rate function on. When you click Don’t find, the dialog 
settings will be saved so that you can close out of the dialog and select an area. When you reopen the 
dialog, the settings will be established as before, and you can click the OK button to perform the 
Find Rate function. This is useful for setting parameters using an area of a waveform (described 
above) and then repositioning the cursor at another point in the record. 
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Chapter 15 Display menu commands 

  
The Display menu includes a number of features that control how the waveforms appear on the screen and how 
much data is displayed at a time. Although these options change the appearance of the data, they do not change 
the data itself. In other words, changing the color of a waveform or showing only a portion of the data on the 
screen will not alter the data stored in the file. 

 TIP  Click the right mouse button in the data window to generate a shortcuts menu that 
includes some display options. 
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Tile Waveforms 

Choosing Tile waveforms centers the waveform in the display window by adjusting the vertical offset 
of the selected waveform. In Chart mode, if there are multiple waveforms displayed, the waveforms 
will be centered in their tracks. In Scope mode, display is optimized to show all the visible waveform 
data with no overlap. Tile waveforms is not available in X/Y mode. 

 Before Tile Waveforms After Tile Waveforms 

 

 

ChartM
ode 

 

 

 

Scope 
Mode 

 

TILE WAVEFORMS In Chart Mode In Scope Mode 

Applies to Selected channel 

 

All active (visible) channels 

Effect on Horizontal 
(Time) Scale 

None None 

Effect on Vertical 
(Amplitude) Scale 

When multiple waveforms are 
displayed, each waveform is centered 
in its “track.” If tracks were resized, 
this function will reset (equalize) the 
tracks and then center each 
waveform in its track. 

Display is optimized to show all the 
visible waveform data with no overlap. 
Waveforms are spaced evenly along the 
vertical axis of the screen. Each 
channel’s data is completely visible and 
is separated from the other channels. 

Channel order 
(top to bottom) 

Numerical order (Top=low, 
Bottom=high) unless channel order 
was manually changed via 
Display>Set Wave Position. 

Numerical order (Top=low, 
Bottom=high) unless channel order was 
manually changed via Display>Set 
Wave Position. 

Limitations None None 

When to use When the vertical offset has shifted 
the channel in its track. 

When multiple waveforms are 
overlapped and hard to distinguish, 
especially if displayed in the same color. 
This pulls the waveforms apart, in order 
to view each channel. 

 

 

 

Autoscale Waveforms 

When Autoscale waveforms is selected, BSL PRO determines the best fit for each displayed 
waveform. The software adjusts the vertical offset so that each channel is centered in the window (or 
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within the channel tracks in the chart mode) and adjusts the units per division on the vertical axis so 
that the waveform fills approximately two-thirds of the available area. 

In Chart mode, the screen is evenly divided into horizontal channel tracks and each waveform is 
autoscaled to fit the division without overlapping. To apply to only the selected waveform, hold the 
CTRL key down before selecting Autoscale waveforms. 

In Scope mode, if more than one channel is active, the channels will overlap but each waveform will autoscale as 
if it were the only waveform in the display. This is useful when overlapping waveforms that have different units 
and scales. The vertical scale shown is that of the active channel; to change the scale, select another channel. 

 

Optimize Ranges 

When Optimize Ranges is selected from the Display menu, the Vertical Scales will be automatically adjusted 
for all channels that have a Range Guide (green band) showing, such that the range limits are set to the upper and 
lower viewable limits of the Vertical Scales. This allows you to quickly see the total Range of each input 
channel. This menu item is active when data is present AND at least one data channel has an active Range 
Guide. 

This item is also selectable using the toolbar icon  or the right-click mouse shortcut. When selected with the 
icon or the right-click, this item only optimizes the Range Guide of the active channel. 

Note: The Range Guide is the green vertical band that appears in the Vertical Scale region for 
analog input channels only (not for duplicated, copied/pasted, or Calculation channels); see page 738. 

 

Overlap Waveforms 

In Scope mode, when Overlap waveforms is selected, all the currently displayed waveforms are “overlapped” 
into one graph window with the same vertical scale and offset. This allows you to compare waveforms by setting 
all channels to the same vertical scale. The overall chosen scale for all the displayed waveforms will be a 
function of the pk-pk value of the combined waves. Overlap Waveforms is best used when comparing similar 
units. One use, for example, is to examine the calculated diastolic, systolic, and mean calculation channels 
“overlapped” with the raw blood pressure waveform. 

 

Compare Waveforms 

It is often useful to compare multiple waveforms by placing them all on the same amplitude (vertical) 
scale, but discount the effect of waveform offset (or baseline). Compare waveforms will automatically 
set the scale to be the same for all channels, and adjust the offset for each channel to center all 
displayed waves. The scale of all the displayed channels is determined by the channel with the largest 
pk-pk range in the display interval. 

 Before Compare Waveforms After Compare Waveforms 

   

The preceding example shows two waveforms that appear to have approximately the same magnitude before 
Compare waveforms is performed. After using Compare waveforms, you can easily see that the magnitude is 
not actually the same — one waveform (the sine wave) has a significantly greater baseline and range relative to 
the other (noise) waveform. 

 



  243 

Autoscale Horizontal 

The Autoscale Horizontal command is a convenient way to display the entire data file (in terms of duration) on 
the screen. When this is selected, the display will be adjusted so that the duration of the entire waveform fits in 
the graph window. For long waveforms, this can take some time to redraw. You can cancel plotting at any time 
by pressing the escape Esc key. 

Note: You cannot Undo the Autoscale Horizontal function, but you can use the Display > 
Zoom back menu command to revert to the previous display settings. 

 

Zoom Back / Zoom Forward 

The Zoom Back and Zoom Forward functions perform “undo” and “redo” commands for the zoom tool and 
any other functions that change the amount of data displayed (either in terms of time or amplitude). This 
effectively undoes changes in the horizontal scale, the vertical scale, or both. You can use the keyboard shortcuts 
of Ctrl-minus or Ctrl-plus, or click the right mouse button in the data window to generate a shortcuts menu and 
make the appropriate zoom selection. Changing mode resets the zoom scale. 

 

Reset Chart Display 

The Reset Chart Display option will redistribute the chart displays evenly so that each channel’s vertical size is 
the same after you have changed the boundaries. This function, which only works in Chart Mode, can be useful 
if you need to expand a display region for analysis and then return to the original display. 

 Before Reset Chart Display After Reset Chart Display 

   
 

Set wave positions... 

By default, channels are arranged on the screen based on their channel numbers, with the lower number channels 
being displayed at the top of the screen. You can change the ordering so that waveforms are placed in an 
arbitrary order. 

The Set Wave Position option of the Display menu generates the Set Waveform Order dialog, which contains 
a scrolling list of all stored channels. The on-screen position of the waveforms is the same as the ordering shown 
in the Set Waveform Order dialog (from top to bottom). You can scroll through the list by clicking on the 
vertical scroll bar at the right. The list will scroll if you move past the top or bottom when clicking and dragging 
the waveform positions. 

The “Tile” checkbox to the left of each channel enables tiling and autoscaling for each channel when checked. 
Click the checkbox to toggle the enable. This can be useful if you have some waveforms which you don’t want 
autoscaled with others. 

You can reposition the waveforms by reordering the channel labels as they appear in this dialog box. To change 
the order of any waveform, click the channel label (e.g., Ch. 4 Respiration), hold down the mouse button, and 
drag the highlighted label to the desired position. 
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Set Waveform Order dialogs and corresponding displays 

Repeat this operation until the waveforms are in the desired order, then click OK to apply the selected order to 
the display screen. Cancel will reset all waveform positions to those set before the dialog was opened. 

 In Chart mode this will result in vertical ordering of the individual waveforms. 
 In Scope mode this will result in vertical ordering of the individual waveforms after a 

tiling or autoscaling operation.  
 

Wave color 

The Wave Color option of the Display menu lets you use color to 
discriminate between waveforms. When you add a new waveform, 
the software assigns the waveform color — but you can use this 
function to change the color. 

To assign a new color to a selected waveform, choose Wave Color 
and then selecting the desired color from the menu that is 
generated.  

Depending on the type of graphics adapter on your computer, you may or 
may not be able to choose “Custom” to display a palette of color 
options. Wave color is disabled on computers with grayscale monitors. 

You can use color to identify the selected waveform because the 
vertical scale, channel text, channel units and measurement pop-
up menus take on the same color as the selected waveform. The 
channel label (along the left edge of the display) will be highlighted 
in the color for that channel. 
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Horizontal Axis... 

This option generates a “Set Horizontal Axis format” dialog with 
two time format options. 

Time (ss.sss) is the default.  

Time (HH:MM:SS) displays as  and rounds as necessary to fit this format. 

 
Show... 

When Show is selected from the Display menu, a submenu appears that allows you 
to control a number of options related to how data is displayed and what additional 
information is displayed in the graph window. 

To enable an item, scroll to select it from the Show submenu. 

A bullet (•) or check mark ( ) appears next to the menu item when it is enabled. 

 

  

 

 

 

 

 

 

 

 

SHOW Option Toolbar / Shortcut Explanation 

Channel numbers 
 

Activates the channel box display above the graph window. 

 See page 749. 

Chart 
 

Activates the Chart display mode. See page 739. 

Dot plot Click the right mouse button 
and scroll to choose Dot plot 

 Hold the Ctrl key 
when you select to 
apply to all channels. 

Allows you to view data in a “dot” format. The software will 
create user-defined, discrete points that map out the selected 
waveform. 

This is often useful for demonstrating the concept of discrete 
digital sampling by dividing the waveform up into data points or 
“dots.” 

Dot size Click the right mouse button 
and scroll to choose Dot size 

 

Use to specify how large 
each dot will be for Dot 
Plot. Each dot is measured 
by the number of monitor 
pixels it occupies. If you 
select a large number (like 
21 pixels), then the 
waveform will look like a 
series of large dots. 

 

 

Grid 
 

Superimposes a set of horizontal and vertical lines on the graph 
window that correspond to horizontal and vertical scale divisions. 
Grids are a useful visual aid to help with measurements and when 
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SHOW Option Toolbar / Shortcut Explanation 

selecting an area. See page 7174. 

Grid Options Click the right mouse button 
and scroll to choose Grid 
buttons 

Activates the Grid Options Dialog with options to lock or unlock 
grid lines and control the width and color of major and minor grid 
lines. See page 7174. 

Journal 
 

Opens a Journal window below the data window. 

Last dot only Click the right mouse button 
and scroll to choose Last dot 
only 

Enabled with Dot mode, plots only the most recently acquired 
data point. This is useful when viewing data as it is being acquired 
and when using the X/Y display mode. 

Line plot Click the right mouse button 
and scroll to choose Line 
plot 

 Hold the Ctrl key 
when you select to 
apply to all 
channels. 

Plots the waveform by connecting each sample point to the next 
with a line. Line plot waveforms match a true analog plot (as 
closely as possible). This is the default display mode for most 
waveforms—except histogram plots, which are displayed in Step 
plot (see page 7216). 

Markers 
 

Activates the marker region display and the marker tools. 

 See page 7172 for Marker details. 

Measurements 
 

Displays the measurement boxes above the graph window. See 
page 7157 for an overview of the measurement process and page 
7161 for an explanation of each measurement. 

Scope 
 

Activate the Scope display mode. See page 740. 

Step plot Click the right mouse button 
and scroll to choose Step 
plot 

 Hold the Ctrl key 
when you select to 
apply to all 
channels. 

Draws waveforms using a “step” plot which connects sample 
points with either vertical or horizontal lines. Step plot is most 
useful for displaying histograms and similar plots, but since it 
displays data much as it appears to a digital processor (like the MP 
UNIT), it can also be useful for examining the effects of various 
sampling rates.  

NOTE: Step plot is mutually exclusive of Line plot. 

Toolbar Click the right mouse button 
at the top of the display by 
the menu items. 

Generates the toolbar display across the top of the data window. 
The Toolbar has shortcut buttons for commonly used features. See 
page 730 for an explanation of the buttons. 

X-Scale  Shows/Hides the Horizontal Scale. Hiding the X scale when 
desired allows for use of full screen for X/Y plots. 

Y-Scale  Shows/Hides the Vertical Scale. Hiding the Y scale when desired 
allows for use of full screen for X/Y plots. 

X/Y 
 

Switches the display to X/Y mode. See page 741. 
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Statistics... 

The Statistics command generates a message box with information about the selected channel. 

 

Channel number: the active channel 

Channel label: associated label text (if any) 

Interval: sampling rate used for data storage 

Length: waveform duration in samples and time 

Min: minimum value for the waveform data 

Max: maximum value for the waveform data 

Mean: mean value for the waveform data 

 

Generally, the sampling rate and waveform length information is the same for all channels, although this is not 
always the case. It is possible to shorten waveforms by editing out sections of the waveform (using Edit > Cut 
and/or Edit > Clear functions). 

The interval specified in this message box reflects the sampling interval the BSL PRO software uses to store the 
data, which is not necessarily the same rate at which it was collected. If data was imported or saved in a format 
other than .ACQ, the sample interval data was not stored, and the software will use a default of 100 samples/sec. 
to plot the data. 

To modify the sample Interval, you can use the Resample function (described on page 7217) or paste data 
collected at one sample rate into a graph with data sampled at a different rate. 

 

Size window... 

 
The Size Window function lets you specify 
exact dimensions for the size of the graph 
window. You can use this to create consistently 
sized windows for pasting into documents. 

The two text boxes allow you to enter screen width and 
height, both of which are scaled in terms of pixels. Standard 
computer displays have 72 pixels per inch (28.3 pixels/cm), 
so a graph window that is 360 pixels wide by 216 pixels high 
would be 12.7cm tall and 7.6cm wide. 

When the Reset Chart Boundaries box is checked, the 
boundaries between the waveforms will be reset so that each 
channel “track” is the same size. This function only works in 
Chart mode. 

Note: The Reset function is also a first-order Display menu 
option. See page 7243 for an example. 

 

Cursor Style 

The Cursor Style option generates a sub-menu with options for the three general cursor styles that are displayed 
in the lower right corner of the graph window. 

  
Refresh Graph 

This will refresh the screen display. Use this option to erase residual I-beam lines on the graph. 
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Chapter 16 Window Menu & Help Menu 
Window menu 

The Window menu is a standard Windows function with window display options. This menu lists all open 
files, which can be useful for file selection when multiple files are open, and also includes several display 
options. See your Windows Manual for details. 

 
 

Help menu 

The Help menu lists the BIOPAC support options available while 
you are running the program. The Tutorial, Manual and Guide files 
are in PDF format and can be easily searched. 

You must have an active “browser” to use the “from Web” options. 

If you have not installed Adobe Acrobat Reader (free at 
3www.adobe.com) or it has never been used on your OS, you must 
install or activate Acrobat to see the PDF menu options. 
 

 

 

About Biopac Student Lab 

The About command of the Help menu generates a dialog with information about the BSL PRO 
software and firmware versions being used and your system parameters, which can be useful if you 
need to call BIOPAC for any reason.  

This dialog also contains information about the MP Unit, which can be useful if you need to make a 
service call. If the unit is connected, an MP icon should appear and the Model, serial number (S/N), 
PCB Rev, and Firmware Rev. should all be displayed. If the MP Unit is not connected, then only the 
MP icon will be displayed. 
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n the hardware portion of the dialog, if the unit is connected, an MP45 icon should appear 
and the Model, S/N, PCB Rev, and Firmware Rev. should all be displayed.  If the MP45 is 
not connected, then only the MP45 icon will be displayed. 
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Chapter 17 Media Menu 

 

   
Media functionality allows users to capture and playback video and/or audio with a USB web cam or firewire DV 
device and synchronize it with physiological information from an MP device. The key functionality is a strong link 
between the video and data cursor when graphs are being used in post-acquisition mode; changing the selection in 
the graph window will automatically jump the video to the time corresponding to the cursor position. The reverse tie 
is also in place where erasing the video will move the data cursor to the corresponding data point in the graph. 
 
For synchronized playback of media player with the BSL PRO cursor in data view, BIOPAC recommends that the 
users sample the MP3x at least as fast as the video frame rate 30Hz. In this case, any measurement errors are limited 
to the basic frame rate error window (1/30 sec).  
 

Set up 

Use to establish Sources, Output and Media parameters. Sets device type for audio and/or video. Use refresh after 
connecting a new device to make it a selectable option. Browse using standard file open/save functionality to specify 
media files. If desired, set a Delay between file segments. 

 

Capture/Playback Viewer 

 For Capture: Use for video signal directly from a video camera; this option is disabled (grayed) in the 
record mode when both the Capture video and Capture audio options in the Media Setup dialog are off. The 
Capture viewer also doubles as a video preview monitor. 

 For Playback: Use to play back media from the disk (stored media files); this option is disabled (grayed) if 
there is no media assigned to the file. 

 
Capture/Playback Viewer is also accessible by toggling the “Show/Hide Media” toolbar button. The viewer is 
similar in appearance to the video player found in YouTube®, with simple play/pause controls when displayed in 
Playback Idle mode. Viewer status is visible in the title bar as “Capture” or “Playback”, and changes dynamically 
depending upon whether video data is being recorded or viewed post-acquisition. 
 
Video Playback and Capture preview include a right-mouse contextual menu item “Grab bitmap” which, when 
selected, generates a ‘Save As’ dialog to save the currently displayed frame as a *.bmp image. 
 
Media Notes 

 Media capture performance is improved under Windows 7 or Vista OS. If the selected webcam drops 
frames because of poor performance/low quality, the degree of synchronization will be compromised. 
Testing indicated the Microsoft Lifecam NX-3000 gave reliable performance with no dropped frames. 

 BSL PRO files can link to media files created by other programs. If the media file is shorter or longer than 
the BSL PRO file, just align the two files at the start. 

 BSL PRO files alignment precision with the media file is user-controlled through the use of a delay 
function that allows a forward or backward time shift. 

 BSL PRO files store the location (path) of the media file. 

 Media functionality does not support the Autosave file acquisition mode. 
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 Media Setup 

 
 

Video Capture 
Device 

Identifies camera connected to the computer. If more than one device is connected, another can 
be selected from the pull-down menu. (Only one camera may be used at a time in BSL PRO) 

Refresh Establishes newly connected hardware for use in the BSL PRO application.. 

Capture Video Enables the video capture device for recording. Left unchecked, no video will be captured, even 
with camera connected. 

Properties Displays properties and settings of video/audio capture device, should adjustments be necessary. 

Audio Capture 
Device 

Use to select audio capture device for recording. This could be a built-in camera microphone or 
any installed audio capture device. Video and audio can be captured independently of one 
another. ‘Refresh’ and ‘Properties’ serve the same function for audio as in video capture. 

Capture format Selects the desired file type for video recording. To save hard disk space while performing 
lengthy acquisitions, *.WMV/*.WMA format is recommended. 

Media folder Non-editable default path for storing the graph and linked video files. If a different directory or 
file name is desired, this can be selected in the main application window via ‘File>Save As’.  

Playback 
assignment 

The Playback assignment region contains a directory list of all recording segment and Playback 
Idle media. The Segment media will be automatically created after each recording segment has 
finished. A place holder will be created for each Playback Idle media pending assignment of this 
option.For example, prior to any recording segment, this region will be empty. Upon completion 
of the first recording segment, the segment’s “media” will be shown in the list along with two 
Playback Idle place holders; one prior to the first recording segment and one following the 
recording segment. Upon completion of the second recording segment, a second media capture 
will appear in the list, followed by an additional Playback Idle placeholder. This pattern is 
repeated for every consecutive segment acquired. 
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Browse Playback media can be assigned using the ‘Browse’ button.  The Browse button can also be used 
to change the assigned recording media.  Pressing Browse brings up a standard FileOpen 
dialog.  Media capture can create *.avi (default), *.wmv/*.wma files, and the Browse dialog will 
additionally support *.mpeg or *.mpg formats for playback only.  

If the file selected using Browse is in a different location than the assigned Media folder, a copy 
of the file will automatically be placed in the new Media folder.  This assures that all associated 
media files reside in one folder.  

Clear Removes a selected media segment from the Playback assignment region. 

Clear All Removes all media segments from the Playback assignment region. Only the assigned media 
link is removed. Media files themselves remain in their assigned directory and are not deleted,  

Automatically 
play media in 
idle mode 

If selected, media files assigned Playback Idle status will be loaded and begin playing 
automatically when the saved acquisition is reopened in Playback mode. The user can then use 
the media window tools to pause, stop or rewind the media.  To assign media to Playback Idle, 
click on the Playback Idle icon and Browse to the desired video file’s directory. This can be 
useful for displaying a brief “preview” video prior to playback of associated data. 

Playback 
synchronization 

Allows for a positive or negative time shift to be introduced between start of graph data and start 
of the linked media file, thus compensating for any data/media alignment issues that may arise. 
Playback synchronization is often necessary because there is an unknown delay between the 
actual start of the acquisition and the start of the first video frame. If precise synchronization is 
required, the Playback synchronization setting allows one to change the timing of the first video 
frame with respect to the first data sample.   

As an example to determine synchronization, an LED can be connected to the I/O output of the 
MP device.  The Digital Outputs Output Control can then be set up to toggle any digital channel 
(D1-D8) on/off.  With the LED viewable in the video, simply determine when the digital output 
occurred in the graph and enter the appropriate Playback synchronization value necessary to 
correct the alignment. Note that one can never achieve better than 1/30 of a second 
synchronization, which is the video frame rate.  

 
Biopac Digital LED connected to MP3x I/O port 

Note: Because synchronization requires a time scale value, it cannot be applied to graphs 
displayed in X-Y mode, or for FFT and Histogram windows.  

Start all 
mediaAfter 
graph start 

Shifts media alignment with graph file to after the start of graph data. The inputted time value 
determines the degree of offset. 

Start all 
mediaBefore 
graph start 

Shifts media alignment with graph file to before the start of graph data. The inputted time value 
determines the degree of offset. 

OK Clicking OK applies all settings, closes the Media Setup dialog and automatically opens the 
media window if a Capture option is enabled.   

Cancel Clicking Cancel will discard any changes made in the Media Setup dialog. 
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Recording Media While Acquiring Data 

1) After connecting camera to computer, use the Media menu to launch Media setup dialog. 

2) Enable the “Capture video” checkbox. (If camera is not connected until after launching the setup dialog, 
use “Refresh” to update this device in the software). 

3) If audio capture is also desired, enable “Capture audio”. (Audio device must be connected) 

4) Choose the video capture format. (The default setting is *.AVI) 

5) Click OK. The Media setup dialog will close and the Video Capture viewer will be displayed. (The 
Capture/Playback viewer is fully resizable and can be positioned anywhere on the screen) 

6) Position the camera as desired and click “Record”. 

7) Click “Stop” when finished, or, if the acquisition is for a set time, wait until completed. 

You may now use the cursor tool to “browse” within the graph and the corresponding portion of the video will be 
displayed in the Playback viewer. (The viewer status will change automatically from “Capture” to”Playback” once 
the cursor is placed within the graph data). You may also browse the video using the Playback viewer’s slider 
control, and the graph’s cursor tool will update to reflect the position of the slider control. The available viewer 
statuses are shown below. 

 

Video Capture: (Displayed prior to and 
during recording) 

 

Video Playback: (Displayed when browsing 
data with cursor tool or while in Playback 
mode) 
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Video Playback Idle Mode: 
In this mode, the assigned video will play 
automatically on a segment-by-segment 
basis when graph is opened for Playback. 
(Viewer Play/Pause controls are available in 
this mode only) 

 
During the capture or playback of audio 
only, the media window will be displayed 
with a static musical note image as shown at 
right. 
 

 

 

The Capture/Playback viewer can be also displayed or hidden by toggling the “Show/Hide Media” button on the 
toolbar. (Highlighted below) 

 
 If a Capture/Playback assignment has not been made, this toolbar button will be dimmed. 

 The Capture/Playback viewer must be hidden in order to access Media setup. If Media setup is accessed 
with the viewer present, the following warning will appear: 

 
NOTE Media setup also cannot be accessed during active recording or playback. The viewer must first be stopped. 

 

Viewing Media in Playback Mode 

To view a media file in it’s entirety along with associated graph data, Playback mode must be used.  

1) After the graph containing media is saved, close the graph and go to FileOpen for Playback. 

2) Select the saved data file and click “Open”. 

3) Click “Play” to view a recording of the data, along with playback of the linked media.  
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The playback can be stopped at any time and the data browsed using the cursor tool. Playback synchronization can 
also be set to compensate for any misalignment between video and graph data. Note that one can never achieve 
better than 1/30 of a second synchronization which is the video frame rate. 

 

NOTE The Media Setup options are available in Playback mode but changes to these settings can only be 
permanently saved when the graph is viewed in FileOpen. 
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Appendix A — Sample Data Files 

Sample data files 

The Biopac Student Lab PRO installation includes the following sample data files, which you are encouraged to 
open and review as you familiarize yourself with the BSL PRO System. 

The “Samples” folder is installed to the Biopac Student Lab 3.7.7 folder. The path to the folder (from default 
installation) is: 

C:\Program Files\Biopac Systems, Inc\Biopac Student Lab 3.7.7\Sample Data\PRO 

Twelve sample acquisition (.acq) files are installed with the PRO. 

Six graph template files are also installed—see page 7265. 

 
 

NOTE: In addition to these sample files, BSL 3.7.7 now includes over 35 different PRO Lessons graph templates 
customized for all MP hardware types. These lessons can be found in C:\Program Files\Biopac Systems, Inc\Biopac 
Student Lab 3.7.7\PRO Lessons 



256 Part E  

Visit the online support center at www.biopac.com 

 

Data file name Screen Shot 

4Channel.acq 

 
 

BloodPressure.acq 
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Data file name Screen Shot 

BPM Gauge.acq 

BPM Gauge.gtl 
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Data file name Screen Shot 

Earthworm data.acq 

Earthworm smooth 
muscle.acq 
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Data file name Screen Shot 

EEG.acq 

 
 

EMGwForce.acq 
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Data file name Screen Shot 

FingerTwitch1.acq 

 
 

FingerTwitch2.acq 
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Data file name Screen Shot 

HeartTemplate.gtl 

 

Six graph templates 
(.gtl) file are installed 
with BSL PRO. See 
page 7182 for a 
discussion of graph 
templates. 

You must select 
“Files of type Graph 
Template” to select 
this file” 
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Data file name Screen Shot 

NerveConduction 
.acq 

 
Segment Timer 
Gauge.gtl 
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Data file name Screen Shot 

SS19L Gauge.gtl 

SS19LA Gauge.gtl 
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Data file name Screen Shot 

StandardCurveData.a
cq 

 
StandardCurveTempl
ate.gtl 
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Data file name Screen Shot 

ValidateMeasure-
ments.acq 
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Appendix B — Table of Analog Presets 

Notes * Notch Filter is either 50 Hz or 60 Hz as determined by the Line Frequency specified when 
the BSL PRO software was installed. It is used to filter out the interference signal introduced 
from electrical power sources. 

 ** The transducer must be calibrated before the recording begins. Typically this involves using 
the “scaling” dialog (accessible via MP UNIT > Setup Channels > View/Change Parameters > 
Scaling…), but more involved calibration may be required. Refer to the BSL Hardware Guide or 
Application Notes available on the BIOPAC Web Site (www.biopac.com). 

  The Band Stop Frequency will be 50 Hz or 60 Hz, based on the Line Frequency specified 
when the BSL PRO software was installed. 

Analog Preset Name 

Channel Label 

Applicable Calc. Presets 

Gain 

X 

Hardware 
Filters 

AC or DC 
.05 or .5 HP
1K or 5K LP 

IIR 
Filters 

Type, 
Freq., Q 

Scaling 
(Mapping) 

Units 
label 

Recommended 
Calibration & 
Sample Rate 
(Samples/sec) 

Default This preset can be used as a starting point when no other preset is applicable or 
when input amplitude and offset are unknown. It is set to maximum bandwidth, and 
a low gain allowing one to record and view almost any Physiological signal that 
falls within a +-50 mV input range. 

Min. Sample Rate: 2X maximum frequency expected or desired. 

Accelerometer (5 g’s max.) 

Accelerometer (5 g), 3 CH 

Use with the BIOPAC SS26L, 0 to 5g, 
Accelerometer 

 

500 

 

DC 

1K LP 

 

BP 

 

11 mV to 1 

10 mV to 0 

 

g’s 

 

Calibration 
required** 

Min. Sample 
Rate: 100 S/S 

Accelerometer (50 g’s max) 

Accelerometer (50 g), 3 CH  

Use with the BIOPAC SS27L, 0 to 50g 
Accelerometer. 

 

500 

 

DC 

1K LP 

 

BP 

 

7.5 mV to 10 

6.5 mV to 0 

 

g’s 

 

Calibration 
required** 

Min. Sample 
Rate: 100 S/S 

Airflow (SS11LA) 

Airflow transducer 

Can be used with the “Lung Volume” 
Calculation Channel preset to obtain 
Volume data. 

 

5,000 

 

DC 

1K LP 

 

BP 

 

-3000 uV to -
10 

3000 uV to 
10 

 

liters/sec 

 

Min. Sample 
Rate: 100 S/S 

Airflow (SS52L) 

Airflow (SS52L) 

SS52L System: Airflow (75 kg, 
exercising adult) <+-8000 ml/sec.> 

Airflow 

 

 

1,000 

 

 

DC 

1K LP 

 

 

BP 

 

 

0 mV to 0 

192.5 mV to 
1 

 

 

liters/sec 

 

 

 

Airflow (small mouse) 

Airflow (small mouse) 

SS45L System: Airflow (30 gm, small 
mouse) <+-12 ml/sec.> 

Airflow 

 

 

1,000 

 

 

DC 

1K LP 

 

 

BP 

 

 

0 mV to 0 

1.285 mV to 
10 

 

 

ml/sec 

 

 

 

Airflow (mouse) 

Airflow (mouse) 

SS46L System: Airflow (50 gm, mouse)  

<+-20 ml/sec.> 

Airflow 

 

 

 

 

1,000 

 

 

DC 

1K LP 

 

 

BP 

 

 

0 mV to 0 

0.770 mV to 
10 

 

 

ml/sec 

 

 

 

Airflow (rat/guinea pig)       
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Analog Preset Name 

Channel Label 

Applicable Calc. Presets 

Gain 

X 

Hardware 
Filters 

AC or DC 
.05 or .5 HP
1K or 5K LP 

IIR 
Filters 

Type, 
Freq., Q 

Scaling 
(Mapping) 

Units 
label 

Recommended 
Calibration & 
Sample Rate 
(Samples/sec) 

Airflow (rat/guinea pig) 

SS47L System: Airflow (350 gm, 
rat/guinea pig) <+-60 ml/sec.> 

Airflow 

 

1,000 

 

DC 

1K LP 

 

BP 

 

0 mV to 0 

0.289 mV to 
10 

 

ml/sec 

 

 

Airflow (cat/rabbit) 

Airflow (cat/rabbit) 

SS48L System: Airflow (750 gm, 
cat/rabbit) <+-150 ml/sec.> 

Airflow 

 

 

1,000 

 

 

DC 

1K LP 

 

 

BP 

 

0 mV to 0 

1.05 mV to 
100 

 

 

ml/sec 

 

 

 

Airflow (small dog) 

Airflow (small dog) 

SS49L System: Airflow (5.5 kg, small 
dog) <+-350 ml/sec.> 

Airflow 

 

 

1,000 

 

 

DC 

1K LP 

 

 

BP 

 

 

0 mV to 0 

0.462 mV to 
100 

 

 

ml/sec 

 

 

 

Airflow (medium dog) 

Airflow (medium dog) 

SS50L System: Airflow (15 kg, medium 
dog)  

<+-1200 ml/sec.> 

Airflow 

 

 

1,000 

 

 

DC 

1K LP 

 

 

BP 

 

 

0 mV to 0 

1.155 mV to 
1000 

 

 

ml/sec 

 

 

 

Airflow (large dog) 

Airflow (large dog) 

SS51L System: Airflow (25 kg, large 
dog) <+-3000 ml/sec.> 

Airflow 

 

 

1,000 

 

 

DC 

1K LP 

 

 

BP 

 

 

0 mV to 0 

0.4815 mV to 
1000 

 

 

ml/sec 

 

 

 

Blood Pressure (Arterial) 

Blood Pressure (Arterial) 

Use with the SS13L for measuring direct 
blood pressure in animals. Can be used 
with several Calculation Presets for real-
time recording of heart rate, Systolic, 
Diastolic, and Mean BP, along with 
changes in pressure with respect to time 
(dp/dt). 

 

1,000 

 

DC 

1K LP 

 

BP 

 

0 mV to 0 

2.5 mV to 
100 

 

mmHg 

 

Calibration 
required** 

Min. Sample 
Rate: 100 S/S 

Blood Pressure Cuff (SS19L) 

Blood Pressure Cuff 

Use with the BIOPAC SS19L, Blood 
Pressure Cuff. 

 

500 

 

DC 

1K LP 

 

BP 

 

0 mV to 0 

2.5 mV to 
100 

 

mmHg 

 

Calibration 
required** 

Min. Sample 
Rate: 100 S/S 

Blood Pressure Cuff (SS19LA) 

Blood Pressure Cuff 

Use with the BIOPAC SS19LA, Blood 
Pressure Cuff. 

 

200 

 

DC 

1K LP 

1: LP, 
66.5 Hz, 
Q=.5 
2: LP, 
38.5, 
Q=1 

3: BS 
Line, 
Q=1 

 

 

 

0 mV to 0 

61.44 mV to 
775.7 

 

mmHg 

 

Calibration 
required** 

Min. Sample 
Rate: 100 S/S 
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Analog Preset Name 

Channel Label 

Applicable Calc. Presets 

Gain 

X 

Hardware 
Filters 

AC or DC 
.05 or .5 HP
1K or 5K LP 

IIR 
Filters 

Type, 
Freq., Q 

Scaling 
(Mapping) 

Units 
label 

Recommended 
Calibration & 
Sample Rate 
(Samples/sec) 

BNC (SS9L, -10 to +10 Volts max. 

BNC Adapter (for MP30)  

<divide by 1000> 

Use when connecting up to external 
devices using the BIOPAC SS9L BNC 
adapter. Voltage amplitudes should be 
greater than +- 1 Volt, and less than +- 
10 Volts. 

 

 

 

 

1,000 

 

 

 

DC 

5K LP 

 

 

 

None 

 

 

 

-1 mV to -1 

1 mV to 1 

 

 

 

Volts 

Min. Sample 
Rate: At least 
2X highest 
frequency of 
interest 

BNC (SS9L, -50 to +50 Volts max.) 

BNC Adapter (for MP30)  

Use when connecting up to external 
devices using the BIOPAC SS9L BNC 
adapter. Voltage amplitudes should be 
greater than +- 10 Volts, and less than 
+- 50 Volts. 

200 DC 

5K LP 

None -1 mV to -1 

1 mV to 1 

Volts 

 

Min. Sample 
Rate: At least 
2X highest 
frequency of 
interest 

BNC (SS70L, -10 to +10 Volts max.) 

BNC Adapter (for MP36/35), Isolated 

<divide by 10> 

 

10 

 

DC 

 

None 

-1000 mV to -
10 

1000 mV to 
10 

 

Volts 

 

Cardiac Output – dZ/dt 

Cardiac Output – dZ/dt 

200 DC 

1K LP 

BP 0 mV to 0 

5 mV to 2 

Ohms/se
c 

 

 

Cardiac Output – Z 

Cardiac Output – Z 

Non-Invasive Cardiac Output Module 

200  

DC 

1K LP 

 

BP 

 

0 mV to 0 

50 mV to 100 

 

Ohms 

 

 

Circuit Probe – Breadboard (-10 to +10 
mV max) 

Circuit Probe 

MP UNIT Circuit Probe and Power 
Cable for Breadboard 

 

5000 

 

DC 

5K LP 

 

N/A 

 

-10000 mV to 
-50 

10000 mV to 
50 

 

mV 

 

 

Circuit Probe – Breadboard (-100 to 
+100 mV max) 

Circuit Probe 

MP UNIT Circuit Probe and Power 
Cable for Breadboard 

500 DC 

5K LP 

N/A -10 mV to -50 

10 mV to 50 

mV  

Circuit Probe – Breadboard (-1 to +1 
Volts max) 

Circuit Probe 

MP UNIT Circuit Probe and Power 
Cable for Breadboard 

50 DC 

5K LP 

N/A -100 mV to -
0.5 

100 mV to 
0.5 

Volts  

Circuit Probe – Breadboard (-5 to +5 
Volts max) 

Circuit Probe 

MP UNIT Circuit Probe and Power 
Cable for Breadboard 

10 DC 

5K LP 

N/A -100 mV to -
0.5 

100 mV to 
0.5 

Volts  

Clench Force – kg (SS25LA) 

Clench Force 

 

500 

 

DC 

 

BP 

 

0 mV to 0 

 

kg 

Calibration 
required**  
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Analog Preset Name 

Channel Label 

Applicable Calc. Presets 

Gain 

X 

Hardware 
Filters 

AC or DC 
.05 or .5 HP
1K or 5K LP 

IIR 
Filters 

Type, 
Freq., Q 

Scaling 
(Mapping) 

Units 
label 

Recommended 
Calibration & 
Sample Rate 
(Samples/sec) 

Use with the BIOPAC SS25LA Hand 
Dynamometer. 

1K LP 3.50 mV to 
100 

 Min. Sample 
Rate: 100 S/S 

Clench Force - kgf/m^2 (SS56L) 100 DC 

1K LP 

1: LP, 
66.5 Hz, 
Q=.5 
2: LP, 
38.5, 
Q=1 

3: BS 
Line, 
Q=1 

0 mV to 0 

20.48 mV to 
3515 

kgf/m^2  

Clench Force - kpa (SS56L) 100 DC 

1K LP 

1: LP, 
66.5 Hz, 
Q=.5 
2: LP, 
38.5, 
Q=1 

3: BS 
Line, 
Q=1 

0 mV to 0 

20.48 mV to 
34.47 

kpa  

Clench Force – lbs (SS25LA) 

Clench Force 

Use with the BIOPAC SS25LA Hand 
Dynamometer. 

500 DC 

1K LP 

BP 0 mV to 0 

3.50 mV to 
220 

lbs Calibration 
required**  

Min. Sample 
Rate: 100 S/S 

Clench Force – N (SS25LA) 

Clench Force (Newtons) 

Hand Dynamometer Clench Force 

Use with the BIOPAC SS25LA Hand 
Dynamometer. 

500 DC 

1K LP 

BP 0 mV to 0 

3.50 mV to 
981 

N Calibration 
required**  

Min. Sample 
Rate: 100 S/S 

Clench Force - psi (SS56L) 100 DC 

1K LP 

1: LP, 
66.5 Hz, 
Q=.5 
2: LP, 
38.5, 
Q=1 

3: BS 
Line, 
Q=1 

0 mV to 0 

61.44 mV to 
15 

psi  

CO2 Expired (GASSYS2) 

GAS - CO2 (Used on GAS-System2) 

 

200 

 

DC 

1K LP 

 

BP 

 

1.027 mV to 
0.04 

11.02 mV to 
1 

 

% CO2 

 

 

 

Current Monitor (BSLCBL10) 

Current/Voltage Drive & Monitor Cable. 
(DSUB 9M + DSUB 9F to clip leads) 

 

 

200 

 

DC 

5K LP 

 

 

None 

 

0 mV to 0 

50 mV to 50 

 

micro 
Amp 

 

Displacement (cm) 

Displacement; use with SS14L. 

 

500 

 

DC 

1K LP 

 

BP 

 

0 mV to 0 

1 mV to 1 

 

 

cm 
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Analog Preset Name 

Channel Label 

Applicable Calc. Presets 

Gain 

X 

Hardware 
Filters 

AC or DC 
.05 or .5 HP
1K or 5K LP 

IIR 
Filters 

Type, 
Freq., Q 

Scaling 
(Mapping) 

Units 
label 

Recommended 
Calibration & 
Sample Rate 
(Samples/sec) 

Displacement (inches) 

Displacement; use with SS14L. 

500 DC 

1K LP 

BP 0 mV to 0 

1 mV to .394 

inches  

Displacement (AD Inst. DT-475)  

Displacement 

500 DC 

1K LP 

BP 0 mV to 0 

9 mV to 1 

inches  

Dissolved O2 (BSL-TCI16) 

Dissolved O2 using BIOPAC 
RXPROBE02 and Vernier (BT (RH) 
connector)  

 

200 

 

DC 

1K LP  

 

BP 

 

0 mV to 0 

25 mV to 100 

 

% O2 

 

 

 

Earthworm Action Potential 

Earthworm Action Potential 

 

10,000 AC 

5 Hz HP, 5 
HP,  5K LP 

HP,  50, 
.707 

 

-10 uV to -10 

10 uV to 10 

micro V 100,000 

 

Electrocardiogram (ECG), .05 - 35 Hz 

Use when recording Human ECG 
signals using the BIOPAC SS2L 
Electrode Leads. This preset will 
preserve more of the ECG component 
amplitude than the (.5 – 35 Hz) filter, but 
with more baseline drift. Works well if 
subject is completely relaxed and 
motionless. 

Can be used with the ECG Calculation 
presets to obtain real time Rate, R-wave 
amplitude, etc.  

1000 AC 

.05 HP, 1K 
LP 

BP -1000 uV to -
1 

1000 uV to 1 

-1 mV to -1 

1 mV to 1 

mV 

 

Min. Sample 
Rate: 100 S/S 

Electrocardiogram (ECG), .05 - 100 Hz, 
AHA American Heart Assoc. 

ECG (.05 – 100 Hz, AHA) 

1,000 AC 

.05 HP, 1K 
LP 

LP, 100, 
.707 

 

-1000 uV to -
1 

1000 uV to 1 

-1 mV to -1 

1 mV to 1 

mV  

Electrocardiogram (ECG), .05 - 150 Hz 

ECG (.05 – 150 Hz) 

Use when recording Human ECG 
signals using the BIOPAC SS2L 
Electrode Leads. This preset is mainly 
used when measuring amplitudes and 
timing of the components of the ECG. It 
can only work if the subject is 
completely relaxed and motionless (no 
interfering EMG signals), and no power 
line (50/60 Hz) interference is present. 

1,000 AC 

.05 HP, 1K 
LP 

LP, 150, 
.707 

 

-1000 uV to -
1 

1000 uV to 1 

-1 mV to -1 

1 mV to 1 

mV Min. Sample 
Rate: 500 S/S 

Electrocardiogram (ECG), .5 - 35 Hz 

ECG (.5 – 35 Hz) 

Electrode Cable with 3 Leads 

Use when recording Human ECG 
signals using the BIOPAC SS2L 
Electrode Leads. This preset will give a 
clean recording with minimal baseline 
drift, however the components of the 
ECG may have a slight reduction in 
amplitude due to the added filters.  

Can be used with the ECG Calculation 

 

1,000 

 

AC 

.5 HP, 1K 
LP 

 

BP 

 

-1000 uV to -
1 

1000 uV to 1 

-1 mV to -1 

1 mV to 1 

 

mV 

Min. Sample 
Rate: 100 S/S 
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Analog Preset Name 

Channel Label 

Applicable Calc. Presets 

Gain 

X 

Hardware 
Filters 

AC or DC 
.05 or .5 HP
1K or 5K LP 

IIR 
Filters 

Type, 
Freq., Q 

Scaling 
(Mapping) 

Units 
label 

Recommended 
Calibration & 
Sample Rate 
(Samples/sec) 

presets to obtain real time Rate, R-wave 
amplitude, etc.  

Additional Calculation Channel Presets 
can be created to filter out unwanted 
EMG interference. 

Electrodermal Activity (EDA), 0 - 35 Hz 

EDA (0 – 35 Hz) 

EDA (GSR) finger electrodes 

EDA (GSR) with electrode pinch leads: 
Use any Preset from SS3LA 

Use when recording electrodermal 
activity (galvanic skin response) using 
the BIOPAC SS3LA EDA (GSR) 
transducer. Changing baseline may 
make this preset hard to work with. If 
only changes in the EDA are desired, 
use the “EDA Change” preset. 
_______________________________ 

SCR setup: For skin resistance, use an 
Expression calculation channel to take 
the reciprocal of conductance and then 
apply proper scaling. 

 

2,000 

 

DC 

1K LP 

 

BP 

 

0 uV to 0 

1000 uV to 
10 

 

micro 
seimens  

 

Calibration 
required**  

Min. Sample 
Rate: 100 S/S 

Electrodermal Activity (EDA) Change 

EDA Change 

Use when recording changes in 
electrodermal activity using the BIOPAC 
SS3LA EDA (GSR) transducer. Baseline 
drift is minimized with the .05 Hz High 
Pass filter. 

5,000 AC 

.05 HP, 1K 
LP 

BP 0 uV to 0 

1000 uV to 
10 

delta 
micro 
seimens  

 

Min. Sample 
Rate: 100 S/S 

Electroencephalogram (EEG), .5 - 35 Hz 

EEG (.5 – 35 Hz) 

Use when recording Human EEG 
signals using the BIOPAC SS2L 
Electrode Leads.  

Can be used with the EEG Calculation 
presets (alpha, beta, delta, and theta) to 
extract the specific EEG frequency 
bands. 

25,000 

20,000 

AC 

.5 HP, 1K 
LP 

BP -10 uV to -10 

10 uV to 10 

micro V Min. Sample 
Rate: 100 S/S 

Electroencephalogram (EEG), .5 - 100 
Hz w/notch 

EEG (.5 - 100 Hz, w/notch)  

Note: This bandwidth is needed for 
extracting the gamma frequency band 
using the calculation channel preset: 
EEG gamma (30 - 90 Hz). 

25,000 

20,000 

AC 

.5 HP, 1K 
LP 

LP, 100, 
.707 

BSLF 

 

-10 uV to -10 

10 uV to 10 

micro V  

Electrogastrogram (EGG) 

EGG 

5,000 AC 

.05 HP, 1K 
LP DC 

BP -1000 uV to -
1 

1000 uV to 1 

mV  

Electromyogram (EMG), 5 - 250 Hz 
w/notch 

EMG (5 – 250 Hz w/notch) 

1,000 AC 

5 HP 

LP, 250, 
.707 

BSLF 

-1 mV to -1 

1 mV to 1 

mV  

Electromyogram (EMG), 5 - 500 Hz 1,000 AC LP, 500, -1 mV to -1 mV  
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Analog Preset Name 

Channel Label 

Applicable Calc. Presets 

Gain 

X 

Hardware 
Filters 

AC or DC 
.05 or .5 HP
1K or 5K LP 

IIR 
Filters 

Type, 
Freq., Q 

Scaling 
(Mapping) 

Units 
label 

Recommended 
Calibration & 
Sample Rate 
(Samples/sec) 

EMG (5 – 500 Hz) 5 HP .707 

 

1 mV to 1 

Electromyogram (EMG), 5 - 1000 Hz 

EMG (5 – 1000 Hz) 

1,000 AC 

5 HP 

LP, 
1000, 
.707 

-1 mV to -1 

1 mV to 1 

mV 

 

 

Electromyogram (EMG), 30 - 250 Hz 
w/notch 

EMG (30 – 250 Hz w/notch) 

Use when recording general EMG 
signals using the BIOPAC SS2L 
Electrode Leads. Bandwidth is limited to 
250 Hz so that a sample rate of 500 S/S 
can be used. Notch filter is added to 
minimize electrical interference, but may 
distort the EMG signal. Can be used 
with the EMG Calculation Channel 
presets to obtain “Integrated” or “RMS” 
data. 

1,000 

 

AC 

.5 HP, 5 Hz, 
1K LP 

HP,  30, 
.707 

LP, 250, 
.707 

BSLF 

-1000 uV to -
1 

1000 uV to 1 

-1 mV to -1 

1 mV to 1 

mV Min. Sample 
Rate: 500 S/S 

Electromyogram (EMG), 30 - 500 Hz  

EMG (30 – 500 Hz) 

Use when recording EMG signals using 
the BIOPAC SS2L Electrode Leads. 
This preset will give maximum EMG 
accuracy, but will require a high sample 
rate. No Notch filter is added so 
electrical interference may pose a 
problem. Can be used with the EMG 
Calculation Channel presets to obtain 
“Integrated” or “RMS” data. 

1,000 AC 

.5 HP, 5 HP,  
1K LP 

HP,  30, 
.707 

LP, 500, 
.707 

-1000 uV to -
1 

1000 uV to 1 

-1 mV to -1 

1 mV to 1 

mV Min. Sample 
Rate: 2000 S/S 

Electromyogram (EMG), 30 - 1000 Hz 

EMG (30 – 1000 Hz) 

1,000 AC 

.5 HP, 5 HP, 

5K LP 

HP,  30, 
.707 

LP, 
1000, 
.707 

-1000 uV to -
1 

1000 uV to 1 

-1 mV to -1 

1 mV to 1 

mV 

 

 

Electrooculogram (EOG), .05 - 35 Hz 

EOG (.05 – 35 Hz) 

Use when recording EOG (eye 
movement) signals using the BIOPAC 
SS2L Electrode Leads. 

2,000 

1,000 

AC 

.05 HP, 1K 
LP 

BP -1000 uV to -
1 

1000 uV to 1 

-1 mV to -1 

1 mV to 1 

mV Min. Sample 
Rate: 100 S/S 

Finger Displacement (cm) 

Finger Displacement 

2,000 DC 

1K LP 

BP 3900 uV to 0 

3400 uV to 2 

cm  

Finger Twitch transducer 

Finger Displacement (inches) 

Finger Displacement 

 

2,000 

 

DC 

1K LP 

 

BP 

 

3900 uV to 0 

3400 uV to 2 

 

inches 

 

 

 

Force (0 – 50 grams) 

Force 

Use with the BIOPAC SS12L, Variable 
Range Force Transducer. 

 

 

500 

 

DC 

1K LP 

 

BP 

 

0 mV to 0 

5 mV to 50 

 

grams 

 

Calibration 
required** 
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Analog Preset Name 

Channel Label 

Applicable Calc. Presets 

Gain 

X 

Hardware 
Filters 

AC or DC 
.05 or .5 HP
1K or 5K LP 

IIR 
Filters 

Type, 
Freq., Q 

Scaling 
(Mapping) 

Units 
label 

Recommended 
Calibration & 
Sample Rate 
(Samples/sec) 

 

 

Force (0 – 100 grams) 

Force 

Use with the BIOPAC SS12L, Variable 
Range Force Transducer. 

500 DC 

1K LP 

BP 0 mV to 0 

5 mV to 100 

grams 

 

Calibration 
required** 

Force (0 – 200 grams) 

Force 

Use with the BIOPAC SS12L, Variable 
Range Force Transducer. 

500 DC 

1K LP 

BP 0 mV to 0 

5 mV to 200 

grams 

 

Calibration 
required** 

Force (0 – 500 grams) 

Force 

Use with the BIOPAC SS12L, Variable 
Range Force Transducer. 

500 DC 

1K LP 

BP 0 mV to 0 

5 mV to 500 

grams 

 

Calibration 
required** 

Force (0 – 1000 grams) 

Force 

Use with the BIOPAC SS12L, Variable 
Range Force Transducer. 

500 DC 

1K LP 

BP 0 mV to 0 

5 mV to 1000 

grams 

 

Calibration 
required** 

Force (iWorx FT-100)  

Force measurment using WPI, AD 
Instruments (CB Sciences) and iWorx (8 
pin, Female) 

 

1,000 

 

DC 

1K LP 

 

 

BP 

 

0 mV to 0 

2.5 mV to 
250 

 

grams 

 

Galvanic Skin Response – GSR 

     See Electrdermal Activity – EDA 

      

Goniometer 

Goniometer (110 mm max.), 2 CH 

Wrist or ankle, +- 180º  

Use with the BIOPAC SS20L, SS21L 
and SS24L Goniometers. 

 

500 

 

DC 

1K LP 

 

BP 

 
-1 mV to -90  

1 mV to 90 

 

degrees 

Calibration 
required**  

Min. Sample 
Rate: 100 S/S 

Goniometer (Intelitool - Flexicomp) 

Goniometery measurement using 
Intelitool (6 pin mini DIN, Female) 

 

200 

 

DC 

1K LP 

 

BP 

 

0 mV to 90 

5 mV to 150 

 

degrees 

 

Heel/Toe Strike 

Heel/Toe Strike assembly 

 

1,000 

 

DC 

1K LP 

 

BP 

 

-5 mV to -1 

5 mV to 1 

 

Impulse 

 

 

Microphone (SS17L, .5 – 200 Hz) 

Microphone 

Piezo Microphone 

Use with the BIOPAC SS17L 
Microphone to record Physiological 
Sounds (such as heart and Korotkoff 
sounds). 

 

200 

 

AC 

.5 HP, 1K 
LP 

 

LP, 200, 
.707 

 

-10 mV to -10 

10 mV to 10 

 

mV 

 

Min. Sample 
Rate: 500 S/S 

Microphone for Speech (SS62L) 

Microphone 

200 AC 

5 HP 

HP, 30, 
.707 

LP, 
3500, 

-10 mV to -10 

10 mV to 10 

mV 10,000 
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Analog Preset Name 

Channel Label 

Applicable Calc. Presets 

Gain 

X 

Hardware 
Filters 

AC or DC 
.05 or .5 HP
1K or 5K LP 

IIR 
Filters 

Type, 
Freq., Q 

Scaling 
(Mapping) 

Units 
label 

Recommended 
Calibration & 
Sample Rate 
(Samples/sec) 

.707 

 

Monitor Audio Output (MP45 only, CH2 
only) 

200 DC None 

100 

.707 

-10 mV to -10 

10 mV to 10 

mV  

MP100/150 Interface (BSLCBL14) 

MP100/150 Interface 

10 DC 

 

None -1000 mV to -
10 

1000 mV to 
10 

Volts  

Nerve Response (BSLCBL3, 4, 9) 

Nerve Response 

Nerve Conduction Recording Cable 

(DSUB 9M to 3x Banana Plugs)  <divide 
by 10> 

Input Range (MP30) = +-700 mV 

Input Range (MP36/35) = +-10 Volts 

 

2,000 

1,000 

 

AC 

.5 HP, 5K 
LP 

 

None 

 

-1000 uV to -
10 

1000 uV to 
10 

-1 mV to -10 

1 mV to 10 

 

 

mV 

 

100,000 

 

Nerve Response (BSLCBL8) 

Nerve Response 

High Impedance Cable 

      

O2 Expired (GASSYS2) 

O2 Expired 

GAS - O2 (Used on GAS-System2) 

200 DC 

1K LP 

BP 0 mV to 0 

20.64 mV to 
20.93 

% O2 

 

 

pH (BSL-TCI21) 

pH 

pH Probe (Generic, BNC style) 

use with RXPROBE01) 

 

200 

 

DC 

1K LP 

 

BP 

 

0 mV to 7 

35 mV to 14 

 

pH 

 

 

Pneumogram 

Pneumogram transducer  

SS67L = SS41L + RX110 + tubing 

 

 

500 

 

DC 

1K LP  

 

 

BP 

 

0  mV to 0 

6.55 mV to 
10 

 

 

cm H2O 

 

 

Pressure (+- 2.5 cm H2O) 

Pressure 

SS40L Diff. Pressure Transducer +-2.5 
cm H20 

 

1,000 

 

DC 

1K LP 

 

BP 

0 mV to 0 

1.6375 mV to 
1 

 

cm H2O 

 

Pressure (+- 12.5 cm H2O) 

Pressure 

SS41L Diff. Pressure Transducer +-12.5 
cm H20 

 

500 

 

DC 

1K LP 

 

BP 

 

0 mV to 0 

6.55 mV to 
10 

 

cm H2O 

 

 

Pressure (+- 25 cm H2O) 

Pressure  

SS42L Diff. Pressure Transducer +-25 
cm H20 

 

500 

 

DC 

1K LP 

 

BP 

 

0 mV to 0 

3.27 mV to 
10 

 

cm H2O 

 

 

Psychological Response 

Psych. Response Indicator 

 

200 

 

DC 

 

BP 

 

0 mV to 0 

 

Respons
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Analog Preset Name 

Channel Label 

Applicable Calc. Presets 

Gain 

X 

Hardware 
Filters 

AC or DC 
.05 or .5 HP
1K or 5K LP 

IIR 
Filters 

Type, 
Freq., Q 

Scaling 
(Mapping) 

Units 
label 

Recommended 
Calibration & 
Sample Rate 
(Samples/sec) 

SS43L Variable Asessment Transducer 1K LP 50 mV to 9 e 

Pulse Plethysmograph (PPG) 

PPG (Pulse) 

Use with the BIOPAC SS4L Pulse 
Plethysmograph (PPG) finger 
transducer to record variations in blood 
density. Can be used with the “Pulse 
Rate” Calculation Channel preset to 
obtain real time pulse rate data. 

 

 

5,000 

 

 

AC 

.5 HP, 1K 
LP 

 

 

BP 

 

 

-1000 uV to -
1 

1000 uV to 1 

 

 

mV 

 

Min. Sample 
Rate: 100 S/S 

Reflex Hammer 

Reflex hammer strike 

SS36L Reflex Hammer 

 

2,000 

 

DC 

1K LP 

 

BP 

 

-1000 uV to -
1 

1000 uV to 1 

 

mV 

 

 

Reflex Hammer (Intelitool - Flexicomp) 

Reflex Hammer 

200 DC 

5K LP 

 

N/A 

-10 mV to -10 

10 mV to 10 

mV  

Respiration (SS5LB) 

Respiration Belt (for Chest), Version 3 

Respiration 

Use with the BIOPAC SS5LB 
Respiratory Effort Transducer to record 
changes in thoracic or abdominal 
circumference. The .05 Hz High Pass 
filter helps to minimize baseline drift. 
Can be used with the “Respiration Rate” 
Calculation Channel preset to obtain 
real time rate data. 

 

1,000 

 

AC 

.05 HP, 1K 
LP 

 

BP 

 

-10 mV to -10 

10 mV to 10 

 

mV 

 

Min. Sample 
Rate: 100 S/S 

Stethoscope (Heart Sounds) 

Stethoscope 

Use with the BIOPAC SS30L electronic 
Stethoscope for recording Heart 
Sounds. 

 

2,000 

 

AC 

.5 HP, 5 HP,  
1K LP 

 

HP, 40, 
.707 

LP, 60, 
.707 

 

-1000 uV to -
1 

1000 uV to 1 

 

mV 

 

Min. Sample 
Rate: 200 S/S 

Stethoscope (Korotkoff Sounds) 

Stethoscope 

Normally used with the BIOPAC SS19L 
for recording and determining Systolic 
and Diastolic Blood Pressure. 

2,000 AC 

.5 HP, 5 HP,  
1K LP 

HP, 50, 
.707 

LP, 100, 
.707 

-1000 uV to -
1 

1000 uV to 1 

mV 

 

Min. Sample 
Rate: 200 S/S 

Stimulator - BSLSTM (0 – 10 Volts ) 

Stimulator 

Stimulator Reference cable from 
BSLSTMA or BSLSTMB(MP36/35 only) 

Use for recording the “Reference 
Output” Pulse of the BIOPAC BSLSTMA 
Stimulator. This preset is used when the 
Range switch on the front of the 
BSLSTM is in the “0-10V” position. The 
amplitude of the pulse reflects the 
Stimulator output voltage.  

Note that there will be some overshoot 
on the leading edge of the pulse. If this 
is not desirable, then change the Analog 
Filter to 1KHz. 

 

 

200 

 

 

DC 

5K LP 

 

 

None 

 

 

0 mV to 0 

50 mV to 10 

 

 

Volts 

Calibration: 
optional to 
obtain greater 
accuracy. 

Min. Sample 
Rate: 200 S/S 
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Analog Preset Name 

Channel Label 

Applicable Calc. Presets 

Gain 

X 

Hardware 
Filters 

AC or DC 
.05 or .5 HP
1K or 5K LP 

IIR 
Filters 

Type, 
Freq., Q 

Scaling 
(Mapping) 

Units 
label 

Recommended 
Calibration & 
Sample Rate 
(Samples/sec) 

Stimulator - BSLSTM (0 – 100 Volts ) 

Stimulator 

Use for recording the “Reference 
Output” Pulse of the BIOPAC BSLSTM 
Stimulator. This preset is used when the 
Range switch on the front of the 
BSLSTM is in the “0-100V” position. The 
amplitude of the pulse reflects the 
Stimulator output voltage. 

Note that there will be some overshoot 
on the leading edge of the pulse. If this 
is not desirable, then change the Analog 
Filter to 1KHz. 

200 DC 

5K LP 

None 0 mV to 0 

50 mV to 100 

Volts 

 

Calibration: 
optional to 
obtain greater 
accuracy. 

Min. Sample 
Rate: 200 S/S 

Stroboscope Flash (TSD122) 

Stroboscope Flash 

200 DC 

5K LP 

None -50 mV to -10 

50 mV to 10 

Volts  

BSL 3.7.3 or below – not in BSL 3.7.7: 

SuperLab Sync. (SS44L) 

SuperLab Interface Cable for MP30 

SuperLab Sync. 

Note: Superlab interface assembly for 
MP36/35 (consists of 1-SS59L; see 
BNC SS9L preset) 

 

200 

 

DC 

1K LP  

 

None 

 

0 mV to 0 

25 mV to 5 

 

Volts 

 

Switch 

Pushbutton Switch 

Use when recording Pushbutton Switch 
State using BIOPAC SS10L PushButton 
HandSwitch. This is useful for Response 
testing, etc. 

 

1,000 

 

DC 

1K LP 

 

LP, 30, 
.707 

BSLF 

 

-1 mV to -1 

1 mV to 1 

 

Volts 

 

Min. Sample 
Rate: 200 S/S 

Temperature (deg. C) 

Temperature 

Skin Temperature (fast response) 

Response time = .6 seconds 

Use when recording Skin Temperature 
in degrees Celsius using the BIOPAC 
SS6L Temperature Transducer.  

Calibration required**  

 

 

2,000 

 

 

DC 

1K LP 

 

 

BP 

 

 

0 uV to 32.22 

1000 uV to 
35 

 

 

deg C 

 

Min. Sample 
Rate: 100 S/S 

Temperature (deg. F) 

Temperature 

Use when recording Skin Temperature 
in degrees Fahrenheit using the 
BIOPAC SS6L Temperature 
Transducer.  

Calibration required** 

2,000 DC 

1K LP 

BP 0 uV to 90 

1000 uV to 
95 

deg F 

 

Min. Sample 
Rate: 100 S/S 

Temperature (waterproof, vinyl) 

Response time = 1.1 seconds 

     Use any preset from SS6L 

 

- 

 

- 

 

- 

 

- 

 

- 

 

Temperature Change (deg. C) 

Temperature Change 

2,000 AC 

.05 HP, 1K 

BP 0 uV to 0 

1000 uV to 

delta 

deg C 

Min. Sample 
Rate: 100 S/S 
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Analog Preset Name 

Channel Label 

Applicable Calc. Presets 

Gain 

X 

Hardware 
Filters 

AC or DC 
.05 or .5 HP
1K or 5K LP 

IIR 
Filters 

Type, 
Freq., Q 

Scaling 
(Mapping) 

Units 
label 

Recommended 
Calibration & 
Sample Rate 
(Samples/sec) 

Use when recording Skin Temperature 
changes in degrees Celsius using the 
BIOPAC SS6L Temperature 
Transducer. Because only the skin 
temperature difference is important, 
calibration to obtain absolute 
temperature is not required. 

 

 

LP 2.78 

Temperature Change (deg. F) 

Temperature Change 

Use when recording Skin Temperature 
changes in degrees Fahrenheit using 
the BIOPAC SS6L Temperature 
Transducer. Because only the skin 
temperature difference is important, 
calibration to obtain absolute 
temperature is not required. 

2,000 AC 

.05 HP, 1K 
LP 

BP 0 uV to 0 

1000 uV to 5 

delta 

deg F 

Min. Sample 
Rate: 100 S/S 

Tobacco Hornworm (BSLCBL8) 

Tobacco Hornworm 

10,000 AC 

.5 HP, 5 HP, 

1K LP 

HP,  10, 
.707 

LP, 250, 
.707 

BSLF 

HP,  30, 
.707 

LP, 250, 
.707 

BSLF 

-10 uV to -10 

10 uV to 10 

 

micro V  

Torsiometer 

Torsiometer (110 mm max.), 1 CHl 

Neck, +- 90º  

Use with the BIOPAC SS22L and 
SS23L Torsiometers. 

 

 

2,000 

 

 

DC 

1K LP 

 

 

BP 

 

-2250 uV to -
90 

2250 uV to 
90 

 

 

degrees 

 

Calibration 
required**  

Min. Sample 
Rate: 100 S/S 
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Appendix C — Table of Calculation Presets 

 

Calculation Preset 

Name; Label; Source CH 

Calculation Function 

Enabled Options; 
Parameters 

Units label Scaling 
(Units) 

New 

 

New calculation channel details 
start on page 69. 

To create a new calculation 
channel preset, see page 72. 

 

 
dp/dt @ 200 samples/sec. 

dp/dt @ 200 s/s 

Source: Blood Pressure (Arterial) only when sample rate 
is 200 s/s 

Computes the change in pressure with respect to time 
(derivative of pressure), so it works in conjunction with a 
pressure source channel. Normally this is used when the 
pressure source channel is measuring direct blood 
pressure from animals. 

Difference 

Intervals between 
samples: 1 

0  > 0 

1 > 200 

mmHg/sec 

dp/dt @ 500 samples/sec. 

dp/dt @ 500 s/s 

Source: Blood Pressure (Arterial) only when sample rate 
is 500 s/s 

Difference 

Intervals between 
samples: 1 

0  > 0 

1 > 500 

mmHg/sec 

dp/dt @ 1000 samples/sec. 

dp/dt @ 1000 s/s  

Source: Blood Pressure (Arterial) only when sample rate 
is 1000 s/s 

Difference 

Intervals between 
samples: 1 

0  > 0 

1 > 1000 

mmHg/sec 

ECG – R-R Interval 

Computes the R wave to next R wave time interval for 
an ECG source channel. This preset is optimized for 
Human ECG (40 – 180 BPM range). 

   

ECG - R-wave Amplitude 

R Amplitude 

Source: Any Human ECG preset listed for SS2L. 

Tracks the R wave amplitude for an ECG source 
channel. This preset is optimized for Human ECG (40 – 
180 BPM range). 

Rate 

Function: Peak Maximum  

Peak detect: Positive 

Auto threshold detect 

Noise rejection: 5% of 
peak  

Window: 

Windowing Units: BPM 

Min: 40 Max: 180 

N/A mV* 

EEG alpha (8 - 13 Hz) 

Alpha 

Source: Any Human EEG preset listed for SS2L. 

Filters out all frequencies except the specific alpha band 
(8 to 13 Hz), which can indicate relaxed and alert states. 

Filter  

Output: Band Pass (l + h) 

LowFreq: 8, HighFreq: 13 

Q: 0.707 

N/A Units of 
source 
channel** 
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Calculation Preset 

Name; Label; Source CH 

Calculation Function 

Enabled Options; 
Parameters 

Units label Scaling 
(Units) 

EEG beta (13 - 30 Hz) 

Beta 

Source: Any Human EEG preset listed for SS2L. 

Filters out all frequencies except the specific beta band 
(which is from 13 to 30 Hz). Frequencies in the beta 
band can indicate levels of alertness and higher 
amplitudes can occur during deep sleep (REM).  

Filter  

Output: Band Pass (l + h) 

LowFreq: 13, HighFreq: 
30 

Q: 0.707 

N/A Units of 
source 
channel** 

EEG delta (1 - 5 Hz) 

Delta 

Source: Any Human EEG preset listed for SS2L. 

Filters out all frequencies except the specific delta band 
(which is from 1 to 5 Hz). Frequencies in the delta band 
are often of higher amplitude when a subject is sleeping. 

Filter  

Output: Band Pass (low + 
high) 

LowFreq: 1, HighFreq: 5 

Q: 0.707 

N/A Units of 
source 
channel** 

EEG theta (4 - 8 Hz) 

Theta 

Source: Any Human EEG preset listed for SS2L. 

Filters out all frequencies except the specific theta band 
(which is from 4 to 8 Hz). Frequencies in the theta band 
are often of higher amplitude when a subject is sleeping. 

Filter  

Output: Band Pass (low + 
high) 

LowFreq: 4, HighFreq: 8 

Q: 0.707 

N/A Units of 
source 
channel** 

EEG gamma (30 - 90 Hz) 

Gamma 

Source: Requires the higher bandwidth 
(Electroencephalogram (EEG), .5 - 100 Hz w/notch) 
preset. 

Filter  

Output: Band Pass (low + 
high) 

LowFreq: 30, HighFreq: 
90 

Q: 0.707 

N/A Units of 
source 
channel** 

EGG (.02 - 125 Hz) 
EGG (.02 - .125 Hz) 
EGG 
Source: Any Human EGG preset listed for SS2L. 

Filter 

Low Pass, 1, .707 

Freq: 1 Hz 

Q: 0.707 

N/A Units of 
source 
channel** 

EMG - Integrated 

Integrated 

Source: Any Human EMG preset listed for SS2L. 

Used as an indication of the EMG output level. Each 
data point of Integrated EMG is calculated using 20 
samples of data from the EMG source channel. Each 
data point used is first Rectified (all negative values are 
inverted), then the Mean value is computed. 

Note: The algorithm performs an average rectified 
value (AVR) to approximate an integration. 

Integrate Parameters 

Average over samples 

Samples:  20 

Parameters: Rectify 

-10000 > -10 

10000 > 10 

mV 

EMG - RMS 

EMG – RMS 

Source: Any Human EMG preset listed for SS2L. 

Used to measure the Standard Deviation of an EMG 
signal, which is an excellent way to compare EMG 
output levels. Any baseline information is removed from 
the data. Each sample point of RMS data is calculated 
using 20 samples of data from the EMG source channel. 
The baseline value is first determined, then each 
computed difference between data point and baseline is 
squared and summed. The square root of this sum is 
then determined. 

Integrate Parameters 

Average over samples 

Samples:  20 

Parameters: Root mean 
square, Remove baseline 

-10000 > -10 

10000 > 10 

mV 
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Calculation Preset 

Name; Label; Source CH 

Calculation Function 

Enabled Options; 
Parameters 

Units label Scaling 
(Units) 

Heart Rate (from ECG) 

Heart Rate 

Source: Any Human ECG preset listed for SS2L. 

Computes the Heart Rate in beats per minute (BPM) for 
an ECG source channel. It computes BPM based on the 
R wave to next R wave interval. This preset is optimized 
for Human ECG (40 – 180 BPM range). 

Note: When recording starts, the data displayed will not 
be accurate until the second R wave is obtained. 

Rate 

Function: Rate (BPM)   

Peak detect: Positive 

Remove baseline 

Auto threshold detect 

Noise rejection: 5% of 
peak  

Window: 

Windowing Units: BPM 

Min: 40 Max: 180 

N/A BPM* 

Large Animal dp/dt Minimum 

dp/dt Min.  

Source Channel: “dp/dt @ # samples/sec.” calculation 
channel. 

Tracks the minimum value for the dp/dt source channel, 
giving one the minimum change in pressure with respect 
to time (derivative of pressure).  

 

Rate 

Function: Peak Minimum  

Peak detect: Negative 

Auto threshold detect 

Noise rejection: 5% of 
peak  

Window: 

Windowing Units: BPM 

Min: 40 Max: 250 

N/A mmHg/sec* 

Large Animal dp/dt Maximum 

dp/dt Max. 

Source Channel: “dp/dt @ # samples/sec.” calculation 
channel. 

Tracks the maximum value for the dp/dt source channel, 
giving one the maximum change in pressure with 
respect to time (derivative of pressure).  

 

Rate 

Function: Peak Maximum  

Peak detect: Positive 

Auto threshold detect 

Noise rejection: 5% of 
peak  

Window: 

Windowing Units: BPM 

Min: 40 Max: 250 

N/A mmHg/sec* 

Large Animal Systolic Blood Pressure (BP) 

Systolic BP 

Source: Blood Pressure (Arterial) 

Tracks the Systolic Blood Pressure (or maximum 
pressure), of a direct blood pressure source channel. 
This preset is optimized for animals with a heart rate in 
the 40 – 250 beats per minute range. 

Rate 

Function: Peak Maximum  

Peak detect: Positive 

Auto threshold detect 

Noise rejection: 5% of 
peak  

Window: 

Windowing Units: BPM 

Min: 40 Max: 250 

N/A mmHg* 

Large Animal Diastolic Blood Pressure (BP) 

Diastolic BP 

Source: Blood Pressure (Arterial) 

Tracks the Diastolic Blood Pressure (or minimum 
pressure), of a direct blood pressure source channel. 
This preset is optimized for animals with a heart rate in 
the 40 – 250 beats per minute range. 

Rate 

Function: Peak Minimum  

Peak detect: Negative 

Auto threshold detect 

Noise rejection: 5% of 
peak  

Window: 

Windowing Units: BPM 

Min: 40 Max: 250 

N/A mmHg* 
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Calculation Preset 

Name; Label; Source CH 

Calculation Function 

Enabled Options; 
Parameters 

Units label Scaling 
(Units) 

Large Animal Mean Blood Pressure (BP) 

Mean BP 

Source: Blood Pressure (Arterial) 
Tracks the Mean Blood Pressure pressure of a direct 
blood pressure source channel. This preset is optimized 
for animals with a heart rate in the 40 – 250 beats per 
minute range. 

Rate 

Function: Mean Value  

Peak detect: Positive 

Auto threshold detect 

Noise rejection: 5% of 
peak  

Window: 

Windowing Units: BPM 

Min: 40 Max: 250 

N/A mmHg* 

Large Animal Heart Rate (from ECG) 

Heart Rate 

Source: Any of the human ECG Presets can be used. 

Computes the Heart Rate in beats per minute (BPM) for 
an ECG source channel. It computes BPM based on the 
R wave to next R wave interval. This preset is optimized 
for large animals with a heart rate in the 40 – 250 beats 
per minute range. 

Note: When the recording starts, the data displayed 
will not be accurate until the second R wave is obtained. 

Rate 

Function: Rate (BPM)  

Peak detect: Positive 

Remove baseline 

Auto threshold detect 

Noise rejection: 5% of 
peak  

Window: 

Windowing Units: BPM 

Min: 40 Max: 250 

N/A BPM* 

Lung Volume 
Volume 
Source: Airflow (SS11LA) 
Computes Volume from an Airflow source channel by 
using a special form of integration. This calculation is 
fairly sensitive, and the procedure given in the Manual 
should be closely followed. Note: Airflow signal must be 
bidirectional (Inhales and Exhales) in order for this 
preset channel to work properly. 

Integrate Parameters 

Reset via channel 

Control Channel: 

Reset thresholds 

LOW 0.00000 

HIGH 0.00000 

Reset trigger: Positive 

-10000 > -10 

10000 > 10 

Liters 

Pulse Rate (from PPG) 
Pulse Rate 
Source: Human Pulse (PPG) 

Computes the Pulse Rate in beats per minute (BPM) for 
a PPG (Pulse) source channel. It computes BPM based 
on the peak to next peak interval. This preset is 
optimized for Human pulse rates that fall in the 40 – 180 
BPM range. 

Note: The data displayed will not be accurate until the 
second peak is recorded. 

Rate 

Function: Rate (BPM)  

Peak detect: Positive 

Auto threshold detect 

Noise rejection: 5% of 
peak  

Window: 

Windowing Units: BPM 

Min: 40 Max: 180 

N/A BPM* 

Respiration Rate 
Source: Respiration 
 Respiration Transducer (SS5LB) 
 Airflow (SS11LA) 
 Airflow (SS52L) Pneumogram 
 Pressure (+- 25 cm H2O) 
 Or, if the sensor is placed at the nostril to 
measure air temperature: Temperature (deg. C) or 
Temperature (deg. F) 

Computes the Respiration Rate in breaths per minute 
(BPM) for a Respiration source channel. It computes 
BPM based on the peak to next peak interval. This 
preset is optimized for Human respiration rates that fall 
in the 6 – 20 BPM range. 

Note:  The data displayed will not be accurate until the 
second peak is recorded. 

Rate 

Function: Rate (BPM)  

Peak detect: Positive 

Auto threshold detect 

Noise rejection: 5% of 
peak  

Window: 

Windowing Units: BPM 

Min: 6 Max: 20 

N/A BPM* 
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Calculation Preset 

Name; Label; Source CH 

Calculation Function 

Enabled Options; 
Parameters 

Units label Scaling 
(Units) 

Segment Timer 
SegmentTimer 
Tracks recording time in seconds in a separate graph 
channel. The Timer is reset at the start of each 
subsequent appended segment.  (Also available as a 
Source in the Expression Calculation Channel) 

 -10000 to -10 

10000 to 10 

seconds 

seconds 

Small Animal dp/dt Minimum 

dp/dt Min. 

Source Channel: “dp/dt @ # samples/sec.” calculation 
channel 

Tracks the minimum value for the dp/dt source channel, 
giving one the minimum change in pressure with respect 
to time (derivative of pressure).  

 

Rate 

Function: Peak Minimum  

Peak detect: Negative 

Auto threshold detect 

Noise rejection: 5% of 
peak  

Window: 

Windowing Units: BPM 

Min: 40 Max: 600 

N/A mmHg/sec* 

Small Animal dp/dt Maximum 

dp/dt Max. 

Source Channel: “dp/dt @ # samples/sec.” calculation 
channel 

Tracks the maximum value for the dp/dt source channel, 
giving one the maximum change in pressure with 
respect to time (derivative of pressure).  

 

Rate 

Function: Peak Maximum  

Peak detect: Positive 

Auto threshold detect 

Noise rejection: 5% of 
peak  

Window: 

Windowing Units: BPM 

Min: 40 Max: 600 

N/A mmHg/sec* 

Small Animal Systolic Blood Pressure (BP) 

Systolic BP 

Source: Blood Pressure (Arterial) 

Tracks the Systolic Blood Pressure (or maximum 
pressure), of a direct blood pressure source channel. 
This preset is optimized for animals with a heart rate in 
the 100 – 600 beat per minute range. 

Rate 

Function: Peak Maximum  

Peak detect: Positive 

Auto threshold detect 

Noise rejection: 5% of 
peak  

Window: 

Windowing Units: BPM 

Min: 40 Max: 600 

N/A mmHg* 

Small Animal Diastolic Blood Pressure (BP) 

Diastolic BP 

Source: Blood Pressure (Arterial) 

Tracks the Diastolic Blood Pressure (or minimum 
pressure), of a direct blood pressure source channel. 
This preset is optimized for animals with a heart rate in 
the 100 –600 beat per minute range. 

Rate 

Function: Peak Minimum  

Peak detect: Negative 

Auto threshold detect 

Noise rejection: 5% of 
peak  

Window: 

Windowing Units: BPM 

Min: 40 Max: 600 

N/A mmHg* 
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Calculation Preset 

Name; Label; Source CH 

Calculation Function 

Enabled Options; 
Parameters 

Units label Scaling 
(Units) 

Small Animal Mean Blood Pressure (BP) 

Mean BP 

Source: Blood Pressure (Arterial) 

Tracks the Mean Blood Pressure pressure of a direct 
blood pressure source channel. This preset is optimized 
for animals with a heart rate in the 100 – 600 beat per 
minute range. 

Rate 

Function: Mean Value  

Peak detect: Positive 

Auto threshold detect 

Noise rejection: 5% of 
peak  

Window: 

Windowing Units: BPM 

Min: 40 Max: 600 

N/A mmHg* 

Small Animal Heart Rate (from ECG) 

Heart Rate 

Source: Any of the human ECG Presets can be used. 
ECG (100 – 600 BPM range) 

Computes the Heart Rate in beats per minute (BPM) for 
an ECG source channel. It computes BPM based on the 
R wave to next R wave interval. This preset is optimized 
for small animals with a heart rate in the 100 – 600 beat 
per minute range. 

Note: When recording starts, the data displayed will 
not be accurate until the second R wave is obtained. 

Rate 

Function: Rate (BPM)  

Peak detect: Positive 

Remove baseline 

Auto threshold detect 

Noise rejection: 5% of 
peak  

Window: 

Windowing Units: BPM 

Min: 40 Max: 600 

N/A BPM* 

Scaling (Units) Notes 

   * The units shown will not necessarily be seen in the Change Scaling Parameters dialog.  They will be 
inserted automatically at the start of the first acquisition segment. 

   ** The units will be the same as the source channel units, but may not be reflected in the Change Scaling 
Parameters dialog. 
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Appendix D — MP Unit Specifications 

MP ACQUISITION UNIT 
The MP data acquisition unit is the heart of the Biopac Student Lab PRO System. The MP Unit has an internal 
microprocessor to control data acquisition and communication with the computer. The MP Unit takes incoming 
signals and converts them into digital signals that can be processed with your computer. There are four analog input 
channels, one of which can be used as a trigger input. You will need to connect the MP Unit to your computer and 
connect electrodes, transducers, and I/O devices to the MP Unit. You are encouraged to take a few minutes to 
familiarize yourself with the MP Unit prior to making any connections. 

The MP36/35 Data Acquisition System is a physiological data recorder designed for medical educational purposes. 
This system is used in medical education and research facilities. This system is not used for the mitigation, cure or 
diagnosis of disease. This device is NOT used in the home. Subject to IEC60601-1, the MP36/35 Data Acquisition 
System is CLASS II, type BF equipment. 

 

SYMBOLS — MP36, MP35, and MP45 

Symbol Description Explanation 

 

Type BF Equipment Classification 

 
Attention Consult accompanying documents 

 

On (partial) 
Turns MP35 on assuming AC300A 
power adapter is powered by the mains 

 

Off (partial) 
Turns MP35 off if but AC300A power 
adapter remains powered by the mains 

 Direct current Direct current input 

 
USB USB port 

 

Functional Earth 
Ground 

Functional Earth Ground Connection 

 
Class II Equipment 

Class II Medical Equipment, as 
established by IEC60601-1 

Fuse Equipment Fuse 

 

COMPLIANCE 

  SAFETY 
The MP36/35 satisfies the Medical Safety Test Standards affiliated with IEC60601-1. The MP36/35 is 
designated as Class I Type BF medical equipment 

  EMC 
The MP36/35 satisfies the Medical Electromagnetic Compatibility (EMC) Test Standards affiliated with 
IEC60601-1-2. 

TYPES OF INPUT DEVICES 
There are three types of devices that connect to the MP UNIT: electrodes, transducers, and I/O devices. 
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Electrodes are relatively simple instruments that attach to the surface of the skin and pick up electrical signals in the 
body. 

Transducers, on the other hand, convert a physical signal into a proportional electrical signal. 

Input/Output devices (I/O for short) are specialized devices like pushbutton switches and headphones. 

 
SIMPLE SENSOR CONNECTORS 
Regardless of the type of device connected, every sensor or I/O device connects to the MP UNIT using a “Simple 
Sensor” connector. Simple Sensor connectors are designed to plugs only one way into the MP UNIT, so you don’t 
have to worry about plugging things in upside down or into the wrong socket. 

Electrodes, transducers, and the pushbutton switch all connect to the channel input ports on the front panel of the 
MP UNIT. 

Headphones and the stimulator connect to the “Analog out” port on the back panel of the MP UNIT. 

MP36/35 only: A digital device may connect to the “I/O Port” on the back panel  

MP36/35 only: A trigger device may be connected to the “Trigger” port on the back panel. 

 
FRONT PANEL 

 
Front Panel, MP UNIT 

The front panel of the MP UNIT has an electrode check port, four analog input ports, and two status indicators. 

Electrode Check 

 The Electrode Check port is a diagnostic tool used with the BSL PRO software to determine if the electrodes 
are properly attached to the subject. See page 7151. 

Input ports: CH 1, CH 2, CH 3, and CH 4  

The inputs on the MP UNIT acquisition unit are referred to as Channels. There are four 9-pin female analog 
input ports on the front of the MP UNIT. The Biopac Student Lab Lessons software will always check to see that 
you have the proper sensors connected to the appropriate channel. 

Status indicators 

The Busy status indicator is activated when the MP UNIT is acquiring data and also during the first few seconds 
after the MP UNIT is powered on to indicate that a self-test is in progress. (When the MP UNIT passes the power-on 
test, the Busy light will turn off.) 

The Power status indicator is illuminated when the MP UNIT is turned on. 
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BACK PANEL 

 
Back Panel, MP36/35 

The back panel of the MP36/35 has an analog output port, a USB port, an I/O Port, a Trigger Port, a DC input, a fuse 
holder, and a power switch, and the unit’s serial number. 

The back panel of the MP30 has an analog output port, a serial port, a DC input, a fuse holder, and a power switch, 
and the unit’s serial number. 

Analog Out port 

There is one 9-pin male “D” analog output port on the back of the MP UNIT that allows signals to be amplified and 
sent out to devices such as headphones. 

USB port (MP36/35 only) 

The MP36/35 connects to the computer via a USB Port, located just below the word USB. 

Uses a standard USB connector. 

Should only be used to connect the MP36/35 to a PC or Macintosh. 

 

Serial port (MP30 only) 

The MP30 connects to the computer via a serial port, located just below the word Serial. 

Uses a standard MINI DIN 8 connector. 

Should only be used to connect the MP30 to a PC (with ISA or PCMCIA card) or Macintosh. 

 

Headphone Output (MP36/35 only) 

Accepts a standard (1/4” or 6.3mm) stereo headphone jack. 

 

I/O Port (MP36/35 only) 

Accepts a DB 25 Female connector. 

Input/Output port used to connect digital devices to the MP36/35. 

 

Trigger Input (MP36/35 only) 

Accepts a male BNC connector. 

Input port used to send trigger signals from another device to the MP36/35. 

Used to synchronize MP36/35 units when more than one MP36/35 is used. 
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DC Input 

Use the DC Input to connect an AC300A power adapter or BAT100 battery to the MP36/35. Use the DC 
Input to connect an AC100A power adapter or BAT100 battery to the MP30. 

 The power supply requirements for the MP UNIT are 12 VDC @ 1 Amp. Only use the AC300A power 
adapter with the MP36/35. The AC300A is a 12 VDC @ 1.25 Amp power supply adapter that can connect to any 
mains rated as 100-250 VAC @ 50/60 Hz, 40VA. 

The receptacle is configured to accept a “+” (positive) input in the center of the connector and a “-” (negative) input 
on the connector housing. 

 The functional earth ground on the AC300A Power Adapter is tied to Mains earth ground and accessible 
metal parts on the MP36/35 unit. 

  The AC300A power adapter is Class II and when it is used to power the MP36/35, the MP36/35-AC300A 
combination is Class II. The MP36/35 unit also incorporates an additional level of isolation between the AC300A 
power adapter and the Subject. 

 

Fuse holder 

 The fuse holder contains a fast-blow fuse that helps protect the MP UNIT from shorts on its power, 
analog, and digital I/O lines. The MP36/35 uses a 1.0 A, 250 V, 3AG, fast-blow fuse and the MP30 uses a 2.0 A, 
250 V, 3AG, fast-blow fuse. 

To remove the fuse, use a screwdriver to remove the fuse cover located below the word Fuse. 

 

Power switch 

ON position — powers up the MP UNIT 

OFF position — cuts the flow of power to the MP UNIT 

 
Mains Power Disconnection 
To completely disconnect the MP36/35 unit and the AC300A power adapter from all poles of the supply mains, 
extract the power cord plug from the mains outlet. Extract the plug by grasping the plastic shell of the plug and pull 
firmly away from the mains outlet in a direction perpendicular to the face of the mains outlet. Take care not to touch 
the metal blades associated with the plug. This procedure will fully power down (de-energize) the MP36/35 unit and 
AC300A power adapter. Please note that the power switch on the back of the MP36/35 unit turns power ON and 
OFF to the MP36/35 unit only. 

 

CLEANING PROCEDURES 
Be sure to unplug the power supply from the MP UNIT before cleaning. To clean the MP UNIT, use a damp, soft 
cloth. Abrasive cleaners are not recommended as they might damage the housing. Do not immerse the MP UNIT or 
any of its components in water (or any other fluid) or expose to extreme temperatures as this can damage the unit. 

Sterilization and Disinfection 

Disposable, sterile, single-use-only, accessories are used with the MP UNIT for educational (teaching) applications. 
Non-disposable accessories can be disinfected, if required, with Cidex® or equivalent.
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SAFETY NOTE 
BIOPAC Systems, Inc. instrumentation is designed for 
educational and research oriented life science investigations. 
BIOPAC Systems, Inc. does not condone the use of its 
instruments for clinical medical applications. 
Instruments, components, and accessories provided by 
BIOPAC Systems, Inc. are not intended for the cure, 
mitigation, treatment, or prevention of disease. 
The MP UNIT is an electrically isolated data acquisition unit, 
designed for biophysical measurements. 
Exercise extreme caution when applying electrodes and taking 
bioelectric measurements while using the Biopac Student Lab 
with other external equipment that also uses electrodes or 
transducers that may make electrical contact with the Subject. 
Always assume that currents can flow between any electrodes 
or electrical contact points. In case of equipment failure, it is 
very important that significant currents are not allowed to pass 
through the heart. 
If electrocautery or defibrillation equipment is used, it is 
recommended that the BIOPAC instrumentation be 
disconnected from the Subject. 
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MP36/35 Input > Output Scaling 

The MP36/35 hardware can pipe signals from any channel input to the output using the “CHX to Output” 
control panel in the BSL PRO software—due to the difference between the input and output range, there 
will be a change in signal level (scaling). The output range depends on the MP device and the output pin 
used as shown in the following table. Note that when using MP35 output pin 2, there is an additional 
baseline offset (2.048 V) applied. 

Output Pin 
(Analog Out port) 

Pin Description Output Range 
(Volts) 

Pin 1* - MP36/35 
Headphones,  
A.C. Coupled 

-2.048 to +2.048 

Low Voltage Stimulator, 
D.C. Coupled 

-10 to +10  
Pin 2 - MP36 
 
 - MP35 

CH Data, 
D.C. coupled 

0 to +4.095 V 
(baseline offset of 2.048 V) 

The input range is gain dependant.  The table below shows the scaling (multiplying) factors to use for 
each gain setting. 

Output Scale***—accurate to ±10% 
Factor 1 Factor 2 

Gain Input Range 
+- millivolts 

Pin 1 (Headphone out) 
and Pin 2 (MP35 only) 

Pin 2 (Low Voltage 
Stimulator) – MP36 only 

x5** ± 2 V 1.024 5 

x10 ± 1 V 2.048 10 

x20 ± 500 mV 4.095 20 

x50 ± 200 mV 10.238 50 

x100 ± 100 mV 20.475 100 

x200 ± 50 mV 40.950 200 

x500 ± 20 mV 102.375 500 

x1,000 ± 10 mV 204.750 1,000 

x2,000 ± 5 mV 409.500 2,000 

x5,000 ± 2 mV 1023.750 5,000 

x10.000 ± 1 mV 2047.500 10,000 

x20,000 ± 0.5 mV 4095.000 20,000 

x50,000 ± 0.2 mV 10238.000 50,000 

Notes 

* 1: To properly measure the output signal you need at least a 2K Ohm load. 

**  2: x5 only available on MP36 and MP45. 

*** 3. Input to Output scaling is accurate to within 10%. 

Example: 

MP35, input signal level = ±10 mV (20 mV- pk to pk), input gain = x100, Output on pin 2. 

Signal output level = 20 mV-pk to pk x 20.475 = 0.4095 V pk to pk. 

However there is a baseline offset of 2.048 V, so actual signal output level is:  

Lowest level = 2.048 V – (0.5 x 0.4095 V) = 1.843 V  

Highest level = 2.048 V + (0.5 x 0.4095 V) = 2.253 V 
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Calibration 

BIOPAC transducers can provide accurate “relative” measures without calibration. 

For example, the voltage output of the EDA/GSR transducer (SS3LA) will change by 1 mV given a 
change of 10 micro Mhos across the electrode(s) connected to the transducer. 

For accurate “absolute” measurement, the voltage output of the transducer must be correlated exactly to 
a physical parameter (such as air flow) and must adjust for temperature, pressure, humidity, and 
orientation (gravity effects)—all of which can vary greatly. Factors beyond the transducer’s accuracy also 
influence “absolute” measurement, such as connections in the system or to the subject. While the 
MP36/35 is a very sensitive, DC stable acquisition unit, too many factors influence true “absolute” 
measurement to achieve it without calibration. 

 

Calibration Guidelines 

Calibration is required if ALL of the following are true: 

1. Precise, absolute, measurements are required. 

“Precise” is considered better than 5% accurate; some transducers may provide better than 5% 
accuracy without calibration. 

“Relative” measurements are often acceptable. Measurements on humans can vary so greatly 
from person to person that in most cases a “relative” measure of change is sufficient. 

For example, when measuring EDA with the SS3LA, the preset: “Electrodermal Activity (GSR) 
Change” is often used and no calibration is required. 

2. The transducer will be plugged into an Analog Input channel. 

3. Communication between the MP36/35 and transducers that can be plugged into the “I/O Port” on 
the back of the MP36/35 (such as the noninvasive blood pressure cuff) occurs serially; since A/D 
conversion is not used, readings will directly match the output of the connected device. 

4. The operational bandwidth of the transducer extends down to 0 Hz (DC - see page 789 for details). 
When an AC Coupled Preset is selected for a transducer, “relative” measurements are taken and 
calibration is not required. 
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Appendix E - Frequently Asked Questions     

 

Q: I have a large data file and it seems to take a long time to redraw the screen. Is there anything I can do to 
speed it up? 

A: Yes. You can choose from four possible remedies for this: 

 
1) The simplest solution is to check the Draft mode for compressed waves and Use all available memory boxes 

in the Display Preferences dialog (File > Preferences > General). Checking these two boxes will cause the 
BSL PRO software to plot data faster (at the expense of some precision) and use as much available memory as 
possible. You can cancel the plotting at any time by holding down the ESC key. 

 
 

2) You can reduce the time interval per division, which causes less data to be displayed on the screen at one time, 
and should reduce plot time. 

 
3) If the data still takes too much time to redraw and you have a color monitor, try reducing the number of colors 

displayed. 

 
4) If you have a high-resolution video card (one capable of displaying many thousands of colors), you may want to 

reduce the resolution to speed up plotting time. 
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Q: Can I use other software with the Biopac Student Lab PRO hardware? Can I use Biopac Student Lab PRO 
software to control other data acquisition hardware? 

A: No. The Biopac Student Lab PRO hardware was designed to work with the Biopac Student Lab PRO software. 
However, the BSL PRO software can read in previously acquired text files generated by the Biopac Student Lab 
PRO or any other software. 

 

Q: I have a device that outputs an RS-232/RS-422 signal. Can I connect this to the digital I/O line? 

A: No. These types of digital output devices have their own communication protocols and are more complex than 
the digital pulses that the Biopac Student Lab PRO can accept as inputs. 

 

Q: I imported a text file and the time scale is wrong. What happened? 

A: When a text file is imported, the Biopac Student Lab PRO software assumes (by default) that the data was 
sampled at 100 Hz or 100 samples per second. This is arbitrary, and there are two ways to adjust this. Both 
methods involve calculating the interval between sample points. To calculate the sampling interval, you need to 
know the rate at which the data was originally sampled. The sampling interval is calculated by dividing one by 
the sample rate. You can adjust the sampling interval to the appropriate value via the File > Open dialog box 
before the data is read in, or if the data is already present, change the time scale in the Display > Horizontal 
Axis dialog box. 

 For instance, if 20 minutes of data was originally collected at 2Hz and imported as a text file, the software will 
interpret this as data collected at 100 samples per second. To set the time scale to accurately reflect the data, 
change the sampling interval from 0.01 to 0.5 seconds per sample. 

 To change this setting before data is read in, click the “Options” button in the File > Open> Text dialog box 
and change the value in the Sampling Interval dialog box. To change the time scale after data has been read in, 
adjust the units per division in the Display > Horizontal axis dialog box. If the data are time-domain data, you 
can adjust the seconds/sample interval at the bottom of the dialog box. This value defines the interval between 
sample points, and can be changed to fit the rate at which the data was originally acquired. 

 

Q: I just filtered a waveform and now my data file is huge. Why is that? 

A: When any type of transformation is performed (e.g. digital filtering, waveform math), the entire waveform is 
converted from integer format (two bytes per sample) to floating-point format (eight bytes per sample). Since 
each sample point in the waveform now takes up four times as much space, the file should be approximately 
four times as large. The Biopac Student Lab PRO software still saves the file as compactly as possible, and 
since some of the information stored describes the time base, the file size will not increase by exactly a factor of 
four. 
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Q: My MP UNIT seems to be connected, but I can’t acquire data. What should I do? 

A: This can be caused by one of several conditions: 

 a)  Check to make sure that the MP UNIT is ON and, if so, that all the connections to the MP UNIT were made 
properly. When the MP UNIT is powered up, a light on the front panel of the MP UNIT will illuminate. If the 
power light will not illuminate, check to make sure the proper power supply is connected. The power supply 
that comes with the MP UNIT is rated at 12 VDC @ 1 Amp, and using other power supplies may result in 
damage to the MP UNIT. 

 b)  If the proper power supply is connected but the power light still does not illuminate, disconnect the power 
supply and check the fuse in the back of the MP UNIT. The fuse is a standard 2.0 Amp fast blow fuse, and can 
be changed by unscrewing the fuse cap and replacing the fuse. 

 c)  If the power light does illuminate, the next step is to see if the “Busy” status light (next to the “Power” light 
on the front panel of the MP UNIT) illuminates when the MP UNIT is powered up. When the MP UNIT is 
powered up, the “Busy” status light should illuminate for three or four seconds and then extinguish. 

 

Q: I set up the channels but I only seem to be acquiring noise. What’s wrong? 

A: A number of phenomena can cause this: 

 

1) Check to make sure that the settings in the Setup Channels dialog box (under the MP UNIT menu) correspond 
to the direct analog connections to the MP UNIT. 

 

2)  Another possible cause is that the Gain settings are too low and should be increased. 

 To access the Gain settings: pull down the MP UNIT menu, select Setup Channels, click the View/Change 
Settings button to access the Parameters dialog, and use the Gain pull-down menu to select another setting. 

 

3) You may also want to select Autoscale waveforms from the Display menu. 

 This will automatically adjust the waveforms to provide the “best fit” in terms of scaling the data to fit in the 
available window space. 

 

4)  It is also possible that the electrodes/transducers themselves are the source of the noise. 

 Proper electrode adhesion techniques involve abrading the skin and securing the electrode in place to reduce 
movement artifact. See page 7299 for more information about electrode noise. 
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Appendix F - Hints for Working with Large Files 

 

It is not uncommon for large data files to be generated (on the order of several megabytes) through some 
combination of (a) high-speed acquisitions, (b) long acquisitions, and (c) multi-channel acquisitions. You may 
encounter system limitations (such as storage space limitations) and find such files difficult to work with and slow in 
loading to memory. 

The Biopac Student Lab PRO software stores the data in as compact a format as possible. Each analog sample takes 
up roughly two bytes of storage space and calculation channel samples take up roughly eight bytes of storage space. 
When a waveform (or a section of a waveform) is transformed (i.e., filtered or integrated) each data point takes up 
roughly eight bytes. As a result, file size can change drastically after transforming one or more waves. 

The following tips can help you get the most out of the Biopac Student Lab PRO when working with large data files. 

Use virtual memory Since the Biopac Student Lab PRO runs under Windows, most computers are able to 
take advantage of the virtual memory feature. While this is slower than conventional 
memory, it will at least make it possible to load some files that might otherwise be 
impossible to load. 

Remove waveforms Since each waveform adds to the total size of the file, try removing (or copying to 
another file) some of the waveforms from a multi-channel file. This is especially true if 
you would like to perform transformations of some sort on at least one of the waves. 

Sample slowly Theoretical and methodological concerns will, to a large extent, dictate sampling rate. 
However, if you can reduce the sampling rate, choose to do so. You may also want to 
resample data after it has been collected by using the Transform > Resample 
command (page 7217). 

Display preferences Check the “Use all available memory” and the “Draft mode for compressed waves” 
options under the File > Preferences > General sub-menu. This should decrease the 
time it takes to redraw waveforms and allow the software to access all available 
memory for storage. 

Store to hard disk Although slightly slower than storing to PC Memory (RAM), acquiring data directly to 
Hard Disk allows you to recover data in the event of a power loss to the Biopac 
Student Lab PRO. Furthermore, much larger data files can typically be stored directly 
to Hard Disk than to PC Memory. 

Use the Append mode The Append mode allows you to pause the acquisition for arbitrary periods. This can 
be helpful when recording only a few key events that will occur randomly over a long 
period of time, since it will reduce unnecessary data. 

Stop plotting and 
change the scale 

If the screen is taking a long time to redraw (because the data files are large), you can 
stop plotting and decrease the horizontal scale value before redrawing. To stop 
plotting, use the ESC key. 



Appendices 295 

Appendix G — Filter Characteristics 

Filter types 
The Biopac Student Lab PRO software employs two types of digital filters:  

1)  Finite Impulse Response (FIR) perform all post-acquisition filtering 

2)  Infinite Impulse Response (IIR) perform online calculations (filtering performed during an acquisition) 

Although the similarities between the two types of filters outweigh the differences, some important distinctions 
remain. 

IIR filters are typically more efficient (faster) than FIR filters. 

This means that IIR filters can filter data faster than FIR filters, which is why IIR filters are used for online 
calculations. 

IIR fillers tend to be less accurate than FIR filters. 

Specifically, IIR filters tend to cause phase distortion or “ringing.”  When the phase of a waveform is distorted, 
some data points on a waveform are shifted (either forward or backward in time) more than others. This can result in 
the intervals between events (such as the Q-R interval or the inter-beat interval in an ECG waveform) being slightly 
lengthened or shortened compared to the original signal. In practice, however, the effect of this distortion is usually 
minimal since the frequencies which are most distorted are also attenuated the most. 

By contrast, FIR filters are phase linear, which means that the interval between any two sample points in the filtered 
waveform will be exactly equal to the distance between the corresponding sample points in the original waveform. 

IIR filters have a variable Q setting 

The Q setting defines the filter response pattern, but FIR filters do not have a Q component. The optimal Q of an IIR 
filter is 0.707, with lower values resulting in a flatter response and higher values resulting in a more peaked 
response. The default Q for all IIR filters is 0.707 (except for Band pass filters where Q defaults to 1), which is 
appropriate for nearly all filter applications. 

In the examples on the following page, the filter responses of several different types of filters are compared. All of 
the filters are 50 HZ low pass filters operating on the same data. 

IIR filters are also used for real-time filtering in the MP UNIT hardware. The following processing rates correspond 
to the sampling rate: 

Sample Rates 
(samples/Sec) 

Possible 
with MP36/35
 

Possible with
MP30 
 

MP36/35 
DSP I.I.R. 
Filter Proc. Rate
(Sample/Sec)  

MP30 
DSP I.I.R. 
Filter Proc. Rate 
(Sample/Sec) 

1 YES YES 20,000 2,000 

2 YES YES 20,000 2,000 

2.5 NO YES N/A 2,000 

5 YES YES 20,000 2,000 

10 YES YES 20,000 2,000 

20 YES YES 20,000 2,000 

25 NO YES N/A 2,000 

50 YES YES 20,000 2,000 

100 YES YES 20,000 2,000 

200 YES YES 20,000 2,000 

250 NO YES N/A 2,000 

500 YES YES 20,000 2,000 

1,000 YES YES 20,000 2,000 

2,000 YES YES 20,000 2,000 

5,000 YES YES 20,000 N/A 

10,000 YES YES 20,000 N/A 
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Sample Rates 
(samples/Sec) 

Possible 
with MP36/35
 

Possible with
MP30 
 

MP36/35 
DSP I.I.R. 
Filter Proc. Rate
(Sample/Sec)  

MP30 
DSP I.I.R. 
Filter Proc. Rate 
(Sample/Sec) 

20,000 YES NO 20,000 N/A 

25,000 YES YES 25,000 N/A 

40,000 NO YES N/A N/A 

50,000 YES NO 50,000 N/A 

100,000 YES YES 100,000 N/A 

 

Frequency Cutoff 
When setting up any IIR filter, a good rule of thumb is to limit the HIGHEST frequency cutoff in the filter to be 
some value less than or equal to the sample rate of the acquisition or data divided by four. 

For a sampling rate of 200 Hz, the cuttoff for a lowpass filter should be no greater than (200/4) or 50 Hz. 
Alternatively, for a lowpass filter of 30 Hz, the acquisition (sample) rate should be no less than (30*4) or 120 Hz. 

For a high pass filter of 250 Hz, the acquisition (sample) rate should be no less than (250*4) or 1000 Hz. 

For a band pass filter of 100 Hz to 500 Hz, the acquisition (sample) rate should be no less than (500*4) or 1,000 Hz. 

For a single frequency band pass (or notch) filter of 60 Hz, the acquisition (sample) rate should be no less than 
(60*4) or 240 Hz. 

If this rule of thumb is not followed, it becomes increasingly more likely that the data from the output of the IIR 
filter will be meaningless. If the acquisition (sample) rate drops below two times the highest cuttoff frequency 
associated with the filter, the data will be completely corrupted. The zone for acquisition rate being between two and 
four times the highest cuttoff frequency associated with the IIR filter is somewhat functional, but the filter break-
points will begin to deviate from the expected break-point. The deviation will result in effectively REDUCED upper 
frequency cuttoff for the IIR filter, the extent of the reduction being more pronounced as the acquisition rate 
approaches two times the highest cuttoff frequency for the IIR filter. 

When an IIR filter is established as a calculation channel, the specified minimum frequency (Freqmin) determines 
the minimum effective Sample Rate (SRmin) as follows: 

SRmin = 4 * Freqmin 

where SRmin is the frequency specified for Low Pass, High Pass, Band Pass and Band Stop and is the lower of the 
two frequencies for Band Pass (low + high) filter 

If the sample rate is lower than this, there is no guarantee as to what will happen to the data because the filter can 
become unstable and huge numbers can be generated. 
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The first graph shows how the number of 
filter coefficients in FIR filters (Q) affects 
the filter’s frequency response. 

Note that as the number of coefficients (Q) 
increases, the filter becomes more accurate. 

 

FIR filter performance as a function of number of coefficients (Q) 

The second graph shows how the pole or 
zero locations of the filter, as related to 
filter “peaking” (specified by Q), affect the 
frequency response of the filter. The “Q” in 
this case is not to be confused with the Q 
from the FIR filter. 

Note how increasing “Q” in the IIR filter 
case affects filter “peaking.” 

 

 
FIR filter performance as a function of changes in pole or zero 

locations 

Coincidentally, the FIR (Q = 10) and IIR (Q = 0.707) filters have very similar responses in this case. 

Technically, the coefficient setting for FIR filters determines the number of multiplies performed by the filtering 
algorithm. In practical terms, it determines how “steep” the frequency response of the filter is. Filters with a large 
number of coefficients have a steep roll-off, whereas the frequency response of filters with a smaller number of 
coefficients is not as steep. 

 

Window Functions (Filter Characteristics) 

A “window” refers to a computation that spans a fixed number of adjacent data 
points. Typically, window functions are used to eliminate discontinuities that may 
result at the edges of the fixed span of points of the digital filter function (FIR 
filters) or the data points of the FFT.  

The following formula, where n = 
0

N 1
n


 and A, B, C and D are constants that define 

the “shape” of the window, is used to describe all windows except the Bartlett 
window: 

N

n32
Dcos

N

n22
Ccos

N

n2
BcosA


  

The following table illustrates the different parameter values for most Window types: 

Window Parameter Values 
Type A B C D 
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Blackman 0.42323 0.49755 0.07922 0.00000 

Blackman -61 0.44959 0.49364 0.05677 0.00000 

Blackman -67 0.42323 0.49755 0.07922 0.00000 

Blackman -74 0.40217 0.49703 0.09392 0.00183 

Blackman -92 0.35875 0.48829 0.14128 0.01168 

Hamming 0.54000 0.46000 0.00000 0.00000 

Hanning 0.50000 0.50000 0.00000 0.00000 

Kaiser-Bessel 0.40243 0.49804 0.09831 0.00122 

Rectangle 0.00000 0.00000 0.00000 0.00000 

Window functions are used for three purposes in the Biopac Student Lab PRO software: 

a) Window functions are applied to the impulse response in the FIR digital filtering functions. 

b) Window functions are applied as part of the FFT function. 

c) Window functions are applied as part of the Derivative transformation. 

 

Digital filtering 

When a window is used in digital filtering, the impulse response of the filter (rather than the data itself) is modified. 
When the impulse response smoothly approaches zero at both the beginning and end of the data, this works 
relatively well. 

When the impulse response is not so well behaved, edge effects occur. To minimize edge effects: 

—  Window, or force the edges of the impulse response to smoothly approach zero. The exact process depends on 
the Window selected (see previous page). 

—  Increase the number of coefficients for the FIR filter used to transform the data. 

 

FFT 

The FFT function also windows data, although the nature of the windowing function is somewhat different in the 
sense that the window operates on the data. One of the assumptions of the FFT is that the input data is an infinitely 
repeating signal with the endpoint wrapping around. In practice, the endpoints are almost never exactly equal. You 
can check this by choosing the Delta measurement item from the measurement pop-up menus, which returns the 
amplitude difference between the first selected point and the last. To the extent that the endpoints differ, the FFT 
output will produce high frequency components as an artifact of the transformation. 

By windowing the data, the effects of this phenomenon are greatly diminished. When data are windowed, a window 
is moved across the data, much as the smoothing function moves across the data. Whereas the smoothing function 
simply takes the average of a specified number of points, each type of window weights the data somewhat 
differently. 
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Appendix H — About Electrodes 

The purpose of an electrode is to act as a “connector” between the Subject’s skin (where electrical signals are easiest 
to detect) and the MP UNIT acquisition unit (via the SS2L lead cable). If an electrode makes good contact with the 
skin, the signals that are generated will be relatively accurate. 

Although they sound complex, electrodes are very simple devices that consist of a small piece of metal designed to 
make indirect contact with the skin and a larger adhesive plastic disk. Each electrode is about 1 inch (2.5 cm) in 
diameter, and is sticky on one side so it will adhere to your skin. The electrode lead (cable with connector end) is 
the interface between the electrode and the MP UNIT acquisition unit. 

 
Electrode lead connector and electrode 

If you look closely at the electrode, you can see that there is a small piece of plastic mesh filled with a bluish gel. 
Since gel conducts electricity (better than your skin, in fact) and is more flexible than the metal part of the electrode, 
your skin can flex and change shape somewhat without losing the electrical connection with the metal part of the 
electrode. 

BIOPAC disposable electrodes are standard disposable electrodes and are widely used in clinical, research, and 
teaching applications. These electrodes come in strips of ten, and you should not remove an electrode from the 
backing until you are ready to use it. 

The following directions will help you get good data from the electrodes by explaining how electrodes work and 
how to attach the electrodes and electrode leads to obtain the best signal. 

Electrode placement 
There are two basic methods of electrode placement: monopolar and bipolar. 

 In a monopolar recording, an active electrode is placed over the region of interest and a 
“reference” electrode is attached to a more distant part of the body. 

 In a bipolar recording, the voltage difference between two electrodes, placed over the 
regions of interest, is measured with respect to the third “reference” electrode. Leads I, II, 
and III are standard bipolar electrode configurations, and are explained in more detail when 
used in a Lesson. 

Preparing the Electrode Site 
One way you can improve electrode connections is to gently rub the area where the 
electrode is to be placed. This is known as abrading the skin, and removes a thin 
layer of dead skin from the surface of the skin. Since dead skin doesn’t conduct 
electricity very well, removing it improves the connection between the electrode and 
the skin. You can use an ELPAD electrode pad (included with the Biopac Student 
Lab) to abrade the selected surface. 

Attaching electrodes 
To attach an electrode, peel the electrode from its backing and place it on the area indicated in the lesson. Once in 
place, press down firmly on the electrode with two fingers and rock the electrode back and forth for a few seconds. 
This will ensure that it is adhering to the skin as much as possible.  
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 T o help insure that the electrode will make good electrical contact with the skin, you may 

want to squeeze a drop or two of electrode gel onto either the surface of the skin or onto 
the electrode (without allowing any to get on the adhesive). 

Connecting the Electrode Lead 
Each electrode lead cable is a different color and each pinch connector on the end of the cable needs to be attached 
to a specific electrode. Note that the connector is polarized and needs to be clipped on such that the metal extensions 
inside the clip are on the down side to make surface contact with the electrode. The pinch connectors work like a 
small clothespin, but will only latch onto the nipple of the electrode from one side of the connector. You should 
follow the figure provided in the lesson to ensure that you connect each lead cable to the proper electrode. 

Reducing Electrode “Noise” 
If an electrode does not adhere well to the skin, the signal plotted on the screen may appear “fuzzy.” This is referred 
to as “noise,” and although it always exists to some degree, it is best to reduce noise as much as possible. Electrodes 
have no moving parts, so there is nothing you have to do to get an electrode to “work” but there are several things 
you can do to reduce noise when electrodes are connected: 

*  Place the electrodes where there is the least amount of hair and/or choose the subject with the least amount of 
hair. A common problem is that something on the surface of the skin is interfering with the electrode contact. If 
there is too much hair (for instance) between the outer layer of skin and the electrode, the electrical activity 
taking place below the surface of the skin may not be detected. 

*  Make sure that everything is connected properly. 

*  Attach the electrodes a few minutes before you are going to use them. The best results are achieved by putting 
the electrodes in place about five minutes before you begin recording data. This gives the electrodes time to 
establish contact with the surface of the skin. 

*  Position the electrode lead cables such that they are not pulling on the electrodes. Connect the electrode cable 
clip (where the cable meets the three individual colored wires) to a convenient location (can be on the Subject’s 
clothes). This will relieve cable strain. 

*  The Subject should not be in contact with nearby metal objects (faucets, pipes, etc.), and should remove any 
wrist or ankle bracelets. 

Removing Electrodes 
Once you have completed a lesson, disconnect the electrode cable pinch connectors, peel the electrode 
off the skin, and dispose of the electrode (BIOPAC electrodes are not reusable). Wash the electrode gel 
residue from the skin, using soap and water. The electrodes may leave a slight ring on the skin for a few 
hours. This is normal, and does not indicate that anything is wrong. 

Electrode Check  
MP3X units include an Electrode Check port on the front panel. Use this diagnostic tool with the BSL PRO software 
to determine if the electrodes are properly attached to the subject (see page 7151). 
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Appendix I — Accelerator Keys (BSL PRO and Lessons) 

 

Ctrl = Control     Shift = S      = up arrow      = down arrow      = Left arrow      = Right arrow 

 

Hot Key 
Seq 

Alt 
keys 
Seq 

Graph Function 

Menu Item 

Journal Function Key 
seq. 
menu 

PRO 

Graph 

PRO 
Jrnl 

Acq 

Graph 

Acq 
Jrnl 

  ---- Moves the cursor up one 
roll 

 X X X X 

  ---- Moves the cursor down 
one roll 

 X X X X 

   When the “I-beam” data 
cursor is active and one 
data point is selected 
(flashing vertical line) this 
will move the cursor 
position 1 pixel (# of 
samples for 1 pixel width) 
to the LEFT. 

Moves the cursor one 
letter or space to the left 

No X X X X 

   Same as the above, but to 
the RIGHT. 

Moves the cursor one 
letter or space to the right 

No X X X X 

Ctrl A  Transform  Find Rate Same Yes X X X X 

S + Ctrl A  Display > Tile Waveforms  

Chart & Scope Mode 

Same Yes X X *  

Ctrl B  Display  Cursor Style  
Arrow 

---- Yes X X Closes 
graph 

--- 

Ctrl C or Ctrl 
Insert 

 Edit Style  Copy: wave 
data for active channel 

Highlighted text in journal Yes X X X X 

Ctrl D  Edit Style  Journal Style 
 Paste Wave Data  

Same Yes X X X X 

Ctrl E  Transform Style  Find 
Next Peak 

Same Yes X X X X 

Ctrl F  Transform Style  Find 
Peak 

Same Yes X X X X 

Ctrl G  Display Style  Cursor 
Style  Zoom 

Same Yes X X No No 

Ctrl H  Not Used (Blinks the top 
and bottom of the 
application window* 

--- N/A X X --- -- 

Ctrl I  Display Style  Cursor 
Style   I-beam 

Same Yes X X No No 

Ctrl J  ---* Line return (Enter) 
<RichEdit control*> 

No X X --- X 

Ctrl K  For Lessons only: Script > 
Reset Menu (not used in 
Pro*) 

--- Yes X X *--- --- 

Ctrl L  For Lessons only: Script > 
Show Vars Browser(not 
used in Pro*) 

--- Yes X X *--- --- 

Ctrl M  Edit  Journal  Paste 
Measurement 

Same Yes X X X X 

Ctrl N  File  New Same Yes X X X X 

Ctrl O  File  Open Same Yes X X X X 

Ctrl P  File  Print Prints Graph Yes X X X X 

Ctrl Q  File  Quit Quits the application Yes X X X X 
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Hot Key 
Seq 

Alt 
keys 
Seq 

Graph Function 

Menu Item 

Journal Function Key 
seq. 
menu 

PRO 

Graph 

PRO 
Jrnl 

Acq 

Graph 

Acq 
Jrnl 

Ctrl R  Transform  Find All 
Peaks 

Same Yes X X X X 

Ctrl S  File  Save Same Yes X X X X 

Ctrl T  MP UNIT  AutoPlotting Same Yes X X X X 

Ctrl U  Not Used* ---- N/A X X *--- --- 

Ctrl V or S 
+ Insert 

 Edit  Paste, wave data for 
active channel 

Edit  Paste, journal text  Yes X X X X 

Ctrl W  File  Close Same Yes X X X X 

Ctrl X or S 
+ Delete 

 Edit  Cut, wave data for 
active channel 

Edit  Cut, journal text Yes X X X, 
delete 
inactive 

X, 
both 

Ctrl Y  Not Used --- N/A X X *--- --- 

Ctrl Z or Alt 
+ Backspace 

 Edit  Undo, changes in 
graph 

Edit  Undo, changes in 
journal 

Yes X X X X 

Ctrl +  Display  Zoom Forward, 
numerical keyboard 

Same Yes X X X X 

Ctrl -  Display  Zoom Back, 
numerical keyboard 

Same Yes X X X X 

Delete  Edit  Clear: wave data in 
active channel 

Deletes journal texts or 
spaces 

Yes X X X X 

F1 or S + 
F1 

 Help  Support Materials 
from Web 

--- No X X No No 

Alt + Space 
bar 

 Start or Stop Acquisition ---- N/A X X X X 

S +   Extends the right edge of 
selected area by one 
screen pixel (however 
many samples make a 
pixel). 

Moves the cursor to the 
right by 1 character and 
highlights the journal 
(starting at cursor 
position) 

No X X X X 

S +   Extends the left edge of 
selected area by one 
screen pixel (however 
many samples make a 
pixel). 

Moves the cursor to the 
left by 1 character and 
highlights the journal 
(starting at cursor 
position) 

No X X X X 

S + Ctl + 
 

 Decreases the left edge of 
a selected area by one 
sample. 

Moves the cursor to the 
right by 1 character and 
highlights the journal 
(starting at cursor 
position) 

No X X X, same 
as ^  

X, 
same 
as ^ 
 

S + Ctl + 
 

 

 Decreases the right edge of 
a selected area by one 
sample.  

Moves the cursor to the 
left by 1 character and 
highlights the journal 
(starting at cursor 
position) 

No X X X, same 
as ^ 

X, 
same 
as ^ 

S +  or 
S + Ctl +  

 --- Moves the highlighted 
area up by row starting at 
the initial cursor position.  

 X X   

S +  or 
S + Ctl +  

 --- Moves the highlighted 
area down by row starting 
at the initial cursor 
position.  

 X X   

Ctrl + 
Rewind 
toolbar 

 Erase all appended 
segments (all data). 

Same No X X X X 
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Hot Key 
Seq 

Alt 
keys 
Seq 

Graph Function 

Menu Item 

Journal Function Key 
seq. 
menu 

PRO 

Graph 

PRO 
Jrnl 

Acq 

Graph 

Acq 
Jrnl 

button 

F2-8 &F11-
12 

 Fixed Event Markers Same No X X X X 

F9  Insert non-Fixed Event 
Markers  

--  X X X X 

  

Note* This is a standard Windows RichEdit accelerator key and since BSL Journals use the RichEdit 
program, this accelerator key is standard. 
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Information in this document is subject to change without notice and 
does not represent a commitment on the part of BIOPAC Systems, Inc. 

Copyright 
This manual and the software described in it are copyrighted with all rights reserved. Under the copyright 
laws, this manual or the software may not be copied, in whole or part, without written consent of BIOPAC 
Systems, Inc., except in the normal use of the software or to make a backup copy. 

The same proprietary and copyright notices must be affixed to any permitted copies as were affixed to the 
original. This exception does not allow copies to be made for others, whether or not sold, but all of the 
material purchased (with all backup copies) may be sold, given, or loaned to another person. Under the 
law, copying includes translating into another language or format. This software is intended for use on 
only one machine at a time. 

Warranty 
BIOPAC Systems, Inc. warrants its hardware products against defects in materials and workmanship for a 
period of 12 months from the date of purchase. If BIOPAC Systems, Inc. receives notice of such defects 
during the warranty period, BIOPAC Systems, Inc. will at its option, either repair or replace the hardware 
products that prove to be defective. This warranty applies only if your BIOPAC Systems, Inc. product fails 
to function properly under normal use and within the manufacturer’s specifications. This warranty does 
not apply if, in the sole opinion of BIOPAC Systems, Inc., your BIOPAC Systems, Inc. product has been 
damaged by accident, misuse, neglect, improper packing, shipping, modification or servicing, by other 
than BIOPAC Systems, Inc. 

Any returns should be supported by a Return Mail Authorization (RMA) number issued by BIOPAC 
Systems, Inc. BIOPAC Systems, Inc. reserves the right to refuse to accept delivery of any shipment 
containing any shipping carton which does not have the RMA number(s) displayed on the outside. The 
Buyer shall prepay transportation charges to the BIOPAC Systems, Inc. designated site. 

BIOPAC Systems, Inc. makes no warranty or representation, either expressed or implied, with respect to 
this software, its quality, performance, merchantability, or fitness for a particular purpose. As a result, this 
software is sold “As is”, and you, the purchaser, are assuming the entire risk as to its quality and 
performance. 

In no event will BIOPAC Systems, Inc. be liable for direct, indirect, special, incidental, or consequential 
damages resulting from any defect in the software or its documentation, even if advised of the possibility 
of such damages, or for damage of any equipment connected to a BIOPAC Systems, Inc. product. 

Trademarks 
BIOPAC is a registered trademark of BIOPAC Systems, Inc. 

Windows is a trademark of Microsoft Corporation. 
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Index 
 

A/D boards (third party), 292 

About Biopac Student Lab PRO, 248 

Absolute value 

ABS Expression function, 110, 219 

Abs Math transformation, 205 

AC coupled, 89 

Accelerator Keys, 32 

acquire box, 71 

Acquire, Setup Channels option, 45 

Acquisition Length, Setup Acquisition option, 47, 85 

Acquisition setup, 47, 66 

Acquistion setup, 69 

Active channel, 49 

Airflow/Volume example, 99 

Algorithms, template, 210 

Alpha waves, 225 

Amplitude scale, 75 

Analog channels, 70 

Gain setting, 91 

Input coupling, 89 

Analog signals, 43 

Append, Setup Acquisition option, 79 

Application Notes, 21 

arbitrary curve fitting, 171 

Arc cosine, ACOS Expression function, 110, 219 

Arc sine, ASIN Expression function, 110, 219 

Arc tangent 

Arc Tan Math transformation, 205 

ATAN Expression function, 110, 219 

Area 

Find Rate function, 102 

Area (measurement), 161 

Auto threshold detect, 237 

Auto Threshold Detect 

Rate calculation option, 101 

AutoPlotting, 153 

Autorange, histogram option, 216 

Autosave file 

Setup Acquisition option, 79 

when Repeat is selected, 86 

Autoscale 

Autoscale after transformations, 190 

Autoscale Horizontal, 34, 36, 42, 243 

Autoscale Vertical, 42 

Autoscale Waveform, 42 

Average 

Average over samples, Integrate option, 94, 95 

Moving average, 213 

Off-line averaging, 228 

Band Pass filter, 108 

Band Stop filter, 108 

Base Point (Scale dialog option for Grid display), 176 

Baseline drift, 238 

Blood pressure analysis. See Rate calculations 

BloodPressure.acq sample file, 256 

BPM 

Rate function, 102 

Rate Function Guidelines, 103 

BPM (measurement), 162 

BSL Hardware Guide, 11 

BSL PRO 

Features, 14 

Overview, 23 

BSL PRO launch error, 27 

BSL vs BSL PRO, 58 

Cal 1 and Cal 2 scaling buttons, 75 

Calculate (measurement), 162 

Calculation channels, 68–69 

Calibration, 89 

Calibration Guidelines, 290 

Can’t Undo, 193 

CE Marking, 284 

Center Horizontal/Vertical, 42 

CH# Output Control, 119 

Change font, Journal Preference, 191 

Channel boxes, 49 

Channel setup, 45, 69 

Chart mode, 39 

CISPR Class 11, 284 

Clear, 195 

Clear All, 195 

Clipboard, 160, 196–97 

Close (File command), 183 

Coefficients (FIR filters), 202, 297 

Colorimeter data, 76 

Column delimiter, 181 

Compare Waveforms, 42 

Compliance, 284 
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Compressed waveform plots, 81, 189 

Connect endpoints (Math Transformation), 205 

Constant (K) 

Calculate measurement option, 162 

Math calculation option, 105 

Waveform Math, 220 

Control 

Calculation Preset, 112, 116 

Control channel, Integrate, 96 

Convolution (Template function), 210 

Copy 

Copy Graph, Clipboard, 197 

Copy Measurement, Clipboard, 196 

Copy Wave Data, Clipboard, 196 

Edit command, 194 

Correlate (measurement), 163 

Correlation 

Template function, 210 

Cosine, COS Expression function, 110, 219 

Count peaks, 102 

Creating new lessons, 58 

Cursor Style, 247 

Customizing menu display, 59 

Cut, 194 

Cutoff frequency, 201, 212 

Data compression, 217 

Data recording, 43 

DC coupled, 89 

Delay 

Calculation channel Preset, 111 

Delimiter, column, 181, 196 

Delta (measurement), 164 

Delta F(measurement), 164 

Delta S (measurement), 164 

Delta T (measurement), 164 

Delta X (measurement), 164 

Derivative, 212 

Difference 

on-line calculation, 100 

transformation function, 215 

Digital Filters, 201–2, 298 

FIR filters, 201 

IIR filters, 203 

Digital Outputs Control, 120 

Disk space, 47, 80, 81, 183, 217 

Display menu commands, 240 

Display Preferences, 189 

Don’t Find 

Find Rate option, 239 

Dot plot, 245 

Dot size, 245 

Draft mode, 189 

Duplicate Waveform, 195 

Duration, acquisition, 85 

ECG data analysis, 233 

Edge 

Edge effect (windowing), 298 

Edge options (Pos/Neg), 149 

Edit 

Edit menu commands, 193 

Markers, 172 

EEG.acq sample file, 259 

Electrode Checker, 152 

EMGwForce.acq sample file, 259 

Enable Value Display, 45, 71 

Envelope, 95 

Event marker. See Markers 

ex power of a data point 

EXP Expression function, 110, 219 

Exp Math transformation, 206 

Exporting data, 55, 181 

Expression 

on-line calculation, 109 

transformation, 218 

FAQ, 291 

FFT Fast Fourier transformation, 222–25, 298 

File menu commands, 179 

File size, 292, 294 

File… button, Setup Acquisition, 79 

Filter 

Filter characteristics, 295 

on-line calculation, 107 

Show filter response, 202 

Filters, 108 

Find 

Find All Peaks, 229 

Find Next Peak, 229 

Find Peak (Peak Detector) function, 226 

Find Rate, 237–39 

FingerTwitch1.acq sample file, 260 

FingerTwitch2.acq sample file, 260 

FIR Finite Impulse Response filters, 201, 295 

Font 

Change font, Journal Preference, 191 

Formula 

Area, 161 

BPM, 162 

Convolution (Transform>Template), 210 

Correlation, 163 

Correlation (Transform>Template), 210 

Delta, 164 

Delta T/F/X, 164 

Freq (Frequency), 165 

Hysteresis, Rate trans., 104 
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IIR Filters, 201 

Integral, 165 

Lin_reg (Linear regression), 166 

Mean, 167 

Mean square error (Transform>Template), 210 

Mean value smoothing (Transformation), 213 

Median value smoothing (Transformation), 213 

Noise rejection, Rate trans., 104 

Remove baseline, Rate trans., 104 

Slope, 168 

Stddev (Standard deviation), 169 

Threshold, Auto threshold detect, Pos/Neg, 104 

Window functions, 297 

Frequency 

Cutoff frequency, 201, 212 

Filter calculation option (Freq), 107 

frequency spectrum, 225 

measurement (Freq), 165 

Frequency cuttoff, 296 

Frequently asked questions, 291 

Function 

Calculation Preset, 106 

Expression option, 110, 219 

Rate calculation option, 101 

Rate Function menu, 102 

Gain setting, 91 

Range guide (vertical scale), 38 

Gauge, 143 

Getting Started, 23 

Graph Template file sample, 261 

Graph window, 25 

Grids 

Clinical grid settings, 177 

Display > Show, 174 

Grid Options, 174 

Hard Disk, acquisition option, 47, 80 

Hardware Guide, 11 

Header, include with text file, 184 

HeartTemplate.gtl sample file, 261 

Help menu, 248 

Help options, 12 

Hemodynamic data analysis, 231 

High Pass filter, 108 

High Speed mode, 81 

Histogram, 216 

Hold relative position 

Horizontal Scale, 36 

Horizontal axis, 20 

Horizontal Axis, 245 

Horizontal scale, 34, 36 

Hot Keys, 32 

Human Subjects, Safety, 141 

Hyperbolic cosine COSH Expression, 110, 219 

Hyperbolic sine SINH Expression, 110, 219 

Hyperbolic tangent TANH Expression, 110, 219 

Hysteresis, 104 

IBI, 102 

IBI inter-beat-interval, 103 

IEC60601, 284 

IIR Infinite Impulse Response filters, 201, 203, 295 

Include 

channel number, 191 

header (with text file), 184 

measurement units, 191 

time values, 191 

INF (measurement value), 160 

Input coupling, 89 

Insert 

Insert Waveform, 195 

Markers, 53, 172 

Installation Guide, 11 

Integral (measurement), 165 

Integrate 

Calculation Preset, 94 

formulas, 97 

transformation, 212 

inter sample interval, 186 

Inter-beat interval. See IBI 

Interpolate pastings, 190 

Interval 

Difference option, 100 

Interval, Rate function, 102 

Inverse mean square error (Template function), 210 

Journal, 54, 198 

Journal Preferences, 55, 191 

K (Constant) 

Calculate measurement option, 162 

Math calculation option, 105 

Waveform Math, 220 

Keyboard shortcuts, 32 

Large files, working with, 294 

Last dot only plot, 246 

Launch BSL PRO, 24 

Launch error, BSL PRO or BSL (Lessons), 27 

Lessons, creating your own, 58 

Limit (Math transformation), 206 

Lin_reg (linear regression measurement), 166 

Line plot, 246 

Linear (FFT option), 223 

Logarithm 

base 10 

Log Math transformation, 206 

LOG10 Expression function, 110, 219 

natural 
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Ln Math transformation, 206 

LOG Expression function, 110, 219 

Low Pass filter, 108 

Markers, 53, 172 

Marker Preferences, 192 

Printing markers, 172 

Time Stamp, 133 

Math 

Calculation Preset, 105 

Math Functions (Transform), 204 

Waveform Math transformation, 220 

MATLAB 

Save As (export), 186 

Max (measurement), 167 

Max cycle period, Integrate, 96 

Max T (measurement), 167 

Mean (measurement), 167 

Mean removal, 209 

Mean square error (Template function), 210 

Mean subtraction, Integrate, 96 

Mean value 

Smoothing option, 100 

Mean value smoothing, 213 

Measurement, 51–52 

copy/export measurements, 160 

Table of Explanations, 161 

measurement result, 160 

****, 160 

INF, 160 

Median (measurement), 167 

Median T (measurement), 168 

Median value 

Smoothing option, 100 

Median value smoothing, 213 

Medical equipment, classification, 284 

Menu display, customizing, 59 

Menu structure, 29 

Min (measurement), 168 

Min T (measurement), 168 

Modeling 

Nonlinear 

NLM measurement, 171 

Moving average, 213 

MP30 

MP30 Specifications, 284 

MP35 

Back Panel, 286 

Front Panel, 285 

Menu, 66 

MP35 Specifications, 284 

MP35/30 

Hardware not found, 24 

Negative edge, 149 

NerveConduction.acq sample file, 262 

New (File command), 179 

New Channel Preset button, 72 

Noise 

Math transformation, 206 

Noise rejection, 238 

resolving acquired, 293 

Noise rejection 

Rate calculation option, 101 

None (measurement option), 168 

Nonlinear modeling 

NLM measurement, 171 

Off-line Averaging, Find peak option, 228 

Offset, 89 

On-line filtering, 107 

Open (File command), 180 

Option, Save As ACQ button, 184 

Options, Save As Text button, 184 

Organize Channel Presets, 154 

Organize List, Preferences, 130 

Output Control, 117 

CH# to Output, 119 

Digital Outputs, 120 

Preferences, 118 

Pulses, 122 

Stimulator - SS58L, 122 

Stimulator—BSLSTM, 122 

Voltage, 121 

Output, Filter calculation parameter, 107 

Overlap Segments button, 80 

Overlap Segments mode, 40 

Overwrite existing data prompt, 153 

Pad with endpoint/zeros, 222 

Parameters, Integrate, 95 

Paste 

Edit command, 194 

Paste Measurement, Journal, 198 

Paste Wave Data, Journal, 198 

PC Memory, acquisition option, 80 

PDF support documents, 248 

Peak 

Count Peaks, 102 

Peak detect Pos/Neg (Find Rate option), 237 

Peak time, Find Rate function, 102 

Peak to peak, Find Rate function, 102 

Peak Detect 

Rate calculation option, 101 

Peak-to-Peak (P-P measurement), 168 

Phase, 223 

Phase distortion, IIR filter, 295 

Playback, 56 
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Plot 

AutoPlotting option, 153 

Dot plot, 245 

Last dot only, 246 

Line plot, 246 

Plot on Screen, Setup Channels option, 45 

Plot Standard Curve, 76 

Plots per page, printing option, 187 

Staircase plot, 102 

Step plot, 246 

Time series plots, 185 

Positive edge, 149 

Power supply, 293 

P-P (peak-to-peak measurement), 168 

Precision 

Horizontal Scale, 36 

Vertical scale, 37 

Preferences 

General (display), 189 

Journal, 191 

Markers, 192 

Output Control, 118 

Presets, 87 

Analog, 88 

Calculation, 93 

Control, 112 

Delay, 111 

Difference, 100 

Expression, 109 

Filter, 107 

Function, 106 

Integrate, 94 

Math, 105 

Rate, 101 

Rescale, 116 

Smoothing, 100 

New Channel Preset button, 72 

Organize Channel Presets, 154 

Print, 187 

Fit to pages option, 187 

Markers, 172 

Plots per page option, 187 

print entire file, 56 

Printer Setup, 188 

PRO Lessons, 21, 248, 304 

Pulse Sequence Output Control, 123 

Pulses Output Control, 122 

Q coefficient (IIR filters), 107, 295 

Questions, frequently asked, 291 

Quit BSL PRO application, 192 

RAM, acquisition storage, 47 

Range guide (vertical scale), 38 

Rate 

BPM, Hz (Find Rate functions), 102 

Calculation Preset, 101 

Find Rate transformation, 237–39 

Read Text Options dialog, 181 

Record 

Record last, Setup Acquisition option, 79 

Record, Setup Acquisition option, 79 

Start acquisition, 48 

Recording data, 43 

Rectify, Integrate, 95 

Refresh Graph, 247 

Remove 

Remove mean, 209, 223 

Remove trend, 224 

Remove Waveform, 195 

Remove baseline 

Rate calculation option, 101 

Remove baseline, Integrate, 95 

Repeat, setup acquisition option, 86 

Resample, 217 

Rescale 

Calculation Preset, 116 

Reset 

Append acquisition button, 79 

Reset Chart Boundaries (Size Window option), 247 

Reset Chart Display option, 243 

Reset Thresholds, Integrate, 96 

Reset trigger, Integrate, 96 

Reset via channel, Integrate option, 94, 96 

Resize Window, 247 

Right mouse button shortcuts, 33 

Ringing, IIR filter, 295 

Root mean square, Integrate, 95 

ROUND Expression function, 110, 219 

RS-232/RS-422 signal, 292 

Safety, 284 

Safety Note, 11 

Sample (measurement), 168 

Sample data files, 255 

Sample Rate, 47, 80–84 

Samples, Integrate, 95 

Save 

Save (File command), 183 

Save As (File command), 183 

Save once, Setup Acquisition option, 79 

Save Settings, Preferences, 123, 129 

Scaling, 74 

Analog channels, 75 

Calculation channels, 76 

Scope mode, 40 

Scroll 
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scroll bars, 34 

Scrolling, MP35/30 menu item, 153 

Section 508 Compliance, 32 

Select 

area, 50 

channel, 49 

Select All (Edit command), 195 

waveform, 49 

Set Template, 208 

Set up Triggering, 149 

Set Wave Positions, 243 

Setup Acquisition, 47 

Setup channels, 69 

Setup Channels, 45 

Shortcuts 

keyboard, 32 

mouse, 33 

Show 

Show Input Values, 71, 150 

Show modified input, 223 

Sine 

SIN Expression function, 110, 219 

Sin Math transformation, 206 

Size Window, 247 

Slope (measurement), 168 

Smoothing 

Calculation Preset, 100 

mean value smoothing, 213 

median value smoothing, 213 

transformation function, 213 

Sound Sequence Output Control, 126 

Spectral analysis. See FFT 

Spectrophotometer data, 76 

Square root 

SQRT Expression function, 110, 219 

Sqrt Math transformation, 207 

Square SQR Expression, 110, 219 

Staircase plot, 102 

Standard Curve, 76 

Plot Standard Curve, 76 

Standard Curve Settings, 78 

Standard deviation (Stddev measurement), 169 

StandardCurveData.acq sample file, 264 

Starting an acquisition, 48 

Startup file 

Customizing for BSL PRO, 63 

Startup Script, modifying, 59 

Statistics (Display command), 247 

Status indicator, software, 48 

Stddev (standard deviation measurement), 169 

Step plot, 246 

Stimulator 

Stimulator Reference Channel, 141 

Stimulator - BSLSTM, 122 

Stimulator – SS58L, 122 

Stopping an acquisition, 48 

Summary to Journal, marker menu, 172 

Symbols, MP35 unit, 284 

Tabs, Journal, 191 

Tangent TAN Expression, 110, 219 

Template Functions, 208 

Text files, 55, 180–82, 184 

Threshold 

Auto Threshold detect, Rate option, 101 

Threshold (Math transformation), 207 

Threshold-crossing algorithm, 238 

Tile Waveforms, 42 

Tile after transformations, 190 

Time 

Expression Source, 110 

measurement, 169 

Time offset (Peak option), 234 

Time scale, 292 

Time series plots, 185 

Transform menu, 199 

Derivative, 212 

Difference, 215 

Digital Filters, 201 

FIR filters, 201 

IIR filters, 203 

Expression, 218 

FFT, 222 

Find Peak (Peak Detector), 226 

Find Rate, 237 

Histogram, 216 

Integrate, 212 

Math Functions, 204 

Smoothing, 213 

Template Functions, 208 

Waveform Math, 220 

Trigger, 149 

Troubleshooting, 255–91 

Truncate TRUNC Expression, 110, 219 

TTL signal, trigger, 149 

Undo, 193 

Update screen interval, 190 

Use all available memory, 190 

User-defined interval (Find peak option), 226 

ValidateMeasurements.acq sample file, 265 

Value (measurement), 170 

Vertical axis, 20, 75 

Virtual memory, 294 

Voltage Output Control, 121 

Warn on Overwrite, 153 
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Wave Color, 244 

Waveform Arithmetic, 162 

Waveform Math, 220–21 

Waveform Statistics dialog, 247 

Waveform, selecting, 49 

Window 

FFT option, 224 

Find Rate limits, 238 

FIR Filter option, 201 

menu, 248 

Rate calculation option, 101 

Window functions/filter characteristics, 298 

Windowing Units, 101, 238 

Windows Metafile, 197 

WMF files, 55, 185 

X-axis T/F/X (measurement), 170 

X-Y mode, 41 

X-Y Mode 

Plot Standard Curve, 76 

Zoom Back / Forward, 243 

Zoom tool, 50 
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